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New Features for Time and Billing Professional Version 4.20

The 4.20 version of Time and Billing Professional has been enhanced with the
following new features.

New Ability to Limit Invoices to Current Engagement

The new ability to limit invoices to current engagements (see page 161) has been
added to the Client Maintenance (see page 144) and Client Inquiry (see page 164)
features of Time and Billing Professional.

In Client Maintenance and Client Inquiry, the Invoices tab lists all invoices for the
client, regardless of what engagements are on the invoice. During the search
execution, the selection of the Current Engagement Only option available on the
AR Invoice Search window allows you to limit that list to the invoices that have the
current engagement.

New Support of Paperless Office Registers and Journals

The Time and Billing Professional module now supports Sage Software Extended
Solutions Paperless Office: Journals and Registers (LM-1018).

For detailed information, see Paperless Office: Journals and Registers at
http://www.sagesoftware.com/mas90/extendedsolutions.

The Paperless Office solution allows printing of journals and registers in PDF
format, and provides a Viewer utility for the viewing and deleting of PDF
documents.

After the document has been printed in PDF, it will be presented to you via a PDF
reader window. If the document has a password associated with it, then you will be
prompted for it. In most cases, a journal and all supported documents will be
created in one PDF file.

The Paperless Office Support is implemented for the following documents:

» Time/Expense Journal (see page 173)

Billing Selection Register (see page 189)

+ Billing Register (see page 219)

Delete Work in Process Register (see page 226)

+ Edit Work in Process Selection Register (see page 230)

Edit Work in Process Journal (see page 235)
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Chapter 1

Introduction

The HighTower Ideal

Chapter 1: Introduction

At HighTower, we are committed to delivering superior accounting, time
management, manufacturing and distribution solutions to small and mid-sized
businesses.

HighTower is a Sage Software® Master Developer for Sage MAS 90 ERP and
Sage MAS 200 ERP software with titles such as Direct Deposit, Gift Card
Expansion Pack, MAStransit, MICR Encoded Laser Checks, Multi-Bin® Advanced
Distribution, Point of Sale® Professional, Professional Retainer Control, Remote
Salesperson PDA, ScanBlaster, Time and Billing®, Time and Billing®
Professional, and Timekeeper® to our credit.

HighTower uses a unique Patch Installation system, which installs the HighTower
enhancements without overwriting your original Sage Software program. Our
patch installation method makes our products attractive to users installing
enhancements from multiple Sage Software Master Developers.

Our promise of exceptional technical products is only exceeded by our
commitment to customer service. Our success is measured in customer
satisfaction.

Welcome to Time and Billing Professional

Time and Billing® Professional is an enhancement for the Sage MAS 90 and
Sage MAS 200 applications developed by Sage Software. The Time and Billing
Professional module works with Sage MAS 90 or 200 to provide you with the
ability to track your employees’ time against billable projects. The Time and Billing
Professional module also provides you with the features to create customer
invoices based on the times entered by employees.

Integrating Time and Billing Professional with other
Sage MAS 90 or 200 Modules

The Time and Billing Professional module integrates with other Sage MAS 90 or
200 modules to create a comprehensive time tracking and billing accounting
system. When integrated, each module "shares" common information with any
related modules. Your company can integrate the following Sage MAS 90 or 200
modules with the Time and Billing Professional module:

» Accounts Receivable (see page 14)

» Accounts Payable (see page 14)

» General Ledger (see page 14)

To integrate the Time and Billing Professional module with these modules, you
must set up these modules before installing Time and Billing Professional.
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Page 14

Chapter 1

Accounts Receivable

You must integrate the Time and Billing Professional with the Accounts
Receivable module. The Time and Billing Professional module integrates with
Accounts Receivable for the following key areas of billing:

+ Billing Data Entry
* Credit Memo Entry

* Open Item versus Balance Forward Billing

Accounts Payable

Use the Accounts Payable module to post reimbursable fees and expenses
directly into the Time and Billing Professional Work in Process files. During
Accounts Payable Invoice Data Entry and Manual Check Entry, you can enter
expense information by employee, client, engagement, or work code.

The Invoice Register and Manual Check Register features in Accounts Payable
will check for valid clients, engagements, employees, work codes, and General
Ledger line accounts setup in Time and Billing Professional. If you select the Post
Work in Process to General Ledger check box on the Additional tab of Time and
Billing Professional Options, the Accounts Payable module will also check the
General Ledger work in process and work in process offset accounts.

The Invoice Register and Manual Check Register features will automatically post
to the Time and Billing Professional files after they are printed. However, if the
Time and Billing Professional Billing Data Entry or Billing Selection features are
processing, you will not be able to update the Accounts Payable expense entries.

General Ledger

The General Ledger module is the key to integrating all financial information from
the Time and Billing Professional module, as well as from the other accounting
modules. The General Ledger module provides complete, timely financial reports
which consistently reflect current information.

If the General Ledger module is installed, all journal entries generated from Time
and Billing Professional are posted directly to the General Ledger following the
printing and updating of the Daily Transaction Register. The financial statements
and other General Ledger reports printed after the completion of the Daily
Transaction Register will reflect postings on the register.

If the General Ledger module is not installed, the Time and Billing Professional
journal entries can be posted to the General Ledger Detail Posting file following
the printing of the Daily Transaction Register. The General Ledger Posting Recap
report printed from this file will provide the necessary audit information to prepare
monthly journal entries for your manual General Ledger. The information on this
report will be purged following Time and Billing Professional period end
processing.

Time and Billing Professional Manual Chapter 1: Introduction



Chapter 1

When the General Ledger is installed Time and Billing Professional is
automatically integrated with it, unless you clear the Integrate Time and Billing
Professional with General Ledger check box on the Additional tab of Time and
Billing Professional Options window.

If this check box is clear, Time and Billing Professional will make no postings to the
General Ledger following Daily Transaction Register printing. If the General

Ledger module is not installed, this option will determine whether Time and Billing
Professional will post the journal entries to the General Ledger Detail Posting file.

Using the Time and Billing Professional Manual

This manual provides the information necessary for setting up and operating your
Time and Billing Professional module. Use the Time and Billing Professional
manual as a guide when initially setting up the module, and then as a resource for

understanding features of the module. The manual contains overviews and
samples of windows and menus.

Sections in this Manual

This manual is divided by the different menus available in Time and Billing
Professional. The following table describes the chapters available in this manual.

Chapter Description

Chapter 2: Time and Billing

Professional Concepts

This chapter explains different concepts you need to
know about using your Time and Billing Professional
system.

Chapter 3: Installing the

Time and Billing
Professional Module

This chapter details the installation procedures for Time
and Billing Professional.

Chapter 4: Migrating Data
from the Time and Billing
Module

This chapter is for companies that currently use the Time
and Billing module and want to migrate to the Time and
Billing Professional module.

Chapter 5: Navigating in

Time and Billing
Professional

This chapter describes the basic features available in the
Time and Billing Professional module.

Chapter 6: Using the Setup

Menu

This chapter describes how to enter the basic information
required to use the Time and Billing Professional module.
This chapter includes setting general options for the
module.

Chapter 7: Using the Main
Menu

This chapter details how to create clients for Time and
Billing Professional data and how to create time entries
for employees.

Chapter 8: Using the Billing

Menu

This chapter details how to setup billing invoices based on
data available in Time and Billing Professional.

Chapter 9: Using the
Reports Menu

This chapter details how to print reports based on
information available in the Time and Billing Professional
module.

Chapter 1: Introduction
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Chapter

Chapter 1

Description

Chapter 10: Using the
Analysis Menu

This chapter details how create analysis reports based on
information available in the Time and Billing Professional
module.

Chapter 11: Using the
Period End Menu

This chapter details the steps required for period-end
processing. This chapter includes period and year-end
processing, clearing billing history, and purging
terminated employees.

Chapter 12:Integration with
Sage MAS 90 or 200

This chapter describes the changes to the modules when
integrated with Time and Billing Professional.

Graphic Conventions

The following icons are used throughout this manual to indicate different types of

information.

Graphic

Description

|

The Note symbol is followed by additional
information about a topic.

g

The Helpful Hint symbol is located in the left
margin and contains additional information about an
option.

N

The Warning symbol is followed by information to
help you avoid costly mistakes.

Text Conventions

The following table describes the text conventions used in this manual.

Text Convention

Explanation

Field font Indicates a field name, list box name, options in a
list, column name, or check box.

Italic font Indicates directory names or references to other
manuals.

Getting Additional Help

This module contains online manuals, online help, and technical support.

Getting Additional Copies of the Manual

The Time and Billing Professional manual is available when you install the module.

Page 16

Time and Billing Professional Manual

Chapter 1: Introduction
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Open the Time and Billing Professional Online Manual

Chapter 1

1 From the Help menu on the Sage MAS 90 or 200 menu bar, select
Enhancement Manuals. The Manuals list appears on the right side of the

screen.
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Page 18

Chapter 1

Using the Time and Billing Professional Online Help

The Time and Billing Professional module includes an extensive online help with
the standard content online help and context-sensitive online help for fields and
windows.

E? Information Center =]
s o

Show Back Print  Options

M Getting Started with Time and Billing Professional
MUsing Time and Bifling Professionai

M Getting Results

Technical Suppart Printed Manual

« LI_I
Online Help

Open the Online Help

* For field level context-sensitive help, move your cursor to the field and press F1.
A pop-up window appears with help for the field.

» For window level context-sensitive help, click the button on the window.
The help screen for the window appears.
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Chapter 1

Support Services

There are several methods of support for your Time and Billing Professional
module:

» Contact your Authorized Reseller or Consultant. If you do not have an
Authorized Reseller or Consultant, consult the Time and Billing Professional
website (www.timeandbilling-software.com).

» Refer to the Enhancement Data Definitions available in the Library Master
Extensions module in the Utilities menu. This feature lists all the data fields
available on each window of this module.

+ Access technical bulletins and download program corrections through the Time
and Billing Professional website (www.timeandbilling-software.com). Note that
program corrections are available exclusively through the Internet.

For more information about fee-based customer support services, contact our
Help Desk Department. Regular Help Desk hours are 9:00 A.M. to 5:00 P.M.
Central Standard Time Monday through Friday. You can reach our Help Desk
Department in the following ways:

» Phone: 1.888.583.3000
» Fax: 847.674.0544

* E-mail: helpdesk@hightowerinc.com

This concludes Chapter 1: Introduction of the Time and Billing Professional
manual.
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Time and Billing Professional Concepts

Data You Need

Page 20

Chapter 2: Time Professional Concepts explains different concepts you need to
know to use your Time and Billing Professional module to the fullest extent.

Before starting the Time and Billing Professional module, the Accounts Receivable
module must be activated and set up. This includes A/R Divisions (if activated)
and at least one salesperson (if activated). The following Accounts Receivable
information must be assembled and available for use:

* Your General Ledger Chart of Accounts

A list of bank information and offices

A list of states in which you operate and collect sales tax

A list of employees, categories, work codes, standard comments, and billing
formats

A list of your clients, their addresses, and phone numbers

A list of engagements for each client, if applicable

All time sheets, expenses, and invoices to be processed

» All payments to be processed

Client Numbering Methods

Use the Time and Billing Professional module to assign up to seven characters to
identify each client. You can use numbers, letters, or a combination of both. If the
Accounts Receivable Division check box is selected on the Accounts
Receivable Options window, the division number must precede the customer
number.

If you use only numbers for the client code, the Time and Billing Professional
module automatically inserts leading zeros. For example, an entry of 150 displays
as 0000150. If you use any letters for the client code, entries remain exactly as
you enter them.

Since client codes identify Time and Billing Professional entries, use a client
numbering method that is best for you. The following list suggests three possible
numbering methods with an explanation of the benefits of each method.

* Use Numbers Only: If you use the numeric key pad on your keyboard, this
method has the advantage of speedy entry. Since leading zeros are inserted
automatically, you need only type the significant digits of the client code. This
method is especially suitable for businesses with a large number of clients
where it cannot be practical to assign a descriptive code to each client.

To assign numbers to each client, increment by 10s or 20s between clients. You
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might also organize your clients into groups using the first two or three digits of
the client code to denote specific types of clients.
For example, clients 0010100 and 0010200 can both be nonprofit clients.

You can also use the first two digits of the client code to designate the first letter
of the client's name (for example, 01 = A, 26 = Z). This could be an advantage if
you want to alphabetically sort information on reports.

* Use an Abbreviation of the Client Name: Use this method to identify the client
by looking at the abbreviated name (for example, ABCPROD, FEDCORP, or
PROTECH). Additionally, this method means all Time and Billing Professional
reports sorted by client code will list clients in alphabetical sequence. Although
this method is the simplest method to use, it is only practical if you have a
relatively small number of clients whose names you easily recognize.

* Use a Combination of Numbers and Letters: Use this method for simple
assignment of codes using common client information such as the first two or
three characters of the client name followed by a four-digit number. This number
might be the last four digits of the client's phone number or another unique
number.

Since leading zeros are not inserted when letters are used, you must type
leading zeros for the numeric portion of the client code. If you do not use the
leading zeros, client codes will not be sorted properly (for example, clients 8
through 10 should be entered as A08, A09, and A10).

When selecting your numbering method, remember that most Time and Billing
Professional reports can be sorted by client code, client name, sort field, zip
code, client type, client partner, client employee, or by the user-defined
miscellaneous fields. If you are using a numeric client numbering method, you
can use the client name sort option to obtain alphabetical listings of client
information. You can also use the sort field to sort clients by other information
such as types of service, product, or industry.

Explanation of General Ledger Postings

The Time and Billing Professional module is a complete, double-entry accounting
system, which minimizes the amount of data entry required, saving time and
reducing the possibility of posting errors.

Regardless of whether you have the General Ledger module installed, Time and
Billing Professional posts journal entries to the Daily Transaction Register (see
page 177) using account numbers defined in General Ledger Account
Maintenance.

« If the General Ledger module is installed, the journal entries will be posted
automatically to the General Ledger.

« If the General Ledger module is NOT installed, you can use the General Ledger
Posting Recap to make journal entries to your manual General Ledger.
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Time/Expense Entry Data Posting to General Ledger

You use the Time/Expense Entry (see page 168) feature to record all unbilled fees
and expenses.

If you selected the Post Work in Process to General Ledger check box on the
Additional tab of Time and Billing Professional Options (see page 80), the
balance of the unbilled fees and expenses recorded is posted to the Work in
Process account and Work in Process offset account. If this check box is cleared,
no General Ledger postings will be made.

During Time/Expense Entry, you can override the revenue/expense account for
each line entered; however, no postings will be made to these accounts until that
line entry is billed.

A Time/Expense entry with a total of $100.00 in fees and expenses will typically be
posted to the General Ledger as follows:

G/L Account Debit Credit

Time/Expense Entry Amount Work in Process 100.00
Work in Process Offset _ 100.00
100.00 100.00

Edit Work in Process Selection Data Posting to General Ledger

Use the Edit Work in Process Selection feature (see page 228) to select unbilled
Work in Process transactions to be edited for a specific client/engagement using a
range of dates, employee codes, work codes, and transaction numbers.

If you selected the Post Work in Process to General Ledger check box on the
Additional tab of Time and Billing Professional Options (see page 80) the posting
will be made. If this check box is clear, no General Ledger postings will be made.

A General Ledger posting for a $250.00 Edit Work in Process Selection amount
will typically be made as follows:

G/L Account Debit Credit

Edit WIP Selection Amount Work in Process Offset 250.00
Work in Process - 250.00
250.00 250.00

Edit Work in Process Entry Data Posting to General Ledger

Use the Edit Work in Process Entry feature (see page 231) to edit, delete, and add
Work in Process transactions previously selected during Edit Work in Process
Selection (see page 228).

If you selected the Post Work in Process to General Ledger check box on the
Additional tab of Time and Billing Professional Options (see page 80), the posting
will be made. If this check box is cleared, no General Ledger postings will be
made.
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During Edit Work in Process Entry, you can override the revenue/expense account
for each line item entered; however, no postings will be made to these accounts
until that line item is billed.

A General Ledger posting for a $300.00 Edit Work in Process Entry amount will
typically be made as follows:

G/L Account Debit Credit

Edit WIP Entry Amount Work in Process 300.00
Work in Process Offset _ 300.00
300.00 300.00

Delete Work in Process Data Posting to General Ledger

Use the Delete Work in Process (see page 224) feature to remove unbilled fees
and expenses entered during Time/Expense Entry (see page 168) or Edit Work in

Process Entry (see page 231).

If you selected the Post Work in Process to General Ledger check box on the
Additional tab of Time and Billing Professional Options (see page 80), the Work in
Process account and Work in Process offset account are adjusted by the amount
of unbilled fees and expenses deleted. If this check box is cleared, no General
Ledger postings will be made.

A General Ledger posting for deleting $100.00 of unbilled fees and expenses will
typically be made as follows:

G/L Account Debit Credit

Deleted Unbilled Amount Work in Process Offset 100.00
Work in Process - 100.00
100.00 100.00

Accounts Payable Invoice Data Entry Posting to General Ledger

Use the Invoice Data Entry feature in Accounts Payable to enter expenses for
specific clients/engagements, when Accounts Payable is integrated with the Time
and Billing Professional module.

Invoices can be distributed directly to General Ledger expense accounts without
posting to the Time and Billing Professional Work in Process accounts if Post
Work in Process to General Ledger check box on the Additional tab of Time
and Billing Professional Options (see page 80) is cleared.

A General Ledger posting for an invoice with a total of $800.00 in expenses will
typically be made as follows:

G/L Account Debit Credit

Reimbursed Expenses Expense 800.00
Invoice Data Entry Amount Accounts Payable - 800.00
800.00 800.00

If you selected the Post Work in Process to General Ledger check box on the
Additional tab of Time and Billing Professional Options (see page 80), the
following additional General Ledger postings will be made:
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G/L Account Debit Credit

Invoice Data Entry Amount Work in Process 800.00
Work in Process Offset ______ 800.00
800.00 800.00

For additional information, see the Accounts Payable Online Help by Sage
Software.

How to Use Work/Category Codes

Page 24

Use work codes to group and identify each type of service, work, and reimbursable
expense you want to track for billing and reporting purposes. Each work code must
be assigned a category code to group related work codes for creating analysis
reports. You can bill efficiently and obtain the exact analysis information you need
with careful selection of work codes (see current page) and category codes (see
page 25).

Using Work Codes

You can define as many work codes as necessary, using three alphanumeric
characters, to track all fees, services, and reimbursable expenses. Work codes
are sometimes referred to as service codes. For each work code, you can specify
billing rates and the General Ledger revenue or expense account.

» Each work code must be unique and cannot be duplicated in more than one
category code.

* Itis recommended that you define your work codes using abbreviated codes
applicable to your specific business.

« If you want to track services and expenses in a specific order, or if you have a
large number of work codes, you may want to define your work codes
numerically.

The following illustrates some possible work code definitions:

Work Code Description Work Code Description
ACN Audit Internal ICN Internal Control
Control Consulting
AFX Audit Fixed Assets INC Investment
Consulting
AIN Audit Inventory POS Postage Expense
ARC Audit Receivables SKD Sick Day
CLR Clerical Services SLT Sales Tax Form
Prep.
CPY Photocopy STF Staff Meeting
Expense
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Work Code Description Work Code Description
DCT Dictation STX State Tax Form
Prep.

DOC Document TRV Travel Expense
Preparation

FPL Financial Planning TXP Tax Planning

FTX Federal Tax Form VAC Vacation Time
Prep

Using Category Codes

Use category codes to group related work codes to sort or summarize work code
information for analysis reports. You can also use category codes to classify each
work code as billable, non-billable, billable expense, or non-billable expense. All
work codes within the same category are defined with the same billing type.
Category codes are especially useful if you have a large number of work codes
defined and do not require a high level of detail in your analysis reports.

» Category codes are defined using three alphanumeric characters, and as with
work codes, it is recommended that you define your category codes using
abbreviated codes applicable to your specific business.

« If you want to track categories in a specific order, you can define your category
codes numerically.

The following table is a partial listing of how the work codes from the previous
example can be organized by category:

Category Code Work Code Description Bill Type
AUD Audit Services Billable
ACN Audit Internal
Control
AFX Audit Fixed Assets
AIN Audit Inventory
ARC Audit Receivables
CLK Clerical Services Billable
CLR Clerical Services
DOC Document
Preparation
DCT Dictation
EXP Expenses Billable Expense
CPY Photocopy
Expense
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Category Code Work Code Description Bill Type
POS Postage Expense
TRV Travel Expense

NOB Non-Billable Time Non-Billable
SKD Sick Day
STF Staff Meeting
VAC Vacation Time

How to Use Engagements
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Use engagements to track separate work activities for a single client. You can
assign a different fee arrangement, billing rate, billing format, budgets, and
employees to each engagement. Depending upon the nature of your business,
you may refer to engagements as projects, jobs, or matters.

To use the Engagement feature, select Multiple Engagements per Client check
box on the Main tab of Time and Billing Professional Options (see page 80). The
terminology used when referring to engagements is also specified in Time and
Billing Professional Options.

If the Multiple Engagements per Client check box is cleared, you are restricted
to a single default engagement code per client. You can only assign a single fee
arrangement, billing rate code, and billing format for each client. All references to
engagements will be turned off in all maintenance and data entry programs, and in
all reports.

If you are using the Engagement feature, you will be required to enter an
engagement code after specifying a client code on the T/2 Client Maintenance
window (see page 144). The engagement code can be 4 - 20 alphanumeric
characters in length. You will also be required to enter the engagement code
following the client code in all data entry programs.

All information maintained on the Billing tab on the T/2 Client Maintenance
window (see page 154) will be recorded separately for each engagement. As a
result, you can assign a separate partner, employee, fee arrangement, billing rate
code, and billing format for each engagement. In addition, you can assign a
separate General Ledger revenue account for each engagement.

All Work in Process and Billing history information is tracked separately for each
engagement code for a client. By utilizing Time and Billing Professional reports
(see page 238), you can selectively print engagement detail for all or a specific
range of engagement codes.

If you want to track engagements for a specific type of service for all clients, you
can use a descriptive 4 - 20 alphanumeric code for each type of engagement. For
example, you can define all audit-type engagements as AUDIT. By grouping
engagements by type in this manner, you can select to print engagement
information for a specific type of work activity.
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If the tracking of engagements by type is not appropriate for your business, you
can assign a numeric sequence for each engagement for a client (that is, the first
engagement for a client can be assigned engagement code
00000000000000000001; and the second engagement can be engagement code
00000000000000000002, and so on).

Billing Engagements Separately

If you select the Bill Separate check box on the Billing tab of the T/2 Client
Maintenance window (see page 154), you can specify separate fee arrangements,
billing frequencies, and billing formats for each engagement.

You can print and record a separate invoice in your Open Invoice file for each
engagement billed for the client. When you process cash receipts, each payment
can be applied separately to each engagement invoice.

« If the Bill Separate check box is cleared, the same fee arrangement, billing
frequency, and billing format will be used for all engagements for the client.

» Only one invoice will be produced for the client for each billing. However, the
invoice can provide separate subtotals of billing detail for each engagement.

Activating the Engagement Feature

If you process the Time and Billing Professional module for a period of time
without using the Engagement feature, and want to activate it, you can do so by
selecting the Multiple Engagements per Client check box on the Main tab of the
Time and Billing Professional Options window (see page 80).

All previously processed client information will be accessible using the default
engagement code, 0000 (if engagement code length is only four characters in
length). You can add additional engagements for clients by assigning new
engagement codes.

Explanation of Billing Rates

Use the Time and Billing Professional module to access a wide selection of
options to automatically determine the billing rate to be used for each activity. You
can enter a standard description for each billing rate code on the Time and Billing

Professional Options window (see page 80).

* On the simplest level, you can assign a single billing rate to be used for each
employee.

» For maximum flexibility, you can assign a unique custom billing rate to be used
for each employee and client/engagement combination.

To implement the most efficient billing rate method for your business, you should
understand all of the methods presented in this chapter before entering billing rate
information.

You can enter information for establishing the billing rate in the following programs:
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+ Employee Maintenance: You can assign up to ten separate billing rates, as
well as the cost per hour for each employee. Billing rates are assigned to billing
rate codes 0 through 9.

* Work Code Maintenance: You can specify the rate method to be used for each
work code.

- For fees, you can enter the billing rate to be used for the work code, use the
billing rate code specified for the client, or specify the separate billing rate
code to be used to determine the actual billing rate established for an
employee.

- For billable expenses, you can specify a fixed amount to be billed or billing
rate to be used.

+ Billing Data Window (in_T/2 Client Maintenance): You can specify the billing
rate code to be used for the client. This billing rate code is used in conjunction
with work codes that have been defined to use the client's billing rate code.

+ Custom Bill Rate Maintenance Window (in_T/2 Client Maintenance): You can
specify a unique billing rate to be used for a specific employee or employee level
for the client. This billing rate supersedes all other billing rates previously
described.

Assigning Billing Rates by Employee

Using the Employee Maintenance feature (see page 92), you can assign up to ten
billing rates for each employee. You can also assign the cost per hour for each
employee billing rate entered for billing rate codes 0 through 9. For each billing
rate code, you can enter the billing rate amount and time unit to be used. You can
define time units as dollars per hour (H) or dollars per unit (U).

The rate you entered for billing rate code 0 will be used as the default rate. If a
zero is specified for any applicable billing rate code, the rate entered for billing rate
code 0 will be used instead. For this reason, you should always specify a rate for
billing rate code O.

Classifying Billing Rate Codes

To build an effective billing rate structure for your employees, you must first
determine how to use billing rate codes. The purpose of each billing rate code
should be consistent for all employees. For example, you may want to classify
billing rate codes by the type of services performed, as illustrated in the following
table.

Billing Rate Code Services Rendered

0 Default or standard rate
1 Management Advisory Services
2 Audit Services
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Billing Rate Code Services Rendered

3 Administrative Services

4 Clerical Services

You assign these billing rate codes to each appropriate work code to determine
the billing rate to be used for each type of service rendered.

For example, employee JWS has a standard billing rate of $75.00 per hour, a
Management Advisory Services rate of $100.00 per hour, and an Audit Services
rate of $65.00 per hour. Administrative and Clerical Services are not applicable for
this employee and are left blank. The billing rate for billing rate code 0 will be used
as the default rate if zero is specified for a billing rate code.

You can also classify billing rate codes by the type of client or the nature of the
engagement, as illustrated in the following table.

Billing Rate Code Type of Client or Engagement

0 Default or standard rate
1 Tax Engagement

2 Audit Engagement

3 Nonprofit Engagement
4 Special Engagement

You assign these billing rate codes to each client and/or engagement to determine
the billing rate to be used. To use this method, you must define the work codes to
use the client's billing rate code.

You can mix these two examples of classifying billing rate codes (for example, by
type of service and type of client/engagement) by reserving certain billing rate
codes for types of services and reserving other billing rate codes for types of
clients and engagements.

As illustrated in the following table, billing rate codes 0 through 4 are reserved for
services, and billing rate codes 5 through 9 are reserved for clients and
engagements.

Billing Rate Code Type of Service or Client/Engagement
0 Default or standard rate

1 Management Advisory Services

2 Audit Services

3 Administrative Services

4 Clerical Services

5 Tax Engagement

6 Audit Engagement
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Billing Rate Code Type of Service or Client/Engagement

7 Nonprofit Engagement
8 Special Engagement
9 In-House Activities

Assigning Billing Rates by Work Code

Using the Work Code Maintenance feature (see page 99), you can specify the rate
method to be used for each individual work code. Use the rate method to control
how the actual billing rate is determined for an activity that uses the work code.

Select one of the following methods from the Rate Method field in Work Code
Maintenance for each work code:

* Work Code Rate: Use this method to enter a single billing rate that will be used
for the work code. This rate will be used, regardless of the employee specified
for an activity.

- For fees, the rate represents dollars per hour or dollars per time unit.

- For expenses, the rate can also represent dollars per quantity such as number
of photocopies.

+ Employee Rate Code: Use this method to enter the billing rate code (0 through
9, or C for cost per hour) to determine which employee rate to use. Typically, you
will determine the appropriate billing rate code based on the type of service
represented by the work code.

For example, suppose work code INC (Investment Consulting) is defined as
billing rate code 1. Work code ARC (Audit Receivables) is defined as billing rate
code 2. Employee JWS is defined with billing rates of $100.00 per hour for billing
rate code 1 and $75.00 per hour for billing rate code 2, as illustrated in the
following table.

Work Code Description Billing Rate Billing Rate
Code
INC Investment 1 100.00/hr
Consulting
ARC Audit Receivables 2 75.00/hr

As a result, a time/expense entry for employee JWS and work code INC is billed
at $100.00 per hour and work code ARC is billed at $75.00 per hour.

» Client Employee Rate Code: Choose this method to use the billing rate code
established for the client on the T/2 Client Maintenance window (see page 144)
to determine which employee rate to use. The billing rate used will be based on
the type of client or the nature of the engagement. This method CANNOT be
specified for billable expense or non-billable expense work codes.
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For example, suppose both work code INC (Investment Consulting) and ARC
(Audit Receivables) are defined as billing rate method C. Client ABC is defined
as billing rate code 2. This method means that for employee JWS from the
previous example, both work codes INC and ARC are billed at $75.00 per hour.

» Fixed Amount: Use this method to specify a fixed dollar amount to be billed for
the work code. You can enter the default fixed amount, or you can enter 0 if the
default is not appropriate.

- You can only use this method for billable expense or non-billable expense
work codes.

- You can also specify a markup rate to calculate the actual billing amount. Both
the fixed amount and the markup rate can be overridden during data entry.

For example, suppose work code POS (Postage Expense) is defined with the
default fixed amount of 0 and a markup rate of 20%. If you enter work code POS
during time/expense entry for the amount of $50.00, the actual billable amount
will be calculated as 50 x 1.20 or $60.00.

Assigning Billing Rates by Client/Engagement

Using the T/2 Client Maintenance window (see page 144), you can specify the
billing rate code (0 through 9, Employee Cost per Hour, or Work Code Rate) to be
used for each client/engagement. Whenever you use a work code that is defined
with employee cost per hour, the billing rate code established for the
client/engagement will be used to determine which employee billing rate to use.
You can use this feature to determine the billing rate based on the type of client or
the nature of the engagement.

On the Billing tab of the T/2 Client Maintenance window (see page 154), you can
enter one of the following codes in the Bill Rate Code field:

« Bill Rate Code: Use this method to specify the billing rate code (0 through 9) to
be used for this client/engagement. The actual billing rate will be determined by
the employee billing rate defined for the specific billing rate code.

* Employee Cost: Use this method to specify the cost per hour default for the
employee as the billing rate to be used.

» Work Code Rate: Use this method to use the billing rate specified for the work
code. To use this method, you must enter the appropriate billing rate code for
each work code in the Billing Rate field in Work Code Maintenance.

Assigning Custom Bill Rates by Client/Engagement

For maximum flexibility in establishing billing rates for fees, you can use the
Custom Billing Rate feature on the T/2 Client Maintenance window (see page
154). You can use this feature to define unique billing rates to be used for a
specific employee working for a specific client/engagement. In addition, you can
assign a custom billing rate to an employee level (0 through 9) rather than to
individual employee codes. Custom billing rates supersede all other billing rates
for fees that are otherwise applicable for the client/engagement.
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You can establish any number of custom billing rates for each client/engagement.
Each custom billing rate can be defined for a specific employee or for an employee
level. You can enter a custom billing rate for an employee by entering the
four-character employee code in the Employee/Level field. You can enter a
custom billing rate for an employee level by entering slash (/) followed by a
number (0 through 9) at this field. All employees that match the specified
employee level will be billed at the specified custom billing rate.

For each custom billing rate entry, you must specify the billing rate method to be
used to determine the billing rate. You can specify one of the following billing rate
methods:

* Rate Amount: Use this method to enter the billing rate amount to be used. You
can also specify the time unit as dollars per hour (H) or dollars per unit (U).

* Work Code Rate: Use this method to use the billing rate method specified for
the work code to determine the billing rate.

+ Employee Rate Code: Use this method to specify the billing rate code (0
through 9) to be used to determine the employee billing rate.

Example: Assume that client AA is established with the following custom billing
rates:

Employee Level Name/Description Billing Billing Rate Time Unit
Method

12 Level 2 R $45.00 H

AAA1 IMA Winnur C 0 -

BBB2 John Doe w - -

CCcC3 B.A. Winnur R $95.00 H

When you process a time/expense entry for client AA, the Time and Billing
Professional system will first search for any custom billing rates established for
each employee. If none are found, the system checks for custom billing rates
established for employee levels. If custom billing rates are not found for either
employees or employee levels, the standard billing rate methods are applied for
the client.

« Employee AAA1 will be billed using the rate established for Billing Rate Code for
that employee.

» Employee BBB2 will be billed using the billing rate method specified for the
applicable work code.

« Employee CCC3 will be billed at a custom billing rate of $95.00 per hour.

« Employee DDD4 at employee level 2 will be billed at a custom billing rate of
$45.00 per hour.

» Employee EEES at employee level 1 will be billed using the standard billing rate
methods established for the applicable work code.
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The following tables recap how billing rates are determined based on each
transaction's work code, employee code, and client/engagement code.

Without Custom Billing Rates

The following table illustrates how billing rates are determined when no custom
billing rates are specified for the employee code or employee level for the

client/engagement.

From Work Code File

Bill Rate E
Type Method Code

From Client/
Engagement
Master File

Client Rate
Code

Source
of

Billing Rate

All R

Billing rate specified for the work code
is used.

BorN E 0-9

Billing rate specified for the
corresponding rate code (0-9) in the
Employee file is used.

Cost per hour in the Employee file is
used.

BorN C

Rate code in the client/engagement file
is used to determine the corresponding
billing rate from the Employee file.

Cost per hour in the Employee file is
used.

Billing rate in the Work Code file is
used.

EorX F

The fixed amount in the work code file
is used as the default amount. The
markup rate in the Work Code file is
used to calculate the bill amount.

Using Custom Billing Rates

The following table illustrates how billing rates are determined when custom billing
rates are specified for the employee code or employee level for the

client/engagement.

Custom Bill Custom
Rate Method Rate Code

Source of Billing Rate

The billing rate entered in Custom Billing Rate
Maintenance is used.
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w The billing rate method and rate code established
for the work code are used.

C 0-9 The rate code entered in Custom Bill Rate
Maintenance is used to determine the
corresponding billing rate in the Employee file.

C The cost per hour in the Employee file is used.

The Time and Billing Professional module provides a flexible means of defining
billing time periods in terms of hours or specific quantities of time (that is, Time
Units). This feature is especially useful for companies that bill their clients or
engagements by the quantity of partial hours or by the day, such as every 30
minutes, or every eight hours.

Using Time Units

To use this capability, select the Use Time Unit Entry check box on the Main tab
of the Time and Billing Professional Options window (see page 80). This method
allows you to use hours or time units when setting up billing rates on the Employee
Maintenance window (see page 92) and the T/2 Client Maintenance window (see
page 144). On these windows, you must specify the time unit to be used for each
billing rate by clicking the Hours/Units button.

Use Number of Hours/Minutes per Time Unit option on the Main tab of the Time
and Billing Professional Options window (see page 80) to define the time unit for
billing. Your entry in this field can use the HH, or HH.HH format. For example:

+ To define one time unit as 1 hour, you would enter 1;
* To define one time unit as 30 minutes, you would enter 00.50 or 00:30;
+ To define one time unit as eight hours, you would enter 08.00 or 08:00.

The time unit entered will always be displayed using the HH.HH format.

If the Use Time Unit Entry check box is cleared, you will not be able to access the
Hours/Units button on the Rates tab of the Employee Maintenance window and
the Custom Billing Rates Maintenance window in the T/2 Client Maintenance
feature (see page 144)

During Time/Expense Entry (see page 168) or Edit Work in Process Entry (see
page 231), the billing rate is defined as using time units or hours.

« If the billing rate is defined as using time units, you must enter the number of
time units for the billing, using the ####.00 format.
For example, if you defined the time unit in Time and Billing Professional
Options window as one-half hour or.50, and you are billing a client for
two-and-one-half hours work, you would enter 5.00 in the HRS/UNTS field in
Time/Expense Entry or Edit Work in Process Entry.
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« If the rate is defined as using hours, you must enter the number of hours for the
billing, using either the HH.HH format.
For example, if you are billing a client for two-and-one-half hours work, you
would enter 2.50 in the HRS/UNTS field in Time/Expense Entry or Edit Work in
Process Entry.

During the Time/Expense Entry or Edit Work in Process Entry update, all
period-to-date and year-to-date amounts are converted automatically to hours.
Billing history and Work in Process detail information, however, retains the time
unit format entered (as hours or time units).

Fee Arrangements

You can use the Time and Billing Professional module to assign a specific fee
arrangement for each client/engagement. You can choose from six different fee
arrangements, which are used to determine how a client/engagement will be
billed, and how the Work in Process (unbilled fees and expenses) will be relieved.
You can assign fee arrangements to each client/engagement using the Billing tab
on the T/2 Client Maintenance window (see page 154).

Explanation of Fee Arrangements

To assign different fee arrangements for each engagement for a client, select the
Bill Separate check box on the Billing tab of the T/2 Client Maintenance window.
If this check box is cleared, all engagements for the client will be billed together
and must use the same fee arrangement.

« If the Include Expenses check box on the Billing tab of the T/2 Client
Maintenance is cleared, fees and expenses will be separated on the Billing Data
Entry window (see page 191).

» The fee arrangements will apply only to the billable fee amounts.

« Billable expense amounts will not be subject to the fee arrangements, and will
always be billed using the standard fee arrangement method.

The Time and Billing Professional module supports the following six fee
arrangements:

- Standard: Use this fee arrangement to determine the billing amount based on
the total of all billable fees and expenses recorded for the client/engagement as
of the Bill Thru Date. Invoices cannot be created if there are no Work in Process
detail lines for the client/engagement.

- Fixed: Use this fee arrangement to specify a fixed amount to be billed to the
client/engagement during each billing cycle. Invoices can be printed using the
fixed fee amount even if there are no Work in Process detail lines for the
client/engagement.

- Not to Exceed: Use this fee arrangement to specify a not to exceed billing
amount. Invoices cannot be created if there are no Work in Process detail lines
for the client/engagement.
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- Non-Billable: Use this fee arrangement to define specific clients/engagements
as non-billable. Invoices cannot be created if there are no Work in Process detail
lines for the client/engagement.

- Retainer: Use this fee arrangement to specify a retainer amount to be billed
during each billing cycle. You can also maintain a balance of retainer payments
received and apply that balance against any billing. Invoices can be printed
using the retainer amount due even if there are no Work in Process detail lines
for the client/engagement.

- Progress: Use this fee arrangement to bill a client/engagement on a
progressive basis without relieving Work in Process. Invoices can be printed
even if there are no Work in Process detail lines for the client/engagement.

Standard Fee Arrangement

Use the Standard fee arrangement to determine the billing amount based on the
total of all billable fees and expenses recorded for the client/engagement.

 During Billing Data Entry (see page 191), the bill amount defaults to the Work in
Process total amount.

* In addition, the bill amount can be changed to perform write-ups and
write-downs.

» The Work in Process is cleared of all billed fees and expenses during the Billing
Register update (see page 219).

Example: During Billing Data Entry, assume that an engagement with an
outstanding Work in Process total of $600.00 is being processed.

Using the standard fee arrangement, the bill amount will default to the Work in
Process total of $600.00. The Billing Data Entry window would display the
following:

BILLABLE WORK IN PROCESS TOTAL: 600.00
BILLED WORK IN PROCESS TOTAL: 600.00
WRITE UP/DN: 0.00

BILL AMOUNT: 600.00

If the bill amount is changed to $620.00, the write-up of $20.00 is calculated
automatically. The Billing Data Entry window would display the following:

BILLABLE WORK IN PROCESS TOTAL: 600.00
BILLED WORK IN PROCESS TOTAL: 600.00
WRITE UP/DN: 20.00

BILL AMOUNT: 620.00

Fixed Fee Arrangement

Use the Fixed fee arrangement to specify a fixed amount to be billed to the
client/engagement during each billing cycle.
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* The bill amount defaults to this fixed fee amount.

 Any difference between the bill amount and the Work in Process total will be
written up or written down automatically.

» The Work in Process is cleared of all billed fees and expenses during the
update.

Using the fixed fee arrangement, you must enter a fixed fee amount on the Billing
Data window in T/2 Client Maintenance (see page 144). During Billing Data Entry
(see page 191), the bill amount defaults to this fixed fee amount.

Example: Using our example of $600.00 of Work in Process, assume that a fixed
fee amount of $500.00 was entered in T/2 Client Maintenance. The Billing Data
Entry window would display the following:

BILLABLE WORK IN PROCESS TOTAL: 600.00
BILLED WORK IN PROCESS TOTAL: 600.00
WRITE UP/DN: -100.00

BILL AMOUNT: 500.00

Note that the write-down amount of -$100.00 (500 minus 600) is calculated
automatically.

If a fixed fee amount of $650.00 was entered in T/2 Client Maintenance, the Billing
Data Entry window would display the following:

BILLABLE WORK IN PROCESS TOTAL: 600.00
BILLED WORK IN PROCESS TOTAL: 600.00
WRITE UP/DN: 50.00

BILL AMOUNT: 650.00

Note that the write-up amount of $50.00 (650 minus 600) was calculated
automatically.

Not To Exceed Fee Arrangement

Use the Not to Exceed fee arrangement to specify a not to exceed billing amount
in T/2 Client Maintenance.

» All fees and expenses up to this amount are billed and cleared.

» The bill amount defaults to the billable Work in Process amount up to the not to
exceed amount.

» Only those Work in Process entries that total this bill amount will be billed and
relieved during the Billing Data Entry update.

+ All unbilled fees and expense entries remain in Work in Process unless you
manually select them in Billing Data Entry.

Example: Using our example of $600.00 of Work in Process, assume that a not to
exceed amount of $500.00 was entered in T/2 Client Maintenance. The Billing
Data Entry window would display the following:
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BILLABLE WORK IN PROCESS TOTAL: 600.00
BILLED WORK IN PROCESS TOTAL: 500.00
WRITE UP/DN: 0.00

BILL AMOUNT: 500.00

In this example, only the first $500.00 worth of billable Work in Process is billed.
The unbilled $100.00 remains in Work in Process unless it is manually selected. In
addition, you can adjust the bill amount to perform write-ups and write-downs.

Non-Billable Fee Arrangement

Use the Non-Billable fee arrangement to define specific clients/engagements as
non-billable (that is, they are not to be billed for any billable fees and expenses
recorded).

* During the billing process, all bill amounts are automatically written down to
zero.

» The Work in Process is cleared of all billed fees and expenses.

Example: Using our example of $600.00 of Work in Process, the Billing Data Entry
window would display the following:

BILLABLE WORK IN PROCESS TOTAL: 600.00
BILLED WORK IN PROCESS TOTAL: 600.00
WRITE UP/DN: -600.00

BILL AMOUNT: 0.00

Note that the Write-Down amount of -$600.00 (0 minus 600) was calculated
automatically.

Retainer Fee Arrangement

Use the Retainer fee arrangement to specify a retainer amount to be billed during
each billing cycle. You can also keep a balance of retainer payments received and
apply that balance against any billings.

» Use the Uncollected Return field in the Client/Engagement Master file to track
the retainer amount billed but not yet paid.

» Use the Retainer Bill Balance field to track the retainer payment amounts
received but not yet applied against billings.

* When bills are processed, the Work in Process is cleared of all billed fees and
expenses.

Using the retainer fee arrangement, you can enter the retainer applied and the
retainer amount due during Billing Data Entry (see page 191). You can set the
retainer applied amount automatically by selecting the Automatically Apply

Retainer Balance to Bills check box on the Billing tab of the Time and Billing

Time and Billing Professional Manual Chapter 2: Time Professional Concepts



Chapter 2

Professional Options window (see page 80). Clearing this option will default the
retainer applied amount to zero, allowing you to apply retainers manually. The
retainer amount due will default to the amount specified for the monthly retainer for
the client/engagement.

Example: Using our example of $600.00 of Work in Process, assume that a
monthly retainer amount of $500.00 was entered in the T/2 Client Maintenance
window (see page 144) and that the retainer balance for the client/engagement is
$2,000.00. If the Automatically Apply Retainer Balance to Bills check box on
the Billing tab of Time and Billing Professional Options is selected, the Billing Data
Entry window would display the following:

RETAINER BALANCE: 2000.00

BILLABLE WORK IN PROCESS TOTAL: 600.00
BILLED WORK IN PROCESS TOTAL: 600.00
WRITE UP/DN: 0.00

RETAINER APPLIED: 600.00

BILL AMOUNT: 0.00

RETAINER AMOUNT DUE: 500.00

Both the retainer applied and the retainer amount due, as well as the bill amount,
can be changed manually. If the retainer balance amount is less than the billed
Work in Process total, the retainer applied amount will default to the retainer
balance amount.

The retainer amount due is considered to be a memo billing and does not create
an open invoice or post to the Accounts Receivable account. This amount
accumulates in the Uncollected Retainer field in the Client/Engagement Master
file.

Progress Fee Arrangement

Use the Progress fee arrangement to bill a client/engagement on a progressive
basis WITHOUT relieving Work in Process.

« A progress bill balance is maintained to keep track of the amount billed.

+ A final billing can be issued to bill any unbilled balance and to clear the Work in
Process.

Using progress billing, you must enter a progress bill amount on the Billing Data
window in T/2 Client Maintenance (see page 144). The bill amount defaults to this
progress bill amount. During the Billing Data Entry update (see page 191), no
Work in Process is billed or relieved. A progress bill balance is maintained with the
total progress billed amount for the client/engagement.

Example: Using our example of $600.00 of Work in Process, assume that a
progress bill amount of $200.00 was entered in T/2 Client Maintenance. The
Billing Data Entry window would display the following after the first month's billing:

BILLABLE WORK IN PROCESS TOTAL: 600.00
BILLED WORK IN PROCESS TOTAL: 0.00
WRITE UP/DN: 0.00

BILL AMOUNT: 200.00
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After this bill has been updated, the progress bill balance for the client will be
increased by $200.00. Sales tax is not billed until the final bill is processed.

Processing a Final Bill

Use Progress billing for any number of billing cycles. Once the engagement or job
is completed for a client, you can process a final bill to bill any unbilled balance
and to clear the Work in Process.

To process a final bill, choose the Final button on the Billing Data Entry window
(see page 191). Use this feature to calculate the bill amount for a final billing by
subtracting the progress bill balance from the Work in Process total. When the
Proceed with Final Bill dialog box appears, click Yes to proceed ahead, or click No
to cancel the final bill. When the final bill is processed, all billed Work in Process is
relieved and the progress bill balance is cleared.

Example: Assume the progress bill balance is now $400.00 and a final progress
bill is issued after the third month. The Billing Data Entry window would display the
following:

BILLABLE WORK IN PROCESS TOTAL: 600.00
BILLED WORK IN PROCESS TOTAL: 600.00
WRITE UP/DN: 0.00

PROGRESS BILL BAL: 400.00

BILL AMOUNT: 200.00

Explanation of Retainer Billing

Many professional service organizations require their clients to pay a retainer to
engage their services.

» Retainers can be one-time payments that are used as a prepayment for services
to be rendered.

* Retainers can also be billed on a monthly or other regular basis.

» Prepaid retainer balances can be applied against current billings to reduce the
amount due for that period.

+ Some firms may want to apply retainer balances only at the completion of an
engagement, or they may want to apply retainers during any billing cycle.

The Time and Billing Professional module provides a comprehensive capability for
recording and processing retainers. To use the Retainer feature, you must set the
fee arrangement for a client/engagement to Retainer on the Billing tab of the T/2_
Client Maintenance window (see page 154). If your Time and Billing Professional
module is integrated with the General Ledger, you can also specify the client
retainer General Ledger account in Time and Billing Professional Options (see
page 80).
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Retainer Data Fields

When you use the retainer fee arrangement, certain additional data entry fields are
activated on the T/2 Client Maintenance and Billing Data Entry windows, as well as
various Time and Billing Professional reports, such as the Retainer Transaction
Report (see page 267). An explanation of these data fields follows:

* Monthly Retainer: You activate this field on the T/2 Client Maintenance Billing
Data window. You can enter the retainer amount you want to bill during each
billing cycle. If you do not want to automatically bill for the retainer amount, enter
zero.

* Uncollected Retainer: You can display this field on the T/2 Client Maintenance
Billing Data window. This field displays the total retainer amount billed but not
yet received. As retainers are billed, this amount is increased. As retainer
payments are recorded using the Accounts Receivable Cash Receipts Entry,
this amount is reduced. If you received retainer payments in excess of the
retainer billed, zero will be displayed in this field.

» Retainer Balance: You can display this field on the T/2 Client Maintenance
window History tab. This field displays the total retainer payments received but
not yet applied against billings. As retainer payments are recorded using the
Accounts Receivable Cash Receipts Entry, this amount is increased. As
retainers are applied during Billing Data Entry, this amount is reduced.

* Retainer Applied: You activate this field on the Billing Data Entry window for
clients/engagements using the retainer fee arrangement. You can enter an
amount less than or equal to the retainer balance for the client/engagement. The
retainer applied will be deducted from the billed Work in Process total amount to
calculate the bill amount for the invoice.

To set the retainer applied amount automatically, select the Automatically
Apply Retainer Balance to Bills check box on the Billing tab of the Time and
Billing Professional Options window (see page 80). If the retainer balance
amount was less than the billed Work in Process total, the retainer applied
amount will be set to the retainer balance amount, and the bill amount will be
reduced by the retainer applied amount. If this option is clear, the retainer
applied will default to zero, and you can apply retainers manually.

* Retainer Amount Due: You activate this field on the Billing Data Entry window
for clients/engagements using the retainer fee arrangement. This field will
default to the monthly retainer amount specified in T/2 Client Maintenance (see
page 144). The amount you entered here will be printed on your invoice, but is
not included in the invoice amount due and does not post to Accounts
Receivable.

Recording Retainer Payments

Use the Accounts Receivable’s Cash Receipts Entry window to record retainer
payments. For open item clients, retainer payments are entered in the same
manner as regular invoices, except that you will be entering RT at the Invoice
Number field. For balance forward clients, you must first select the Adjust option
and enter RT at the G/L Account field.
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If you are using engagements, you will be prompted for the engagement code.
Since the retainer balance is tracked for each engagement, you must specify the
engagement code to which the payment will be applied. Enter the retainer
payment amount at the Amount Posted field.

During the Cash Receipts Journal update, the retainer payment amount is added
to the retainer balance of the client/engagement. Additionally, the uncollected
retainer for the client/engagement is reduced by the retainer payment amount.
Retainer payments do not affect the Accounts Receivable balance for the client,
and no open invoice is created for the retainer payment. The client retainer
account specified in Time and Billing Professional Options will be credited with the
retainer payment.

The retainer balance and uncollected retainer amounts are printed on the Aged
Invoice Report for your reference. Since retainers are not considered to be part of
Accounts Receivable, they have no effect on the aged receivables balance printed
on the report.

Billing and Applying Retainers

Additional retainer amounts can be billed during the normal billing process. You
can also apply any retainer balance against current billable fees and expenses
during the billing process.

When you select the retainer clients/engagements for billing using either Billing
Selection (see page 186) or Billing Data Entry (see page 191), the retainer amount
due is automatically set to the monthly retainer amount specified in T/2 Client
Maintenance (see page 144). If the monthly retainer amount is zero, you must
manually enter the amount of additional retainer to be billed each billing period.

The Retainer Balance field in the Client Master file contains the balance of the
retainer payments received but not yet applied. You can apply this balance against
current fees and expenses. The Retainer Applied field in Billing Data Entry is
used to indicate the amount of the retainer balance that is to be applied to the
current billing.

To set the retainer applied amount automatically, select the Automatically Apply
Retainer Balance to Bills check box on the Billing tab of Time and Billing
Professional Options. The Retainer Applied field will be set to either the billed
Work in Process total amount or the retainer balance amount, whichever is less.

Clear the Automatically Apply Retainer Balance to Bills check box on the
Billing tab of Time and Billing Professional Options to default the Retainer
Applied field to zero. This option allows you to apply retainers manually. If you
want only to apply the retainer balance on the final billing for an engagement, clear
the check box.

The retainer applied amount will reduce the amount posted to Accounts
Receivable. The client retainer account will be debited with the retainer applied
amount during the Billing Reqister update (see page 219). The retainer applied
amount has no effect on the postings to the Work in Process account.
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During the Billing Register update, the Retainer Balance field in the Client Master
file is reduced by the retainer applied amount. The Uncollected Retainer field is
increased by the retainer amount due. The retainer amount due is considered to
be a memo billing and does not create an open invoice or post to the Accounts
Receivable account.

How to Adjust Work in Process

During the Time/Expense Journal update (see page 173), all transactions entered
using the Time/Expense Entry feature (see page 168) are posted to the Work in
Process Detail file and remain there until they are billed during Billing Data Entry. If
you selected the Post Work in Process General Ledger check box on the
Additional tab of Time and Billing Professional Options (see page 80), the
General Ledger Work in Process account is also updated during the
Time/Expense Journal Update.

Once transactions are posted to the Work in Process Detail file after the
Time/Expense Journal Update, they can be modified using several programs.
Work in Process transactions can be transferred from one client/engagement to
another using the Transfer Work in Process feature (see page 222); they can be
deleted using the Delete Work in Process feature (see page 224); or they can be
edited, added, or deleted using the Edit Work in Process Selection (see page 228)
and Edit Work in Process Entry (see page 231) features.

Transfer Work in Process

The Transfer Work in Process feature is useful when you have posted one or more
Work in Process transactions and have discovered that they were assigned to the
wrong client/engagement. This feature allows you to transfer unbilled Work in
Process information from one client/engagement to another client/engagement for
a specific range of dates.

To use the Transfer Work in Process feature, you must first specify the original
client and/or engagement code, employee code, work code, and/or transaction
numbers from which Work in Process information will be transferred. You can also
specify a range of transaction dates. You can then specify the client and
engagement codes that will be assigned to the selected transactions. A
Transaction Work in Process Audit Report can be printed which provides an audit
trail of transferred transactions.

When you use the Transfer Work in Process feature, the General Ledger Work in
Process account balance is not affected.

Delete Work in Process

The Delete Work in Process feature is useful in two instances. First, you can use
the feature to delete Work in Process transactions which should not have been
posted. Second, you can use the program to remove transactions which should
have been posted, but which contain incorrect data (for example, incorrect
employee code, work code, billing rate, or revenue account number); or you can
use the Edit Work in Process feature to correct the data.
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To use the Delete Work in Process feature, you must first specify the client code
and engagement code. You can also specify a range of dates, employee codes,
work codes, and/or transaction numbers to specify which transactions to delete.
You can print a Delete Work in Process Register (see page 224) to verify the
selected transactions. The update process which follows the printing of the
register will remove the selected transactions from the Work in Process Detail file
and update the Time and Billing Professional files as appropriate.

If you selected the Post Work in Process to General Ledger check box on the
Additional tab of Time and Billing Professional Options (see page 80), the
General Ledger Work in Process account is relieved of the deleted transaction
amounts during the Delete Work in Process Update.

Once you have deleted the erroneous transactions, you can use Time/Expense
Entry to re-enter the correct information.

Edit Work in Process Selection

Use the Edit Work in Process Selection feature (see page 228) to select unbilled
Work in Process transactions to be edited for a specific client/engagement using a
range of dates, employee codes, work codes, and transaction numbers.

To use the Edit Work in Process Selection feature, you must first specify the client
code and engagement code. You can also specify a range of dates, employee
codes, work codes, and/or transaction numbers to determine which transactions
are to be selected. You can print an Edit Work in Process Selection Register to
verify the transactions selected for editing. During the Edit Work in Process
Selection Register update, if you selected the Post Work in Process to General
Ledger check box on the Additional tab of the Time and Billing Professional
Options window (see page 80), the Work in Process transactions will be updated
to the General Ledger. Once you have selected Work in Process transactions to
be edited, you can use Edit Work in Process Entry to enter the correct information.

Edit Work in Process Entry

The Edit Work in Process Entry feature (see page 231) is used to edit, delete, and
add Work in Process transactions previously selected during Edit Work in Process
Selection.

To use the Edit Work in Process Entry feature, you must first specify the client
code and engagement code (if applicable) or the transaction number of the Work
in Process transaction to be edited. You can edit, add, or delete Work in Process
information by modifying the fields. You can print an Edit Work in Process Journal
(see page 235) as an audit report for all Work in Process transactions edited using
the Edit Work in Process Entry feature. During the Edit Work in Process Journal
Update, if you selected the Post Work in Process to General Ledger check box
on the Additional tab of Time and Billing Professional Options (see page 80), the
adjusted Work in Process amounts are posted to the appropriate General Ledger
accounts.
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Progress Fee Bill

To adjust the amount of a progress fee bill, which is not a final bill, you must create
a negative progress bill, reversing the original bill in full and then create a new bill
using the correct amount.

To adjust the date of a previously recorded invoice which was incorrectly entered
as a final bill, perform the following:

1 Select the Billing Data Entry option (see page 191) and enter the client for whom
the invoice is to be corrected.

2 Clear the Print Invoices check box.

3 Enter the original invoice number and the correct invoice date. Change the Bill
Amount field to 0.00 and update the Billing Selection Register (see page 189).

How to Use the Schedule/Budget Feature

The Schedule/Budget feature is a useful tool for scheduling work-related activities
for clients and engagements. You can also use this feature for tracking actual
hours and amounts against budgeted amounts for scheduled activities. You can
enter activities by work code or work code category. An activity can be tracked with
additional detail by specifying the employee code.

Use the Schedule/Budget Maintenance option (see page 150) within T/2 Client
Maintenance (see page 144) to enter schedule/budget information. For each
schedule/budget entry, you can specify the projected start date, actual start date,
projected completion date, and actual completion date for each activity. You can
enter the schedule type for each activity to specify whether the activity is monthly,
quarterly, semi-annual, annual, or non-recurring.

Once a schedule/budget entry is established, the actual hours and amount
information is maintained automatically during the Time/Expense Journal (see
page 173) or Edit Work in Process Journal update (see page 235). If the Accounts
Payable module is integrated with Time and Billing Professional, expenses can
also be updated from the Accounts Payable Invoice Register and Manual Check
Register updates. It is important to note that unless a schedule/budget entry is
established, no accumulation of actual hours and amounts will be recorded in the
Schedule/Budget file.

Use the Schedule/Budget feature specifically to track scheduled activities and to
track budget amounts by work/category code and employee code. Since the
standard Time and Billing Professional Analysis reports provide a recap of hours
and amounts by client/engagement, employee, and work/category code, it is not
necessary to use the Schedule/Budget feature to record hours and amounts.

You can print the Employee Scheduling Report, accessed from the Analysis menu,
to list all scheduled activities by employee in chronological order. This report
serves as a reminder to each employee of forthcoming activities. Any
schedule/budget activities recorded in Schedule/Budget Maintenance without a
specific employee (for example, if All was entered for the employee code) will not
be printed on the report.
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The Budget Reports By Client, Employee, Work Code, or Category, accessed from
the Analysis menu, provide detailed listings of all schedule/budget entries. The
budget amount, actual amount, and variance information is provided for each
activity.

How to Track Schedule/Budget Information

Depending upon your specific requirements, you can track schedule/budget
information using different levels of detail. The level of detail you want to obtain
can be applied differently to each client/engagement as required.

Schedule/Budget by Client/Engagement

On the least detailed level, you can make a single entry to account for all activities
for the client/engagement. You can specify All for both the work/category code
and the employee code, as illustrated in the following example.

Work/Category Employee

All All

The budgeted hours and amount entered on the Billing tab in T/2 Client
Maintenance are recorded automatically on a default basis. You do not need to
use the schedule/budget option to establish this level of budgeting detail.

Schedule/Budget by Work/Category Code

On this level of detail, you can schedule or budget by work code or work code
category, regardless of the employee. The work code category is specified by
typing slash (/) followed by the category code. To enter the budget, regardless of
the employee, All must be specified for the employee code, as illustrated in the
following example.

Work/Category Employee

001 All
005 All
/010 All

All activities for the client/engagement for the specified work code or work code
category are tracked, regardless of the employee that performed the work. This
method is appropriate if several employees are working on the same activity and
you want to track the total hours and amounts recorded for the work/category
code. You can also use this method if the actual employee doing the work has not
been determined at the time of budgeting.

One drawback of this method, however, is that the Employee Scheduling Report
cannot record activities to which employees have not been assigned.
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Schedule/Budget by Employee

This method allows you to track the total hours and amounts recorded for each
employee, regardless of the type of work performed. You must specify All for the
work/category code and enter a specific employee code, as illustrated in the
following table.

Work/Category Employee

All DW
All DLR
All GNS

All activities for the client/engagement for the specified employee are tracked,
regardless of the type of work performed. This method is appropriate if you want to
track budget information against total hours and amounts recorded for each
employee.

Since this method is not work code specific, it is not useful for tracking scheduled
activities.

Schedule/Budget by Work/Category Code and Employee Code

This method allows you to track schedule/budget information at the most detailed
level. Each activity is identified by specifying both the work/category code and the
employee code, as illustrated in the following table.

Work/Category Employee

001 DW
005 DLR
/010 GNS

Each employee performing the same type of service must be specified separately.

Often it is desirable to track activities using multiple levels of schedule/budget
detail. For example, you may want to track an activity for a work/category code
with All as the employee code. You may also want to track an activity for the same
work/category code and a specific employee. Any hours and amounts entered
during Time/Expense Entry (see page 168) or Edit Work in Process Entry (see
page 231) using the same work/category code and employee will be recorded for
both of the schedule/budget entries.

Schedule Types

For each work/category code entered on the Schedule/Budget Maintenance
window (see page 150), you must enter a schedule type, which is used to
determine whether the activity for the client/engagement recurs, and if so, on what
kind of schedule.

At the Schedule Type field, you have the option of selecting N (Non-Recurring), M
(Monthly), A (Annual), Q (Quarterly), or S (Semi-Annual).
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The non-recurring schedule type assumes that the activity will be performed only
once for the client/engagement. You can specify a projected start and completion
date for the activity. During the Time/Expense Journal (see page 173) and Edit
Work in Process Journal update (see page 235), the Actual Start Date field is
updated with the earliest occurrence of the activity. You can enter an actual
completion date when the activity has been completed.

The monthly schedule type assumes that the activity for the client/engagement will
be performed once every month. During Period End Processing (see page 328),
all activities with schedule type M will automatically increment the Projected Start
Date and Projected Completion Date fields by one month, and all actual hours
and amounts will be cleared.

The annual schedule type assumes that the activity for the client/engagement will
be performed once every year. During Year End Processing (see page 330), all
activities with schedule type A will automatically increment the Projected Start
Date and Projected Completion Date fields by one year, and all actual hours and
amounts will be cleared.

The quarterly schedule type assumes that the activity for the client/engagement
will be performed once every quarter. When Period End Processing is performed
in periods 3, 6, 9, or 12, all activities with schedule type Q will automatically
increment the Projected Start Date and Projected Completion Date fields by
three months, and all actual hours and amounts will be cleared.

The semi-annual schedule type assumes that the activity for the
client/engagement will be performed once every six months. When Period End
Processing is performed in periods 6 or 12, all activities with schedule type S will
automatically increment the Projected Start Date and Projected Completion
Date fields by six months, and all actual hours and amounts will be cleared.

Posting to Future Accounting Periods

The Time and Billing Professional module allows you to post transactions to a
future accounting period. Unlike the General Ledger module, however, the future
posting capability for Time and Billing Professional is limited to the accounting
period following the current period specified in Time and Billing Professional
Options (see page 80).

As time/expense, invoice, and cash receipt transactions are posted, the System
Date for invoices and the Deposit Date for cash receipts are used to update the
transactions and check them against the current Time and Billing Professional
period defined in Time and Billing Professional Options. The transaction amounts
posted in the future periods are not displayed in the client's Billing History for the
Period-To-Date and Year-To-Date columns. Instead, the Future option must be
used to display a special window containing the future period activity and the
Year-To-Date amounts reflecting future postings.
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Posting to Analysis Reports by Period

Data for your Time and Billing Professional Analysis reports is accumulated during
the update of the Time and Expense Journal, Edit WIP Journal, Billing Register,
and Delete WIP Update. The data for the analysis reports is maintained by
accounting period in 3 files:

« T2S - Billing Analysis History File
* T2W - Future Periods for Bill Analysis History
* T2Y - Monthly Time Analysis File

The period into which time/billing data is posted is determined by the Posting Date
selected when updating the three journals. It is not determined by the individual
transaction detail. Further, the update cannot post to any period prior to the current
T/2 period. Also, anything posted to a future period does not show on the Analysis
Reports until you close the current period. During period end processing, any
future period transactions that exist will be moved into the new current period.

Example 1

Your current T/2 Period is 01/2010. You enter an expense with a date of 1/5/2010.
Next, you print and update the Time and Expense Journal with a Posting Date of
01/31/2010. The expense will post to period 01.

Example 2

Your current T/2 Period is 01/2010. You enter an expense with a date of 1/5/2010.
Next, you print and update the Time and Expense Journal with a Posting Date of
02/20/2010. The expense will post to a future period. It will not appear on your
Analysis Reports until the period end is run. After period end, the expense will
appear in period 02.

Example 3

Your current T/2 Period is 03/2010. You enter an expense with a date of 1/5/2010.
Next, you print and update the Time and Expense Journal with a Posting Date of
01/31/2010. The expense will post to period 03 since the Posting Date is not a
future period and the current period is 03.

Open Item Versus Balance Forward Billing

A very important feature of the Time and Billing Professional module is its ability to
accommodate both open item and balance forward billing. This attribute is
assigned based on the selection made in the Accounts Receivable module for a
specific customer.

Open Item Billing

In open item billing, you can retain all invoices in detail and apply cash receipts to
specific invoices. If you need a complete audit trail of all activity affecting each
open invoice, you should use the open item billing method.
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All transactions (for example, payments and adjustments) which affect the balance
of each invoice are retained. The transaction detail can be displayed using the
History and Invoices tabs of the Client Maintenance (see page 144) and Client
Inquiry (see page 164) windows.

For open item clients, you must apply each cash receipt against specific invoices.
Using the Auto method, the system automatically applies the cash receipt to each
open invoice, starting with the oldest, until the amount is fully distributed. All
outstanding invoices will be printed on the client statements along with any
payments applied to each invoice.

Balance Forward Billing

In balance forward billing, only current period activity is retained in detail. Any
past-period balances are summarized into a single balance forward amount.
Generally, companies using repetitive billing for services often employ a balance
forward method of billing. If you choose to operate on a balance forward basis, it is
recommended that you retain a copy of the client statements as a detailed history
of client activity.

In addition to the balance forward amount, a separate balance is maintained for
each aging category. The current balance for a balance forward client is calculated
as the balance forward amount plus additional invoices entered for the current
month, minus any payments received.

When cash receipts are applied to balance forward clients, the cash receipt
amount is always applied to the oldest balance first.

Consider the following items when setting up a billing format.

+ In all billing formats, you must have a [START_TOT\1]and an [END_TOT\1]
somewhere inside the format. The \1 can be replaced with any number, but
these numbers must match. The purpose of the numbers is to match up the
totals in the total section, allowing you to put totals in multiple locations
throughout the document. Even if you are not using the totals, you must have
the [START_TOT\1] and an [END_TOT\1] in the billing format form.

+ Totals appearing inside the [START_TOT\1]and an [END_TOT\1] will be
appended to the end of the body section of the form, after all the line detail has
been printed. This means that the positioning of the totals section will vary from
document to document. Note that if the totals section pushed the lines in the
body over the maximum specified in the header, it will print onto another page. If
you wish to print the totals section in the same location on all invoices (as with
pre-printed forms), move the totals numbers outside of the totals block (but keep
the [START_TOT\1] and an [END_TOT\1] in the document).

If the billing format looks similar to the following, the total due will appear
immediately following the last line item in the body. If the total line pushes the
number of lines in the body over the maximum, it will put the totals on another

page.
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[END_BODY]
[START_TOT\]

TOTAL DUE: [INV_AMT]
[END_TOT\1]

If you modify the billing format to look similar to the following, the total due will
appear at the bottom of the invoice form for the last page of every invoice. This is
essential when using pre-printed forms. Even if there is nothing within the totals
block, the [START_TOT\1] and an [END_TOT\1] must be on the billing format, or it
will produce erratic results such as printing on two or more pages, with no data
showing up on the second and subsequent pages.

[END_BODY]
[START_TOT\1]

TOTAL DUE: [INV_AMT]
[END_TOT\]

* Do not put numeric or constant data on the same line as the [SUB_CAT_TEXT]
field descriptor. The result will be that if the [SUB_CAT_TEXT] field has more
than one line, the first line will appear on the same line as the numeric data, but
the remaining additional lines will appear above the first line, as shown below:

comment fields work. This is line 2 and

this is line 3. The last line is in fact

the first line of the category text field.

This is a test to show you how the line$500.00

This is different from the way the [LN_EXT_COMM] field descriptor works, which
does print properly even with more than one line. The only difference is that the
numeric or constant data appears on the first line instead of the last, as shown
below:

This is a test to show you how the line$500.00
comment fields work. This is line 2 and
this is line 3.

Due to programming limitations, the [SUB_CAT_TEXT] field cannot be printed out
the same way as the [LN_EXT_COMM] field.

« If the number of lines per page on the invoice is equivalent to the number of lines
per page set up in the Device Configurator, do not put a number in the heading
of the billing format for lines per page. Keep this number at 0, and let the system
read it from the Device Configurator. This setting can cause erratic page-break
problems.

* The [CLNT_BALANCE] field may not equal the [CURRENT] field when printing
invoices into a future period. The [CLNT_BALANCE] field totals up the
[BALANCE_FWD] field minus [CASH_RECEIVED] plus [PTD_FIN_CHGS] plus
[NET_INV_AMT] plus [PROG_BILL_AMT] fields. These are all period sensitive
fields which are updated at period end. The [CURRENT] field is calculated from
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the Open Invoices File and the Invoice Transaction Payment History File. This
information will be based on the Invoice Date you assign when printing invoices.
The [CLNT_BALANCE] field will only show data for the current period. It will not
show data for the future period.

» The [BALANCE_FWD] field shows data for the entire client. It does not get
separated out by engagement. This field is calculated from the Invoice
Transaction Payment History File by accumulating all the | (Invoice), F (Finance
Charge), B (Balance Forward), or E (Balance Forward, Other Charge) type
transactions which have a transaction date earlier than the Time and Billing
Professional period beginning date. Any P (Payment) or X (Prepayment) type
transactions with a transaction date earlier than the Time and Billing
Professional Period Beginning Date reduces the [BALANCE_FWD] value. If the
[PTD_FIN_CHG] field is not being used, the [BALANCE_FWD] amount is
increased by the transaction amount (for example, when the transaction type is
F and the transaction date is after the Time and Billing Professional beginning
period date). If the [PTD_FIN_CHG] field is used, the [BALANCE_FWD] amount
is not changed. However, the [BALANCE_FWD] amount is not changed whether
or not the [CASH_RECEIVED] field is being used. The [CASH_RECEIVED]
amount is calculated from the Invoice Transaction Payment History file, which
sums all payments and prepayments (types P and X) that have transaction
dates within the current period.

* When reprinting invoices, if you originally used the fields [CLNT_BALANCE],
[CURRENT], [AGED_1], [AGED_2], [AGED_3], [AGED_4], [PTD_FIN_CHGS],
[BALANCE_FWD], [UNCOLL_RETAIN], or [CASH_RECEIVED], they will not be
printed with the same numbers as the original invoice. These values are not
stored in the Billing History Detail File and will be recalculated each time the
invoice is reprinted.

Time and Billing Professional Reports

Page 52

All transaction-oriented Time and Billing Professional reports, such as the Aged
Invoice Report, are date-sensitive and provide accurate information for any
specific date as long as the date does not represent a period which has already
been closed.

You can print the Detail Work in Process Report (see page 258) for a specified
range of dates. You can print the Aged Work in Process Report (see page 255) as
of a specified date. Both of these reports can include future period transactions.
However, these reports do not include billed transactions, regardless of the dates
specified.

The Time and Billing Professional Analysis reports reports (see page 270), such
as the Productivity (see pages 53, 271), Profitability (see pages 54, 279), Fee
Analysis (see pages 54, 286), Time Analysis (see pages 55, 293), and Budget
(see pages 56, 303 ) reports provide information for the current Time and Billing
Professional period. To obtain billing information for the next accounting period,
you must complete Period End Processing (see page 328) for the current period.
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If Period End Processing is not performed on a regular basis, period-to-date
activity for multiple months may be combined on the Time and Billing Professional
Analysis reports. For this reason, it is strongly recommended that no more than
two periods are ever open at the same time.

The Sales Tax Report reflects all sales tax from all invoices recorded since the last
time the report was printed and the file was cleared. You should print this report
and clear the file before processing any invoices for the next reporting period.

Analysis Report Calculations

You can find the important analysis information that allows you to evaluate the
profitability of your clients/engagements and the productivity of your employees in

the Productivity (see page 271), Profitability (see page 279), Fee Analysis (see
pages 54, 286), Time Analysis (see pages 55, 293), and Budget (see pages 56,
303 ) Reports on the Time and Billing Professional Analysis menu (see page
270). Using this information, you can determine how your time is spent, analyze
your fees, and develop comprehensive budgets.

Productivity Reports

« Billable Hours: This number represents the total billable hours/time units
entered during Time/Expense Entry or Edit Work in Process Entry.

* Percentage of Billable Hours: This percentage represents the total Billable
hours compared to the total hours.

Billable Hours X 100
Total Hours

* Non-Billable Hours: This number represents the total non-billable hours/time
units entered during Time/Expense Entry or Edit Work in Process Entry.

» Percentage of Non-Billable Hours: This percentage represents the total
non-billable hours compared to the total hours.

Non-Billable Hours x 100
Total Hours

» Total Hours: This number represents the total billable and non-billable hours
entered during Time/Expense Entry or Edit Work in Process Entry.

Billable Hours + Non-Billable Hours

+ Billable Fees: This amount represents the total billable fees entered during
Time/Expense Entry or Edit Work in Process Entry.

» Standard Rate: This rate represents the total billable fees based on the total
billable hours.

Billable Fees
Billable Hours

» Billable Expenses: This amount represents the total billable expenses entered
during Time/Expense Entry or Edit Work in Process Entry.
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+ Billed Hours: This number represents the total billable hours billed.
» Billed Fees: This amount represents the total billable fees billed.

» Billed Rate: This rate represents the total billed fees based on the total billed
hours.

Billed Fees
Billed Hours

Profitability Reports

» Billed Hours: This number represents the total billable hours billed.
* Non-Bill Hours: This number represents the total non-billable hours billed.
» Billed Fees: This amount represents the total billable fees billed.

+ Employee Cost: This amount represents the total employee cost billed for all
billable and non-billable fees.

Total Employee Cost billed for Billable Fees
+

Total Employee Cost billed for Non-Billable Fees

» Billed Expenses: This amount represents the total billable expenses billed.

* Expense Cost: This amount represents the total expense cost billed for all
billable and non-billable expenses.

Total Expense Cost billed for Billable Fees
+

Total Expense Cost billed for Non-Billable Fees

» Total Billed: This amount represents the total billable fees and billable
expenses billed.

Billed Fees + Billed Expenses

» Total Cost: This amount represents the total employee cost and expense cost.
Employee Cost + Expense Cost

» Gross Profit: This amount represents the total billed amount less the total cost.
Total Billed - Total Cost

» Percentage of Gross Profit: This percentage represents the total billed amount
less the total cost compared to the total cost.

Total Billed - Total Cost x 100
Total Billed

Fee Analysis Reports

» Billed Hours: This number represents the total billable hours billed.
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+ Billed Fees: This amount represents the total billable fees billed.

* Fee Write-Up/Down: This amount represents the total write-up/down amount
for fees billed.

» Standard Fees: This amount represents the total billed fees less the fee
write-up/down amount.

Billed Fees - Fee Write-Up/Down

* Percentage of Fee Realized: This percentage represents the amount of billed
fees based on standard fees.

Billed Fees x 100
Standard Fees

» Billed Expenses: This amount represents the total billable expenses billed.

+ Expense Write-Up/Down: This amount represents the total write-up/down
amount for expenses billed.

» Standard Expenses: This amount represents the total billed expenses less the
expense write-up/down amount.

Billed Expenses - Expense Write-Up/Down

» Percentage of Expense Realized: This percentage represents the amount of
billed expenses based on the standard expense.

Billed Expenses x 100
Standard Expenses

» Total Billed: This amount represents the total billable fees and billable
expenses billed.

Billed Fees + Billed Expenses

Time Analysis Reports

« Billable Hours: This number represents the total billable hours/time units
entered during Time/Expense Entry or Edit Work in Process Entry.

* Non-Bill Hours: This number represents the total non-billable hours billed.

» Target Hours: This number represent the total target hours/time units entered in
the History and Target tabs in Employee Maintenance.

» Variance: This number represents the total hours less the target hours.

Total Hours - Target Hours

* Percentage of Variance: This percentage represents the total hours less the
target hours as compared to the total hours.

Total Houts - Target Hours x 100
Total Houts
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« Billable Fees: This amount represents the total billable fees entered during
Time/Expense Entry or Edit Work in Process Entry.

Budget Reports

* Budget Hours: This number represents the total budget hours/time units
entered during Schedule/Budget Maintenance in T/2 Client Maintenance.

* Non-Bill Hours: This number represents the total non-billable hours billed.
 Billed Hours: This number represents the total billable hours billed.
» Variance Hours: This number represents the total hours less the budget hours.

Total Hours - Budget Hours

» Percentage of Variance Hours: This percentage represents the total hours less
the budget hours as compared to the budget hours.

Total Hours - Budget Hours x 100
Budget Hours

* Budget Amount: This amount represents the budget amount entered during
Schedule/Budget Maintenance in T/2 Client Maintenance.

* Budget Rate: This rate represents the budget amount based on the total budget
hours.

Budget Amount
Budget Hours

» Actual Amount: This amount represents the total billable fees or billable
expenses entered during Time/Expense Entry or Edit Work in Process Entry.

» Actual Rate: This rate represents the actual amount based on the total actual
hours.

Actual Amount
Actual Hours

» Variance Amount: This amount represents the actual amount less the budget
amount.

Actual Amount - Budget Amount

* Percentage of Variance Amount: This percentage represents the actual
amount less the budget amount as compared to the budget amount.

Actual Amount - Budget Amount x 100
Budget Amount

This concludes Chapter 2: Time Professional Concepts of the Time and Billing
Professional manual. The remaining chapters of the manual contains detailed
procedural steps for each Time and Billing Professional activity.
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Installing the Time and Billing Professional Module

Chapter 3: Installing the Time and Billing Professional Module provides detailed
installation instructions, and contains the steps to register the Time and Billing
Professional module.

System Requirements

Sage Software does set standard system requirements for workstations using
Sage MAS 90 or 200. See the system requirements determined by Sage Software
(www.sagesoftware.com).

Pre-installation Instructions

» Before installing the Time and Billing Professional module, you must have

Sage MAS 90 or 200 installed on your system. Install the correct version of
Sage MAS 90 or 200 that works with the version of Time and Billing
Professional. You may be required to upgrade your Sage MAS 90 or 200 system
before installing Time and Billing Professional. See the installation
documentation provided by Sage Software for installation instructions.

If the Sage MAS 90 or 200 program or any upgrades have just been installed,
enter the Sage MAS 90 or 200 system to finish the installation procedures.

Ensure the Sage MAS 90 or 200 General Ledger, Accounts Payable, and
Account Receivable modules are completely installed and configured. See the
online documentation provided by Sage Software for full instructions.

Make sure that all of the following entry files have been updated or cleared
BEFORE installing Time and Billing Professional to avoid any data corruption.

- Accounts Receivable Cash Receipts Entry

Accounts Payable Invoice Data Entry

- Accounts Payable Manual Check Entry

General Ledger General Journal Entry
- General Ledger Recurring Journal Entry
- General Ledger Transaction Journal Entry

If you are upgrading from a previous version of Time and Billing Professional,
make sure all Time and Billing Professional entry files have been updated or
cleared BEFORE installing the latest version.

All users should exit from Sage MAS 90 or 200 before beginning the Time and
Billing Professional installation.

Installing Time and Billing Professional

Complete the following steps to install the Time and Billing Professional module.
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1 Close all programs.

Chapter 3

2 Launch your Time and Billing Professional installation program. The Time and

Billing Professional Setup Wizard Welcome window appears.

@8 Time and Billing Professional for MAS 90 4.20 Setup

Welcome to the

Time and Billing Professional for MAS 90

Welcome to the Time and Billing Professional for MAS
90 4.20 Setup Wizard

through the ins

Cancel

Installation Wizard - Welcome Window

3 Click Next to begin installation. The License Agreement window appears.

&% Time and Billing Professional for MAS 90 4.20 Setup

License Agreement

lling Tirn d Billing

HIGHTOWER INCORPORATED, EMD-USER CUSTOMER, LICENSE AGREEMEMT

Important: HighTower Incorporated ("HighTower"), licenses the enclosed Pragram to
wou only upon the condition that you accept all of the terms contained in this Customer
License Agreement (the "Agreement"), Please read these terms carsfully, because
opening this package indicates your acceptance of them. IF wou do not agree with these
terms, then HighTower is urwilling to license the Pragram to you. In this event, you
should return this UWNOPEMNED, UNUSED package to the dealer From which it was acquired

within ten {10) days after purchase For a Full refund.

THIS IS & LICENSE, IT GIVES ¥OU CERTAIM LIMITED RIGHTS TO USE THE PROGRAM,
PROGRAM COPIES AND DOCUMENTATION, HIGHTCOMWWER AMD ITS SUPPLIERS RETAIN
(OWMERSHIP AND TITLE TO ALL OF THE PROGRAM, PROGRAM COPIES AND
DOCUMENTATION AMD ALL COPYRIGHTS AND OTHER PROPRIETARY RIGHTS THEREIM.
ALL RIGHTS MOT SPECIFICALLY GRAMNTED TO ¥OU IN THIS AGREEMENT ARE EXPRESSLY
RESERVED BY HIGHTOWER. OR ITS SUPPLIERS,

1 Mafiritione e vead in bhic davaamant bhe Fallomine basme baue e mesninae

Time and Billing Professional/for MAS 90 < Back I Agree Cancel

Installation Wizard - License Agreement Window

4 Click | Agree to accept the agreement. The destination location window

appears.
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Licensze Agreement

Fle. fore i ling Time and Billing

Time and Billing Professional/for MAS 90 < Back Mext > Cancel

Installation Wizard - Destination Location Window

5 Select the Sage Installation, and click Next. The Choose Components window
appears.

@8 Time and Billing Professional for, MAS 90 4.20 Setup

oose Components
features of Time and Eiling

mponents to inskal

Time and Billing Professional for MAS 90 < Back. Install Cancel

Installation Wizard - Enhancement Selection Window

6 Select the Library Master Extensions and Time and Billing Professional
options from the list of applications, and click Install. This may take a few
minutes.
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While installing the enhancements, the system displays the following messages.

Enhancement Installation

Installation is being Finalized... Please wait

Fleaze wait while Enhancements are Processed,

Installation Wizard - Enhancement Installation Messages

When the installation is finalized, the Installation Complete window appears.

&% Time and Billing Professional for, MAS 90 4.20 Setup

Installation Complete

Time and Billing Professional for, MAS 90 < Back Cancel

Installation Wizard - Installation Complete Window

7 Click Next to continue. The final installation window appears.
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&8 Time and Billing Professional for MAS 90 4,20 Setup

n Complete

letec

Completing the Time and Billing Professional for MAS
90 4.20 Setup Wizard

Tirme and Biling P

Time and Billing Professional for MAS| 90 | Finish | Cancel

Installation Wizard - Finish Installation Window

8 Click Finish to complete the installation.

System Startup

System Startup is an automatic procedure that must be performed once per
company. This procedure is initiated the first time you access Time and Billing
Professional for a specific company.

Set Up the Time and Billing Professional Module in Role Maintenance

You must make sure that you check the module in the Role Maintenance feature of
the Sage MAS 90 or 200 Library Master module.

1 From the Sage MAS 90 or 200 Library Master module, select Main » Role
Maintenance from the menu. The Role Maintenance window appears.

[ Role Maintenance (LW2) 9/7,/2005

Role ADMINISTRATOR s OIoIoIC) Copy Role...

Description |Adm\nistralor

1 Tasks | 2 Security Events I 3 Module Options I 4 DDEC Securiy I

4 Purchase Drder d
& Remote Salesperson PDA

& Report Master

2 Return Merchandise Authorization

4 Sales Order

2 ScanBlaster

& Time and Biling

& Inquiry

& MaintenancesD ata Entry

# Reports/Fomms

& Setup Options -
# Update/Period End LI

I Accept I LCancel I Delete ]E@

Role Maintenance Window
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2 Select your user role defined for your Sage MAS 90 or 200 system. See your
Sage MAS 90 or 200 Library Master Online Help for more information.

3 Check the Time and Billing Professional option.

4 Click Accept.

Register the Time and Billing Professional Enhancement

When you try to open the Time and Billing Professional module for the first time,
you will need to register the enhancement. You can install all enhancements for a
45-access trial period. When you purchase an enhancement, you will receive a
registration ID and key from your Time and Billing Professional representative, or
you can access the key through the Internet. You register enhancements through
the Library Master Extensions module.

1 From the Library Master Extensions module, select Main » Enhancement
Registration from the menu. The Enhancement Registration window appears.

ﬂj Enhancement Registration [ 2] -1C]
Customer Murnber Registration Level 410
Registration Key hA55A555555550055555
Product Key 55555 55555 55555 55555 55555
Enhancement I Registered? I Erpiration Date I
Library Master E stensions ez
MICR Encoded Laser Checks ‘Yes
tulti-bin Advanced Distribution ‘Yes
Payrall Direct Deposit ez
Point of Sale Professional ‘Yes
Professional Retainer Control ‘Yes
Remate S alesperson PDA ez

ScanBlaster Yes
Time and Billing Yes
Time and Eilline 10N Wi

Timekeeper ez
Remate Licerses =6
Register Licenses = 36

Enhancement Registration Window

2 Enter the registration key in the Registration Key field.

You can also click the Via Internet button to automatically populate the
registration and product keys.

3 Enter the unlocking key in the Product Key field.
4 Click Accept. The system will register purchased enhancements.

See the Library Master Extensions Manual for more information.

Sage MAS 200 or Sage MAS 200 for SQL Installations

After the installation or upgrade is completed on the Sage MAS 200 server, you
must run the a Client Server Workstation Install on each workstation for each
enhancement that has been installed or upgraded.
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1 To run the Client Server Workstation Install, click the Main menu of the Library
Master Extensions module.

2 Click the Client/Server Workstation Install menu option to display the Client
Server Workstation Installation window.

3 For each enhancement there are three options that may be selected - Install,
Help, and Manual. Select Install (the Help and Manual options are not
required).

4 After the options have been selected, click Proceed to install the selected
options to the workstation.

See the Library Master Extensions Manual for more information.

Define the Time and Billing Professional Enhancement

The System Startup occurs when you try to access the Time and Billing
Professional module for the first time.

1 Select an option from the Time and Billing Professional module. If the application
has not been activated, the following dialog box displays.

i Sage MAS 90 [ %]

9 Diata files have not been created for this madule. You must
-.‘:(/ activate this module using Compary Maintenance. Do you
want to run Company Maintenance now?

Sage MAS 90 Dialog Box

2 Click Yes. The Company Maintenance window appears.

Ejl:ompany Maintenance {MCC) 9,/7/2005
Campany Cade | MCC |7 @ @ @ @
Company Mame | My Candy Compary Demo Data
il PY.
1. Main 2. F’refalen:esl 3. Servers I 4. E-mail I
~— Campany Infarmatiar
Address Telephane [ -
Fax [ -
Federal ID Mo.
State ID Mo.
URL Address
— Ativated Modules
Module | Data Level | ‘l
Accounts Papable 410
Accounts Recsivable 410
Eill of M aterials 410
Bank Reconciliation 410
General Ledger 410
Payrall Direct Deposit 410
Inventory Management 410
MICR Encoded Laser Checks 410 j
[] Use as Default Company for Server Settings [ Accept I Cancel I Delete

Company Maintenance Window
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3 Click the Activate button. The Activate Application window appears.

ﬂj Activate Module M=l
My Candy Company Demo Data [MCC|
‘ | Madule | Activate | - 5
Point of Sale Professional @
Time and Billing Professional
Time and Billing ACTIVATED
MultiBin Advanced Distribution ACTIVATED
Remote Salesperson PDA ACTIMATED
Prafessional Retainer Control ACTIVATED
MICR Encoded Laser Checks ACTIVATED
Payroll Direct D eposit ACTIVATED
|
-

Activate Application Window

|Z[NOTE: For more information about activating modules, see the Library
Master Module Online Help by Sage Software.

4 Select the Time and Billing Professional module, and click Proceed.

5 From the Modules menu, click Time and Billing Professional. The application
displays the Change Date window.

{5 MAS 90 Change Accounting Date HE
£ Enter the accounting date for
5 Time and Biling Professional

Date

(]

MAS 90 Change Accounting Date Window

6 Click OK. You can change the date, but the application defaults to the current
accounting date. The following dialog box displays.

i Sage MasS 90 %]

9 The T/2 module has not been set up for company MCC. Do pou
a.‘/ want ta set up the madule now?

Sage MAS 90 Dialog Box

7 Click Yes to begin defining files to start Time and Billing Professional.

When all data files are defined, you automatically advance to options in the Time
and Billing Professional Setup menu. See Chapter 6: Using the Setup Menu (see
page 78) for more information about the options in the Setup menu.

This concludes Chapter 3: Installing the Time and Billing Professional Module of
the Time and Billing Professional manual.
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Chapter 4
Migrating Data from the Time and Billing Module

If your company currently uses the Time and Billing module and is migrating to the
Time and Billing Professional module, you must migrate the data from the Time
and Billing module to the Time and Billing Professional module. Read all the
procedures in Chapter 4: Migrating Data from the Time and Billing Module prior to
beginning this process to ensure the Time and Billing Professional module has the
correct data.

|Z[NOTE: If you are upgrading to Time and Billing Professional from a time
and billing management system other than Sage MAS 90 or 200, contact your
reseller for migration procedures.

Time and Billing Professional Migration Requirements

These are the requirements for migrating data from standard Time and Billing to
Time and Billing Professional:

®WARNING: You MUST back up the entire Sage MAS 90 or 200 directory
before migrating data from the Time and Billing module to the Time and Billing
Professional module. The Time and Billing Professional Data Migration utility
makes permanent changes to the Accounts Receivable and Accounts Payable
modules.

» Accounts Receivable and Time and Billing Professional must be activated for
your company.

» Accounts Receivable must be converted to the current level.

« Time and Billing does not have to be upgraded to the new Time and Billing
Professional level.

For example, if you are running Time and Billing 3.71 and want to convert to
Time and Billing Professional 3.72, you will not have to install Time and Billing
3.72 before updating to Time and Billing Professional 3.72. This utility will
internally convert the data and migrate it in the proper format. If you choose to
continue running the original Time and Billing module, it will be necessary to
upgrade to the current level to continue processing.

» Accounts Receivable must be set up with divisions if the Accounts Receivable
Divisions check box is selected in Accounts Receivable Options, and with at
least one salesperson if Salesperson Commission Reporting check box is
selected.

» Free disk space - You need at least two times the size of your current Time and
Billing system as free disk space. In addition, the migration makes copies of
certain Accounts Receivable files. There should be enough space to
accommodate these files.
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What Gets Migrated

The utility will migrate all Time and Billing data including client/engagement
information and history, work in process transactions, existing open invoices and
history, and reporting/analysis data.

What Does Not Get Migrated

Invoice forms (graphical and non-graphical), Time and Billing Sales Tax Account
Maintenance, and in-progress data entries are not migrated. These will have to be
set up manually in Time and Billing Professional.

Migration Procedures

Copy your entire Sage MAS 90 or 200 directory BEFORE you begin this process.
You can exit the migration at any time. The settings will be retained for a later time.
You can also print out the mappings. The utility will check to see if the Time and

Billing Professional system is already active and will not start the migration if it is.

®WARNING: Credit memos cannot be created for invoices entered through
Time and Billing and migrated to Time and Billing Professional. Time and Billing
does not maintain enough history detail in order to create the credit memo.

How the Migration Works

If Time and Billing is in a prior level of Sage MAS 90 or 200, the utility will copy the
entire Time and Billing system for the company to a work directory (for example,
TBLWW will be copied to TBLWW_T2) and convert the data to the current level.

If Accounts Receivable and Accounts Payable were integrated with Time and
Billing, the following Accounts Receivable and Accounts Payable files are affected
by the migration:

AR1, AR3, AR4, AR5, ARG, ARN, ARV, AR_12, AR_16, AR_17, and AP_13.

The utility first makes a copy of these files by adding a .HTI extension to the name
of the files. It then modifies the new files. At the end of the process, the migration
utility renames the original files from .SOA to .T2 and the work files from .HTI to
.SOA.

Accessing the Time and Billing Migration to Professional Window

The Time and Billing Migration to Professional window is a mapping feature that
maps Time and Billing data to Time and Billing Professional. You can access this
window from the Run menu or by accessing Time and Billing Professional for the
first time.

®WARNING: You MUST back up the entire Sage MAS 90 or 200 directory
before migrating data from the Time and Billing module to the Time and Billing
Professional module.
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Open the Time and Billing Migration to Professional Window from the Run
Menu

1 Ensure you have a copy of your entire Sage MAS 90 or 200 directory.

2 From the Sage MAS 90 or 200 File menu, select Run. The Run window
appears.

{MAS 90 Run Program | 7| x|

g[-.o Enter the name of the program you want to run.
-

Program T2 CBA

MAS 90 Run Program Window

3 Enter T2ZWCBA in the Program Name field, and click OK. The Time and Billing
Migration to Professional window appears.

Open the Time and Billing Migration to Professional Window from the Time
and Billing Professional

1 Ensure you have a copy of your entire Sage MAS 90 or 200 directory.

2 Access an option from the Time and Billing Professional module. When you try
to open a window from the Time and Billing Professional module for the first
time, the following warning appears.

[ Sage MAS 90 [ %]

! Yy Time and Biling Professional is being ru for the first time: for this comparny.
Data exists in Standard Time and Billing. This will be wour anly oppartunity
to migrate this data to Time and Biling Professional.

Do you wish to migrate your data ta Time and Biling Professional?

Sage MAS 90 Dialog
3 Click Yes to start the Time and Billing Professional Data Migration Utility.
If you click No, the standard System Startup process begins.

Using the Time and Billing Migration to Professional Window

The Time and Billing Professional Data Migration Utility allows you to map Time
and Billing clients to existing customers in Accounts Receivable, or create new
customers. Once all Time and Billing clients are mapped properly, the utility can
migrate Time and Billing data to Time and Billing Professional and Accounts
Receivable.
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Migrate Time and Billing Data to Time and Billing Professional

{% Time and Billing Data Migration
B T/B Client |New| A/R Customer | Salesiep | Incl Open Inv ‘;
LI | e ean I ABLEMAN A ooom N M
sEEDW  FAEEW 5 om LR
— Migration Setting CANRIDG [ CANRIDE S oom B\
|=] |EDWAELE [ EDWAELE A | oom AQ (&
Engagement Code Length 4= - =
=l |GENECOM O GENECOM | oo A
Ezisting T/B Invoice Temms oo |y HAAS [ HAAS T oool T [
~ Mew Customer Defaults ———— | HIDDBEA I HIDDBEA Moot |
Divisian W], [fowern  @HOwWARD A oom |
Salespersan { LABIFOIR [ LaNGFOR S| 0001 S
i N |MASTMIC [ MASTMIC Aoz A&
OLSON o OLSON A oooz A M
Temns Code 00 |5 = =
~ |REEDADY [ REEDADV O aops |
Sales Code L | scHwPES & SCHWPES 4| oonz o
Dl Pyt Type CHECK | |scoTT o sCoTT S| ooz S|
Comment TRAVIS o TRAVIS l ooz l =) |
ULTRA o ULTRA Alom A&
ZZZFIRM g Al ooo R =
All new Clignts
[ Procesd l LCancel l Clear
\ Uwiw/ | B/21/2004

Time and Billing Migration to Professional Data Window

1 Review the current options being migrated from the Current Options section.
The current options CANNOT be changed from this window.

* The Accounts Receivable Divisions field indicates whether Accounts
Receivable is set up to use divisions.
This field is set up in Accounts Receivable Options and CANNOT be changed
during migration.

» The Multiple Engagements per Client field indicates whether Time and Billing
is set up for multiple engagements.
This field is set up in Accounts Receivable Options and CANNOT be changed
during migration.

2 Set the length of fields in the Migration Settings section.

a Set the maximum length for engagement codes in Time and Billing
Professional (4 - 20 characters) in the Engagement Code Length field. Time
and Billing engagement codes will be converted to the new format.

For example, for an engagement length of 15, code 0123 will become
000000000000123.

b Set the terms for open invoices that will be migrated to Time and Billing
Professional in the Existing T/B Invoice Terms field.

3 Set the defaults for new customers in the New Customer Defaults section.

a Select the default division for new customers created in Accounts Receivable
in the Division field. The division is required to create a new customer. Any
existing division may be used in the mapping.

b Select the default salesperson for new customers created in Accounts
Receivable in the Salesperson field.
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¢ Select the default terms for new customers created in Accounts Receivable in
the Terms Code field.

d Select the default sales code for new customers created in Accounts
Receivable in the Sales Code field.

e Select the default payment type for new customers created in Accounts
Receivable in the Dflt Pymt Type field.

f Enter default comments for new customers created in Accounts Receivable in
the Comment field.

g Click All new Clients button to set all the mappings to new customers and to
use the defaults for customer codes and salesperson codes.

4 Set and review the mappings for existing Time and Billing customers in the grid

section.

a The T/B Client column contains all the clients that exist in the TB1 file (Time
and Billing Client Masterfile).

b Check New to map the client as a new Accounts Receivable customer
(customer is to be created during the migration).

OR

Clear the field to map the customer as an existing Accounts Receivable
customer.

¢ Select the Accounts Receivable customer to which the Time and Billing client
will be mapped from the A/R Customer field.

* When the New field is marked, the default division will be combined with the
client code to create the new Accounts Receivable customer. This field can be
modified to any code desired as long as it uses an existing division (if divisions
are enabled) and the code does not already exist in Accounts Receivable.

+ If the New field is not checked, an existing Accounts Receivable customer
must be entered.

d Select the salesperson for the customer from the Salesrep field.

+ If the mapping is for a new customer, the Salesrep field will default to the
salesperson set in the Default Salesperson field. This field can contain any
existing Accounts Receivable salesperson for the division assigned to the new
customer.

+ If the mapping is for an existing Accounts Receivable customer, this field is
disabled.
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e Check Include Open Invoices to include the invoices in the migration. The
migration process will update all open Time and Billing invoices and client
totals to Accounts Receivable. It is possible that Accounts Receivable and
Time and Billing have been running in parallel and, therefore, this information
already exists in Accounts Receivable.

If this field is not checked, open Time and Billing invoices and client totals will
not be posted to Accounts Receivable.

5 Click Proceed to migrate the data. The migrated data will be available in Time
and Billing Professional and Accounts Receivable.

This concludes Chapter 4: Migrating Data from the Time and Billing Module of the
Time and Billing Professional manual.
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Navigating in Time and Billing Professional

Chapter 5: Navigating in Time and Billing Professional contains instructions on
how to access specific features of the Time and Billing Professional module. This
chapter describes how to access windows in Time and Billing Professional, use
the menu bar, and use different button fields available in the module.

Using the Modules Tree

The Time and Billing Professional module displays the menu options in the
Sage MAS 90 or 200 Modules tab, which contains the "tree-like" view. You can
access a window in the Time and Billing Professional module through the tree-like

SEMAS 90 Desktop _[Oo[x
| File Modulss My Tasks View Help || Man Biing Reports Anabysis PeriodEnd Sstup Custom Reports
|G B0 smle (=]
eS| x| | Find Task | Find
| Address | |
24 [ Time and Biling Professional - Setup |
Tasks |y Tasis | Up one level. .
1 Bar Code 2| | |E2Time and Biling Pro options
1 Material Requirements Planning [E-Division Maintenance
21 Timekeeper (| office Maintenance
{3 Library Master Extensions [E-lEmployes Maintenance
{21 Paint of Sale Professional = Catenory Maintenance
=2 Time and Biling Professional [E-]5tandard Comment Maintenance
e % MF‘" [EZlwork Code Maintenance
S = E‘ '"gt E3Biling Format Maintenance
s A::Ejs; =2 Time and Billng Pro Uiities
903 Period End [E-IMemo Manager Maintenance
=] setup
{E3 Division Maintenance
[E office Maintenance
{E Employee Maintenance
{E3) Category Maintenance
{E) standard Comment Maintenance
{E3) work Code Maintenance
{E3 Biling Format Maintenance
{E3) Time and Billing Pro Utilties
{E3) Mema Manager Maintenance
{27 Custom Reports
-1 Time and Biling
(- MultiBin Advanced Distribution
(] Remote Salespersan PDA
(] ScanBlaster
(-] Professional Retainer Control
(] MICR Encoded Laser Checks =
Time and Billng Professional Dema (LW2) Time and Biling Professional | [ of7jzoos Iz

Sage MAS 90 Window

Open a Time and Billing Professional Window through the Modules Tree

1 Double-click the Time and Billing Professional module from the Modules tab.
The module expands to display all the menu options available in the Time and
Billing Professional module.
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2 Click the menu option you want to access. The names of the windows available
in the menu appear on the right side of the Sage MAS 90 or 200 window.

Tirne and Biling Professional - Setup
Up one level,.,,
[ Time and Eilling Pro Gptions
aDivisiUn Maintenance
[EX|0ffice Maintenance
EEmplﬂyeE Mainkenance
Ecategﬂry Mainkenance
[ standard Comment Maintenance
[l work Code Maintenance
[EEiling Format: Maintenance
== Time and Eilling Pro Ltilities
aMemo Manager Maintenance

Windows Available in the Setup Menu

3 Double-click the name of the window to open. The system displays the selected
window.

Using the Time and Billing Professional Menu Bar

The Time and Billing Professional menu bar is available through the Sage MAS 90
or 200 menu bar. You can access the windows in the Time and Billing Professional
module through the menu bar.

AS 90 Desktop _[Ofx
File Modules My Tasks View Help Main Biing Reports Analysis PeriodEnd Setup Custom Reports
w60 8ml ol I
00 x [H|a Find Task [ Find
Address |
2 [Time and Biling Professional - Setup [ \

Tasks |y Tasks | £1up one level..
®-C1 Bar Code || |EAmime and Biling Pro options
-] Materisl Requirements Planning [ElDivision Maintenance - AT .
B Tinekesper Eloffies Maikonance Time and Billing Professional Menu
-] Library Master Extensions [EolEmployes Maintenance
-] Paint of Sale Praofessional B category Maintanance
-] Time and Biing Professional [E-lstandard Comment Maintenance

-] Main [EJwork Cade Maintenance
L] biling (=] Biling Format Maintenance
[E1Time and Biling Pro Utilities
[E=]Memo Manager Maintenance

[
#-{] Reports
=] Analysis
®-{] Period End
=] Setup
{58 Time and Biling Pre
{= Division Maintenan
{= office Maintenance
{= Emplayss Maintenance
{=3 Category Maintsnance
{= standard Comment Maintenance
{=) wiork Code Maintenance
{= Biling Format Maintenance
{=3) Time and Billing Pro Utilties
{=2) Memo Manager Maintsnance
{1 Custam Reports
£1-"] Time and Biling
£1-] MultiBin Advanced Distribution
#1-"] Remoke Salesperson FDA
£1-] ScanBlaster
#1-_] Professional Retainer Control
£1-] MICR Encoded Laser Checks

[
[
[
[
[
[

[Tirme and Billing Prafessional Dema (LW2) Tirne and Billng Professional [ omyz00s [z

Sage MAS 90 Window

Open a Time and Billing Professional Window through the Menu Bar

1 From the Modules menu, select Time and Billing Professional.

2 Select the menu option, and then select the name of the window. The system
displays the selected window.
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After opening the Time and Billing Professional module, the Time and Billing
Professional menu appears on the right side of the menu bar. You can access
additional Time and Billing Professional windows using this menu bar.

Using Buttons and Keyboard Commands in Time and Billing
Professional

The Time and Billing Professional module uses the standard Sage MAS 90 or 200
buttons and icons that you use to perform a specific activity. You can also use the
keyboard to perform many of the same functions. The following table describes
each button and provides the keyboard variation of the button when applicable.

Button Keyboard Description

TAB Advances you to the next field on a window.
In a grid, pressing the TAB key moves focus from cell to
cell. At the end of the row, pressing TAB moves the key to
the next row.

ENTER Advances you to the next required field on a window and
allows you to save changes.

SPACEBAR You can use the spacebar to clear or select a check box or
radio button field.

BACKSPACE Deletes the information in a field.

ESC Closes the current window.
In a grid, pressing the ESC key cancels a cell entry.

DELETE Deletes information from a field.

HOME Highlights the first item in a list box or Lookup window.
In a grid, pressing the HOME key moves focus to the first
cell of a row.

END Highlights the last item in a list box or Lookup window.
In a grid, pressing the END key moves focus to the last cell
of a row.

PAGE UP Highlights an item in the previous page of a list box or
Lookup window.

PAGE DOWN Highlights an item in the next page of a list box or Lookup
window.

CTRL+HOME In a grid, moves focus to the first row in the same cell
position.

CTRL+END In a grid, moves focus to the last row in the same cell
position.

CTRL+ENTER In a grid, adds line feeds to comments.

CTRL+INSERT Inserts a line.

CTRL+DELETE Deletes the current line.

ARROW In a grid, pressing the ARROW keys moves focus from cell
to cell.
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Keyboard
F1in a Field

Chapter 5

Description

Displays the pop-up help for the current field.

F1 on a Window

Displays the help for the entire window.

Frinter S etup...

F2 Displays the Lookup window for the current field. Select an
item from the Lookup window and click Select. The item

E] item f the Look ind d click Select. The it
appears in the field.

5 F3 Displays an alternate Lookup window for the current field.
or This window is usually more tailored for the current field
ALT+L than the general Lookup window. Select an item from the
Lookup window and click Select. The item appears in the
field.
F4 Allows you to print the information available on a window.
This option my display an options window, where you can
select the type of data to include in a printout.
F5 In a grid, allows you to toggle between the primary and
secondary grids.
3 Opens a window for you to perform a special task
c2) associated to the field or window. Usually allows you to
display/enter lot/serial items.

CTRL+F5 Many windows display Browse buttons in the lower left
corner, to help you browse through existing records. This
button displays the first record available.

CTRL+F6 Many windows display Browse buttons in the lower left
corner, to help you browse through existing records. This
button displays the previous record available.

CTRL+F7 Many windows display Browse buttons in the lower left
corner, to help you browse through existing records. This
button displays the next record available.

CTRL+F8 Many windows display Browse buttons in the lower left
corner, to help you browse through existing records. This
button displays the last record available.

ALT+A Saves the information you added or changed in a window.

Accep
ALT+C Disregards any changes you entered in a window.

Lancel

ALT+D Removes the currently selected record from the
Sage MAS 90 or 200 system.
ALT+P Click this button to print a report, journal, or listing.
Frinl
- ALT+V Click this button to preview a report, journal, or listing

before printing it.

ALT+S Click this button to change the printing configurations for

the report, journal, or listing.
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Button Keyboard Description
SHIFT+F1 Displays Help text for the window.
ALT+O Click OK for dialog boxes and line entries.
ALT+U Undo line changes.
ALT+N Inserts a line.
ALT+E Deletes a line.
ALT+1,2,3 ... In a data entry window, selects the first tab, second tab,
third tab . . .
ALT+B Opens a Batch window where you can start a multiple data
[ entry session.
Sends an e-mail to the address entered in the E-mail
Q Address field.
Displays a text window to enter or view additional
@ information about an item.
ALT+M Opens the Memo Maintenance window where you can
write a memo.
ALT+Q Launches the MapQuest website for directions to a
@ location.
= ALT+S Shows the image specified at the adjacent field.
ALT+S Search through a list or Lookup window for items that
match a specified search criteria. Use the Search option to
limit the number of items in a list or Lookup window.
= ALT+U Launches a website based on the URL entered at the URL
@ Address field.
ALT+N Displays the next number for a record. Click this button to
i add a new item.
= Changes the size of the window to the expanded view.
= Changes the size of the window to the standard view.
Sxp
E] ALT+Z Displays the details of an item.
5 Calculates the net balance.
F2 Opens the calculator.
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Button Keyboard Description
_— F2 Opens the calendar.
=
=5 Displays options for changing budget amounts.
]
ALT+U De-selects all rows in a grid.
ALT+S Selects all rows in a grid.
‘@

Selects a column in a grid.

Selects a row in a grid.

| | @) 8

ALT+N Inserts a row in a grid.

ALT+W Moves a row down in a grid.
ALT+U Moves a row up in a grid.

This button prints a report from a grid.

)
= ALT+E Deletes a row in a grid.
=5
— ALT+R Resets a row in a grid.
=

B

Saves changes.

B

Switches between displaying the New Balance view and
the Debits and Credits view.

(3]

Lists files in a directory.

&

Opens a Text Maintenance window where you can write an
extended description.

This button is available on a Lookup window. Click Filters to
enter additional filters for the lookup. The text on this button
will appear in red, if filters already exist.

Custom...

This button is available on a Lookup window. Click Custom
to create a unique lookup view by adding, removing, and/or
modifying columns and filters.
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Description

This button is available on a Lookup window. Click Find to
activate the search.

Click Select to select a record, or double-click the current
line.

This concludes Chapter 5: Navigating in Time and Billing Professional of the Time
and Billing Professional manual.
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Using the Setup Menu

Chapter 6: Using the Setup Menu teaches you how to setup options for your
company and how to create and maintain standard data used within the Time and
Billing Professional module. The activities in this chapter are performed by a
manager or system administrator.

How to Use the Setup Menu

Page 78

The Time and Billing Professional Setup menu contains the features used to build
and maintain the files required for the operation of the Time and Billing
Professional module. You might not need to use every feature available in the
Setup menu. Select only the options your company requires.

This chapter does not describe every procedure that can be completed on a Setup
window. This chapter describes each option so you can setup your Time and
Billing Professional system quickly and start using the module. Detailed
instructions about changing information, deleting information, and printing from the
Setup windows are available in the online help. The following instructions provide
a quick overview of how to complete these procedures.

Open a Window from the Setup Menu

1 Double-click the Time and Billing Professional module from the Modules tab.
The module expands to display all the menu options available in the Time and
Billing Professional module.

2 Click the Setup menu. The names of the windows available in the menu appear
on the right side of the Sage MAS 90 or 200 window.
Time and Billing Professional - Setup

Up one lewvel, .,
[ Time and Billing Pro Options

aDiws\Un Maintenance

[E2] ffice Maintenance
EEmplnyee Maintenance
Ecategnry Mainkenance

[ standard Comment Maintenance
[l work Code Maintenance
[EBiling Format: Maintenance

=2 Time and Billing Pro Utilities
aMemo Manager Maintenance

Windows Available in the Setup Menu

3 Double-click the name of the window to open. The system displays the selected
window.

Add a Record

1 Enter the new record name or number in the first field on the window.
Every window in the Setup menu, with the exception of the Time and Billing
Professional Options window and the Time and Billing Pro Utilities window,
allows you to manually enter new information in the first field. The Time and

Billing Professional Options and Time and Billing Pro Utilities windows set the
options for the entire module and do not have separate records.
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2 Set the options your company requires from the fields available on the window.
See the section in this chapter for detailed information about each option you
can set.

3 Click Accept to save the changes.
Select an Item from a Lookup List

Many fields in the Setup menu feature a Lookup list. These lists allow you to select
data for the field.

* Click the E] button (or the alternate button) in the appropriate field to select
an item from a Lookup window. Selecting from a sortable list places the item you
selected in the field.

Change a Record

1 Click the E] button in the first field to select a record account from a Lookup
window (or use the {4 (4 (& (¥ buttons to access the desired information). The
system displays the record’s information on the window.

2 Review and edit the options your company requires in the fields available on the
window. (See the respective section in this chapter for detailed information about
each option you can set.)

3 Click Accept to save the changes.
Delete a Record

1 Click the E] button in the first field to select a record account from the Lookup
window. The system displays the record’s information in the window.

2 Click Delete. The system displays a warning dialog box similar to the following.

i Sage MAS 90 [ x]

(] Delete This Office Code?
LY

Sage MAS 90 Warning Dialog

3 Click Yes. The record is deleted.

4 Click Accept on the main window to save the changes.

Print a Setup Listing

You can print information from any of the windows available in the Setup menu.
These windows provide a listing of the options set or the records available. For

many of the windows you can select the type of information to include in the listing.
For detailed information about each type of listing, see the online help.
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1 Click the button on the window. A Listing window similar to the following
appears.
ﬂﬂEmpluyee Listing [ 2 _[C]x]

Sort Optian Employee Code ﬂ

L L]
L L]
L

D Print Employee Cast

Repart Farmat Summary ﬂ

=

Starting Ending
Q zz|Q,
Q, Q,
Q, zz[a,

0 - Managing Partner ﬂ 7 - Clenical ﬂ

Selection

Employee
Last Name

Office Code

& & EE

Employee Level

Canon Sales [ Print. I Prexiew | Frinter Setup... |@

[ Lw2 | 9/7/2005
Employee Listing Window

2 Select how to sort the list from the Sort Options field.

3 Select the type of information to include in the list from the remaining fields on
the Listing window. For many fields, you can select all records or a range of
information.

For example, in the previous picture you can check All to print all account
numbers, or you can use the Lookup windows in the Starting and Ending fields
and select specific accounts. If there is a date field available on a Listing window
and you want to print information for a particular date, enter the same date in the
Starting and Ending fields.

4 Click Print to print the list, or Preview to preview the list.

Time and Billing Professional Options
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The module’s Options window, a standard feature available in all Sage MAS 90
and Sage MAS 200 accounting software modules, allows you to customize each
module to fit your company's specific accounting requirements. The Time and
Billing Professional Options window allows you to select from a wide range of
options. Using this feature you tailor the Time and Billing Professional module to
suit your business requirements. Configure which Sage MAS 90 or 200 modules
will integrate with Time and Billing Professional, set standards for company
terminology, and determine billing procedures.

After installing Time and Billing Professional, the system startup process begins
and the Time and Billing Professional Options window appears. You can set up the
module right after installation and update the configuration whenever required by
your business.

The Time and Billing Professional Options window contains five tabs for different
configuration settings: the Main, the Additional, the Billing, the Terminology, and
the Employee tab.
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Configure the Standard Time and Billing Professional Options on the Main
Tab

The Main tab of the Time and Billing Professional Options window contains the
general settings for the Time and Billing Professional module.

1 From the Setup menu of the Time and Billing Professional module, select Time
and Billing Pro Options. The Time and Billing Professional window appears.

ﬂj Time and Billing Professional Dptions
I 2. Additional I 2. Billing | 4. Terminology | 5. Emplayes
Multiple Engagements per Client Use Time Unit Entry
Engagement Code Length 20 j Mumber of Hourg/Minutes per Time Uit 25
Default Engagement | 00000000000000000000
Current Time and Billing Pro Fiscal Year 1998 %
Allow Dverride of G/L Account in Data Entry (o' s e g P R 03 ﬂ
MNext Automatic Transaction Mumber 0000035
Engrit Mema Availin Data Entry  Allow Maintenance ¥ | Use &/A Invoice Sequence ]
MNext Automatic Invoice Humber 0000070
[ Lw2 | 9/7/2008

Time and Billing Professional Options Window - Main Tab

2 Set how Time and Billing Professional will handle engagements. Select the
options your company requires.

a Check Multiple Engagements Per Client to use engagements for designated
clients. When you select this option, the Engagement Code Length field and
Default Engagement field become available.

b Enter the number of alphanumeric characters as the length for your
engagement codes in the Engagement Code Length field. Engagement
codes can be between 4 and 20 characters.

¢ Enter the default engagement code number for the Time and Billing
Professional module in the Default Engagement field.

3 Check All Override of G/L Account in Data Entry to allow Time and Billing
Professional to override the default General Ledger account during data entry.

4 Set how Time and Billing Professional will handle memos. Select the options
your company requires.

Select the type of engagement memo access users have in the Time and Billing
Professional module from the Engagement Memo Available in Data Entry
field. Options include:

* Not Available - To deny any memo access
* Inquiry Only - For read only access

» Allow Maintenance - To allow users to review, change, and create
engagement memos during time and billing entry.
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5 Select the time units for the Time and Billing Professional module. Select the
options your company requires.

a Check Use Time Unit Entry if your company uses a time unit other than
hours.

When this field is selected, the Number of Hours/Minutes per Time Unit
field becomes available.

b Enter the number of hours or minutes for each time unit in the Number of
Hours/Minutes per Time Unit field. Enter this information in the HH, HH.HH,
or HH:HH format.

For example, enter 1 to indicate 1 hour and 1.5 or 1:30 to indicate one hour
and 30 minutes. If you use the HH:MM format, the time amount entered is
automatically converted into fractional hours using the HH.HH format.

6 Set the year and period information for the Time and Billing Professional
module.

a Select the current fiscal year for the Time and Billing Professional module in
the Current Time and Billing Pro Fiscal Year field. This year must reflect the
calendar year associated with the current time and billing period.

This field, and Current Time and Billing Pro Period field differentiates
between the current years and the future year. The information in this field is
automatically updated during the Time and Billing Professional period end
(see page 329) or year end (see page 330) processing.

b Select the current accounting period from the Current Time and Billing Pro
Period field.

This field, and the Current Time and Billing Pro Fiscal Year field
differentiates between the current period and a future period. The information
in this field is automatically updated during the Time and Billing Professional
period end (see page 329) processing.

7 Set the next time transaction and billing invoice numbers for the Time and Billing
Professional module.

a Enter the next automatic transaction number for the Time/Expense Entry (see
page 168) and Edit Work In Process Entry (see page 231) windows in the
Next Automatic Transaction Number field. You may enter up to seven
alphanumeric characters. When a user creates a new time entry, the
transaction will be assigned the number entered in this field. This field is
updated after each new transaction.
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b Check Use A/R Invoice Sequence to use the invoice number sequence
defined in the Accounts Receivable module for the Time and Billing
Professional module. The Invoice Printing window will use the next Accounts
Receivable invoice number for billing invoices.

If you select this option, the Next Automatic Invoice Number field will be
disabled.

¢ Enter the next automatic invoice number for the Invoice Printing window in the
Next Automatic Invoice Number field. You may enter up to seven
alphanumeric characters. When a user creates a new invoice, the invoice
number will be assigned the number entered in this field. This field is updated
after each new invoice.

The Next Automatic Invoice Number field is not available if the Use A/R
Invoice Sequence field is checked.

8 Click the next tab to continue.

Enter Recap, Passwords, and General Ledger Information on the Additional
Tab

Use the Additional tab of the Time and Billing Professional Options window to
enter additional information regarding your Time and Billing operations, such as
recap information, passwords, and integration options to the General Ledger
module.

1 Click the Additional tab from the Time and Billing Professional Options window
to access additional options for your time and billing procedures.

Ei Time and Billing Professional Dptions
1. Main 3. Billing | 4. Terminology | 5 Employes
General Ledg
Recap by Client/Engagement Summary ﬂ Past Work in Process to General Ledger
Recap by Employes Sumrmary ﬂ Past Work Code Revenue by Division D
Recap by Work Code Category | Surmmany ﬂ Default Revenue 40001 %
Update by User Code ]
Password for Update User Code Overide
Password to Add/Maintain Codes
Password for Rate Dverride in Data Enty
Integrate Time and Biling Professional wit
{Eeneral Ledger
[ Lwz | 9/7/2008

Time and Billing Professional Options Window - Additional Tab

2 Select the amount of details to print in the Daily Time/Expense Recap report.
Select the options your company requires.
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a Select the amount of client/engagement details to include in the report from
the Recap by Client/Engagement field. Options include:

* None - To not print this recap report

* Detail - To print a detailed Daily Time/Expense Recap in order of the client
codes and engagements

+ Extended Comments - To print data with extended comments

» Summary - To print a summarized report by client codes and engagements

b Select the amount of employee details to include in the report from the Recap
by Employee field. Options include:

* None - To not print this recap report

* Detail - To print a detailed Daily Time/Expense Recap in order of the
employee codes

+ Extended Comments - To print data with extended comments

+ Summary - To print a summarized report by employee codes

¢ Select the amount of work category details to include in the report from the
Recap by Work Code Category field. Options include:

* None - To not print this recap report

* Detail - To print a detailed Daily Time/Expense Recap in order of the work
codes

+ Extended Comments - To print data with extended comments

* Summary - To print a summarized report by work codes

3 Select how to update codes used in the Time and Billing Professional module.
Select the options your company requires.

a Check Update by User Code to print the the Time/Expense Journal (see
page 173) or Edit Work In Process Journal (see page 235), and update the
transactions by a specific user code.

If this option is checked, the Password for Update User Code Override field
becomes available.

b Enter a password in the Password for Update User Code Override field if
you want to verify user code overrides during the Time/Expense Entry (see
page 168) or Edit Work In Process Entry (see page 231) process. This
password will be requested when a user tries to update a transaction originally
created by another user. You may enter up to six alphanumeric characters.

» To not password protect user code overrides, leave this field blank.

» The Password for Update User Code Override field is available only if the
Update by User Code field is selected.
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¢ Enter a password in the Password to Add/Maintain Codes field if you want
to password protect the creating and changing of clients, engagements,
employees, or work codes. You may enter up to six alphanumeric characters.

If you do not want to secure the ability to add or maintain codes, leave this
field blank.

d Enter a password in the Password for Rate Override in Data Entry field if
you want to verify rate overrides during data entry. This password will be
requested when a user tries to update a billing rate, amount, or rate code. You
may enter up to six alphanumeric characters.

To not password protect rate overrides, leave this field blank.

4 Determine how the Time and Billing Professional module integrates with the
General Ledger module. Select the options your company requires.

a Check Integrate Time and Billing Professional with General Ledger to
integrate Time and Billing Professional with the General Ledger module
(General Ledger must be installed to integrate).

If you select this option, any General Ledger posting from Time and Billing
Professional will be updated to the General Ledger module, and posted to the
General Ledger Recap.

b Check Post Work in Process to General Ledger to post Work in Process
transactions to the General Ledger.

¢ Check Post Work Code Revenue by Division to post work code revenues by
division.

d Select the General Ledger account to be used as a default revenue account
when entering new clients in the Default Revenue Account field.

5 Click the next tab to continue.
Set Billing Features for Time and Billing Professional on the Billing Tab

Use the Billing tab of the Time and Billing Professional Options window to set
standards for your billing operations.
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1 Click the Billing tab from the Time and Billing Professional Options window to
access standard options for your billing procedures.

ﬂﬂTime and Billing Professional Options

1. Main I 2. Additional ] 3. Billing | 4. Teminology I 5. Employes
Drays to Retain Employes Hourly Analysis oo [ Use Graphical Forms D ]
Retain Detailed Billing History
Track Extended Comments Allow Batch Entry

Batch Entry Override Pagsword
Billing *w/orksheet Format Standard ] Mest Batch Number 00001
Select and Print Bills by Category j
Hash Total Field Wark j [ Split Commissions Between Salespersons
Billing Text DisplapFrint width 50 j
Automatically 4pply Retainer Balance to Bille

| beset

[ Lwz | 9/7/2005

Time and Billing Professional Options Window - Billing Tab

2 Set how Time and Billing Professional will track historical data. Select the
options your company requires.

a Enter the number of days to retain employee hourly analysis in the Days to
Retain Employee Hourly Analysis field. You may enter up to three digits.

b Check Retain Detailed Billing History to retain detained history information
for all bills entered in Billing Data Entry and Billing Selection.

* History invoices CANNOT be reprinted. You can purge these invoices during
period end processing.

* If you select this field, the Track Extended Comment field becomes
available.

¢ Check Track Extended Comment to track extended comments in the
detailed billing history.
This field is available only if the Retain Detailed Billing History field is
selected.

3 Set how Time and Billing Professional will print billing invoices. Select the
options your company requires.

a Select the worksheet format the Time and Billing Professional module will use
from the Billing Worksheet Format field. Options include:

» Standard - To allow clients/engagements to be selected based on the partner,
responsible employee, client type, billing frequency, or fee arrangement.

» Extended - To also include the client address and contact information,
production and billing history information, receivables aging information, and a
fee recap by employee. The extended form also provides page breaks by
engagement code.
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b Select how to sort the print order on the Billing Data Entry, Billing Worksheet,
and Billing Selection Register windows from the Select and Print Bills by
field. Options include:

» Date - To print work in process transactions in order of date

» Category - To print the work in process transactions in order of the work code
categories

¢ Select how to determine the hash total from the Hash Total field. The Hash
Total field in the Time/Expense Entry and Edit Work In Process Entry windows
displays the total of all specified codes, and may be used to determine
whether a transaction has been lost or omitted from processing.
Select the code to use to determine the total. Options include:

» Client Code

+ Engagement Code

+ Employee Code

» Work Code

d Select the print/display width from the Billing Text Display/Print Width field.

Select the maximum number of characters (from 50 to 75) for the Bill Text and
Category Bill Text fields during Billing Data Entry (see page 191) and Invoice

Printing (see page 216).

Changing this field will affect the way the existing Bill Text and Category Bill
Text displays and prints on invoices. After you change this field, verify that
your Bill Text word-wraps correctly.

e Check Automatically Apply Retainer Balance to Bills to automatically apply
any retainer balanced to invoices during the Billing Selection (see page 186)
and during Billing Data Entry (see page 191) process.

f Check Use Graphical Forms to use graphical forms when printing.

4 Set how Time and Billing Professional will handle batch entry of invoices. Select
the options your company requires.

a Check Allow Batch Entry to allow batch entry of invoices.

When you check this field, the Batch Entry Override Password and Next
Batch Number fields become available.

b Enter a password to be used during batch entry in the Batch Entry Override
Password field. This field is available only if the Allow Batch Entry field is
selected.

If you do not want to secure the batch entry feature, leave this field blank.

c Enter the next batch number to be used during batch entry in the Next Batch
Number field. This field is available only if the Allow Batch Entry field is
selected.
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5 Check Split Commissions Between Salespersons to allow commission to be
split between salespersons during billing.

6 Click the next tab to continue.

Customize Field Names in Time and Billing Professional with the
Terminology Tab

Use the Terminology tab of the Time and Billing Professional Options window to
customize the Time and Billing Professional module with terminology used in your
company.

1 Click the Terminology tab from the Time and Billing Professional Options
window to access terminology options.

EﬁTime and Billing Professional Options
1. Main I 2. Additional I 3 Billing I 4. Teminology 5. Employee
Time and Billng Fro Teminology Libbr Employee Biling R ates Descriptions
Client Client Clt. Biling Rate Code O Gen oot Sve
Engagement Engagement Engmt Biling Rate Code 1 Mngmt Adwisary
Employee Emplopee Emply Biling Fiate Code 2 Audit Services
Wark Code Wark WL Billing Rate Code 3 Phone Support
Biling Rate Code 4 Mizcellaneous
Client Misc Fields Descriptions Billing Fiate Code 5 Special
IFEL) Indlustry Biling Rats Cods § Financial Pln
Field 2 Acot Saft? Biling Fiate Code 7 Tax Ret-Corp
A= Vearknd Biling Rats Cods 3 Tan Ret Fitshp
=P Newsletter Biling Rats Cods 3 Tan Retndiv
\ [ [owz [ as7/z008

Time and Billing Professional Options Window - Terminology Tab

2 Change any of the Time and Billing Professional terminology and abbreviations.
You may customize your system to specifically match your industry
requirements by renaming the terminology used throughout the system.

|Z[NOTE: This information is changed in field labels only - NOT in menu
options or report titles.

I:Jj HINT: You can change the full field label in the Terminology fields - up to
ten characters, and the abbreviation in the Abbr fields - up to five characters.

a Change the name of the Client Code label in the Client field. You can change
the full field label in the Client Terminology field, and the abbreviation in the
Client Abbr field .

b Change the name of the Engagement Code label in the Engagement field.
You can change the full field label in the Engagement Terminology field, and
the abbreviation in the Engagement Abbr field.
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¢ Change the name of the Employee Code label in the Employee field. You can
change the full field label in the Employee Terminology field, and the
abbreviation in the Employee Abbr field.

d Change the name of the Work Code label in the Work Code field. You can
change the full field label in the Work Code Terminology field, and the
abbreviation in the Work Code Abbr field.

3 Add your own fields to the Client tab of the T/2 Client Maintenance window (see
page 146) by entering the names in the Descriptions fields in the Client Misc
Fields section. You may enter up to fen characters in each of the user-defined

fields.
These fields are not required. If you do not enter information in this section, the
fields on the Client Maintenance window’s Client tab will not be available during

data entry and report printing.

One example of using these fields is to enter information about your client’s
company size, industry, number of employees.

4 Enter a standard description in the Descriptions field for each billing rate in the
Employee Billing Rates area for each Billing Rate Code. You may enter up to
15 alphanumeric characters per rate.

There is a total of ten different Employee Billing Rate Codes (0 through 9).

Set Up Employee Types on the Employee Tab

Use the Employee tab of the Time and Billing Professional Options window to set
up employee-specific information for the Time and Billing Professional module.

1 Click the Employee tab from the Time and Billing Professional Options window
to access employee information for your time and billing procedures.

EﬁTime and Billing Professional Options

1. Main I 2 Additional I 3. Biling I 4. Teiminology I 5. Employes

Level Diesc O | Managing Partner Lewel Dezc & | Consultant
LevelDesc 1 | Partner Level Desc B | Staff Accountant
Level Diesc 2 | Manager Level Desc 7 | Clerical

Level Desc 3 | Supervisor Level Desc 8

Level Desc 4 | Senior Level Desc 3

Period Ending Target Hours  Period Ending Target Hours  Period Ending Target Hours

014311938 180.00| | 05/31/1938 180.00| | 09/30/1938 180.00
02/28/1938 180.00| | 0B/30/1938 180.00) 1043141938 180.00
03/31/1938 180.00| | OF7/31/1938 180.00) | 11/30/1938 180.00
04/30/1938 180.00| | 08/31/1938 180.00) | 12/31/1938 .o

[ Lw2 | 9/7/2005

Time and Billing Professional Options Window - Employee Tab

2 Enter the description of each employee level in the Level Desc fields. Employee
levels are assigned to different types of employees, such as manager, director,
and technician. You may enter up to 30 alphanumeric characters per level.
There is a total of ten different employee levels (0 through 9).
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3 Enter the default target hours for all employees for each period in the Target
Hours field. You may use up to two digits to the right of the decimal point.

4 Click Accept to save the changes on the Time and Billing Professional Options
window.

OR

Click Cancel to exit without saving.

Division Maintenance

Use Division Maintenance to organize your customer and invoice information by
divisions. You can define up to 100 divisions by department, branch, or profit
center. Each division can maintain its own Accounts Receivable and Discounts
Allowed account numbers for posting to the General Ledger. Amounts posted to
each account reflect the activities for only that division. If you integrate the General
Ledger module with Accounts Receivable, you can print the Accounts Receivable
ending balance amounts for each profit center on your financial statements and
other General Ledger reports.

Divisions affect the numbering of your customers. The division number precedes
the customer number entered in Customer Maintenance and determines which
General Ledger accounts are posted to when an invoice or cash receipt is
processed. Additionally, all reports containing customer invoice and payment
information provide subtotals by division. The accounts posted to are based on the
accounts specified in Division Maintenance.

+ If the Accounts Receivable Divisions check box is selected on the Accounts
Receivable Options window, use Division Maintenance to assign a number and
description to each division of your company. You also record the General
Ledger account numbers transactions to post when invoices or cash receipts are
processed for a customer within a specific division.

« If the Accounts Receivable Divisions check box is cleared on the Accounts
Receivable Options window, enter information for division 00 only.

- Division 00 CANNOT be deleted.

- You CANNOT post invoices, cash receipts, or finance charges if any General
Ledger account numbers are blank.

See the Accounts Receivable Online Help by Sage Software for more information.
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Create a Division

1 From the Setup menu of the Time and Billing Professional module, select
Division Maintenance. The T/2 Division Maintenance window appears.

[ T2 Division Maintenance
Division Ne. |00 [, Description | MAIN DIVISION
[ Default Revenue 400-01 % Accounting Fees ]
Work in Process 115-00 % Wwork In Process
WP Offset 11600 % ok In Process Oifset
Progress Bill Offzet 22000 % Defered Revenue
Clierit Retainer 20500 % Cligrt Retainers
@@ | Accept I LCancel ] Delete
[ Lw2 | 9/7/2005

T/2 Division Maintenance Window
2 Enter the division number (from 01 to 99) in the Division Number field.

+ Click the button to enable a division from a list of all Sage MAS 90 or 200
divisions available.

+ Click the E] button to search for a division that is already enabled in Time and
Billing Professional, so you can change the settings.

+ Use the {4} (4 (&1 (3} buttons to access the desired information.

3 Enter the description for this division in the Description field.

I:JjHINT: Click the E] button in the following fields to select a specific item
from a Lookup window. Selecting from a sortable list places the item you
selected in the field. .

4 Enter the General Ledger default revenue account for the division in the Default
Revenue field.

5 Enter the General Ledger Work in Process account for the division in the Work
in Process field.

6 Enter the General Ledger Work in Process offset account for the division in the
WIP Offset field.

7 Enter the General Ledger progress bill offset account for the division in the
Progress Bill Offset field.

8 Enter the General Ledger client retainer account in the Client Retainer field.
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9 Click Accept to save the changes.
OR

Click Cancel to exit without saving.

Office Maintenance

This feature assigns a code and description to each office of your company. Enter
the Office Code representing the office you want to add or maintain.

Create an Office

1 From the Setup menu of the Time and Billing Professional module, select Office
Maintenance. The Office Maintenance window appears.

ﬂ-ﬁﬂfﬁce Maintenance K HiE
Dffice Code  |NET |G,

Description | METWORK COMSULTAMTS

@@ | Accept | Cancel I Delete
I Lw2 | 9/7/2008

Office Maintenance Window

2 Enter a three-character, alphanumeric code (0-9 or A-Z) to identify an office in
the Office Code field.

+ Click the E] button to search for an office that is already available in Time and
Billing Professional, so you can change the settings.

+ Use the {4 @ (& () buttons to access the desired information).
3 Enter a description for the office in the Description field.

4 Click Accept to save the changes.
OR

Click Cancel to exit without saving.

Employee Maintenance

Use Employee Maintenance to create and maintain detailed information for each
of your employees. This option provides several functions that allow you to set up,
maintain, and inquire about employees. Employee Maintenance is used to create
and maintain a file of billing rate and billing history information, along with target
billable hours, for each of your billable employees. You may maintain fen separate
billing rates and a cost per hour for each employee.

®WARNING: You can only delete an inactive employee, which means there
CANNOT be outstanding activity for the employee.
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The Employee Maintenance window contains four tabs for different configuration
settings: the Main, the Rate, the Target, and the History tab.

Create an Employee on the Main Tab

Use the Main tab of the Employee Maintenance window to enter the employee’s
office, level, and cost per hour.

1 From the Setup menu of the Time and Billing Professional module, select
Employee Maintenance. The Employee Maintenance window appears.

Ej Employee Maintenance [ M= 3

Emplaves Cade D20 |G Last | DOE First | JOHN

2. Rates I 3. Target I 4. Higtory I

Office  |NET |G NETWORK CONSLILTANTS

Level 5 - Consultant = Cost per Hour 33,000

[ Teminated Employes [ ] Termination Date ]

@@ [ Accept l LCancel ] Delete
[ Lw2 | 9/7/2005

Employee Maintenance Window - Main Tab

2 Enter a four-character, alphanumeric code (0-9 or A-Z) to identify a new
employee in the Employee Code field.

+ Click the E] button to search for an employee that is already available in Time
and Billing Professional, so you can change the settings.

+ Use the {4 (4 (k1 (B} buttons to access the desired information.

* Click the button to create a new employee by copying the information
from an existing employee.

3 Enter the employee’s last name in the Last field.
4 Enter the employee’s first name in the First field.

5 Click the button to access the Employee Memo Maintenance feature (see
page 94).

6 Select or enter the three-character office code for the employee in the Office
field.

* Click the button to create a new office code by launching the Office
Maintenance window (see page 92).

7 Select the employee’s level (such as manager, director, or technician) from the
Level field.

8 Enter the billing rate for the employee in the Cost Per Hour field. You may enter
up to three decimal places.
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9 Check Terminated Employee to mark an employee as terminated.

The Termination Date field becomes enabled.

10Enter the date the employee was terminated in the Termination Date field. This
field is only available in the Terminated Employee field is selected.

|Z[NOTE: You do not have to enter a date in the Termination Date field. If
you do not enter a date, the employee will not be purged from the Time and
Billing Professional system files during Purge Terminated Employees
processing.

11Click the next tab to continue.
Update Employee Memos

1 From the Employee Maintenance window, click the button to access the
Employee Memo Maintenance feature. The Employee Memo Maintenance
window appears.

E:j Employee Memo Maintenance EJE|

Mema | MAS 30 % 1445 30 PRODUCT TRAINING

Mema Date | 05/10/1338 Reminder Date 0670171358

Lisa McCarthy with State OF The A1t Inc. called today to confim that Ima
“winnur and Flachel Scott are registered for the June 14th, 5 day, Product
Training Module,

All hotel reservations have been made. Lisa said transpartation to and from
the seminar is included. Lunch will be provided by State Of The Art.

A Training Manual and Case Study diskettes will be provided. No ather
materials will be needsd

@@ [ ALccept I Lancel I Delete

Employee Memo Maintenance Window

2 Review the information or make the necessary changes on the Employee Memo
Maintenance window.

a Enter a new code to create a new memo in the Memo field, or select an
existing code from the field.

b Enter a description of the memo in the Description text field.

¢ Enter the starting date for the memo in the Memo Date field.

d Enter a reminder date for the memo in the Reminder Date field.
e Enter the memo in the text field.

f Click Accept to save the memo.

3 Click the appropriate command button to return to the Employee Maintenance
window.
See the Time and Billing Professional Online Help for detailed information.
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Enter an Employee’s Billing Rates on the Rates Tab

Use the Rates tab of the Employee Maintenance window to enter the employee’s
billing rates for all ten rate codes. You can set an employee rates per hour or per
unit.

1 Click the Rates tab from the Employee Maintenance window to access an
employee’s billing rates.

LﬁEmployee Maintenance EH W= E3
Emplayee Code nzen |Gy Last | DOE First | JOHN
1. Main I 2 Rates | 3. Target I A Historp I
|
Hours/ Hours/
Description Rate Uity Description Rate Uritg
0 - Gen &cck Sve 120.000 5 - Special 120.000
1 - Mgt Adviscry oo - Financial Pin oo
2 - it Services od 7 -TaxRet-Cap od
3 - Phane Support 120,000 5 - Tax RetPrishp oo
4 - Miscellaneous od 3 - Tax RetIndiv od
@@ [ Accept l LCancel ] Delete
[ [ [Lwz [ a/7/2005

Employee Maintenance Window - Rates Tab

2 Enter the billing rates for each of the ten billing rate codes applicable for this
employee in the Rate field. You may enter up to three decimal places for the
amount.

3 Select the unit of measurement for the billing rate from the Hours/Units field.
You can bill a customer at a rate per hour or per unit (such as per job).

4 Toggle measurement by clicking the Hours/Units button.
* The button means the rate is per hour.

* The

i button means the rate is per unit.

5 Click the next tab to continue.
Enter the Target Number of Hours to Bill on the Target Tab

Use the Target tab of the Employee Maintenance window to enter the employee’s
target billing hours for each fiscal/monthly period.
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1 Click the Target tab from the Employee Maintenance window to access an
employee’s target billing hours.

ﬂﬂEmpluyEE Maintenance EH HE B
Emplopes Cods nzen | C Last | DOE First |JOHN
1. Main I 2. Rates I 4 History I

Period Ending Target Hours  Period Ending Target Hours  Period Ending Target Hours

01/31/1938 160.00 05/31/1338 160.00 03/30/1338 160.00
02/28/1398 1e0.00 0643041398 1e0.00 10/31/1998 1e0.00
03/31/1938 160.00 07/31/1938 160.00 11/30/1338 160.00
04,/30/1392 1e0.00 02/31,/1392 1e0.00 12/31/1998 1e0.00
eoob) Lo Limmn ] oo

Lw2z | 9/7/2005

Employee Maintenance Window - Target Tab

2 Enter the number of target hours to be worked by the employee in the Target
Hours fields for each period.

3 Click the next tab to continue.
View or Edit the Employee’s Historical Time on the History Tab

Use the History tab of the Employee Maintenance window to view/edit historical
information concerning this employee.

1 Click the History tab from the Employee Maintenance window to access an
employee’s historical hours.

i Employee Maintenance | (5] x|
Emplayee Code ;o0 |Gy [ Lest [wiknUR First | IM&
1. Main ] 2 Rates ] 3. Target ] 4 History l
Current Period 05 Period to Date ‘Year to Date Last ‘Year
Billable Hours 88.00 325.00 .o
Hon-Billable Hours 16.00 173.00 .00
Billable Amount 15,875.00 58,535.00 ]
Mon-Billable Amount .00 5.020.00 .00
Billed Fees 15,480.00 6428736 ]
Billed E xpenses oo oo oo
‘write Ups/D ownz oo 3,802.64- oo
@@ [ Accept l Cancel l Delete
\ [ [owz [ as7/z008

Employee Maintenance Window - History Tab

2 Enter the appropriate information in the Period to Date, Year to Date, and Last
Year fields.

a Change the number of Billable Hours posted to the employee.

b Change the number of Non-Billable Hours posted to the employee.
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¢ Change the dollar value of the Billable Amount posted to the employee .

d Change the dollar value of the Non-Billable Amount posted to the employee.
e Change the dollar value of the Billed Fees posted to the employee.

f Change the dollar value of the Billed Expenses posted to the employee .

g Change the dollar value of the Write Ups/Downs posted to the employee.

3 Click Accept to save the changes.
OR

Click Cancel to exit without saving.

Category Maintenance

The Category Maintenance window allows you to establish category codes, which
are used to group related work codes for sorting purposes on analysis reports.
Category codes are also used to classify each work code as billable, non-billable,
billable expense, or non-billable expense. All work codes within the same category
are defined with the same billing type. Category codes are assigned to each work
code on the Work Code Maintenance window (see page 99).

Create a Category Code

1 From the Setup menu of the Time and Billing Professional module, select
Category Maintenance. The Category Maintenance window appears.

ﬂ*ﬁtategnry Maintenance ﬂ !E E
Category Code  |MET %

Description METWORK CONSULTING

Bill Type Billable ]

@@ | Accept I Cancel ] Delete
[ Lwz | 9/7/2005

Category Maintenance Window

2 Enter a three-character, alphanumeric code (0-9 or A-Z) to identify a category in
the Category Code field.

* Click the E] button to search for a category that is already available in Time
and Billing Professional, so you can change the settings.

» Use the {4} ) (& (b buttons to access the desired information.

3 Enter a description for the category in the Description field.
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4 Select the bill type for the category from the Bill Type field. Options include:

Billable

Non-Billable

Billable Expense
Non-Billable Expense

All work codes, defined within a category are defined with the same bill type.
5 Click Accept to save the changes.
OR

Click Cancel to exit without saving.

Standard Comment Maintenance

The Standard Comment Maintenance window allows you to maintain any number
of commonly used phrases that may be entered during Time/Expense Entry (see
page 168) and Billing Data Entry (see page 191).

Create a Standard Comment

1 From the Setup menu of the Time and Billing Professional module, select
Standard Comment Maintenance. The Standard Comment Maintenance
window appears.
iy Standard Comment Maintenance E W= 3

Comment Code | 506 OQ METWORK CONSULTING

Review of the netwark server and work stations for HIPAS compliance. d

[-|

@@ | Accept I LCancel ] Delete
[ Lw2 | 9/7/2005

Standard Comment Maintenance Window

2 Enter a three-character, alphanumeric code (0-9 or A-Z) to identify a new
comment in the Comment Code field.

+ Click the E] button to search for a comment that is already available in Time
and Billing Professional, so you can change the information.

+ Use the {4 (4 (& (3 buttons to access the desired information.

+ Click the button to create a new comment by copying the information from
an existing comment.

3 Enter a description to identify this standard comment code in the Description
field.
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4 Enter the comment in the Text field.

This field is a standard Sage MAS 90 or 200 text edit box so you may type as
much textual information as needed. The edit box will simply continue scrolling
lines as you type. Full Windows cut, paste, and edit capabilities apply within this
text box.

5 Click Accept to save the changes.
OR

Click Cancel to exit without saving.

Work Code Maintenance

The Work Code Maintenance window allows you to maintain work codes used to
identify each type of service, work, and reimbursable expense you want to track
for billing and reporting purposes. Work codes are sometimes referred to as
service codes.

The Work Code Maintenance window contains two tabs for different configuration
settings: the Main and the History tab.

Create the Work Code on the Main Tab

Use the Main tab of the Work Code Maintenance window to enter/maintain
information for a specific work code. The work code is assigned to a category code
on this tab along with entering other pertinent information, such as rate code and
rate method, billing rate, assignment of a comment code (if desired), taxes, and
posting information

1 From the Setup menu of the Time and Billing Professional module, select Work
Code Maintenance. The Work Code Maintenance window appears. .

ﬂj Work Code Maintenance [ 2] -1C]
“work Code HP& % Desc | HIPPa COMPLIANCE SURVEY

] zkeey |

Categary Code | MET |G NETWORK CONSULTING Billable

Rate Method | Employes Rate Code || Round Extended Amount |No v/
Fate Code 5 - Special r||  Subject to Commissian [
Biling Rate .0oo Dizable ‘Work Code

Fized Amount .an Tax Clas:
Markup Rate o0z NT Q:\ Nontzxable
Subject ko Exemption

Comment Code | 506 |G NETWORK. CONSULTING

Fost Methad Use Engagement Account ﬂ

G/L Account

@@ [ Accept _[ Lancel I Delete
| Lwz | a/7/2008

Work Code Maintenance Window - Main Tab
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2 Enter a three-character, alphanumeric code (0-9 or A-Z) to identify a new work
code in the Work Code field.

* Click the E] button to search for a work code that is already available in Time
and Billing Professional, so you can change the information.
+ Use the @4 (@) () () buttons to access the desired information.

=,

* Click the button to create a new work code by copying the information
from an existing work code.

3 Enter a description for the work code in the Desc(ription) field.

4 Enter the three-character category code for the work code in the Category
Code field.

+ Click the E] button to access a Lookup window and search for a specific
category code that is already available in Time and Billing Professional.

* Click the button to create a new category code by launching the Category
Maintenance window.

5 Select the billing rate for the work code from the Rate Method field. Options
include:

Work Code Rate

Employee Rate Code

Fixed Rate

Client Employee Rate Code

« If you select Work Code Rate or Client Employee Rate Code, the Billing Rate
field becomes available.

« If you select Employee Rate Code, the Rate Code field becomes available.

+ If you select Fix Rate, the Fixed Amount and Markup Rate fields become
available.

6 Select the rate for the employee from the Rate Code field.
This field is only available if Employee Rate Code is selected in the Rate
Method field. Select one of the billing rates created on the Time and Billing
Professional Options window (see page 80).

7 Enter the amount of a billing rate for a work code or employee in the Billing
Rate field. You can enter a rate with up to three decimals.
This field is available only if Work Code Rate or Client Employee Rate Code is
selected in the Rate Method field.

8 Enter the fixed expense amount (up to two decimals) in the Fixed Amount field.
This field is only available if Fixed Amount is selected in the Rate Method field.

9 Enter a markup percentage for fixed rates in the Markup Rate field. You may
enter a value with up to two decimal places.
This field is only available if Fixed Amount is selected in the Rate Method field.
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10Select or enter the comment to add to the work code in the Comment Code
field.

* Click the E] button to access a Lookup window and search for a specific work
code that is already available in Time and Billing Professional.

* Click the button to create a new comment by launching the Standard
Comment Maintenance window.

11Select how to round dollar amounts on the_Time/Expense Entry (see page 168)
and Edit Work in Process Entry (see page 231) windows from the Round
Extended Amount field.

» Select No for no rounding.

« Select $1 to round to the nearest dollar.

+ Select $10 to round to the nearest 10 dollar amount.

12Check Subject to Commission if the work code is subject to commission.

13Check Disable Work Code to mark a work code as disabled.
If a user selects a disabled work code in Time/Expense Entry (see page 168),
the user will be notified that the work code is unavailable, and the field will be
cleared.

14Select a tax class to assign to the work code from the Tax Class field. You can
select Taxable (TX) or Non-Taxable (NT) code.

15Check Subject to Exemption if the work code is subject to tax exemption.

16Select how to post the work code to the General Ledger from the Post Method
field.

» Selecting Work Code Account will activate the G/L Account field and allow
you to select the actual account to post the revenue from the work code.

+ If you select Engagement Account, the G/L revenue posting account will be
selected using the G/L Revenue Account field on the Billing tab of the Client
Maintenance window.

* The Post Method field is not available if the bill type for the work code is
non-billable, billable expense, or non-billable expense.

17Select the General Ledger account number used to post revenue or expenses
for the work code from the G/L Account field.

View the History of a Work Code on the History Tab

Use the History tab of the Work Code Maintenance window to view/maintain
historical information about a specific work code. Billable hours, billable amounts,
billed fees, and write ups/downs are tracked on this tab and accumulated for the
period, current year, and previous year.
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1 Click the History tab from the Work Code Maintenance window to access a
work code history.

ﬂ-ﬁ\'ﬂ)rk Code Maintenance K HiE
‘work Code BJE |Gy E] Desc |ADJUSTING EMTRIES
tun | ]
Current Period 05 Period to Date Year to Date Last rear
Billable: Hours 47.00 208.00 .o
Billable Amount 3.525.00 15,600.00 .00
Biled Fees 244549 1316918 .00
wiiite Upg/Downg 29.51- 1,008.82- oo
@@ [ Accept I Cancel I Delete
\ [ [rowz [ os7/z008

Work Code Maintenance Window - History Tab
You can change any of the information on this tab.

2 Enter the appropriate information in the Period to Date, Year to Date, and Last
Year fields.

a Change the number of Billable Hours posted to the work code.
This field is automatically updated by the information in the Time/Expense
Journal (see page 173), Edit Work In Process Selection Register (see page
228), and the Edit Work In Process Journal (see page 235) updates.

b Change the dollar value of the Billable Amount posted to the category code
for the work code. This field is automatically updated by the information in the
Time/Expense Journal (see page 173), Edit Work In Process Selection
Register (see page 228) , and the Edit Work In Process Journal (see page
235) updates.

This information is available only if the category code is set as Billable or
Billable Expense. (See the Create a Category Code section on page 97.)

c Change the fee or expense amount for Billed Fees for the work code. This
field is maintained automatically during the Billing Register (see page 219)
update.

d Enter the Write Ups/Downs between the fee or expense billed and the work
in process amount accumulated for the work code in the Period to Date, Year
to Date, and Last Year fields.

This field is maintained automatically during the Billing Register (see page
219) update.
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3 Click Accept to save the changes.
OR

Click Cancel to exit without saving.

Billing Format Maintenance

The Billing Format Maintenance window allows you to create and maintain up to
26 different billing formats for printing invoices. You may assign a specific billing
format code to each client/engagement. Seven default billing formats have been
provided, which you may use “As Is" or copy to create other customized formats.
For each billing format, you may select from predefined data fields, as well as any
free-form text, and specify where each field will be printed on your invoices.

The Billing Format Maintenance window contains two tabs for different
configuration settings: the Main and the Form tab.
Default Billing Format Codes

Format codes A through G are included when the Time and Billing Professional
module is installed. The default billing formats have been provided to allow you to
copy and modify them to meet the billing requirements of your company. The
following tables describe each default format.

Sample Work Code Format

The following table describes a sample work code format of a billing format.

Print Non-Billable Transactions No

Print Fees Format Detail by Work Code
Print Expenses Format Summary by Work code
Standard or Wide Format Standard

Number of Lines Per Page 00

Number of Lines for Invoice Body 30
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The following is a sample of the billing format described in the table.

[COMP_NAME\C]
[COMP_ADDI\C]
[COMP_ADD2\C]
[COMP_ADD3\C]
[COMP_ADD4\C]

[COMP_PHONE\CSP1]

[SUB_WRK_CODE\R] TOTAL: [SUBTOT WIP\-]
[END_FEES]
TOTAL FEES:  [TOT WIP_AMT\]

[START EXPNS]
[SUB_CAT DESC\B]
[SUB_CAT TEXT\B]
[SUB_WRK_DESC]
[

[SUBTOT _WUD\-]

[TOT_WUD_AMT\]

[CLNT _NAME] INVOICE NO.: [INV_NO]
[CLNT_ADDI] DATE: [INV_DATE\SDO1]
[CLNT_ADD2 CLIENT CODE: [CLNT _CD]
[CLNT_CITY\F],[CLNT_ST\][CLNT ZIP\2]

CONTACT: [CLNT_CONTACT] PAGE NO.: [PG_NO]
FOR PROFESSIONAL SERVICES RENDERED:
[START BODY]
[BILL_TEXT\LB]
WIP AMOUNT MARKDOWN BILL AMOUNT

[START FEES]

[SUB_CAT TEXT\B]

[SUB_WRK_DESC\B]

[LN_DATE] [30\F], [31\1] [LN_WIP_AMT] [WRITE_UP_DN] [BILL_ AMT\R]

[SUBTOT FEES\-BR]

[TOT FEES\-R]

[SUBTOT_EXPNS\LR]

END_EXPNS]
TOTAL EXPENSES: [55\-LR]
[END_BODY]
[START_TOT\2]
SALES TAX: [TAX_AMT\LR]
AMOUNT DUE: [INV_AMT\-=R]
[END_TOT\2]
PAYMENT DUE UPON RECEIPT
CURRENT OVER 30 OVER 60 OVER 90 OVER 120  BALANCE DUE
[CURRENT\S]  [AGED_I\S] [AGED_2\S] [AGED 3\S]  [AGED_4\S] [69\S]

FORMAT CODE A--Detail Bill by Date

The following table describes billing format code A.

Print Non-Billable Transactions

No

Print Fees Format

Detail by Date

Print Expenses Format

Detail by Date

Standard or Wide Format Standard
Number of Lines Per Page 00
Number of Lines for Invoice Body 30
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FORMAT CODE B--Detail Bill, No Detail Amounts

The following table describes billing format code B.

Print Non-Billable Transactions

No

Print Fees Format

Detail by Date

Print Expenses Format

Detail by Date

Standard or Wide Format Standard
Number of Lines Per Page 00
Number of Lines for Invoice Body 30

FORMAT CODE C--Summary Bill by Category

The following table describes billing format code C.

Print Non-Billable Transactions

No

Print Fees Format

Summary by Category

Print Expenses Format

Detail by Category

Standard or Wide Format Standard
Number of Lines Per Page 00
Number of Lines for Invoice Body 30

FORMAT CODE D--Summary Bill, One Total

The following table describes billing format code D.

Print Non-Billable Transactions No
Print Fees Format Total Only
Print Expenses Format Total Only
Standard or Wide Format Standard
Number of Lines Per Page 00
Number of Lines for Invoice Body 30
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FORMAT CODE E--Progress Bill by Date
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The following table describes billing format code E.

Print Non-Billable Transactions

No

Print Fees Format

Detail by Date

Print Expenses Format

Detail by Date

Standard or Wide Format Standard
Number of Lines Per Page 00
Number of Lines for Invoice Body 30

FORMAT CODE F--Detail Retainer Bill

The following table describes billing format code F.

Print Non-Billable Transactions

No

Print Fees Format

Detail by Date

Print Expenses Format

Detail by Date

Standard or Wide Format Standard
Number of Lines Per Page 00
Number of Lines for Invoice Body 28

FORMAT CODE G--Summary Retainer Bill

The following table describes billing format code G.

Print Non-Billable Transactions

No

Print Fees Format

Summary by Category

Print Expenses Format

Detail by Category

Standard or Wide Format Standard
Number of Lines Per Page 00
Number of Lines for Invoice Body 28
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Creating a Billing Format
An invoice consists of three major sections: Header, Body, and Totals.

» The Header section contains company and client address information, invoice
number, and date, and is typically printed only on the first page of the invoice.

» The Body section contains detailed fee and expense information as well as
comments. You can print the Body section over several pages depending on the
number of detail lines printed.

» The Totals section contains cumulative totals for the invoice and is normally
printed on the last page of the invoice.

The following steps outline the creation of a billing format:

A Enter the billing format code to be added or maintained. At this time, you specify
whether the standard or wide report format will be used; what the number of
lines per page and the number of lines for the invoice body will be; whether
non-billable transactions will be included on the invoice; and whether fees and
expenses will be sorted by date, sorted by work code, category, summarized, or
printed as totals.

B Customize the layout of the data items on the billing format. At this time, you
enter data items and markers on the billing format itself, edit existing text, type
literal text, and apply special formatting commands using the data format
options as needed.

C Prepare the billing format for printing. This process can take some time
depending upon the complexity of the billing format being generated.

During this process, you also may want to refer to the Billing Format Data ltems
Table (see page 117), the sample default billing formats (see page 103), and the
Billing Format Code Listing (see page 117) included in this chapter.

Once the billing format code has been generated, it can be used during Client
Maintenance (see page 144) or Billing Data Entry (see page 191) for each invoice
to be printed during Invoice Printing (see page 216).

Create the Billing Format on the Main Tab

Use the Main tab of the Billing Format Maintenance window to maintain options,
specific to a particular billing format.
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1 From the Setup menu of the Time and Billing Professional module, select
Billing Format Maintenance. The Billing Format Maintenance window appears.

Lﬁﬂilling Format Maintenance EH W= E3
Billing Format Code | & % Description | Detail Bill by Date
1. Main | 2 Form I
Print Mon-Billable Tranzactions D -w
Fees Format Detail by Date j
Expenzes Format | Detail by Date j
Standard or ‘Wide Format Standard ¥ =
Mumber of Lines per Page oo
Mumber of Lines for Invoice Body a0
@@ [ Accept l LCancel ] Delete
| [ [Lwz [ a/7/2005

Billing Format Maintenance Window - Main Tab

2 Enter a one-character, alphanumeric code (0-9 or A-Z) to identify a new billing
format code in the Billing Format Code field.

» Click the E] button to search for a format code that is already available in
Time and Billing Professional, so you can change the settings.

» Use the {4} ) (& (b buttons to access the desired information.
3 Enter a description for the billing format code in the Description field.

4 Check Print Non-Billable Transactions to allow non-billable transactions to
print on the billing format.

5 Select the format for printing fees from the Fees Format field. Options include:

Detail by Date

Detail by Category
Detail by Work Code
Summary by Category
Summary by Work Code
Totals

6 Select the format for printing expenses from the Expenses Format field.
Options include:

Detail by Date

Detail by Category
Detail by Work Code
Summary by Category
Summary by Work Code
Totals
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7 Select the report page format from the Standard or Wide Format field.
» Select Standard to print 78 characters per line

OR
+ Select Wide to print 128 characters per line.

8 Enter the number of lines for the invoice form in the Number of Lines Per Page
field. This number must be equal to or greater than the combined total of lines
for the invoice Header, Body, and Totals sections.

Enter 0 (zero) to perform an automatic form-feed at the end of each page.

|Z[NOTE: The printer must be configured properly to match the invoice form
in order to use the form-feed feature.

9 Enter the number of lines for the Body section of the invoice form in the Number
of Lines For Invoice Body field.

Enter 0 (zero) to use the Billing Format Markers to define the location of the
Body section on the invoice.

10Click the next tab to continue.

V¥ You can also perform the following actions:

* Click the button to create a new form by copying another form.

* Click the button to print a "test" invoice with asterisks printed in the
selected fields.
This feature allows you to view the changes to an invoice before committing the
changes.

* Click the button to remove any type of change made to a form. The
form is reset to the original default settings.
The Reset button is displayed only if you are using billing format codes A-G.

Change the Content of an Invoice Form on the Form Tab

The Form tab the of the Billing Format Maintenance window contains a view of the
invoice form and allows you to add fields of information to the form.
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1 Click the Form tab from the Billing Format Maintenance window to access a
view of the invoice form layout.

{5 Billing Format Maintenance EH M= B
Biling Format Code | A Qb Description | Detail Bill by D ate

1. Main | 2 Fom |

1FG_ND 7 TERMS_DESC 13 COMP_PHONE

21NV N & COMP_HAME 14 CLNT D

31NV DATE 3 COMP_ADD1 15 CLNT_NAME

PRI | 10 COME ADDZ 16 CLHT_ADD1

SINV_DISC_DATE || 11 COMP_ADDE 17 CLNT_ADDZ

& TERMS, [TDE 12 COMP_ADD# 18 CLNT_80D3

S =

1 1 4 4 3 3 4 4 5 5 & & 7 7

T R Sy (O U SO, [ S, [y (O S S, [ —
20| [END_EXPHE] B
21 TOTAL EXPENEES: [TOT_EXPNEY-L]
e
33| [END_EODY]
B4 [START_TOTVZ]
35 SALES TAX: [TAX_AMTWL]
el AMOUNT DUE: [INV_AMT:-]
37 DUE DATE: [INV_DUE_DATE]I
38 5
@[@]®]o) [ gecopt [ Corcel | Dec

I Lwz | a/7/2008

Billing Format Maintenance Window - Form Tab

The Form tab consists of two sections: the Data Item section and the Billing
Format Layout section.

* The top, Data Item section contains the data items which you can add to
invoices. There are over 100 data items to select from. Use the horizontal scroll
bar to view all the items.

» The bottom, Billing Format Layout section is used to create the billing format for
printing your invoices. Use the vertical and horizontal scroll bars in this section to
view the full invoice format.

2 Enter any changes to the form using the features available on the Form tab.
» Click the button to add a new blank line to the form.
OR
* Click the button to remove a line from the form.
A Add a data item to the form.

a Right-click the item you want to insert from one of the three Data Item
sections.

b Move your mouse to the desired location of insertion in the Billing Format
Layout section.

c Click your right mouse button and select Paste from the pop-up menu. The
item appears on the form.

Page 110 Time and Billing Professional Manual Chapter 6: Using the Setup Menu



Chapter 6

B Add special format commands (see page 128) to the form.

You can use special format commands with a selected data item to print the
data in a format different then the default format. The format commands are
specified by typing a backslash (\) followed by a format option.

C Add additional lines of text.

You can add additional information that is not enclosed in brackets to print on
the invoice as literal text. Insert the text in any location on the form.

D Change any information already available on the form.

You can type over or delete any information already listed on the form.

5 From the Main tab, click the button to print a "test" invoice with
asterisks printed in the selected fields. This feature allows you to view the

changes to an invoice before committing the changes.

6 Click Accept to save the changes. The following dialog appears.

{5 Sage MasS 90
P Do you wish ta prepare Biling Format 47
</

Sage MAS 90 Dialog

7 Click Yes to prepare the form.

Using Billing Format Markers

Use the Billing Format markers to designate where a specific section begins and
ends on the invoice form. In addition to the Header, Body, and Totals markers,
markers are available to designate the Fees and Expenses subsections within the
Body section of the invoice.

The marker fields only designate the positions for the sections and subsections
and do not print any data at the designated positions. When a marker is used, it is
important that no other markers, data items, or text be placed on the same line.

Use of the marker fields to designate sections and subsections is strictly optional.
However, only data items appropriate for Header and Totals sections are printed
outside marker sections. Data fields for fee or expense detail lines are printed in
the appropriate Fees or Expenses subsection within the Body section of the
invoice.

Each section or subsection is defined by two sets of markers.

» The beginning of a section or subsection is marked by the start marker.
For example, the beginning of the Header section is marked by [START_HEAD].

+ A corresponding end marker is used to define the end of a section or subsection.
The end of the Header is marked by [END_HEAD].
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|Z[NOTE: You must always specify both the start and end markers for a
section or subsection.

The following illustration displays the Body and Totals sections of a typical billing
format for an invoice that includes detail lines for fees and expenses:

FOR PROFESSIONAL SERVICES RENDERED:

[START BODY]
[START FEES]
[LN_DATE][LN_EXT COMM] [BILL_AMT]

[END FEES]
TOTAL FEES: [TOT_FEES]

[START EXPNS]

[LN_DATE] [WORK_CD DESC] [BILL_AMT]

[END EXPNS]
TOTAL EXPENSES: [TOT_EXPNS]
[END BODY]
[START TOT\1]
AMOUNT DUE: [INV_AMT]
[END TOT\]

Notice that the fees and expenses are within the [START_BODY] and
[END_BODY] markers. The total of all fees, [TOT_FEES], will print after the last
fee detail line is printed. Similarly, the total of all expenses, [TOT_EXPNS], will
print after all expense lines.

Header Markers

The Header section of the invoice is marked by the [START_HEAD] and
[END_HEAD] marker fields. Any text and data fields within these two markers will
only print on the first page of the invoice. If you want to print information such as
the client name or invoice number on each page of the invoice, do not use these
data items inside the Header section. No other sections can be defined within the
Header section.

Body Markers

The Body section of the invoice is marked by the [START_BODY] and
[END_BODY] marker fields. The position of these two markers designates the
area of the invoice form that will be used to print detailed information for fees and
expenses. You must define the Fees section and the Expenses section within the
Body section. Any totals for fees and expenses must be defined within the Body
section but outside the Fees and Expenses subsections.
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If you entered 0 (zero) in the Number of Lines for Invoice Body field for the form
to define where the invoice Body section begins and ends, the number of lines
between the [START_BODY] and [END_BODY] markers determines the number
of lines available for printing invoice detail information.

Fees Markers

The Fees subsection of the invoice is marked by the [START_FEES] and
[END_FEES] marker fields. The position of these two markers designates the
information that will be printed for each fee detail line on the invoice. The Fees
subsection must be within the Body section of the invoice. Only those data fields
designated as Detail Data ltems (see page 114) and Subtotal Data ltems (see
page 115) are included in this subsection.

The number of lines that will be printed for each detail line is based on how many
different lines you use to position the Detail Data Items within the Fees section.
The number of lines entered at the Number of Lines for Invoice Body field on
the header window must be divisible by the total number of lines between the
[START_FEES] and [END_FEES] marker fields. Extended comments will print as
many lines as are necessary to print the entire comment.

Expenses Markers

The Expenses subsection of the invoice is marked by the [START_EXPNS] and
[END_EXPNS] marker fields. The position of these two markers designates the
information that will be printed for each expense detail line on the invoice. The
Expense subsection must be within the Body section of the invoice. Only those
data fields designated as Detail Data ltems (see page 114) and Subtotal Data
Items (see page 115) will be included in this subsection.

The number of lines that will be printed for each detail line is based on how many
different lines you used to position the Detail Data ltems within the Expenses
section. Extended comments will print as many lines as are necessary to print the
entire comment.

Totals Markers

The Totals section of the invoice is marked by the [START_TOT\1] and
[END_TOT\1] marker fields. Any text and data fields within these two markers will
only print on the last page of the invoice. No other sections can be defined within
the Totals section.

Using the Billing Format Data Item Table

The Billing Format Data Item Table details the available data items you can select
to print on invoices. These data items are listed in the table in numeric order under
the following column headings: Item number, Group, Name, Description, Size,
Type, and Additional Information.
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* The Item number or name must be indicated on the billing format to select the
data item to be printed on the invoice.

« The Group indicates the section of the invoice where the data item will be
printed: Header, Detail, Subtotal, Header/Total, or Marker.

» The ltem Name must be indicated on the billing format to select the data item to
be printed on the invoice.

» The Description provides an explanation of the Item Name.

» The Size designates the number of characters each data item will print on the
invoice.

» The Type indicates whether a Detail or Subtotal data item can be printed in the
Fees Subsection (F) or the Expenses Subsection (E); some data items can be
printed in both subsections and are indicated by FE.

* The Additional Information column shows the source of the data item (for
example, field, window, option, file, calculation, or formula).

« Formulas may vary depending upon the client/engagement fee arrangement
and the data items selected.

» Exceptions are detailed in footnotes at the bottom of each page for quick
reference.

Data items are classified under five separate groups: Header, Detail, Subtotal,
Header/Total, and Marker.

Header Data Items

The Header data items consist of information from the company name and
address, client name and address, engagement information, and applicable
invoice information to be printed on each page of the invoice, or on the Header
section of the invoice.

The [BILL_TEXT] Header data item must be on a separate line, and its width
depends upon the setting in the Billing Text Display/Print Width field in Time and
Billing Professional Options (see page 80).

Detail Data Items

The Detail data items consist of information from the Work in Process Detail file
that can be printed within the Fees subsection, within the Expense subsection, or
within the Fees and Expenses subsections on the invoice. Detail data items
CANNQOT be printed in the Header or Total sections.

The [LN_EXT_COMM] detail data item prints the extended comment or the
30-character line comment if there is no extended comment. If there is a page
break in the middle of an extended comment and [BILL_TEXT] was used in the
Header section, the free-form text defined by [BILL_TEXT] will NOT be printed on
subsequent pages.
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Subtotal Data Items

The Subtotal data items can be specified within the Fees or Expenses subsection
of the invoice to print category code or work code information for fees and
expenses.

+ Subtotal data items must be placed before the [END_FEES] or [END_EXPNS]
marker items.

« If more than one subtotal numeric data item is used, they must be placed on the
same line.

Subtotal data items can only be printed if Detail by Category, Summary by
Category, Summary by Work Code, or Detail by Work Code is selected in the
Fees Format or Expenses Format field on the Main tab of the Billing Format
Maintenance window (see page 107).

The [SUB_CAT_TEXT] Subtotal data item is always printed once at the beginning
of each category grouping, regardless of its placement in the data item group.
Data items can be placed to the right or left of this data item, depending upon the
width entered in the Billing Text Display/Print Width field on the Time and Billing
Profession Options window (see page 80).

The [SUB_CAT_CODE] and [SUB_CAT_DESC] Subtotal data items print once per
category if Detail by Category, Summary by Category, Summary by Work
Code, or Detail by Work Code is selected in the Fees Format or Expenses
Format field on the Main tab of the Billing Format Maintenance window (see page
107).

* If these data items are placed on a line other than the line containing the subtotal
numeric data items, the category code and/or category description will be
printed at the beginning of the category group, regardless of its placement in the
data item group.

« If these data items are placed on the same line as the subtotal numeric fields,
the category code and category description will be printed on the same line as
the subtotal numeric fields.

The [SUB_WRK_CODE] and [SUB_WRK_DESC] subtotal data items print once
per work code if Detail by Work Code or Summary by Work Code is selected in
the Fees Format or Expenses Format field on the Main tab of the Billing Format
Maintenance window (see page 107).

+ If these data items are placed on a line other than the line containing the subtotal
numeric data items, the work code and/or work code description will be printed
at the beginning of the work code group, regardless of its placement in the data
item group.

+ If these data items are placed on the same line as the subtotal numeric fields,
the work code and work code description will be printed on the same line as the
subtotal numeric fields.
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Header/Total Data Items

The Header/Total data items consist of information from the Client/Engagement
Master file and appropriate invoice total information to be printed on each page of
the invoice, or in the Totals section of the invoice.

+ Total data items must be placed after the [END_FEES] and [END_EXPNS]
marker items.

 For clients/engagements with progress billing fee arrangements, the
[TAX_AMT], [INV_AMT], and [PROG_BALANCE] Header/Total data item value
will be zero except on the final bill. The [PROG_BILL_AMT] value will be zero on
the final bill.

» The [NET_INV_AMT] Header/Total data item does not apply to clients with
standard, fixed, or not to exceed fee arrangements.

+ The [CURRENT] Header/Total data item does not include other invoice amounts
currently being billed for bill separate clients.

» The [UNCOLL_RETAIN], [PTD_FIN_CHGS], [BALANCE_FWD], and
[CASH_RECEIVED] Header/Total data items must be placed outside the
[START_BODY] and [END_BODY] markers.

Marker Data Items

Use the Marker data items to designate where a specific section begins and ends
on the invoice form. When you use a Marker data item, you must define it on a line
which contains no other markers, data items, or text.

* No markers other than [START_HEAD] and [END_HEAD] can be defined within
the Header section of the invoice.

* The [START_FEES], [END_FEES], [START_EXPNS], and [END_EXPNS]
Marker data items must be within the Body section of the invoice.

* No markers other than [START_TOT] and [END_TOT] can be defined within the
Totals section of the invoice.
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The Billing Format Data Item Table details the available data items you can select

to print on invoices.

Description

Additional Information

Header

PG_NO

Page Number

System generated

Header

INV_NO

Invoice Number

Generated during
Invoice Printing;
Billing Data Entry
Invoice Number field

Header

INV_DATE

Invoice Date

Billing Data Entry
Main tab

Invoice Date field;
Invoice Printing
Invoice Date field

Header

INV_DUE_DATE

Due Date

Billing Data Entry
Main tab

Invoice Date field;
Invoice Printing
Invoice Date field

Header

INV_DISC_DATE

Discount Date

Billing Data Entry
Main tab

Invoice Date field;
Invoice Printing
Invoice Date field

Header

TERMS_CODE

Terms Code

Billing Data Entry

Header

TERMS_DESC

Terms Description

Billing Data Entry

Header

COMP_NAME

Company Name

35

Company
Maintenance
Company Name field

Header

COMP_ADD/1

Company Address
Line 1

35

Company
Maintenance
Address field

10

Header

COMP_ADD2

Company Address
Line 2

35

Company
Maintenance
Address field

1

Header

COMP_ADD3

Company Address
Line 3

35

Company
Maintenance
Address field

12

Header

COMP_ADD4

Company Address
Line 4

35

Company
Maintenance
Address field
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Description Additional Information
13 Header COMP_PHONE Company 10 - Company
Phone # Maintenance
Telephone field
14 Header CLNT_CD Client Code 7 - Client Maintenance
Client Code field
15 Header CLNT_NAME Client Name 30 - Client Maintenance
Name field
16 Header CLNT_ADD1 Client Address 30 - Client Maintenance
Line 1 Main tab
Address field
17 Header CLNT_ADD2 Client Address 30 - Client Maintenance
Line 2 Main tab
Address field
18 Header CLNT_ADD3 Client Address 30 - Client Maintenance
Line 3 Main tab
Address field
19 Header CLNT_CITY Client City 20 - Client Maintenance
Main tab
City field
20 Header CLNT_ST Client State 2 - Client Maintenance
Main tab
State field
21 Header CLNT_ZIP Client Zip Code 10 - Client Maintenance
Main tab
Zip Code field
22 Header CLNT_CNTRY Client Country 3 - Billing Format
Maintenance Form
Tab
Country field
23 Header CLNT_PHONE Client Phone 10 - Client Maintenance
Number Main tab
Telephone field
24 Header CLNT_EXT Client Next - Client Maintenance
Main tab
25 Header CLNT_FAX Client FAX/Telex 15 - Client Maintenance
Number Main tab
Fax field
26 Header CLNT_CONTACT Client Contact 30 - Client Maintenance
Main tab
Primary Contact field
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Additional Information

27 Header CLNT_CONTNAME Client Contact 10 Billing Format
Name Maintenance Form
Tab
Client Contact field
28 Header CLNT_COMM1 Client Comment 1 30 Client Maintenance
Main tab
Comment 1 field
29 Header CLNT_COMM2 Client Comment 2 30 Client Maintenance
Main tab
Comment 2 field
30 Header BILL_TO_CD Bill To Code
31 Header BILL_TO_NAME Bill To Name
32 Header BILL_TO_ADD1 Bill To Address
Line 1
33 Header BILL_TO_ADD2 Bill To Address
Line 2
34 Header BILL_TO_ADD3 Bill To Address
Line 3
35 Header BILL_TO_CITY Bill To City
36 Header BILL_TO_ST Bill To State
37 Header BILL_TO_ZIP Bill To Zip
38 Header BILL_TO_CNTRY Bill To Country
39 Header BT_CONTA_CODE Bill To Contact
Code
40 Header BT_CONT_NAME Bill To Contact
Name
41 Header SPRSN_CODE Salesperson Code
42 Header SPRSN_NAME Salesperson
Name
43 Header ENGMT_CD Engagement 4 Client Maintenance
Code Engagement Code
field
44 Header ENGMT_DESC Engagement 30 Client Maintenance
Description Description field
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Additional Information

45 Header ENGMT_COMM1 Engagement 30 - Client Maintenance
Comment 1 Billing tab
Comment 1 field
46 Header ENGMT_COMM2 Engagement 30 - Client Maintenance
Comment 2 Billing tab
Comment 2 field
47 Header SALES_TAX_SCHD Sales Tax 9 - Client Maintenance
Schedule Additional tab
Sales Tax Schedule
fields
48 Header TAX_SCHD_DESC Sales Tax 30 - Library Master
Schedule module Sales Tax
Description Schedule
Maintenance
49 Header BILL_TEXT1 Free Form Text 50-75 - Billing Data Entry Text
Editor
50 Header CONFIRM_TO Confirm To
51 Detail LN_NO Line Number 4 FE Billing Data Entry
Detail tab
Line field
52 Detail LN_DATE Transaction Date 6 FE Billing Data Entry
Detail tab
Date field
53 Detail EMPLY_CD Employee Code 4 FE Billing Data Entry
Detail tab
Emply field
54 Detail EMPLY_LNAME Employee Last 15 FE Employee
Name Maintenance
Last Name field
55 Detail EMPLY_FNAME Employee First 15 FE Employee
Name Maintenance
First field
56 Detail LN_ENGMT Line Engagement 4 FE Time/Expense Entry
Code Engagement field
57 Detail LN_ENGMT_DESC Line Engagement 30 FE Client Maintenance
Code Description Billing tab
58 Detail WORK_CD Work Code 3 FE Billing Data Entry
Detail window
W. C. field
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Description Additional Information
59 Detail WORK_CD_DESC Work Code 30 FE Work Code
Description Maintenance
Description field
60 Detail CATEG_CD Category Code 3 FE Work Code
Maintenance
Category Code field
61 Detail CATEG_DESC Category 30 FE Category
Description Maintenance
Description field
62 Detail LN_COMM Line Comment 30 FE Time/Expense Entry
(the first 30 Billing Data Entry
characters) A/P Invoice Data
Entry
Comment field
63 Detail LN_EXT_COMM3 Extended 50 FE Time/Expense Entry
Comment Billing Data Entry
(multiple lines) A/P Invoice Data
Entry
Detail tab
Extended Comment
field
64 Detail SUBJ_EXMPTN Subject to 1 FE Work Code
Exemption Maintenance
Subject to Exemption
field;
Time/Expense Entry
Subject to Exemption
field
65 Detail SUBJ_COMMSN Subject to
Commission
66 Detail REV/EXP_ACCT Revenue/ 12 FE Work Code
Expense G/L Maintenance
Account G/L Account field;
Time/Expense Entry
REV/EXP Account
field
67 Detail WRITE_UP_DN Write-Up/Write-Do 8.2 FE Billing Data Entry
wn Amount Detail tab
Write Up/Down field
68 Detail FEE_HRS Fee Hours 4.2 F Billing Data Entry
Detail tab
Hours/Units field
69 Detail EXP_UNTS Expense Units 4.2 E Billing Data Entry
Detail tab
Hours/Units field
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Description Additional Information
70 Detail RATE?2 Billing Rate 5.3 FE Work Code
Maintenance
Billing Rate field;
Time/Expense Entry
Rate field
7 Detail BILL_AMT Bill Amount 8.2 FE Billing Data Entry
Detail tab
Bill Amount field
72 Detail MARKUP_% Markup % 3.3 E Work Code
Maintenance
Markup Rate field
73 Subtotal | SUBTOT_HRS*5 Category Total for 5.2 F Calculation
Hours
74 | Subtotal | SUBTOT_FEES*® Category Total for 8.2 F Calculation
Fees
75 Subtotal | TOT_HRS Invoice Total for 5.2 F Calculation
Hours
76 Subtotal | TOT_FEES Invoice Total for 8.2 F Calculation
Fees
77 Subtotal SUBTOT_UNTS“'5 Category Total for 5.2 E Calculation
Expense Units
78 | Subtotal | SUBTOT EXPNS*5 | Category Total for 8.2 E Calculation
Expenses
79 Subtotal | TOT_UNTS Invoice Total for 5.2 E Calculation
Expense Units
80 Subtotal | TOT_EXPNS Invoice Total for 8.2 E Calculation
Expenses
81 Header/ TAX_AMT6 Sales Tax Amount 8.2 - Billing Data Entry
Total Main tab
Sales Tax field;
Billing Register
Sales Tax field
82 Header/ | TAXBL_AMT Taxable Amount 8.2 - Calculation
Total Total
83 Header/ | NON_TAXBL_AMT Non-Taxable 8.2 - Calculation
Total Amount Total
84 Header/ INV_AMT6 Invoice Amount 8.2 - Formula:
Total TOT_FEES+TOT_EX
PNS+TAX_AMT
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Description Additional Information
85 Header/ | NET_INV_AMT’ Net Invoice 8.2 Formula for Final
Total Amount Progress bills: INV_AMT
- PROG_BALANCE
Formula for Retainer
bills:
INV_AMT -
RET_APPLIED
86 Header CONT_TITL Continued Title 9 System-generated
87 Header/ | RET_APPLIED Retainer Applied 8.2 Billing Data Entry
Total Main tab
Retainer Applied field;
Billing Register
RET Applied field
88 Header/ PROG_BALANCE6 Progress Bill 8.2 Client Maintenance
Total Balance (Total of History tab
Progress Bill Progress Bill Balance
Amounts field
previously billed
and updated)
89 Header/ | CURRENT® Current AIR 8.2 Calculation
Total amount for the Open Invoice File
client added to the Invoice Transaction/
current invoice Payment History File
90 Header/ | AGED_1 Aging Bucket 1 8.2 Calculation
Total (that is, over 30 Open Invoice File
days) Invoice Transaction/
Payment History File
91 Header/ | AGED_2 Aging Bucket 2 8.2 Calculation
Total (that is, over 60 Open Invoice File
days) Invoice Transaction/
Payment History File
92 Header/ | AGED_3 Aging Bucket 3 8.2 Calculation
Total (that is, over 90 Open Invoice File
days) Invoice Transaction/
Payment History File
93 Header/ | AGED_4 Aging Bucket 4 8.2 Calculation
Total (that is, over 120 Open Invoice File
days) Invoice Transaction/
Payment History File
94 Header/ | CLNT_BALANCE Client Balance 8.2 Formula:
Total BALANCE_FWD-
CASH_RECEIVED+
PTD_FIN_CHGS+
NET_INV_AMT+
PROG_BILL_AMT
95 Header/ | INVC_MSSGH1 Invoice 6 Invoice Printing
Total Message 1 Message Line 1 field
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Additional Information

96 Header/ | INVC_MSSG2 Invoice 6 Invoice Printing
Total Message 2 Message Line 2 field
97 Detail BASE_AMT Base Expense 8.2 Time/Expense Entry
Amount for a Extended Amount
Billable Expense field;
Work Code with a A/P Invoice Data
Fixed Amount Entry
Rate Method Amount field
98 Marker START_HEAD? Start First Page of - -
Header Section
99 Marker END_HEAD9 End First Page of - -
Header Section
100 Marker START_BODY Start of Invoice - -
Body Section
101 Marker END_BODY End of Invoice - -
Body Section
102 Marker START_FEES10 Start of Fees - -
Section
103 | Marker | END_FEES'C End of Fees - -
Section
104 Marker START_EXPNS10 Start of Expenses - -
Section
105 | Marker | END_EXPNS'0 End of Expenses - -
Section
106 Marker START_TOT11 Start of Totals - -
Section
107 | Marker | END_TOT! End of Totals - -
Section
108 Header/ | RET_BALANCE Previous Retainer 8.2 Billing Selection
Total Balance Less Register
Retainer Applied Retainer Balance
field;
Billing Data Entry
Retainer Balance field
109 Header/ | RET_AMT_DUE Retainer Amount 8.2 Billing Data Entry
Total Due Retainer Amount Due
field;
Billing Register
RET Due field
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Additional Information

110 Header/ PROG_BILL_AMT12 Progress Bill 8.2 - Client Maintenance
Total Amount Billing tab
Progress Amount
field;
Billing Data Entry
Bill Amount field
111 | Header/ | UNCOLL_RETAIN'™ | Uncollected - - Client Maintenance
Total Retainer (total of Billing Data
retainers billed but Uncollected Retainer
not yet received) field;
Billing Data Entry
Uncollected Retainer
field
112 | Header/ | PTD_FIN_CHGS'3 Period To Date - - Calculation
Total Finance Charges Client Master file
113 | Header/ | BALANCE_FWD'3 Balance Forward - - Calculation
Total Invoice
Trans/Payment
History file
114 | Header/ | CASH_RECEIVED' | Cash Received - - Calculation
Total Invoice
Trans/Payment Hist.
file. The sum of all
payments and
prepayments that
have a transaction
date within the current
period.
115 | Subtotal | SUB_CAT _CODE™ Subtotal Category 3 FE Work Code
Code Maintenance
Category Code field
116 | Subtotal | SUB_CAT_DESC™ Subtotal Category 30 FE Category
Description Maintenance
Description field
117 Subtotal SUB_CAT_TEXT15 Subtotal Category 50-75 FE Billing Data Entry
Bill text Bill by Category tab
Billing Entry Text
Editor
118 Subtotal SUB_WRK_CODE16 Subtotal Work 3 FE Billing Data Entry
Code Detail tab
W.C. field
119 | Subtotal | SUB_WRK_DESC'® Subtotal Work 30 FE Work Code
Code Description Maintenance
Description field
120 Detail LN_WIP_AMT Work in Process 8.2 FE Billing Data Entry
Amount Detail tab
Bill Amount field
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Description Additional Information
121 Subtotal | SUBTOT_WIP® Subtotal WIP 8.2 FE Calculation
Amount
122 Subtotal SUBTOT_WUD5 Subtotal Net Write 8.2 FE Calculation
Up/Down Amount
123 Header/ | TOT_WIP_AMT Total WIP Amount 8.2 - Calculation
Total
124 Header/ | TOT_WUD_AMT Total Net Write 8.2 - Calculation
Total Up/Down Amount
125 Header USER_1 User-defined field 15 - Client Maintenance
1 Additional tab
Client Misc 1 field
126 | Header USER_2 User-defined field 15 - Client Maintenance
2 Additional tab
Client Misc 2 field
127 Header USER_3 User-defined field 15 - Client Maintenance
3 Additional tab
Client Misc 3 field
128 Header USER 4 User-defined field 15 - Client Maintenance
4 Additional tab
Client Misc 4 field
129 Header BILL_THRU_DAT Bill Thru Date 6 - Billing Data Entry
Bill Thru field
130 TAXCODE_1_DSC Tax Discount
131 TAXCODE_2_DSC Tax Discount
132 TAXCODE_3 DSC Tax Discount
133 TAXCODE_4_DSC Tax Discount
134 TAXCODE_1_AMT Tax Amount
135 TAXCODE_2_AMT Tax Amount
136 TAXCODE_3_AMT Tax Amount
137 TAXCODE_4 AMT Tax Amount
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1 This data item must be on a separate line, and its width depends upon your entry at the Billing Text Display/Print Width option
in Time and Billing Options.

2 Can only be used if using Detail by Date (D) Billing Format.

3 If there is a page break in the middle of an Extended Comment and [BILL_TEXT] was used in the Header section, the
free-form text defined by [BILL_TEXT] will not be printed on subsequent pages.

4 This data item may be printed only if you entered Detail by Category, Summary by Category, Detail by Work Code, or
Summary by Work Code at the Fees Format or Expenses Format field on the Billing Format Maintenance Main tab.

5 If more than one subtotal numeric data item is used, they must be placed on the same line.

6 For clients/engagements with Progress Billing fee arrangements, this data item value will be zero except on the Final Bill.
7 This data item does not apply to Standard, Fixed, or Not To Exceed fee arrangements.

8 This data item value does not include other invoice amounts currently being billed for Bill Separate clients.

9 No other markers can be defined within the Header section of the invoice.

10 This marker must be within the Body section of the invoice.

11 No other markers may be defined within the Totals section of the invoice.

12 For clients/engagements with Progress Billing fee arrangements, this data item value will be zero on the Final bill.

13 This data item must be placed outside the [START_BODY] and [END_BODY] markers.

14 The [SUB_CAT_CODE] and [SUB_CAT_DESC] Subtotal data items print once per category if you entered Detail by
Category, Summary by Category, Detail by Work Code, or Summary by Work Code at the Fees Format or Expenses Format
field on the Billing Format Maintenance Main tab. For additional information, refer to Data Item Groups.

15 The [SUB_CAT_TEXT] Subtotal data item is always printed once at the beginning of each category grouping regardless of
its placement in the category group. Data items can be placed to the right or left of this data item, providing the width entered at
the Billing Text Display/Print Width option in Time and Billing Options is taken into consideration.

16 The [SUB_WRK_CODE] and [SUB_WRK_DESC] Subtotal data items print once per Work Code if you entered Detail by
Work Code or Summary by Work Code at the Fees Format or Expenses Format field on the Billing Format Maintenance Main
tab. For additional information, refer to Data Item Groups.
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Use special format commands with the data item name to print the data in a format
different than the default format. Specify the format commands by typing a
backslash (\), followed by a format option. For example, you can type
[LN_DATE\D15] to print a date field in Date Format \D15 (that is, May 31, 2004), or
you can type [COMP_PHONE\P3] to print a telephone number field in Phone
Format \P3 (for example, 555-4444).

* Numeric Formats: Enter a mask specifying the number of digits to be
displayed, and the placement of commas and the decimal point. A pound sign
(#) is used to designate each digit to be printed. A minus sign (-) can be used to
designate where the minus sign is to be displayed. You can also use
parentheses in the mask to be printed for negative values. A dollar sign ($) can
also be specified. If you do not specify a mask for a numeric data type field, the
#H#HHE.00 format will be used for hours and the ##HH#H###HHE.00 format will be used
for amounts. The following table shows sample masks, the number retrieved
from the data file, and the printed result.

Mask Number Output
\HHE #HHE.00 1234.56 1,234.56
\HHE #HE.00- -1234.56 1,234.56-
\HHHEHHE 1234.56 1235
\(#EH# #14#.00) -1234.56 (1,234.56)
\$#Ht .00 1234.56 $1234.56

* Phone Formats: There are three different formats available for printing
telephone numbers. If no format option is specified, the first format (for example,

P1) will be used.

Format Option Format Mask Example

\P1 (FHHE) #itt HHEHE (555) 555-5555
\P2 Hith HHH A 555 555-5555
\P3 Hith HHHHE 555-5555
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+ Date Formats: You can format date fields by entering one of the following

established in the Terminal Preference option on the Library Master System

Preferences menu will be used. For additional information on Terminal
Preferences, refer to your Library Master Online Help.

Format Option Format Mask Example
\DO1 MM/DD/YY 05/31/04
\D02 MM-DD-YY 05-31-04
\D03 mmmDD/YY May31/04
\D04 mmmDD-YY May31-04
\D05 DD/MM/YY 31/05/04
\D06 DD-MM-YY 31-05-04
\DO7 DDmmm/YY 31May/04
\D08 DDmmm-YY 31May-04
\D09 MM/DD 05/31
\D10 MM-DD 05-31
\D11 mmmDD May31
\D12 DD/MM 31/05
\D13 DD-MM 31-05
\D14 DDmmm 31May
\D15 MMMMMM DD, YYYY MAY 31, 2004
\D16 DD MMMMMM YYYY 31 MAY 2004
\DD DD 31

\DM MM 05

\DY DY 04

\DML MMMMMM May

\DYL YYYY 2004
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+ Additional Data Item Formatting Options: By entering a data item name or
number followed by a backslash (\), you can enter other format options that
perform a variety of functions. You can specify the starting position of data by
entering a backslash, followed by a number from 1 through 9. That number
specifies the number of characters after the last printed text where you want to
begin printing the selected item. For example, data item [COMP_ADD1\5] will
print the first line of the company address five characters to the right of the last
printed text. Data item [9\2] will print the company telephone number two
characters to the right of the last printed text.

* Marker Options: A marker data item (for example, [START_BODY]) followed by
a backslash and a number indicates that data item values will begin printing the
specified number of lines below the previous section. For example, in an invoice
containing Body and Totals information, [START_TOT\2] will print the first Totals
line two lines below the last line printed (even if the last line is a blank line).

The following table indicates the available data format options:

Format Option Printed Result

\ followed by the number of | Prints data item values starting at the specified number of
lines lines below the previous section, if used with a marker
data item. For example, [START_TOT\2] on Billing
Format Code A prints totals starting on the second line
below the previous Body section.

\ followed by the number of | Prints the non-numeric, string data item value starting at a
positions specified single-digit number of positions to the right of
the previous data item value. For example,
[EMPY_LNAME\1] on Billing Format Code A prints the
employee’s last name starting at the second position to
the right of the employee’s first name, [EMPLY_FNAME].

\- Prints a dashed line above the data item value, the same
length as the data item value. This is typically used with
Header/Total Subtotal data items.

\= Prints a double-dashed line below the data item value,
and is the same length as the data item. This is typically
used with Header/Total and Subtotal data items.

\HHHE Defines a numeric mask.

\B followed by the number Prints the specified single-digit number of blank lines

of blank lines below the data item value. One blank line will be indicated
if no number is specified. If more than one \B format
option is used per line, then only the last \B format option
is used.
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Format Option Printed Result

\C Centers the data item value for the defined length of the
data item beginning at the position of the left bracket. This
option cannot be used with the [BILL_TEXT],
[LN_EXT_COMM], and [SUB_CAT_TEXT] data items.

\D14 Defines date mask number 14.

\F Floats or prints the following text immediately after this
data item value (used for adding punctuation). For
example, [CITY\F], on Billing Format Code A will print a
comma immediately after the city (for example, Irvine,
CA).

\L Suppresses printing of all information on the line if the
data item value is zero or blank. For example,
[TOT_FEES\-L] on Billing Format Code A will suppress
printing of any information on the line (including the words
TOTAL FEES:) if there are no fees. However, if fees do
exist, the words TOTAL FEES: followed by the data item
value will be printed.

\P2 Defines phone mask number 2.

\R Prints the data item value right-justified to the position of
the right bracket. This option cannot be used with the
[BILL_TEXT], [LN_EXT_COMM], and [SUB_CAT_TEXT]
data items.

\S Suppresses printing all information from the previous data
item value up to and including the current data item value
if the data item value is zero or blank. For example,
[AGED_1\S] on Billing Format Code A will suppress
printing of any information from the previous data item
value (for example, [CURRENT\S] to the current data
item value if there is no aging information for Aging
Category 1.

+ Combining Formatting Options: You can combine two or more format options
for a single data item. Enter the data item name or number followed by a
backslash (\), followed by one or more formatting codes. For example, enter
[COMP_PHONE\3P2] to print the company phone number three characters to
the right of the previous data item value using phone number mask P2. You can
specify the format options in any order except for the date and numeric mask
format options. If the date or numeric mask format option is used, it must be
specified last.
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Possible Errors

When adding fields and formats to a billing format, the following errors can occur if
you enter data incorrectly.

* Invalid Field Name: The field name specified inside the brackets is not a valid
data field or marker name.

* Invalid Field Number: The field number specified inside the brackets is not a
valid data field number.

* Outside of START_BODY: A marker field that must be between
[START_BODY] and [END_BODY] (for example, [START_FEES],
[START_EXPNS]) was found outside the proper markers.

* Found Without a START: An end marker field was found without a
corresponding start marker (for example, [END_FEES] was found without a
[START_FEES]).

* Found Without an END: A start marker field was found without a corresponding
end marker (for example, [START_FEES] was found without an [END_FEES]).

 Inside Another Block: A marker field that cannot be inside another block (for
example, [START_HEAD], [START_TOT]) was found inside a block.

+ Invalid Number of Brackets: An extra bracket was found without a matching
bracket.

* Occurs More Than Once: A marker field was defined more than once. Marker
fields can be specified only once on a form.

Time and Billing Professional Utilities
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The Time and Billing Professional Utilities window contains special features that
allow you to change certain fields for a large number of clients/engagements or
employees. You can change a code or other value listed in a particular field to
another code or value throughout the Time and Billing Professional module.

» From the Setup menu of the Time and Billing Professional module, select Time
and Billing Pro Utilities. The Time and Billing Professional Utilities window
appears

{5 Time and Billing Professional Utilities E W= 3

Ultilitiess tlerur
) iRlebal Slient Fizld Changel
() Global Emplovee Rate Change

(7} Engagement Code Length Change
(O Engagement Code Renumber

[ Lw2 | 9/7/2005

Time and Billing Professional Utilities Window
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The Time and Billing Professional Utilities feature includes the following options:

» Global Client Field Change (see page 133)

» Global Employee Rate Change (see page 135)

* Engagement Code Length Change (see page 137)

* Engagement Code Renumber (see page 137)

Complete a Global Client Field Change

The Global Client Field Change utility enables you to change specified client fields
for a large number of clients/engagements. This feature is especially useful for
reassigning a group of clients to a different partner or employee.

1 Select Global Client Field Change from the Time and Billing Professional
Utilities window, and click Proceed. The Global Client Field Change window
appears.

(i Global Client Field Change K W= B3
Field Al From To Field Al From To
Clent Partrer [ [m30 |@, (0150 [€ || Biling Format O &, Q,
Cliernt Employes D C% C% Bill Freguency D
Engagement Partner D % % Bill Separate D
Engagement Employee D C% C%

Figld Al From To
Revenue Account [ % %
Bil Rate Code [ = =
Selection All - Starting Ending
Client Code @, $977Z77 |G
Engagement Code i T 7T 7T T |
Client Types All
[ [ [Lwz [ a/7/2005

Global Client Field Change Window

2 Select the field information to change in the Field sections of the Global Client
Field Change window.

a Select the information to change in the From field
AND

b Select the new information in the To field.
OR

c Check All to change all the data in a field to the new information.

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field
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The following table lists the fields you can change.

Field Description

Client Partner

Change one employee to another employee in the Client
Partner fields.

Client Employee

Change one employee to another employee in the Client
Employee fields.

Engagement Partner

Change one employee to another employee in the
Engagement Partner fields.

Engagement Employee

Change one employee to another employee in the
Engagement Employee fields.

Billing Format

Change one billing format code to another billing format
code in the Billing Format fields.

Bill Frequency

Change one bill frequency amount to another in the Bill
Frequency fields.

Bill Separate

Change one bill separate amount to another in the Bill
Separate fields.

Revenue Account

Change one General Ledger to another in the Revenue
fields.

Bill Rate Code

Change one bill rate to another in the Bill Rate Code
fields.

3 Select the field information to change in the Selection section of the Global
Client Field Change window.

a Select the client codes to change the field information for in the Client Code

field.

» Check All to change the information in all client codes.

OR

» Enter the client codes to change in the Starting and Ending fields.

b Select the engagement codes to change the field information for in the
Engagement Code field.

» Check All to change the information in all engagement codes.

OR

» Enter the engagement codes to change in the Starting and Ending fields.
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¢ Enter the client types to change the field information for in the Client Type
field.

The default value of All means all client types will be changed. You may enter
up to four alphanumeric characters for each client type you enter. Leave a
space between each client type.

4 Click Proceed to change the information in Time and Billing Professional.
Complete a Global Employee Rate Change

The Global Employee Rate Change feature allows you to change the employee
cost per hour or billing rate for a large group of employees. The previous cost per
hour or billing rate may be increased or decreased by a specified percentage or
dollar amount, or changed to a fixed rate.

1 Select Global Employee Rate Change from the Time and Billing Professional
Utilities window, and click Proceed. The Global Employee Rate Change window
appears.

Eﬁﬁlohal Employee Rate Change |- x]
Field Type Change By Round?
Cost per Hour Markup Amount Al 190.000 | []

Gen Acct Svo Markup Amount Al ooo | [
Mngmt Advisomy arkup Amaunt hdl .ooo ]
Audit Services Markup Amount hdl .00o ]
Phone Support Markup Amount Al ooo | [
Miscellaneous Markup Amount hdl .00o ]
Special Markup Amourk hdl om0
Financial Pin Markup Amount Al ooo | [
Tax Ret-Corp Markup Amount = ooo | [
Tax Ret-Prishp Markup Amount = o0 | [
Tax RetIndiv Markup Amaount j .0oa D
Selection Al Starting Ending

Employes Code % ZZ7 %

Office Code Q, = |,

Employes Level 0-Managing Patner = || | 0 - Managing Partner =

\ [ [owz [ as7/z008

Global Employee Rate Change Window

2 Select the type of markup from the Type field for each billing rate you want to
change. You can select:

* Markup Amount - To markup the billing rate by a specific amount
» Markup Percent - To markup the rate by a specific percent
» Fixed Amount Change - To change the employee billing rate to a fixed amount

3 Enter the percentage or amount of change for the billing rate in the Change By
field. You can enter dollar amounts up to three decimal places.

4 Check Round? to calculate the new rate rounded to the nearest whole dollar
amount.
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The following table lists the fields you can change.

Field Description

Cost per Hour

Change the employee cost per hour in this field.

Gen Acct Svc

Change the billing rate for general ledger account
services in this field.

Mngmt Advisory

Change the billing rate for management advisory services
in this field.

Audit Services

Change the billing rate for the audit services in this field.

Phone Support

Change the billing rate for phone support service in this
field.

Miscellaneous

Change the billing rate for miscellaneous services.

Special

Change the billing rate for special services.

Financial PIn

Change the billing rate for financial plan services.

Tax Ret-Corp

Change the billing rate for corporate tax return services.

Tax Ret-Prtshp

Change the billing rate for partnership tax return services

Tax Ret-Indiv

Change the billing rate for individual tax return services.

5 Select the employees for whom to change the rates in the Employee Code

field.

» Check All to change the rates for all employees.

OR

» Enter the employee codes to change in the Starting and Ending fields.

6 Select the offices for which to change the employee rates in the Office Code

field.

» Check All to change the rates for all offices.

OR

» Enter the office codes to change in the Starting and Ending fields.

the field.

I:Jj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in

7 Select the employee levels for which to change the employee rates in the
Employee Level Starting and Ending fields.

8 Click Proceed to change the information in Time and Billing Professional.
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Change the Engagement Code Length

The Engagement Code Length Change feature allows you to change the length of
engagement codes.

1 Select Engagement Code Length Change from the Time and Billing
Professional Utilities window, and click Proceed. The Engagement Code Length
Change window appears.

gﬁEngagement Code Length Change HE

Fram Tao

Engagement Code Length 20 15

Cancel

Engagement Code Length Change Window

2 Enter the new code length in the To field. This number can be 4 to 20
characters.

3 Click Proceed. The system changes the length of the engagement code.
Change an Engagement Code

The Engagement Code Renumber feature allows you to change an engagement
code’s number globally throughout Time and Billing Professional.

1 Select Engagement Code Renumber from the Time and Billing Professional
Utilities window, and click Proceed. The Engagement Code Renumber window

appears.
(i Engagement Code Renumber K W= B3
Client Cade 01-ABLEMAN % ABLE MANUFACTURING

0ld Engagement Code (00000000000000000000 % PROFESSIONAL SERVICES
MNew Engagement Code 0000000000000000001 2

Client Code Old Engagement Code New Engagement Code

0L-AELEMAN 00000000000000000000 000000000000000000LZ

[ Lw2 | 9/7/2005

Engagement Code Renumber Window

2 Select the client code for the engagement code you want to change from the
Client Code field.

3 Select the engagement code you want to change from the Old Engagement
Code field.

4 Enter the new code in the New Engagement Code field.
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5 If you entered the erroneous code, click the button, and repeat steps 2
through 4.

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

6 Click OK. The client code, old engagement code, and new engagement code
appear in the list.

7 To remove an item from the list, highlight the respective line and click the
button.

8 To remove all items from the list, click the button.

9 Click Proceed. The system changes the engagement code throughout Time and
Billing Professional.

Memo Manager Maintenance

The Memo Manager Maintenance feature has been designed by Sage Software
starting with version 4.10 of Sage MAS 90 and Sage MAS 200. Use the Memo
Manager Maintenance window to view, maintain, and manage memos in Time and
Billing Professional. In Memo Manager Maintenance, you can define where
memos can be displayed or maintained within Time and Billing Professional. You
can also specify a default setting for the automatic display of memos when
accessing certain tasks. Multiple types of memos can be defined.

Configure Memo Maintenance in Time and Billing Professional

1 From the Setup menu of the Time and Billing Professional module, select Memo
Manager Maintenance. The Memo Manager Maintenance window appears.

Ej Memo Manager Maintenance {(LW2)9/7/2005

Module Tirne: and Billing Professional Tl wo®®
-

Memo Type | Customer =
Role ddministrator | Sl Administrator
Task | tMemo Options | Auta Display | ?g
1 Cash Receipts Entry Maintain j O
2 | Biling Data Enty aintain j O
2 | Client Inquiry M aintain j O
4 | Client Maintenance Maintain j g
5 | A/P Invoice Data Entry Maintain j O
i AP Manual Check Entry Maintain j O

Memo Manager Maintenance Window

2 Select the type of memo to configure from the drop-down list in the Memo Type
field.
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3 Select the role for the memo type and module you want to maintain from the
Role field.

Depending on the security permissions set up for the role, the Memo Options
field displays the permission allowed for maintaining memos. Once you select a
role, the Tasks field displays the module’s tasks available for the selected memo

type.

4 Select the memo option allowing or restricting actions that can be performed on
the memo from the Memo Options field. The memo option initially displayed is
based on the least restrictive option allowed after comparing any role security
permissions for this task. The following table describes each option.

Option Description

Show Allows you to display memos for the selected task.
Memos cannot be edited or deleted.

Hide Allows you to hide the memo button in the selected task
window, however, auto-display memos can still be
optionally processed.

Maintain Allows you to add, modify, or delete memos for the
selected task.

5 Check Auto Display to allow memos to automatically display when the window
(or task) is accessed.

6 Click Accept to save the changes.
OR
Click Cancel to exit without saving.
Copy the Memo Maintenance from One Employee Role to Another

Use the Copy button to copy the memo settings from one role to another.

1 From the Memo Manager Maintenance window, select the type of memo to
configure from the drop-down list in the Memo Type field.

2 Select the role for the memo type and module you want to copy from the Role
field.

3 Click the button to copy the current role’s memo rights to another role.
The Copy Memo Manager Role Setting window appears.
gﬁtopy Memo Manager Role Settings HE

Module Time and Biling Professional
Memo Type | Customer

Role Administrator | Administratar

Copy Settings to Role | DEFAULT % }

Copy Memo Manager Role Setting Window
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4 Select the role to copy the same memo access to from the Lookup available in
the Copy Settings to Role field.

5 Click Proceed to copy the data.

6 Click Accept on the Memo Manager Maintenance window to save the changes.
Purge Memos from Specific User Roles in Time and Billing Professional

Use the Purge button to purge memos. You can filter memos to be purged by
expiration date, memo date, reminder start/end date, and memo code.

1 From the Memo Manager Maintenance window, select the type of memo to
purge from the drop-down list in the Memo Type field.

2 Select the role that you want to purge the memo types from in the Role field.

3 Click the button. The Purge Memos window appears.

{if Purge Memos [ 7]

Module Time and Biling Professional

Memo Type Customer

Select Field Operand ‘ Walue

Expiration Date Begins with j 02/15/98
Mermo Date Al
Reminder Start Date Al
Reminder End Date &l
Mema Code Al

[ [

LCancel

Purge Memos Window

The Purge Memos window allows you to select exactly which memos to purge.
You can purge the memos based on memo Expiration Date, Memo Date,
Reminder Start Date, Reminder End Date, and Memo Code.

4 Select the operand equation to use to limit the memos to purge from the
Operand field.

For example, you can limit the purge to not include any memos that have an
expiration date beginning with August 29, 2005. You would select the Begins
With operand for the Expiration Date option.

The following table describes each option.

Operand Description

Begins With Returns any record whose field value begins with the filter
value specified on this row.

Ends With Returns any record whose field value ends with the filter
value specified on this row.

Contains Returns any record whose field value contains the filter
value specified on this row.
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Operand Description

Less Than Returns any record where the field value is less than the
filter value specified on this row. Specifically, fieldValue <
filterValue.

Greater Than Returns any record where the field value is greater than

the filter value specified on this row. Specifically,
fieldValue > filterValue.

Range Returns any record where the field value is in between the
specified filter value. To enter the filter value, separate two
values by a comma. Specifically: filterValue1 < fieldValue
AND fieldValue > filterValue2.

Equal To Returns any record where the field value exactly equals
the filter value.

All For display in filter preview only, has no effect on filter
results.

5 Enter the exact date or specific data in the Value field.

6 Click Proceed to purge the data. The following warning appears.
[fiSage MAS 90

2

Memos have been zelected to purge. Do pou want bo proceed?

No

Sage MAS 90 Dialog

7 Click Yes to purge the memos.

8 Click Accept on the Memo Manager Maintenance window to save the changes.

This concludes Chapter 6: Using the Setup Menu of the Time and Billing
Professional manual.
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Using the Main Menu

Chapter 7: Using the Main Menu teaches managers how to setup clients, how to
enter time and expenses, and how to update the Sage MAS 90 or 200 system with
employee time spent on engagements.

How to Use the Main Menu

The Main menu contains the options used to create your Client Master file, enter
time and expense transactions, process cash receipts and write-offs, and print the
necessary audit reports. This chapter does not describe every procedure that can
be completed on a Main window. For example, this chapter does not include
detailed instructions on how to print or change information from certain windows
available in the Main menu. Detailed instructions about changing, deleting, and
printing information from the Main windows are available in the online help. The
following instructions provide a quick overview of how to complete these
procedures.

Open a Window from the Main Menu

1 Double-click the Time and Billing Professional module from the Modules tab.
The module expands to display all the menu options available in the Time and
Billing Professional module.

2 Click the Main menu. The names of the windows available in the menu appear
on the right side of the Sage MAS 90 or 200 window.

Time and Biling Professional - Main I
Up one level...

Elclient Maintenance

Elclient tnauiry

ElBilling History Inguiry

EXTime Expense Entry

[E=] TimeExpense Journal

Da\ly Transaction Register

Windows Available in the Main Menu

3 Double-click the name of the window to open. The system displays the selected
window.

Select Items from a Lookup List

Many fields in the Main menu feature a Lookup list. These lists allow you to select
data for the field.

* Click the E] button (or the alternate button) in the appropriate field to select

an item from a Lookup window. Selecting from a sortable list places the item you
selected in the field.
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Change a Record

1 Click the E] button in the first field to select a record account from a Lookup
window (or use the (i) (@ (& (s buttons to access the desired information). The
system displays the record’s information on the window.

2 Review and edit the options your company requires in the fields available on the
window. (See the respective section in this chapter for detailed information about
each option you can set.)

3 Click Accept to save the changes.
Delete a Record

1 Click the E] button in the first field to select a record account from the Lookup
window. The system displays the record’s information on the window.

2 Click Delete. The system displays a warning dialog box similar to the following.

i Sage MAS 90 [ %]
' Delste Client 01ZZZFIRM?
e

Sage MAS 90 Warning Dialog

3 Click Yes. The record is deleted.

4 Click Accept on the main window to save the changes.
Print from a Window

You can print information from many of the windows available in the Main menu.
These windows provide a listing of the options set or the records available. For
many of the windows you can select the type of information to include in the listing.
For detailed information about each type of listing, see the online help.

1 Click the button on the window. A Listing window similar to the following
appears.

i Client Listing [ 2] _ [T x]
Sart Dptions Client Cade j
Repart Type ta Print Complete Client File with Balance Data = L] Prirt Custom Biling Fiates
Clients ta Print Clients Only j |:| Print Schedule/Budget Information
[] Frint Memos
Selectian All Starting Ending
Cliert Code ao- G, flirrrrrrdlis N
Engagement Cade prrrrrrrrr sy
Ll
L
Ll
L
Ll
L
Canon Sales [ Print l Freview I Printer Sefup.. I ®
[ Lw2 | 8/7/2005

Client Listing Window
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2 Select how to sort the list from the Sort Options field.

3 Select the type of information to include in the report from the remaining fields
on the Listing window. For many fields, you can select all records or a range of
information.

For example, in the previous picture you can check All to print all clients, or you
can use the Lookup windows in the Starting and Ending fields and select
specific clients. If there is a date field available on a Listing window and you want
to print information for a particular date, enter the same date in the Starting and
Ending fields.

4 Click the Print button to print the list, or the Preview button to print preview the
list.

Client Maintenance

Page 144

The Client Maintenance window allows you to create and maintain a file containing
detailed information for each of your clients. You may also maintain information for
engagements for a client, if applicable. The Client Maintenance window provides
options to maintain address and other client data, billing data, custom billing rates,
and budget scheduling information. You may also display billing history, aged and
open invoices, and work in process information. Starting with version 4.20 of Sage
MAS 90 and Sage MAS 200, you can limit invoices to current engagements (see
page 161).

The Client Maintenance window contains six tabs for different configuration
settings: the Client, the Engagement, the Billing, the History, the Invoices, and the
WIP tab.

P Select Client Maintenance from the Main menu of the Time and Billing
Professional module to access this feature. The T/2 Client Maintenance window
appears.

Copy Engagements from One Client to Another

You can copy engagements from one client to another, when the engagements are
very similar. .

|Z[NOTE: You must use this feature BEFORE selecting a client from the
Client Code field on the Client Maintenance window.
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5 T/2 Client Maintenance

Client Code | % Name| |
Engagement Code | | Copy Engagements |Descmpt\on | |
1. Client ] 2. Engagement 1 3. Billing ] 4 History ] 5. Invoices 1 B WIP ]
Address Referred By l:l
| |
Primary Enntactl:l
ZIP Code
City State I:l | |
Bt —| Clnt Partner l:l
Telephane | Ext | | Clnt Emply l:l
Fax
st [ ] ity L ]
Comment1 | ||| aarEnd ]
Commert 2| ||| newsiter ]
Lloje/e)
Enter Client Code HTI | Lw2 | 8A8/2007

T/2 Client Maintenance Window

1 Click the button to copy a client engagement. The Copy Engagements
window appears.

ﬂﬂl-tupy Engagement{s} [ 7]
To Client Code O1-ABLEMAN | ABLE MAMUFACTURING

Starting Engagement Code 00000000000000000000 %
Ending Engagement Code 00000000000000000000 %

‘ Copy Custorn R ate Information

Copy Schedule/Budget Information

From Client Codz O7-MASTMIC % MASTER MICRO MAMUFACTURING

.Erucead o

I Lw2 | 9/7/2008
Copy Engagement(s) Window

I:b HINT: Click the @ button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

2 Select the client that will have the new engagement from the To Client Code
field.

3 Select the client that has the engagement that will be copied from the From
Client Code field.

4 Select the first engagement to copy in the Starting Engagement Code field.

5 Select the last engagement to copy in the Ending Engagement Code field.
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Map button available
in the Address field
to access
www.mapquest.com
and view the location
map or find the
directions.
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I:gj HINT: You can copy several engagements by entering a range of numbers
in the Starting Engagement Code and the Ending Engagement Code field.

To copy only one engagement, select the same number in both fields.

6 Check Copy Custom Rate Information to copy any custom rates configured for
the engagement to the new engagement.

7 Check Copy Schedule/Budget Information to copy any schedules or budgets
configured for the engagement to the new engagement.

8 Click Proceed to copy the engagement.
Review and Enter Basic Data about a Client on the Client Tab

The Client tab of the T/2 Client Maintenance window stores general information
on the specified client.

[& T/2 Client Maintenance Q‘El@l
Client Code 01-4BLEMAN |y Name | ABLE MANUFACTURING

Engagement Code 00000000000000000000 % Description | [SE{E1E%5

1. Client 1 2. Engagement ] 2. Billing ] 4. Histary 5. Invoices ] E. WP ]
Address 9445 HIGHLAND AVE Refered By MARTIM ABL %
Primaty Contact|MARTIN ABL @, [ ]
ZIP Code: 92718 .
MARTIMN ABLE
City IRVINE State |Ca
Courtry Clrit Partner 720 |G B.A WINNUR
Telephone | [714) 5554650 Ext |80S0 | CiwtEmply 0250 |, JOSEPH WILSON
Fax 714-555-9130
Sort ABLE Industiy MAMUFACTURING
Acct Soft? Ny
Commertt 1 ‘ear End 123
Comment 2 Mewvssletter N
Eelks Ceeon[_iea [_boee
Enter Engagement Description HTI L2 8/16/2007

T/2 Client Maintenance Window - Client Tab

1 Enter or select a client in the Client Code field.

* Click the button to enable a client from a list of all Sage MAS 90 or 200
clients available.

+ Click the E] button to search for a client that is already enabled in Time and
Billing Professional, so you can change the settings.

« Click the [F]] button to create a new client by launching the Accounts
Receivable Customer Maintenance window.
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2 Enter or select a client engagement in the Engagement Code field.

* Click the E] button to search for an existing client engagement, or create a
new client engagement by entering a new engagement code.

See the Set Up Client/Engagements on the Engagement Tab section (see
page 148) for creating a new engagement.

3 Enter a description for the client engagement in the Description field.

|Z[NOTE: Many of the fields on the Client tab are view-only. These are
maintained in Accounts Receivable Customer Maintenance. See the Accounts
Receivable Manual or Online Help by Sage Software for more information

4 Enter any comments to print on an invoice for a client in the Comment 1 or
Comment 2 fields. You may enter up to 30 alphanumeric characters per
comment.

5 Enter or select the name of the person or company that referred the current
client in the Referred By field.

» Enter a backslash (/) and enter a client code
+ Click the E] button to select the client code from the Lookup.
* You can also just type the name of a person as the referral.
6 Enter or select a primary contact for the client in the Primary Contact field.

* Click the E] button to search for a contact that is already enabled in Time and
Billing Professional.

* Click the button to create a new contact by launching the Accounts
Receivable Customer Contact Maintenance window.

7 Enter or select an employee partner responsible for the client in the Client
Partner field.

+ Click the E] button to search for an employee partner that is already enabled
in Time and Billing Professional.

* Click the button to create a new employee partner by launching the
Employee Maintenance window (see page 92).

8 Enter or select an employee responsible for the client in the Client Employee
field.

* Click the E] button to search for an employee that is already enabled in Time
and Billing Professional.

+ Click the button to create a new employee by launching the Employee
Maintenance window (see page 92).

Chapter 7: Using the Main Menu Time and Billing Professional Manual Page 147



Page 148

Chapter 7

9 Enter data in any user-defined fields on the Client tab. The Client tab will include
up to four fields defined by your company on the Terminology tab of the Time_
and Billing Professional Options window (see page 88).

10Click the next tab to continue.
Set Up Client/Engagements on the Engagement Tab

The Engagement tab of the Client Maintenance window allows you to create and
maintain engagements for clients.

1 Click the Engagement tab to access the engagement information.

{5 T/2 Client Maintenance

Client Code

Engagement Cods

1. Client

Date Opened

Start Date
Completion Date
Budget Hours
Budget Rate
Budget Amt

Engrat Partner

01-4BLEMAN |Gy

00000000000000000000 % Description | PROFESSIONAL SERVICES

l

3 Billing

0140171997
Projected Actusl
01/01/1997 011571997

55.00
1205.450
EE.299.75

o120 |G B4 WINNUR

I

Name | ABLE MANLFACTURING

4 History 1 5. Invoices ] . wiP ]

[ Contacts _[ Schedule ... _[ Memos...]

Copy From..

Status Open bl

Comment 1

Comment 2

Engrit E mply 0250 |y JOSEFH wIL5ON

Engrit Contact MARTIN ABL % MARTIN ABLE

Lolo/e)

[ Accept I LCancel I Delete

HTI | Lw2 | 8162007

T/2 Client Maintenance Window - Engagement Tab

2 Enter the date when this client/engagement was originally created in the Date
Opened field.

3 Enter the date when this client/engagement is projected to be started in the
Projected Start Date field.

4 Enter the date when this client/engagement was actually started in the Actual
Start Date field.

5 Enter the date when this client/engagement is projected to be completed in the
Projected Completion Date field.

6 Enter the date when this client/engagement was actually completed in the
Actual Completion Date field.

7 Enter the total hours budgeted for the client/engagement in the Budget Hours
field. This field will automatically update with the amount of budgeted hours
created in the budget schedule (see page 150).

8 Enter the budget rate used to calculate the budget amount based on the
budgeted number of hours in the Budget Rate field.
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9 Enter the total revenue budgeted for the client/engagement in the Budget
Amount field. This field will automatically update with the amount of budgeted
dollars entered in the budget schedule (see page 150).

10Enter or select an employee partner responsible for the client/engagement in
the Engmt Partner field.

* Click the E] button to search for an employee partner that is already enabled
in Time and Billing Professional.

* Click the button to create a new employee partner by launching the
Employee Maintenance window (see page 92).

11Enter or select an employee responsible for the client/engagement in the
Engmt Emply field.

* Click the E] button to search for an employee that is already enabled in Time
and Billing Professional.

* Click the button to create a new employee by launching the Employee
Maintenance window (see page 92).

12Enter or select a contact for the client/engagement in the Engmt Contact field.

* Click the E] button to search for a contact that is already enabled in Time and
Billing Professional.

» Create a new contact by entering a new code. A dialog box will appear
allowing you to create a new contact by clicking Yes and launching the
Accounts Receivable Customer Contact Maintenance window.

ts Receivable Customer Contact Maintenance
! button.

* You can also launch the A
window by clicking the [

13Select the status of the client/engagement from the Status field. Options
include:

Prepare
Open
Inactive
Complete

14Enter any comments to print on an invoice for a client/engagement in the
Comment 1 or Comment 2 fields. You may enter up to 30 alphanumeric
characters per comment.

15Click Accept to save the changes.

16Click the next tab to continue.
Create a New Client by Copying an Existing Client
Use the Copy From button on the Client Maintenance window to copy information

from existing client when defining a new client. After you copy the information, you
can modify the information that is unique to the new client.
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1 Enter a new client in the Client Code field.
2 Enter a new engagement in the Engagement Code field.

3 Enter a description for the client engagement in the Description field.

4 Click the button. The Copy From window appears.

ﬂ*ﬁtupy From HE
Clignt Code TEST
Engagement Code oooo
Copy Fram Client Code ABLEMAN % ABLE MANUFACTURING
Copy From Engagement Code ooao % PROFESSIONAL SERVICES
[ Lol | 94242005

Copy From Window

5 Select the client to copy the information from in the Copy From Client Code
field.

6 Select the engagement to copy the information from in the Copy From
Engagement Code field.

7 Click Proceed to copy the information.
Schedule Budgets for Engagements

You can use the Schedule/Budget Maintenance feature available on the
Engagement tab of the Client Maintenance window to create a schedule for
individual work codes and categories. You can also use this feature to view the
history of budget information for each task (see page 152).

1 Click the button on the Engagement tab. The Schedule/Budget

Maintenance window appears.

ﬂj Schedule / Budget Maintenance
work,

/Categary HPa | HIPF& COMPLIANCE SURVEY
Employes 0280 |G JOHN DOE

Comment, Mebworking
Schedule Type | Mon-Recuring j
Budget Hours 40.00 Status | Plarned 7|
Budget Rate 120.000 Projected Start Date  |03/07/2005
Budget Amount 4,800.00 Actual Start Date | 03/15/2005
Projected Completion Date
Actual Completion D ate

@@ | Accept | LCancel _[ Delete

Schedule/Budget Maintenance Window
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2 Enter or select a work code in the Work/Category field.
+ Click the E] button to select one work code.
» Click the |&] button to set the schedule for all work codes.

» Create a new work code by typing a new code.
A dialog box will appear allowing you to create a new code by clicking Yes and
launching the Work Code Maintenance window (see page 99).

* Click the button to update a work code.

3 Enter or select an employee to assign to the task in the Employee field.
* Click the E] button to select one employee.
 Click the button to set the schedule for all employees.

» Create a new employee by entering a new employee code.
A dialog box will appear allowing you to create a new employee by clicking
Yes and launching the Employee Maintenance window (see page 92).

* Click the button to update an employee.

4 Enter any comments about the schedule in the Comment field. You may enter
up to 30 alphanumeric characters.

5 Select how often this task will be done from the Schedule Type field.
You can select:

Non-Recurring
Monthly
Quarterly
Semi-Annual
Annual

6 Enter the total hours budgeted for the task in the Budget Hours field. The
information in this field will automatically update the Budget Hours field on the
Engagement tab.

7 Enter the budget rate used to calculate the budget amount based on the
budgeted number of hours in the Budget Rate field.

8 Enter the total revenue budgeted for the task in the Budget Amount field. The
information in this field will automatically update the Budget Amount field on
the Engagement tab.

9 Select the status of the task from the Status field. Options include:

Planned
Active
Completed
Cancelled

10Enter the date when this task is projected to be started in the Projected Start
Date field.
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11Enter the date when this task was actually started in the Actual Start Date field.

12Enter the date when this task is projected to be completed in the Projected
Completion Date field.

13Enter the date when this task was actually completed in the Actual Completion
Date field.

14Click Accept to save the changes. You can continue to schedule each task for a
client/engagement.

View the Budget History for a Task

You can use the Schedule/Budget Maintenance feature available on the
Engagement tab to view the budget history of a task.

1 Click the button on the Engagement tab of the Client Maintenance

window. The Schedule/Budget Maintenance window appears. .

ﬂj Schedule / Budget Maintenance

wark
T, HPa | HIPF& COMPLIANCE SURVEY
Employes 0280 |G JOHN DOE

Comment Metworking
Scheduls Type | NonRecuring ||
Budget Hours 40.00 Status | Plarned =]
Budget Rate 120.000 Projected Start Date | 03/07/2005
Budget Amount 4,800.00 Actual Start Date | 09/15/2005
Projected Completion Date
Actual Completion Date

@@ | Accept | Lancel I Delete

Schedule/Budget Maintenance Window

2 Select the task to review from the Work/Category field.

3 Select the employee assigned to the task from the Employee field.

4 Click the button. The Budget History window appears.

[ Budget History | 7 x|
Current Current Last Vear Last Year
Hours Amount Hours Amount
Budget 40.00 4.800.00 .00 .00
Actual Fes .00 .00 .00 .00
Wariahce Amount 40.00- 4,800.00- .00 .00
Variance Percent -100.00% -100.00% A00% A00%
Fix

Budget History Window
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5 To update any of the values, click the |__Fi button. The Fix Budget History

window appears.

fiakFix Budget History HE
Current &ctual Mon-Billable Hours 200]
Cument Actual Billable Hours 200
Cument Actual Amount 1E0.00
Last rear Actual Billable/Mon-Billable Hours on
Last rear Actual Amount 115.00

I Lwz | B/22/2004

Budget History Window

6 Update the actual billable and non-billable hours in the following fields:

Current Actual Non-Billable Hours field

e Current Actual Billable Hours field

Last Year Actual Billable/Non-Billable Hours field

7 Update the revenue for the task in the following fields:

Current Actual Amount field

Last Year Actual Amount field
8 Click OK. The Budget History window displays the corrected values.

9 Click OK again to close the Budget History window.

Create an Engagement Memo

You can use the Engagement Memo Maintenance feature available on the
Engagement tab of the Client Maintenance window to create a memo for an

engagement.

1 Click the Memos.. | putton on the Engagement tab. The Engagement Memo

Maintenance window appears.

EﬁEngagement Memo Maintenance H
Memo |MISCNOTES |G Description MISCELLAMEOUS NOTES
Memo Date | 05/01/1998 Reminder Date | 05/31/1998 | Display During Data Entry |:|

r. Martin Able requires that we contact him personally regarding any financial questions. ;I
Mo other personnel at Able Manufacturing may be contacted without specific authorization
from Mr. Able.

-]
@@ | Accept | Cancel l Delete

Engagement Memo Maintenance Window

2 Enter a new code to create a new memo in the Memo field, or select an existing

code from the field.
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3 Enter a description of the memo in the Description field.
4 Enter the starting date for the memo in the Memo Date field.
5 Enter a reminder date for the memo in the Reminder Date field.

6 Check Display During Data Entry to display the memo when an employee
enters data concerning the engagement in Time and Billing Professional.

7 Enter the memo in the text field.

8 Click Accept to save the memo.
Set Up Billing Procedures for a Client on the Billing Tab

The Billing tab of the Client Maintenance window stores specific billing information
for the specified client/engagement.

1 Click the Billing tab on the Client Maintenance window to access the billing
information.

i T2 Client Maintenance g|§|@

Cliert Code D1-4BLEMAN | O Narme | ABLE MANLIFACTURING

Engagement Code 00000000000000000000 % Description | PROFESSIONAL SERWICES

1. Client l 2. Engagement l 3. Billing ] 4 Histary l 5 Invoices l B WIP ]
Bill Separate
Fee Arangement | Retainer Biling -

Include Expenzes Primary Bill To %
Bill Rate Code 7 - Tax Ret-Cop hal
Monthiy R etainer .on Bill Format & %
Uncollected Rinr i} Detail Bill by Date
G/L Revenue | 11100 Q

i [
Bill Frequency | M

@@ [ Accept l Cancel l Delete

Check. thiz Box to clear Bill Text duning Biling Register Update HTI L2 8/16/2007

T/2 Client Maintenance Window - Billing Tab

2 Check Bill Separate to print each engagement bill separately for this client.

If you do not select this option, all engagements for the client print together on
one invoice.

3 Select how to bill the customer from the Fee Arrangement field. The options
include:

Standard Billing

Fixed Fee Billing

Non-Billable Fee Arrangement
Progress Billing

Retainer Billing

Not to Exceed Amount Billing.
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» If you select Fixed Fee Billing, Progress Billing, Retainer Billing, and Not to
Exceed Amount Billing, additional fields become available on the Billing tab.

4 Check Include Expenses to include expenses in the distribution bill amount
during Billing Data Entry (see page 191).

5 Select a billing rate for the client/engagement from the Bill Rate Code field.

6 Enter a fee amount in the Fixed Fee Amount field.
This field is available only if Fixed Fee Billing is selected in the Fee
Arrangement field.

7 Enter a progress amount in the Progress Amount field.
This field is available only if Progress Billing is selected in the Fee
Arrangement field.

8 Enter a retainer fee in the Monthly Retainer field.
This field is available only if Retainer Billing is selected in the Fee
Arrangement field.

Any uncollected retainer fees appear in the Uncollected Rtnr field.

9 Enter a maximum fee in the Not to Exceed field.
This field is available only if Not to Exceed Amount Billing is selected in the
Fee Arrangement field.

10Select the General Ledger account to post offsetting revenue for time sheet
entries from the G/L Revenue field.

11Check Clear Bill Text to clear Bill Text and Category Bill Text during the Billing
Register update.

12Enter the one-character bill frequency code to be used as selection criteria
when making bill selections and printing invoices in the Bill Frequency field.

If this field is blank, the engagement will be selected for billing for all bill
frequencies.

13Enter or select a primary billing address in the Primary Bill To field.
+ Select an existing address from the Lookup.

» Create a new address by entering a new code. A dialog box will appear
allowing you to create a new code by clicking the Yes button and launching
the Client Bill To Address Maintenance window (see page 156).

+ Click the button to update an address.

14Select the billing format to use while printing invoices for this client/engagement
from the Bill Format field.

15Click the next tab to continue.
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Set Up a Billing Address for a Customer

You can use the Client Bill To Address Maintenance feature available on the
Billing tab of the Client Maintenance window to create a billing address for a
client.

1 Click the button on the Billing tab. The Client Bill To Address

Maintenance window appears.

(i Client Bill To Address Maintenance | 7 x|
Bil To Code OFF1 % Mame | Office Mumber One
Address (53] | 5555 W. 5th St n
Global ]
ZIP Code 55555
City Young America State | M
Country US4, % United States of Ame
Telephane 555-555-5555 Ext 555
Fax 555-555-5551
Contact JANE L, JANE SMITH
Memao ;I
]
Sales Tax
[ Schedule ca Q
@@ | Accept I Cancel l Delete

Client Bill To Address Maintenance Window

2 Enter or select a bill to code in the Bill To Code field.

+ Click the E] button to select an existing address from the Lookup.

OR
» Type a new code to create a new address.
3 Enter the name of the address location in the Name field.
4 Check Default to mark the billing address as the default address.
5 Check Global if this is the main address for the client.
6 Enter the client’s address in the Address field.

7 Enter the client’s zip code in the Zip Code field.
When you enter the zip code, the City, State, and Country fields are
automatically filled.

8 Enter the client’s phone number and extension in the Telephone and Ext fields.

9 Enter the client’s fax number in the Fax field.
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10Enter or select a contact for the client/engagement in the Contact field.

+ Click the E] button to search for a contact that is already enabled in Time and
Billing Professional.

» Create a new contact by entering a new code. A dialog box will appear
allowing you to create a new contact by clicking Yes and launching the
Accounts Receivable Customer Contact Maintenance window.

11Enter any other additional information about the client in the Memo field.
12Select the sales tax schedule for the client from the Schedule field.

13For sales tax exemptions, click the button to access the Client Tax
Exemptions Maintenance window.

{5 Client Tax Exemptions Maintenance EH
Client Code 01-ACME ACME ‘WELDING COMPANY
Bill To Code OFF1 Office Number One
Tan Code Cé Califorriz

Exemplon | 5555555

Tax Code D escription Exemption Number

Client Tax Exemptions Maintenance Window

a Enter the exemption number in the Exemption field, and click OK. The
exemption will appear in the list.

b Click Accept on the Client Tax Exemptions Maintenance window to save the
exemption.

14Click Accept on the Client Bill to Address Maintenance window to save the
changes.

Set Up Custom Billing Rates for a Client

You can set up custom billing rates for a client based on a particular employee or
an employee level.

1 Click the button on the Billing tab of the Client Maintenance

window. The Client Billing Rates window appears.
[ Custom Eilling Rates HE

Employes S 5- Corsultant

/Level

Fiate Method Employee Fate Code 7|

Rate Code 0- Gen Acct Sve j

Rate m] (]

@@ | Accent I Cancel l Delete

Custom Billing Rates Window
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2 Select an employee or an employee level from the Employee/Level field.

* Click the E] button to search for an employee or level that is already enabled
for this client.

* Click the button to search for an employee from a list of all
Sage MAS 90 or 200 employees available.

3 Select the billing rate method from the Rate Method field. The options include:

Rate Entered
Work Code Rate
Employee Rate Code

« If you select Rate Entered, the Rate field becomes available.
« If you select Employee Rate Code, the Rate Code field becomes available.

4 Select a rate code from the Rate Code field.
This field is available if Employee Rate Code is selected in the Rate Method
field.

5 Enter the rate amount in the Rate field.
This field is available if Rate Entered is selected in the Rate Method field.

6 Select the unit of measurement for the billing rate using the Hours/Units button.
You can bill a customer at a rate per hour or per unit (such as per job). Toggle
measurement by clicking the button.

+ The button means the rate is per hour
* The

{| button means the rate is per unit

7 Click Accept on the Client Billing Rates window to save the changes.
View or Edit the Client’s Historical Billing on the History Tab

Use the History tab to view/edit historical information concerning this
client/engagement.
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1 Click the History tab from the Client Maintenance window to access a client’s
historical budget.

[& T/2 Client Maintenance g‘ﬁl@

Client Code 01-4BLEMAN |y Name | ABLE MANUFACTURING

00000000000000000000 % Description | PROFESSIONAL SERVICES

l%]HINT: Click the

Budget button to

. Engagement Code
display a recap of the

detailed budget 1. Client 1 2 Engagement ] 3 Biling ] 1 5. Invoices ] B WIP ]
amounts and hours.

The Budget History Last Billing Period 05 Period to Date ‘rear to Date Job to Date Last Year
window appears Date | 05/15/1938 Billable Hrs 33.00 437.00 il 4,800.00
displaying the budget Amaunt 5,060.05 | | Mon-Billable Hrs 400 52.00 i 515.00
(hours and amount), rp— 700 485,00 i 5,315.00

actual fee (hours and
amount), variance
amount (hours and
amount), and
variance percent

Date | 05/03/19928

Amaunt 5,000.00

WP Balance

Billable Amount
MNon-Billable Amt
Billed Fees

Billed Expenzes

3.605.00

oo
394307
1.056.93

50,209.23
2,075.00
42544 21
113879

oo
oo

24367200
3,006.43
235,900.00
3,290.00

£043.60 Wwiite Ups/Dns 193.00- 5,873.03 oo 10,482.00-
(hours and amount). Receipts 5,000.00 24,5830 w [ znasmo
Retainer Balance
EUdQEt 0 &) Current Period 3 Future Period ) AllEngmts

[ Accept _[ LCancel _[ Delete

HTI | Lw2 | 86,2007

AR

T/2 Client Maintenance Window - History Tab

2 Select the period to review by clicking one of the radio buttons at the bottom of
the window.

* Click Current Period to view data from the current period.
* Click Future Period to view data budgeted for the future.

« Click All Engagements for the totals of all engagements.

|Z[NOTE: You can change the data on the window only when Current
Period is selected.

|Z[SPECIAL NOTE: You can change any of the information on this tab
when Current Period is selected, except the WIP Balance field. This field
indicates the total outstanding, unbilled, work in process for this
client/engagement.

3 Change the date of the last bill/invoice printed for this client/engagement in the
Last Billing Date field.

4 Change the total amount on the last bill/invoice for this client/engagement in the
Last Billing Amount field.

5 Change the date the client made the last payment in the Last Payment Date
field.

6 Change the amount the client paid for the last payment in the Last Payment
Amount field.

Chapter 7: Using the Main Menu Time and Billing Professional Manual Page 159



Page 160

Chapter 7

V¥ Change the relevant information in the Period to Date, Year to Date, Job to
Date, and Last Year columns for the following fields.

7 Change the number of Billable Hours charged to the client/engagement.
8 Change the number of Non-Billable Hours charged to the client/engagement.

9 Change the dollar value of the Billable Amount charged to the
client/engagement.

10Change the dollar value of the Non-Billable Amount charged to the
client/engagement.

11Change the dollar value of the Billed Fees charged to the client/engagement.

12Change the dollar value of the Billed Expenses charged to the
client/engagement.

13Change the dollar value of the Write Ups/Downs charged to the
client/engagement.

14Change the dollar value of the Receipts charged to the client/engagement.

15Click the next tab to continue.
Review the Client/Engagement Invoice on the Invoices Tab

The Invoices tab of the Client Maintenance window displays the history of invoices
for the specified client/engagement. The Invoices tab shows historical invoices,
payments, credits, and adjustments. This tab also displays total fields to show the
total outstanding balance for this client/engagement.

1 Click the Invoices tab from the Client Maintenance window to access client’'s
historical invoices.

(i T/2 Client Maintenance E]|E|@

Client Code

Engagement Code

D1-4BLEMAN | Ty

Name |ABLE MANUFACTURING

(00000000000000000000

% Description | PROFESSIOMAL SERYICES

1. Client

Imvoice

] 2. Engagement. 1

T Invoice

Due

T C 2
PHT Chk No:10833
Iy 03415/38  0315/92
PT Chk Mo:10633

PHT Chi Nor10442

IMY 04/15/98  04/15/98

INY 05/15/98  05/15/98
MAROODT F/C 03/31/38

C/M Refnc:427395

3. Biling

Trans
Daty

04/27/38
03/31/98
(04/27/38
(05/03/98
(04/30/98
05/31/98
03/31/98
04/27/38

]

4 Histoy

Transaction

000 (1
£000.00-

8,683.00

2,000.00-
5,000.00-

7.900.00
5,060.05
50.00

50.00-

] 5. Invoices 1 E. WP ]

Discount

Imvoice

0 B E

Balance
14.643.05

Current
14.643.05

30 Days
.o

B0 Day:
.o

90 Days
.o

120 Days
.o

[ Accept l LCancel l Delete

HTI | w2 | 8/6/2007

Ww®o)

T/2 Client Maintenance Window - Invoices Tab

2 Use the action buttons to view further details about the invoices.
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* Click the [@ button to search for a particular invoice. The Accounts
Receivable A/R Invoice Search window appears (see page 161).

» Select an invoice and click the button to view the invoice details. The
Billing History Inquiry window (see page 165) appears.

* Click the button to display the full details about each payment amount.

lreoice Tin Invoice Due Trang Tranzaction Discount Iresoice
Mumber Typ Date Date Date Amount Amount Balance

PMT Chk Mo:9957 03/29/98 E.000.00-

PMT Chk Mo:10633 04/27/98 8,000.00- .00 .00

Invoices Tab with Check Payments

+ Click the or E] button to include/exclude invoices from other Sage MAS
90 or 200 modules for the client. The "plus" function includes other module
invoices and the "minus" function displays only Time and Billing Professional
invoices.

3 Click the next tab to continue.

Limiting Invoices to Current Engagements

Upon clicking the button on the Invoices tab of the Client Maintenance/Client
Inquiry window, the A/R Invoice Search window appears.

[ AR Invoice Search @El

Sart Invaices By Invoice Number i
Transaction Type Al i
Age Invaices By DueDate <
Zero Balance Invoices Lunent Engagement Uni:
Selection Al Starting Ending
Irreoice Number LE777PT
Invoice Date
Customer Purchase Order z2zzZzazEzIzEIZ

AIR Invoice Search Window

The selection of the Current Engagement Only option available on the A/R Invoice
Search window allows you to limit the list to the invoices that have the current
engagement.

For example:

+ If you select Client 01-ABC on the Invoices tab of the Client Maintenance
window,

AND

Inv #0000001 has Engagements: 001 on it
Inv #0000002 has Engagements: 002 on it
Inv #0000003 has Engagements: 001 and 002 on it
Inv #0000004 has Engagements: 003 on it
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You check Current Engagement Only option on the A/R Invoice Search
window and click OK,

THEN

* If you select Engagement 001 on the Invoices tab of the Client
Maintenance/Client Inquiry window, only Invoices 0000001 and 000003 will

show in the list.

* If you select Engagement 002 for the same client, invoices 0000002 and
0000003 will show in the list.

If you clear the Current Engagement Only check box on the A/R Invoice Search
window, all four invoices will display in the list on the Invoices tab of the Client
Maintenance/Client Inquiry window.

View the Work in Process on the WIP Tab

Use the WIP tab of the Client Maintenance window to view unbilled Work in
Process history for the specified client/engagement. This window also displays
total fields to show the total outstanding balance for this client/engagement.

1 Click the WIP tab from the Client Maintenance window to access work in
process information.

[ T/2 Client Maintenance

1. Client 2. Engagement ]
Engagement Date
(00000000000000000000 03/04/98
(10000000000000000000 03/04/38
(0000000000000000000 04,1198
01/12/5
0/19/38
(0000000000000000000 (085/29/98
(00000000000000000000 05/31/98
(10000000000000000000 (06/01/38
(0000000000000000000 (0B/01./98
(0000000000000000000 (0B/01/98
(00000000000000000000 06/01/98
(10000000000000000000 (0B/01/38
(0000000000000000000 (0B/01./38
Balance Cument
4,043 60 4,043 60

Cliert Code O1-ABLEMAN |Gy

Engagement Code 00000000000000000000 %

2. Billing

Emply W.C.

0130 ONS

0140 PHN

M50 CLR
50

04/17/98 0130

0220 MON
30 Days

.an

Name | ABLE MANUFACTURING
Diescription |PROFESSIONAL SERVICES

] 4. Histary 5. Invoices
Hours?
Cat Type Units Rate
MIC B 8.00 125.000
EXP E 4.00 5.000
CLE B 5.00 13.880
CLE B 300 13.850
HEE
EXP E  BO.OD 1.000
AUD B 5.00 75.000
CLK B 4.00 13.850
EXP E 3500 1.000
NOE M 300 000
AUD B 4.00 200,000
CLk B 4.00 13850
MOB M 3.00 000
ACC B E.00 150,000
B0 Days 90 Days
oo oo

] B WP ]

oc
500,00
120 Days
oo

AR

[ Accept _[ LCancel _[

Delete

HTI

Lw2 | 8/16/2007

T/2 Client Maintenance Window - WIP Tab

2 Use the action buttons to view further details about the engagements.
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* Click the button to search for a particular engagement. The WIP Search

window appears.

E*EWIP Search [ 7]
B Tyge AT -
Selection Al Starting Ending
Engagement Code [] |00000000000000000000 Qy (00000000000000000000 Qy
Date 12/31/2993
Employee Code % s %
‘work Code Qy 777 |,

WIP Search Window

a Select the bill types to include in the search from the Bill Type field.

b Select the engagement criteria from the Engagement Code, Date,
Employee Code, and Work Code fields.

- Check All to include the information for all clients.
OR

- Enter the client codes to include in the Starting and Ending fields.

I:gj HINT: Click the E] button in the appropriate field to select an item from
a Lookup window. Selecting from a sortable list places the item you selected
in the field.

c Click OK.

Click an invoice and click the button to view the work in process details.
The WIP Drill Down window appears.

{i WP Drill Down HE

Clnt O7-ABLEMAN ABLE MAMUFACTURING

Engmt 00000000000000000000 PROFESSIONAL SERVICES

Emply 0260 PATRICIA HARRISOM Hours/Units 8.00
WC MON MONTHLY ACCOUNTING SERWIC Rate 75.000
Category | ACC GENERAL ACCOUMTIMG SERVICE Amaunt E00.00

Bil Type | Billable

Cornment

MOMTHLY ACCOUNTIMNG SERVICES ;I

WIP Drill Down Window

- Review the information, and click OK.

3 Click Accept on the Client Maintenance window to save the changes.
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I:JjHINT: Click the

Map button available
in the Address field
to access
www.mapquest.com
and view the location
map or find the
directions.
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Use Client Inquiry to quickly review vital information for any specific client. This
window is a read-only version of the Client Maintenance window (see page 144).
The information displayed CANNOT be modified.

You can review client/engagement invoices on the Invoices tab of the Client
Inquiry window as you do on the Invoices tab of the Client Maintenance window
(see page 160). You can search for a particular invoice, view the invoice details,
display the full details about each payment type, and include/exclude invoices
from other Sage MAS 90 or 200 modules for the client.

Starting with version 4.20 of Sage MAS 90 and Sage MAS 200, you can |imit
invoices to current engagements (see page 161).

The Client Inquiry window contains six tabs for different configuration settings: the
Client, the Engagement, the Billing, the History, the Invoices, and the WIP tab.

View the Details about a Client/Engagement

1 From the Main menu of the Time and Billing Professional module, select Client
Inquiry. The Client Inquiry window appears.

[ T/2 Client Ingquiry

Client Code: 01-5BLEMAN % Name | ABLE MANLFACTURING

Engagement Code 00000000000000000000 % Description | PROFESSIONAL SERVICES

1. Client 1 2 Engagement ] 3 Biling ] 4 History B Invnices ] B WP ]
Address 9445 HIGHLAND AVE Refered By MARTIM ABL
Primary Contact| MARTIM ABL
ZIP Code: 92718
3 MARTIM ABLE
City IRVINE State |Ca
ool Cint Pattrer 120 B WINNUR
Telephone | (714) 555-4660 Es |S050 | ChtEmply  |0250 JOSEPH WILSON
Fax 7145659130
Sort ABLE Industiy MAMUFACTURING
Acct Soft? i
Comment 1 ear End 1231
Comment 2 Newsletter i
@eo®)

HTI | Lw2 | 8162007

T/2 Client Inquiry Window
2 Select a client from the Client Code field.

3 Select a client engagement from the Engagement Code field. This window
displays the details about the client/engagement.

4 On the Main tab and on the Engagement tab of the Client Inquiry window, you
can use the available Inquiry buttons () to access the respective Inquiry
windows to view more details about the corresponding items.
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5 On the Engagement tab of the Client Inquiry window, you can use the available
action buttons to access the respective windows to view more details about the
corresponding items.

+ Click the |-
window.

* Click the button to access the Schedule/Budget Inquiry window.

+ Click the Memcs... | button to access the Engagement Memo Inquiry
window.

| button to access the Customer Contact Maintenance

See the Time and Billing Professional Online Help for detailed information.

6 On the Invoices tab of the Client Inquiry window, you can use the available
action buttons to view further details about the invoices.

* Click the button to search for a particular invoice. The Accounts
Receivable A/R Invoice Search window appears.

+ Click an invoice and click the button to view the invoice details. The Billing
History Inquiry window (see page 165) appears.

7 On the WIP tab of the Client Inquiry window, you can use the available action
buttons to view further details about the invoices.

* Click the button to search for a particular engagement. The WIP Search
window appears (see page 162).

* Click an invoice and click the @ button to view the details for a particular
engagement. The WIP Drill Down window appears (see page 162).

8 Review the information available on the window, and click OK when finished.

Billing History Inquiry

Use the Billing History Inquiry feature to view detailed or summary billing
information, and details about each line item in an invoice. You may want to use
this feature for rapid access to invoice history information when handling a client
phone inquiry. The information displayed CANNOT be modified.

The Billing History Inquiry window contains two tabs for different configuration
settings: the Header and the Lines tab.
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Review the Details of an Invoice

1 From the Main menu of the Time and Billing Professional module, select Billing
History Inquiry. The Billing History Inquiry window appears.

i Billing History Inquiry [ M= 3
Inwoice Mumber | 0000042 % Date | 0441541998 | Type |INY
1. Header I 2. Lines I

Client 01-ABLEMAN ABLE MANUFACTURING

Bill To ABLE MANUFACTURING
Confim To Fax 714-565-3130
- Temnz Code |00 | MO TERMS
Fee Arrangement Standard Billing
Salesperson
Fees
Billed WP 812005 Source Jounal Tarable .00
Write Up/D own 220.05- T2-9359 Man-T axable 7900.00
Bill Amaunt 7.900.00 Schedule Sales Tan .00
Sales Tan .00 Irvoice Total 7900.00
Met Invoice 7900.00

@@ [ LCurrent. Hﬁp\it Comm, ][Ta§ Detail. ]
[ [ [Lwz [ a/7/2005

Billing History Inquiry Window - Header Tab

2 Select an invoice to view from the Invoice Number field. The fields on the
Header tab display the summary of the billing cost.

3 Access additional information by clicking the command buttons available on the
Header tab.

* Click the button to view the client’s main address and billing address.
on the Invoice History - Addresses window.

[ Invoice History - Addresses | 7 x|
— Add i BillTo Address
Mame ABLE MANUFACTURING Mame ABLE MANUFACTURING
Address | 3445 HIGHLAND AVE. Address | 9445 HIGHLAND AVE.
ZIP Code | 32718 ZIP Code | 92718
City IRVIME State | CA City IRYIME State |CA
Country Country

Invoice History - Addresses Window

* Click the button to view the client’s current balance on the Current
Balance Data window.

[ Current Balance Data | 7 x|
[ Net Irvoice 7.900.00 ]
Total Payments 0o
Total Prepayments .on
Total Adjustments 0o
Imvoice Balance 7.800.00

Current Balance Data Window
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* Click the button to view how commissions are split between several
salespeople for the current client/engagement on the Split Commission window.

[k Split Commission [ 7]
Salesperson

# of Commission

0200 Shelly ‘W estland 50.0007%

0100 Jim Kentley 50.000%

Split Commission Window

* Click the button to view tax information for the client/engagement on
the Tax Detail window.
[iak Tax Detail [ =]
Document (0000089 Customer | 01-4BLEMA | ABLE MANUFACTURING
Schedule Ca Califarmia
Tax Code Description
NONTAXABLE Maontaxahle Tax Code
Taxable Sales Taxable Freight Taxable Tax Tax Amaount
oo oo oo oo
Non-Taxable Sales Nan-T axable Freight Exempt Sales Eremption Mumber
10510.45 oo oo
Tax Code Taxable Nan-T axable Erempt Tax Amount
Total .0o

Tax Detail Window

4 Click the Lines tab to view the billing details.

ory Ing H = =
Invoice Humber | 0000042 % Date | 04/15/1938 | Type |IMW
1. Header ] 2. Lines ]
Date Emply  "W.C. Cat  Bill Hours/ WP Wirite Bill

Type Units Amaunt Up/Dn Amaunt

it CLER ES
21.68- 8.3

B 800,00

TELEPHOME SUPPORT OF vOUR ACCO

03/20/58 0240 MIC B 26.00 2600.00

(0000000000000000000 Cront: CUSTOM REPORT DESIGN AND DEWEL

0an0/sgs  mz0 CLI Mas B 5.00 300.00
00000000000000000000 Crnt: CLIENT CONFEREWCES

04410s98 0160 QFR ACC B 4.00 E00.00 16.26- 58374
(0000000000000000000 Crnt: PREPARATION OF PAYROLL TAX RET

0an0/8 0220 MON ACC B 200 1200
00000000000000000000 Crnt: MONTHLY ACCOUNTING SERVICES

04411498 0220 MON ACC B E.00 500,00 24.33- 75,61
00000000000000000000 Crnt: MONTHLY ACCOUMTING SERVICES

0441198 0250 QPR ACC B 800 1040.00 2818 101182
(0000000000000000000 Crnt: PREPARATION OF PAYROLL TAX RET ﬂ

243225

2439 87561

3252 11E7.48

@@ [ Current... J [§phl Comm.. ] [Ta§ Detail...]
[ Lw2 | 9/7/2005
Billing History Inquiry Window - Lines Tab

5 Use the action buttons to view further billing details.
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+ Click the button to search for a particular invoice. The Invoice Search
Options window appears.

{5 Invoice Search Dptions EH
Bill Type Al ﬂ
Selection Al Starting Ending
{ Date 12/31/2933 ]

Invoice Search Options Window
a Select the bill types to include in the search from the Bill Type field.

b Select the dates of the engagements to view from the Date field, and click
OK.

* Click an invoice and click the button to view the details. The Invoice
History Drill Down window appears.

Cc
(o]
\}
T
E
!I‘! ﬂ*ﬂlnvnice History Drill Down HE
S
Clnt O1-ABLEMAN ABLE MANLFACTURING
E Engrnt 00000000000000000000 PROFESSIONAL SERVICES
Ermply 0150 BETH CLARK Hours/Units 13.00
W.C CLR CLERICAL SERVICES WP Amount 180.05
Category | CLK CLERICAL Write Up/Dn 4.88-
R Bil Type | Billable Bill &mount 175.17
& Comment
CLERICAL SERVICES ;I

Invoice History Drill Down Window

- Review the information, and click OK.

Time/Expense Entry

Use Time/Expense Entry to enter all fees and expenses to be recorded for each
client/engagement. You can use time sheets as source documents to record all

employee activities, or you can record employee time individually. You can also

use expense sheets as source documents to record all expenses.

Enter Time/Expense entries in batches identified by a unique transaction number.
You can enter any number of fees and expenses in a single batch.

All information entered using Time/Expense Entry is updated to the Time and
Billing Work in Process file following the Time/Expense Journal update.
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Access the Time/Expense Entry Window

When you select Time/Expense Entry from the Time and Billing Professional
Main menu, the Time/Expense Entry Defaults window appears. Use this window
to enter the next transaction number, or to set tab defaults (see page 172) for the
Time/Expense Entry window.

ﬂj Time/Expense Entry Defaults [ 7] %]

MNest Transaction Number | 0000035
Trahsaction Date 03/07/2005

Time/Expense Entry Defaults Window

1 Change the transaction number, if necessary.
2 Change the date, if necessary.

3 Click OK. The Time/Expense Entry window appears.

{i Time/Expense Entry

Transaction Number 0000085 |Gy () Transaction Date [03/07/2005 | Onkold [

Employes Client Engagement “fork,
JOHN DOE ACME WELDING COMPANY NETwORKING SERVICES AUTO EXPEMSES
D |G OIADME |Gk 00000000000000000000 |2, | AR |
Date Rate Code Revenue Account Bilable
03/07 /2005 || 40a-m ST 35.00
TawClass NT % Subject ko Exemption Rate 1.000
Comment .
AUTO EXPENSES (A]  Amount 35.00
Line Date Emply  Clnt Engmt . C. Houwrs/Unite Rale

Comment Amaount

ME (00000000000000000000 CME

CLIENT - NON-BILLAELE TIME

03/07/05 0280 01-ACHME 00000000000000000000 HP&

Review of the network server and warkstations for *Ewtended™

03/07/05 0280  O1-GEMECOM  0000000OOOOOOOO0O00T TEL 50
TELEPHOME SUPPORT OF YOUR COMPUTER SOFTWARE *Extended™

[iins [ipel]  QuickLine Total Hours 800 Tatal &mt 57500

@@ WG (e 0 [ Anoept _[ Lancel I Delete
| [ [owz [ wrems

Time/Expense Entry Window

Enter Time and Expenses

1 Select an existing time/expense entry transaction number, or create a new
transaction number in the Transaction Number field.

* Click the E] button to search for an existing time/expense entry transaction.
+ Click the button to create a new time/expense entry.

2 Enter the transaction date of this time/expense entry in the Transaction Date
field.

3 You can place a time/expense entry on hold (see page 172) by selecting the On
Hold check box.
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4 Enter or select an employee for the time/expense entry in the Employee Code
field.

* Click the E] button to search for an employee that is already enabled in Time
and Billing Professional.

» Create a new employee by entering a new code. A dialog box will appear
allowing you to create a new employee by clicking Yes and launching the
Employee Maintenance window (see page 92).

* You can also launch the Employee Maintenance window by clicking the
button.

5 Enter or select a client to be billed for the time/expense entry from the Client
field.

* Click the E] button to search for a client that is already enabled in Time and
Billing Professional.

+ Click the button to search for a client from a list of all Sage MAS 90 or 200
customers available.

» Create a new client by entering a new code. A dialog box will appear allowing
you to create a new client by clicking Yes and launching the Client
Maintenance window (see page 144).

6 Select the engagement for which you want to bill the client from the
Engagement field.

 After you select the engagement to bill time and expenses to, you can also
launch the the Client Maintenance window (see page 144) by clicking the
button.

* You can update an engagement memo by clicking the ]| button to launch the
Engagement Memo Maintenance window (see page 153).

7 Enter or select a work code to be billed for the time/expense entry from the
Work field.

+ Click the E] button to search for a code that is already enabled in Time and
Billing Professional.

» Create a new work code by entering a new code. A dialog box will appear
allowing you to create a new work code by clicking Yes and launching the
Work Code Maintenance window (see page 99).

+ After you select the work to bill time and expenses to, you can also launch the
Work Code Maintenance window by clicking the button.

8 Enter the date for the time/expense task in the Date field.

9 Select the rate code associated with this time/expense entry from the Rate
Code field.
This field defaults to the rate code assigned to the employee, or to work code.
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10Select the revenue account for the time/expense entry from the Revenue
Account field.

11Select the sales tax class for the time/expense entry from the Tax Class field.

12Check Subject to Exemption to use exemptions defined for the
client/engagement. Specific exemption numbers determine whether sales tax
will be calculated for the time/expense entry.

13Enter a comment to be associated with this time/expense entry in the Comment
field. This field defaults to the comments assigned to a work code.

14Click the @ button to add extended comments by accessing the Extended
Comment Maintenance window (see page 173).

15Enter the number of hours associated with this time/expense entry in the Hours
field.

16Enter the rate for the time/expense entry in the Rate field. This field defaults to
the rate assigned to the work code.

17Enter the total amount for the time/expense entry in the Amount field. This field
automatically displays the calculated amount based on the data entered in the
Hours and Rate fields.

18Click OK to add the line to the time/expense transaction.
The information appears in the list on the Time/Expense Entry window. The
window updates the Total Hours and Total Amount fields with each
time/expense entry.

19The W.C. Hash field displays the total of all specified codes. You can use this
field to determine whether a transaction has been lost or omitted from
processing.

20Repeat steps 3 -18 for each time/expense entry for the employee or
engagement.

21If you need to quickly access an entry in the list, enter the number of the line in
the Quick Line field.

22|f you need to change tab defaults (see page 172) from the Time/Expense Entry
window, click the [ 7 button.

23Click Accept to save the entire time/expense transaction.

Chapter 7: Using the Main Menu Time and Billing Professional Manual Page 171



Page 172

Chapter 7

Set Tab Defaults for the Time/Expense Entry Window

When you select Time/Expense Entry from the Time and Billing Professional
Main menu, the Time/Expense Entry Defaults window appears. From this window,
you can set tab defaults for the Time/Expense Entry window.

[ Time,/Expense Entry Defaults | 7| x|

Transaction Date 09/07 /2005

Mext Transaction Humber | 0000035

Time/Expense Entry Defaults Window

1 Click the button. The Tab Settings window appears.

ﬂ*ﬁTah Settings HE

Field

Ralg
Mark Up Percent
Rate Code

-
o

o
w
@

Subject ta T ax Exemption
Tax Class

General Ledger Account

OO00OEREE

Comment

H
3

Tab Settings Window

2 Check all the fields you want to see in your tab sequence during data entry. You
can select from the following fields:

+ Rate field

» Mark Up Percent field

* Rate Code field

» Subject to Tax Exemption field
+ Tax Class field

* General Ledger Account field

« Comment field

3 Click OK. The system saves the changes and closes the Tab Settings window.

When you press the TAB key on the Time/Expense Entry window, the system will
move the focus to the fields you checked on the Tab Settings window.

Place a Time/Expense Entry on Hold

You can place a time/expense entry on hold. The entry will not be billable to a
client when the transaction is on hold.

1 From the Time/Expense Entry window, select the transaction from the
Transaction Number field.

2 Select the On Hold check box. The transaction is marked in Time and Billing
Professional as on hold.
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Add Extended Comments

1 Click the @ button on the respective window to add extended comments by
accessing the Extended Comment Maintenance window.

E:ﬁ Extended Comment Maintenance

Crfue)

ADJUSTING ENTRIES]

Extended Comment Maintenance Window

2 Review the information or make the necessary changes on the Extended
Comment Maintenance window using the appropriate command buttons.

a Click the button to select a standard billing comment
OR

Enter the comment in the text box.

You can enter up to 75 characters per line for as many lines as necessary
depending upon the setting in the Billing Text Display/Print Width field on
the Billing tab in Time and Billing Professional Options (see page 80).

To indicate that any text should not be printed on the invoice, type /* before the
specified text and type */ after the end of the text.

b To cancel the changes, click the button.
3 Click OK or Cancel to return to the main window.

See the Time and Billing Professional Online Help for detailed information.

Time/Expense Journal

The Time/Expense Journal produces an audit report itemizing all information
entered through Time/Expense Entry. After you print the Time/Expense Journal,
you can update the Time and Billing Professional files.

You can also use this option to print the Daily Time/Expense Recap Reports,
depending upon how the Recap by Client/Engagement, Recap by Employee,
and Recap by Work Code Category fields are set on the Time and Billing
Professional Options window (see page 80).
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Printed reports provide a permanent audit trail of your entries and ensure that all
entries are correct before the data is posted to the permanent files. The
Time/Expense Journal must be printed BEFORE you can update the General
Ledger.

|Z[NOTE: The Time and Billing Professional module now supports Sage
Software Extended Solutions Paperless Office: Journals and Registers
(LM-1018).

The Paperless Office solution allows printing of journals and registers in PDF
format, and provides a Viewer utility for the viewing and deleting of PDF
documents.

Print the Time/Expense Journal

1 From the Main menu of the Time and Billing Professional module, select
Time/Expense Journal. The Time/Expense Journal window appears.

ﬂ*ﬁTime,ﬁ'Ekpense Journal HE

Canon Sales

Current General Ledger Period |s: 5 Ending: 054311938
Time and Biling Professional Posting Da | 05/31/1938

FPrint I Preview l PFrinter Setup..
[ Lw2 | 9/7/2005

Time/Expense Journal Window

2 Make sure the date in the Time and Billing Professional Posting Date field is
correct, and click Print.

If any transactions are on hold, the following dialog appears.

[ Sage MAS 90

9
</

Fiint Tranzactions on hold?

Sage MAS 90 Dialog

3 Click Yes to include transactions on hold.
OR

Click No to exclude the on hold transactions.

The Time/Expense Journal prints.
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The Time/Expense Journal includes the transaction date, employee number, client
number, engagement number, work code, bill type, tax code, comments, hours,
units, rates, amount, transaction number, and whether or not the transaction is on
hold.

(i Time'\Expense Journal [_ O] <]

Time and Billing Pr 1al Demo

TIME/EXPENSE JOURNAL
REGISTER NO:- TT-0007

ET
DATE Emply  Clent Engmt WC. TE COMMENT HOURS THITS RATE AMOTNT
TEANS NO: 0000035 TEANS DATE: 020705 ON HOLD?: N
#0075 0230 01-ACME 00000000000000000000 CaR E NT AUTOEXPENSES 3500 1.000 3500
*020705 0280 01-ACME 00000000000000000000 CNE N NT CLIENT - NON-EILLAELE TIME 100 000 Ruil
*020705 0280 01-ACME 00000000000000000000 HP4 B NT £.50 120,000 780.00

Review of the netwark server and workstations for
HIPAA complianee

*90705 0280 01-GENECOM 00000000000000000001  TEL B NT 50 120.000 0.00
TELEFHOHNE SUPPORT OF YOUR COMPUTER SOFTWARE

EBILLAELE FEE TOTALS 7.00 £40.00
NON-BILLAELE FEE TOTALS 100 kUil
BILLABLE EXPENSE TOTALS. 3500
W.C HASH TOTAL o TRANS HO: 0000035 TOTALS: 2.00 2875.00
EBILLAELE FEE TOTALS 7.00 £40.00
WON-BILLABLE FEE TOTALS 100 na
BILLAELE EXPENSE TOTALS: 3500
W.C HASH TOTAL: o EEPORT TOTALS: .00 875.00

I * WAENING - DATE NOT IN CUFRENT T/2 PERIOD |

g,
12 ) == [ [ 4
N\

Time/Expense Journal

If any transaction dates on the journal are outside the starting and ending dates of
the current period, an asterisk prints preceding the date, and the *WARNING -
DATE NOT IN CURRENT T/2 PERIOD message prints on the last page of the
journal.

If you configured Time and Billing Professional to print recap reports for
clients/engagements, employees, or work codes, the following dialog appears.

i Sage MAS 90 [ x]

L ] Da you want to print the Daily Recap Reparts?
&

[ |[ Mo H End ]

Sage MAS 90 Dialog

4 Click Yes to print the reports.
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The following is an example of a client/engagement report.
i epensedourol ——_____ EBEE|

i

TIME/ERPENSE RECAP REPORT

SUMMARY BY Client/Engagement

Clientt FILLAELE NON-EILL  EILLAELE NON-EILL BILLAELE  HON-EILL TOTAL
Engagement HES/BASE ~ HESEBASE  UNITS UNITS AMOUNT AMOUNT AMOUNT

0l-ACME ACME WELDING COMPANY
00000000000000000000 NETWORKING SERVICES

Engmt 00000000000000000000 .30 100 780.00 oo 780,00
EXPENSE TOTALS: oo Ruil 3500 3500 oo 3500

Client 01-4CME A.50 100 780.00 oo 73000
EXPENSE TOTALS: oo Ruil 3500 3500 oo 3500

01-GENECOM GENERATION/2 COMPUTER DIST
00000000000000000001 NETWORK INSTALLATION

Engmt 00000000000000000001 50 na Aa0.00 oo &0.00
EXPENSE TOTALS, oo na na oo oo
Client D1-GENECOR 30 Ruil &0.00 o0 &0.00
EXPENSE TOTALS, oo na na oo oo
EEPORT FEE TOTALS: 7.00 100 £40.00 o0 240,00
EXPENSE TOTALS, oo na 3500 3500 oo 3500
EEPORT TOTALS: 875.00 oo 87500
I | >

Time/Expense Journal - Summary by Client/Engagement

The following is an example of an employee report.

Expense Journal

TIME/EXPENSE RECAP REPORT

SUMMARY BY Employee
Employee BILLAELE ~ NON-EILL  BILLABLE NON-EILL BILLAELE ~ NON-EILL TOTAL
CODE NAME HRS/EASE  HRS/BASE  UNITS UNITS AMOUNT AMOUNT AMOUNT
0230 JOHN DOE
Employss 0280 7.00 100 240.00 m 240.00
EXPENSE TOTALS: m il 3500 3500 m 3500
REPORT FEE TOTALS 7.00 100 240.00 oo £40.00
EXPENSE TOTALS: m 00 3500 3500 m 3500
REPORT TOTALS 275.00 oo 875.00

T

Time/Expense Journal - Summary by Employee
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The following is an example of a category/work code report.
(i Time'\Expense Journal [_ O] <]

Time and Billing Pr 1al Demo

TIME/EXPENSE RECAP REPORT
SUMMARY BY CATEGORY Work CODE

CATEGORY BILLABLE HON-BILL BILLABLE HWON-BILL BILLABLE WON-BILL TOTAL
CODE DESCEIPTION HES/BASE HESBASE UNITS UHITS AMOUNT AMOUNT AMOUNT
EXP FBILLABELE EXPENSES BILLABLE EXPENSE
Work CAR Ruil oo 3500 3500 Ruil 3500
CATEGORY EXP na oo 3500 3500 na 3500
MIC MICROCOMPUTEER CONSULTING  BILLAELE FEE
Wark TEL S0 oo 0,00 Ruil &0.00
CATEGORY MIC S0 oo 0,00 Ruil &0.00
WET HWETWOREK CONSULTING BILLABLE FEE
Work HPA £.50 oo 73000 na 780.00
CATEGORY NET £.50 oo 780,00 Ruil 780.00
WOE NWON-BILLABLE TIME NON-BILLABLE FEE
Work CHE Ruil 1.00 oo Ruil Ruil
CATEGORY MOB na 100 oo na na
REPORT FEE TOTALS 72.00 100 24000 na 24000
EXPENSE TOTALS, na oo 3500 3500 na 3500
REPORT TOTALS #7500 na 2875.00
T |
Rlel reer JO[0) »

Time/Expense Journal - Detail by Category/Work Code

After the Time/Expense Profit Journal displays the information, the following
dialog box appears.

2 Do you want to update the Time/Expense Journal?
</

Sage MAS 90 Dialog Box

5 After ensuring the reports are accurate, click Yes to update Sage MAS 90 or 200
with the information.

The following dialog box appears.

i Sage MAS 90 [ <]

2

Do pou want to print & Daily Transaction Register?

Sage MAS 90 Dialog Box

6 Click Yes to print the Daily Transaction Register.

If you click No, you can print the Daily Transaction Register at another time.

See the Daily Transaction Register section (see page 177).

Daily Transaction Register

The Daily Transaction Register is an audit report detailing all General Ledger
transactions posted through the Time/Expense Entry (see page 168) and Edit
Work in Process Entry (see page 231).
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« If Time and Billing Professional and General Ledger are integrated, all entries
can be updated directly to the General Ledger after this register has been
printed.

« If the General Ledger module is not installed, your transactions are updated to
the General Ledger Recap file. The General Ledger Posting Recap and this
register can be used as a reference when posting transactions to your general
ledger.

You may print the Daily Transaction Register each time you have entered a batch
of invoices, or time/expense entries.

Print the Daily Transaction Register

1 From the Main menu of the Time and Billing Professional module, select Daily
Transaction Register. The Daily Transaction Register window appears.

EjDaily Transaction Register (LWZ2) 9/7,/2005

TIME AND BILLING PROFESSIONAL DAILY TRANSACTION REGISTER

Canon Sales = . Print I Freylewl Setup

Daily Transaction Register Window

2 Click Print. The Daily Transaction Register prints.

Each transaction appears sorted by General Ledger account number and
description, along with the appropriate debit and credit amounts.

[ View Daily Transaction Register [_ O] x
| % & @fioe S]] 10 ] [z > b A | ~Crystal oo

Preview |
H

Daily Transaction Register
Time and Billing Professional Demo {(LW2) _

Postings For: 53171938

Source Joumal Account Humber Account Description/Posting Comment Debi Credi

TT-000001 115-00 Work In Frocess #7500
TIME/EXPENS E JO URNAL

16-00 Wark In Fracess Offset #75.00
TIMEEXPENSE JO URNAL

Joumal 000001 Torals: 97500 97500

Source TT Totals: 575 00 575 00

SBIAY8 Tokaks: ~ g5ap 87500

Report Torals: 875 .00 875 00

o] i o

| | | twa | arres

Daily Transaction Register
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After the Daily Transaction Register displays the information, the following
dialog box appears.

Sage MAS 90

“» 4 Do you want to update the Dailp Transaction Register?
2

Sage MAS 90 Dialog Box

3 After ensuring the register is accurate, click Yes to update Sage MAS 90 or 200
with the information.

This concludes Chapter 7: Using the Main Menu of the Time and Billing
Professional manual.
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Chapter 8
Using the Billing Menu

Chapter 8: Using the Billing Menu teaches you how to setup billing invoices. Use
the Billing menu to select work in process transactions for billing and printing
invoices. You can choose to print the billing worksheet to review work in process to
be selected for billing. You can select work in process transactions as a group
using the Billing Selection feature (see page 186), or you can select them
individually using Billing Data Entry (see page 191). You can enter write-ups and
write-downs by client and/or engagement, by work code category, or by individual
transactions using Billing Data Entry. You can choose to print invoices for selected
clients and/or engagements using the Invoice Printing feature (see page 216), and
you can print a billing register as an audit trail. Also, you can use the other options
in this menu like the Transfer Work in Process (see page ), Delete Work in
Process (see page 224), Edit Work in Process Selection (see page 228), and Edit
Work in Process Entry (see page 231) to modify or delete work in process
transactions.

How to Use the Billing Menu

This chapter does not describe every procedure that can be completed on a Billing
window. For example, this chapter does not include detailed instructions on how to
print or change information from certain windows available in the Billing menu.
Detailed instructions about changing, deleting, and printing information from the
Billing windows are available in the online help. The following instructions provide
a quick overview of how to complete these procedures.

Open a Window from the Billing Menu

1 Double-click the Time and Billing Professional module from the Modules tab.
The module expands to display all the menu options available in the Time and
Billing Professional module.

2 Click the Billing menu. The names of the windows available in the menu appear
on the right side of the Sage MAS 90 or 200 window.

Timne and Biling Professional - Billin

Up one level...

[E]Biling Worksheets

[ElEiling Selection

[==lBiling Selection Register
[=lEiling Data Entry

=2l credit Memo Entry
Invoice Prinking

[Z=lBilling Register

[ Transfer work in Process
[EolDelete Wark in Process
[ESlEdit Wark in Process Selection
[E2lEdit Work in Process Entry
[Z=]Edit Work in Process Journal

Windows Available in the Billing Menu

3 Double-click the name of the window to open. The system displays the selected
window.
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Select Items from a Lookup List

Many fields in the Billing menu feature a Lookup list. These lists allow you to select
data for the field.

* Click the E] button in the first field to select an item from the Lookup window.
The system displays the information in the field.

Delete a Record

1 Click the E] button in the first field to select a record account from the Lookup
window. The system displays the record’s information on the window.

2 Click Delete. The system displays a warning dialog box similar to the following.

[ Sage MAS 90

(] Delete this Credit Mema?
LY

Sage MAS 90 Warning Dialog
3 Click Yes. The record is deleted.

4 Click Accept on the main window to save the changes.
Print from a Window

You can print information from many of the windows available in the Billing menu.
These windows provide a listing of the options set or the records available. For
many of the windows you can select the type of information to include in the listing.
For detailed information about each type of listing, see the Online Help.

1 Click the button on the window. A Listing window similar to the following
appears.

{if Invoice Printing

Invoice Type to Print | &l j PFrint Invoices Already Printed

Message Line 1

Message Line 2

Next Invoice Mo 0000070

Invoice Date 09/07/2005 [] Override Date ‘

{ Biling Frequency Al j Batch: ALL
Selection All Starting Ending
Client Code 00 Q, 9 zzzzzzz |G
Engagement Code BN v rrsrrs sy rs g
Canon Sales [ Erint _[ Prexview | Frinter Setup... | @

[ Lw2 | 9/7/2008

Invoice Printing Window
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2 Select the type of information to include in the report from the remaining fields
on the Listing window. For many fields, you can select all records or a range of
information.

For example, in the previous picture you can check All to print all clients, or you
can use the Lookup windows in the Starting and Ending fields and select
specific clients.

3 Click the Print button to print the list, or the Preview button to print preview the
list.

Billing Worksheets

Use the Billing Worksheets feature to print Work in Process information for
selected clients/engagements for review by a responsible partner or employee,
prior to printing bills.

* You can choose to print this report for a specified Bill Thru Date to exclude
activities after that date.

* You can select clients/engagements based on the partner, responsible
employee, client type, billing frequency, or fee arrangement.

* You can add write-up/write-down amounts and additional comments on the
report.

Once this report has been reviewed and annotated by a responsible partner or
employee, it may be used as a source document for Billing Data Entry (see page
191).

You can choose to print billing worksheets in either standard or extended format,
based upon the selection in the Billing Worksheet Format field on the Billing tab
of the Time and Billing Options window (see page 85).

* You can use the standard format to select clients/engagements based on the
partner, responsible employee, client type, billing frequency, or fee arrangement.

» The extended format also includes the client address and contact information,
production and billing history information, receivables aging information, as well
as a fee recap by employee, and provides page breaks by engagement code.

You can choose to print the billing information both formats either by date or
category, for depending upon the setting in the Select and Print Bills by field on
the Billing tab of the Time and Billing Options window (see page 85).
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Ellent Paitrier

Client Emploves
Engagement Partrer

Engagement Employee
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Create the Billing Worksheets Report

1 From the Billing menu of the Time and Billing Professional module, select
Billing Worksheets. The Billing Worksheets window appears.

{5 Billing Worksheets EEE

K

Sort Options Client Code: 1
Bill Thiu Date 12/31/2933

Client Types to Print Al hd

Billing Frequencies ta Print All hd

Fee Amrangements to Print Al -

Frint Wark In Process Detail [ Print Estended Comments [] Page Break by Client

Selection All Starting Ending

Client Code =S Q,

Engagement Code s

Canon R330-400 5 Ver 1.0 ([ Pt | Pesien | Pintergenp

HTI | Lwhw' | 8/6/2007

Billing Worksheets Window

2 Select how to sort the report from the options available in the Sort Options field.
You can sort the report by:

Client Code

Client Partner

Client Employee
Engagement Partner
Engagement Employee

3 Enter a date in the Bill Thru Date field to exclude activities after that date.

4 Select the types of clients to print from the Client Types to Print field. Options
include All and Selected Types.

5 If you choose Selected Types, a text field appears to the right of the Client
Types to Print field. Enter the type to print in this field.

6 Select the billing frequencies to print from the Billing Frequencies to Print
field. Options include All and Selected Frequencies.

7 If you choose Selected Frequencies, a text field appears to the right of the
Billing Frequencies to Print field. Enter the frequency to print in this field.

8 Select the fee arrangements to print from the Fee Arrangements to Print field.
Options include All and Selected Arrangements.
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If you choose Selected Arrangements, six check-box fields appear to the right
of the Fee Arrangements to Print field.

i Billing Worksheets EE=
Sort Optians Client Code =
Bill Thru Date 12/31/2999
Client Types ta Print All -
Billing Freguencies to Print Selected Frequencies = |
Fee Arrangements ta Print Selected Anangements v || |[] Fixed  [[] Progress  [[] NonBillable
[] Retainer [] Standard [] Mot toExceed
Print Work. In Process Detail [[] Frint Extended Comments [[] Page Break by Client \
Selectian All Starting Ending
Client Code Q, zrzzrr |G,
Engagement Code s
Canon iR330-400 PS Yer 1.0 [ Print l Prewview l Printer Setup..
Enter up to five Frequencies HTI | Lwh 8/6/2007

Billing Worksheets Window

9 Check the fee arrangements to enclose. Options include:
* Fixed

* Progress

* Non-Billable

* Retainer

Standard

Not To Exceed

10Check Print Work in Process Detail to include work in process detail
information on the worksheets.

Do not check this option if you want to print only summary totals on the
worksheet.

11Check Print Extended Comments to include the extended comments on the
billing worksheet. Extended comments are entered during Time/Expense Entry
(see page 168).

12Check Page Break by Client to print each client on a separate page.
13Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR

 Enter the client codes to include in the Starting and Ending fields.
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I:gj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

14Enter the client engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
+ Enter the engagement codes to include in the Starting and Ending fields.

15Select the client partners to include on the billing worksheets from the Client
Partner field.
This field is only available if Client Partner is selected in the Sort Options field.

16Select the employee to include on the billing worksheets from the Client
Employee field.
This field is only available if Client Employee is selected in the Sort Options
field.

17Select the engagement partners to include on the billing worksheets from the
Engagement Partner field.
This field is only available if Engagement Partner is selected in the Sort
Options field.

18Select the employee to include on the billing worksheets from the Engagement
Employee field.
This field is only available if Engagement Employee is selected in the Sort
Options field.

19Click Print to print the list, or Preview to print preview the list.
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The Billing Worksheet lists client codes, engagement codes, work codes, hours,
rates, work in process amounts, and total billable amount.

(GiBilling Worksheets [_ O] <]
Time and Billing P
BILLING WORKZHEETS
SORTED BY Chent CODE
BiLL THRU DATE: 12/31/94
ET WIP EILL
CATEG WC. DESCRIPTION DATE  Emply T X COMMENT HOURS RATE AMOUNT AMOUNT
Clisnt CODE: 01-ABLEMAN ABLE MANUFACTURING
E 4 CODE 00000000000000000000  PROFESSIONAL SERVICES STANDARD
0ACC MON MONTHLY ACCOUNTING 060158 0220 B NT MONTHLY ACCOUNTING SERVICES 600 150000 900,00
ACC MON MONTHLY ACCOUNTING 060158 0250 B NT MONTHLY ACCOUNTING SERVICES 200 75000 £00.00
CATEGORY ACC GENERAL ACCOUNTING SERVICES TOTALS 14.00 1500.00
AUD MTG CLIENT MEETINGS - 052958 0250 B NT MEETING AT AELE MANUFACTURIN*™* 500 75000 37500
AUD MTG CLIENT MEETINGS - 060158 0110 B NT CLIENT MEETINGS - AUDIT 400 200000 500,00
CATEGORY AUD AUDIT SERVICES TOTALS: 2.00 117500
CLE CLE CLERICAL SERVICES 041158 0150 B NT CLERICAL SERVICES 500 13850 69.25
CLE CLE CLERICAL SERVICES 060158 0150 B NT CLERICAL SERVICES 4.00 13850 5540
CLE DOC DOCUMENT PREPARATI 041298 (0150 E NT DOCUMENT PREPARATION 300 13.850 41.53
CLE DOC DOCUMENT FREPARATI 055158 0150 B NT DOCUMENT PREPARATION 4.00 13850 5540
CATEGORY CLE CLERICAL TOTALS: 15.00 221 60
MIC ONS OWSITESUFFORTSE 0304858 0130 B NT ON SITE REQUIREMENT ANALYSIS 200 125000 1000.00
NOB CNB CLIENT-HON-EILLA 080158 0110 N NT CLIENT - NON-BILLABLE TIME 300 0.000 0.00
NOB CNB CLIENT-HOW-EILLA 080158 0220 N NT CLIENT - NON-BILLABLE TIME 300 0.000 0.00
CATEGORY HOB NON-BILLABLE TIME TOTALS £.00 0.00 =l
g |
) ) == [O1[C)

Billing Worksheets

Billing Selection

Use the Billing Selection feature to select Work in Process transactions to be billed
for a group of clients/engagements. You can also select by client partner, client
employee, client type, billing frequency, and fee arrangement. The Bill Thru Date
option is used to exclude activities after the specified date. You may perform
multiple selections in series, as necessary.

If you want to bill for individual clients/engagements, use Billing Data Entry (see
page 191) instead. You may also use the Billing Data Entry feature to perform
write-ups or write-downs of transactions selected using this program.

|Z[SPECIAL NOTE: This option CANNOT be used when any of the following
options are in progress: the Time/Expense Journal update (see page 173),
Billing Data Entry (see page 191) and Billing Register update (see page 219),
Transfer Work in Process (see page 222) and Audit report update, Delete Work
in Process (see page 224) and Register update, Edit Work in Process Selection
(see page 228) and Register update, Edit Work in Process Journal update (see
page 235), Manual Check Register update (see page 347), or_Invoice Register
update (see page 343).
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Bill Work In Process Transactions for a Group of Clients/Engagements

1 From the Billing menu of the Time and Billing Professional module, select
Billing Selection.

If you set the option for batch entries, the T/2 Billing Entry Batch window
appears. Use this window to create, change, or delete a billing batch entry.

{i 7/2 Billing Data Entry Batch

BatchNumber | 00002 |Gl User ID

Private Batch ]

Ok bedity I LCancel I Delete J

T/2 Billing Data Entry Batch Window

2 Select an existing batch entry number or create a new batch number in the
Batch Number field.

« Click the [ button to search for an existing batch number.

* Click the button to create a new batch number.
3 Check Private Batch if this billing batch is only available for you.
4 Click OK to accept the changes.

OR

Click Modify to change the next batch number.

The Billing Selection window appears.

{Billing Selection

Bil Thiu Date 09/07/2005 Batch: 00002

Client Types to Select Al ﬂ

Biling Frequencies to Select Al ﬂ

Fee Anangements ko Select Al ﬂ

Selection Al Starting Ending

Cliert: Code - =% Wz G,

Engagement Code N s s srasrssd o

Client Partrer % s %

Client Employee % s %

[ Procesd I Cancel I Clear @

I Lw2 | 9/7/2008

Billing Selection Window
5 Enter a date in the Bill Thru Date field to exclude activities after that date.

6 Select the types of clients to include from the Client Types to Select field.
Options include All and Selected Types.

7 If you choose Selected Types, a text field appears to the right of the Client
Types to Select field. Enter the type to include in this field.
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8 Select the billing frequencies to include from the Billing Frequencies to Select
field. Options include All and Selected Frequencies.

9 If you choose Selected Frequencies, a text field appears to the right of the
Billing Frequencies to Select field. Enter the frequency to include in this field.

10Select the fee arrangements to include from the Fee Arrangements to Select
field. Options include:

All

Fixed
Non-Billable
Progress
Retainer
Standard

Not To Exceed

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

11Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR
» Enter the client codes to include in the Starting and Ending fields.
12Enter the client engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.
13Select the client partners to include from the Client Partner field.
» Check All to include the information for all client partners.
OR
* Enter the client partner codes to include in the Starting and Ending fields.
14Select the client employees to include from the Client Employee field.
» Check All to include the information for all client employees.
OR
 Enter the client employee codes to include in the Starting and Ending fields.

15Click Proceed to create the billing selection.
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Billing Selection Register

The Billing Selection Register provides a detailed listing of Work in Process
information selected for billing using the Billing Selection feature (see page 186) or
Billing Data Entry feature (see page 191). In addition to the work in process
amount, the Billing Selection Register provides the write-up/write-down amount
and bill amount for each transaction.

The billing information will be printed by date or category, depending on the
selection in the Select and Print Bills by field on the Billing tab of the Time and
Billing Professional Options window (see page 85). .

|Z[NOTE: The Time and Billing Professional module now supports Sage
Software Extended Solutions Paperless Office: Journals and Registers
(LM-1018).

The Paperless Office solution allows printing of journals and registers in PDF
format, and provides a Viewer utility for the viewing and deleting of PDF
documents.

Print the Billing Selection Register

1 From the Billing menu of the Time and Billing Professional module, select
Billing Selection Register. The Billing Selection Register window appears.

ﬂ*ﬂﬂilling Selection Register

TIME AMD BILLING PROFESSIONAL BILLING SELECTION REGISTER

Canon Salss | Brit | Preview l Prifiter Setup..

Billing Selection Register Window

2 Click Print. The Invoice Batch Print window appears if you set the options for
batch entries.

[iik T2 Invoice Batch Print H BE B

Print &l Batches
Batch Mumber i User D

0

T/2 Invoice Batch Print Window
3 Select the batches to print.
» Check Print All Batches to print all batches.

OR

* Clear this field and select the batch number to print from the Batch Number
field.
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4 Click OK. The following dialog appears.

i Sage MAS 90 [ <]

9 Do pou want to print the Billing Selection Register
\_'/ for all batches?

Sage MAS 90 Dialog

5 Click Yes. The second Billing Selection Register window appears.

{Billing Selection Register

Print Biling Detail [] Piint Extended Comments [] Print Mon-Billable Lines }
Selection All Starting Ending

Cliert Code - Q, werrrr |G

Engagement Cade | i

Canon Sales - Proceed
\ Lw2 | 9/7/2008

Billing Selection Register Window

6 Check Print Billing Detail to print billing detail on the Billing Selection Register.

Do not check this option if you want to print only summary totals on the register.

7 Check Print Extended Comments to print extended comments on the Billing
Selection Register.
Extended comments are entered (see page 173) during time/expense entry.

8 Check Print Non-Billable Lines to print non-billable time and expense lines on
the Billing Selection Register.

9 Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR

» Enter the client codes to include in the Starting and Ending fields.

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

10Enter the client engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.

11Click Proceed to print the Billing Selection Register.
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The Billing Selection Register lists client codes, engagement codes, work codes,
hours, rates, work in process amounts, write-ups/write-downs amounts, and total
billable amount.

5 villing Selection Regeter

DILLING SELECTION REGISTER
BATUR NO ALL BATOHES
ET wir WRITE BILL
DATE  Emply CATEG WO,  DESCRIFTION T X COMMENT HOURS EATE AMOUNT URDOWH AMOUNT
Clanl CODE UL-AULEMAN AULE MARUFACTURING
Engagement CODE: 00000000000000000000  PROFESSICHAL SERVICED STARDAED
DILL THEW DATE, 05018 PRINT INVOLCET. ¥ DILLING FORMAT. A& Datul Bill by Dale
CI04EE 01N MIC ONS  ON-SITESUFPORTSE B NT ON SITE REQUIREMENT ANA 200 12500 100000 oo 100000
MA1sE 0130 CLE <LE  CLERICAL SERVICES E HT CLERICAL FERVICES 500 13830 €925 000 325
04N2EE 0150 CLE  DOC  DOCUMENT PREPARATL U HT DOCUMENT PREPARATION 2 1280 4155 [ 4155
031558 0360 AUD MTG CLIERT MEETINGE E HT CLIENT MEETIRGS - AUDIT 100 75000 7500 000 7500
0I09AE 0380 ADD  MTG  CLIENT MEETINGS - B MT MEETING AT ABLE MAMNUFAC s 75000 500 non 37500
033158 0130 CLE DOC  DOCUMERT PEEPARATI B HT DOCUMENT PREPARATION 400 13830 3540 000 3540
Engagement 00000000000000000000 FEE TOTALS: 2600 161620 000 161620
UIO4EE 0180 EXP FUN  TELEPUONE EXPENSES E NT TELEFNONE EXPENSES 000 oo wm
MATEE 0130 EXP M2C MINELLAKECUZEXPE E HT MUICELLANECUI EXPENIED 4200 000 4200
DANSEE U210 EXP CAR AUTO EXPENSES E HT AUTO EXFENSES Bl [ 0
031558 0100 SFT SMT SOFTWARE MECELL E TX JOFTWAEE - MIZCELLAKEOU 100000 000 100000
04RE 0100 SFT SMT  SOFTWARE. MICELL  E TX SOFTWARE - MISCELLANECD 20000 non 2000
Fragapemant DOOO0O00000000000000 EXFENSE TOTALS: 131200 a0 13200
Fragagemant DOOO0O00000000000000 TOT ALS 600 22820 a0 Ere R
Engagement CODE: 00000000000000000001  NETWORE INFTALLATION FROGRES FROGEES BALAHCE: 000
DILL THEW DATE, 05018 PRINT INVOLCET. ¥ IILLING FORMAT. E Progs 5l by Date
TROGRESS BILLING a0 a0 a0 a0 300
Fragagemant DOOO0O00000000000001 TOTALS a0 a0 a0 300
Cliert 01-ABLEMAN TOTALS: 600 292820 non A7 ||
L5}
ICYENES =l2)

Billing Selection Register

Billing Data Entry

Use the Billing Data Entry feature to select individual clients and engagements for
billing and to enter write-up/write-down amounts. Enter write-up/write-down
amounts for the client/engagement total, for the work code category total, or for
individual transactions. Individual transactions may be “de-selected” so that they
may be billed at a future time. You may also enter or modify comments for
individual transactions as well as enter additional text to be printed on the bill.

|Z[SPECIAL NOTE: This option CANNOT be used when any of the following
options are in progress: the Time/Expense Journal update (see page 173),
Billing Data Entry (see page 191) and Billing Reqister update (see page 219),
Transfer Work in Process (see page 222) and Audit Report update, Delete
Work in Process (see page 224) and Register update, Edit Work in Process
Selection (see page 228) and Register update, Edit Work in Process Journal
update (see page 235), Manual Check Register update (see page 347), or_

Invoice Regqister update (see page 343).

The Billing Data Entry window consists of four tabs of information: the Header tab,
the Addresses tab, the Detail tab, and the Totals tab.

Create a Billing Data Entry
When you select Billing Data Entry from the Time and Billing Professional Billing

menu, the Billing Data Entry Batch window appears if you set the option for batch
entries. Use this window to create, change, or delete a billing batch entry.
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The Batch Entry Method allows multiple entry sessions to take place
simultaneously, each with unique batch numbers assigned automatically by the
system, or manually by the user. Each batch can be printed and updated
individually, without affecting other batches. Batches can be specified as private,
accessible only by the user who created them, unless the override password is
known.

1 From the Billing menu of the Time and Billing Professional module, select
Billing Data Entry.

If the Allow Batch Entry option is selected on the Billing tab of the Time and
Billing Professional Options window (see page 85), the T/2 Billing Data Entry
Batch window appears.

5 7/2 Billing Data Entry Batch

BatchMumber | 00003 |G, User ID

Private Batch [

| 0K I Modify l Cancel l Delete J

T/2 Billing Data Entry Batch Window

a Select an existing batch entry number or create a new batch number from the
Batch Number field.

* Click the E] button to search for an existing batch number.
* Click the button to create a new batch number.
b Check Private Batch if this billing batch is only available for you.

c Click OK on the T/2 Billing Data Entry Batch window.

The Billing Data Entry Defaults window appears.

{iBilling Data Entry Defaults | 7 x|

Bill Thru Date 09/07/2005

Billing Data Entry Defaults Window

d Enter the default date to use as the last date that will be billed in the Bill Thru
Date field. This date displays in the Bill Thru field on the T/2 Billing Data Entry
window.

Transactions after this date will NOT be selected for billing.

e Click OK on the Billing Data Entry Defaults window.

The T/2 Billing Data Entry window appears.
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Engagement

1. Headsr ] 2 Addresses
Irwoice Mumber moniF1 | ()
8/7/2007

8/7/2007

Ireeoice Date
Due Date

Discount Date 8/7/2007

Client 4BLE MANUFACTURING

|

Quick Print | Customer

Chapter 8

PROFESSIONAL SERVICES

3 Detail ]

Bl To OFF1 @ Office Number One

Temns Code |00 |G, MO TERMS

Bill Farmat

4. Totals

A |G Detail Bil by Date
Salesperson | 0200 % Shelly Westland

Bill Thru

] Batch: 00007

SpitComm [Wo v
Sales Tax Piirt Irwoice Fax | 714-555.9130
Schedule Ca % Confirm Ta | MARTIN ABLE %
California
l I gmos... | Eill Text J
EOOO
HTI | w2 | &/7/2007

T/2 Billing Data Entry Window - Header Tab

The Header tab of the T/2 Billing Data Entry window contains the basic billing

invoice information.

2 Select a client for the billing invoice from the Client field.

« Click the [&] button to search for an existing client.

* Click the button to change the Time and Billing Professional information
for the client on the Client Maintenance window (see page 144).

3 Once you select a client, the | Customer | and = Ciedit

buttons become available.

* Click Customer to access the Accounts Receivable Client Maintenance window.

+ Click Credit to access the Accounts Receivable Customer Credit History

window.

4 Select an engagement for the billing invoice from the Engagement field.

the field.

I:gj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in

5 Once you select an engagement, the

Cluick Print

button becomes available. Click

this button to print the current bill only (see page 201).

6 The default date to use as the last date that will be billed displays in the Bill
Thru field. Transactions after this date will NOT be selected for billing. Change

the date, if necessary.

7 Enter the seven-character invoice number in the Invoice Number field, or click
the button to accept the next new, automatically incremented invoice

number.
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8 If you check the Print Invoice field, you can leave the Invoice Number field
blank.

+ All invoices where this field is blank will be automatically assigned an invoice
number during invoice printing.

* If you are applying a prepayment to an invoice, enter the invoice number
assigned to the prepayment during Accounts Receivable Cash Receipts Entry
as the billing invoice number.

9 Enter the invoice due date in the Due Date field.
10Enter the invoice discount date in the Discount Date field.

11Check On Hold if this invoice is not to be sent out immediately.

|Z[NOTE: The On Hold field is not available if the Allow Batch Entry option
is selected on the Billing tab of the Time and Billing Professional Options
window (see page 85).

12Select the tax schedule for the billing invoice from the Sales Tax Schedule
field.

13Enter or select a billing address in the Bill To field.
+ Click the E] button to search for an existing address from the Lookup.

» Create a new address by entering a new code. A dialog box will appear
allowing you to create a new code by clicking Yes and launching the Client Bill
To Address Maintenance window (see page 156).

« Click the button to update an address.
14Select the billing terms from the Terms Code field.
15Select the billing format from the Bill Format field.
16Select the salesperson for the invoice from the Salesperson field.

17Select whether or not to split the commission between salespeople from the
Split Commission field.
This field is available if the Split Commissions Between Salespersons check
box is selected on the Billing tab of the Time and Billing Professional Options
window (see page 85). Options include: Yes, No, and Override.

» Select Yes to distribute the total commission amount among up to five
salespersons on the Split Commission Entry window (see page 203).

» Select Override to post an override commission from the Override Commission

Entry window (see page 204).

If the Override option is selected, the standard commission is posted to the
primary salesperson. The override commission is posted to the salesperson
specified on the Split Commission Entry window (see page 203).

» Select No to post the commission only to the primary salesperson on the order.

Time and Billing Professional Manual Chapter 8: Using the Billing Menu



Chapter 8

18Click the button to change the commission percentages previously
entered on the Split Commission Entry window (see page 203).
This field is available if the Split Commissions Between Salespersons check
box is selected on the Billing tab of the Time and Billing Professional Options
window (see page 85).

19Check Print Invoice to print an invoice for this client/engagement.
20Enter the customer’s fax number in the Fax field.

21Enter or select the name of the person to contact regarding invoices in the
Confirm To field.

22Click the button to create an engagement memo through the
Engagement Memo Maintenance window. See the Create an Engagement
Memo section (see page 153) for more information.

23Click the button to enter additional text (see page 204) to appear

on billing invoices.

24Click the next tab to continue.
Enter the Billing Address on the Addresses Tab

Use the Billing Data Entry Addresses tab to enter specific information for the
customer and the desired bill to address.

1 Click the Addresses tab of the T/2 Billing Data Entry window to view the client’s
standard and billing addresses.

[ T/2 Billing Data Entry
Dl ABLE MANUFACTURING Quick Print | Customer | Credit

Engagement PROFESSIOMAL SERVICES Bill Thru

T Hesdsr |02 AddEsEs ] 3. Detai | 4 Totals | Balch: 00001

Bil Tadddess | OFFT | Copy Bil To
Address Bill To Address
Name ABLE MANUFACTURING Name Office Number One
Address | 9445 HIGHLAND AVE. Address
ZIP Code | 92718 ZIF Code
City IRVIME State | CA City State
Country C% Country C%
PEPE Cenl Lo

HTI | L2 8472007

T/2 Billing Data Entry Window - Addresses Tab
2 Select the billing address from the Bill To Address field.
* Click the @ button to select an existing client.from the Lookup.

+ Create a new address by entering a new code. A dialog box will appear
allowing you to create a new code by clicking Yes and launching the Client Bill
To Address Maintenance window (see page 156).

Chapter 8: Using the Billing Menu Time and Billing Professional Manual Page 195



Page 196

Chapter 8

* Click the button to update an address. The address appears in the Bill To
Address section of the Addresses tab.

 Click the button and the address will also appear in the
Address section of the Addresses tab. You will then be finished with entering
the addresses.

3 Enter the client’s name in the Name field.

4 Enter the client’s address for the engagement in the Address field.
5 Enter the client’s zip code in the Zip Code field.

6 Enter the client’s city in the City field.

7 Enter the client’s state in the State field.

8 Select the client’s country in the Country field.

9 Enter the name of the client in the Bill To Name field.
10Enter the client’s billing address in the Bill To Address field.
11Enter the client’s billing zip code in the Bill To Zip Code field.
12Enter the client’s billing city in the Bill To City field.

13Enter the client’s billing state in the Bill To State field.
14Enter the client’s billing country in the Bill To Country field.

15Click the next tab to continue.
Enter Details about Each Transaction on the Detail Tab

The detailed work in process transaction information is displayed on the Detail tab.
Each line represents a work in process transaction that has been recorded for the
client/engagement on or prior to the Bill Thru Date.

The Detail tab allows you to enter write-ups/write-downs for a transaction. When
write-ups/write-downs are entered for the client/engagement, the
write-up/write-down amount for each billed line item is automatically calculated
using a two-step process. First, the client/engagement write-up/write-down
percentage is calculated by dividing the write-up/write-down amount for the entire
bill by the billed work in process total. Then, the write-up/write-down amount for
each billed line item is calculated by multiplying the client/engagement
write-up/write-down percentage by the work in process amount for each billed line.

Write-Ups/Write-Downs may be based on the total bill amount for fees and
expenses or on separate bill amounts for fees and expenses, depending upon if
the Include Expenses field is checked on the Billing tab of the Client
Maintenance window (see page 156).
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1 Click the Detail tab of the T/2 Billing Data Entry window to view the transaction
details being billed.

% T/2 Billing Data Entry (=1
Client ABLE MANUFACTURING Quick Fint [ Customer | Credil
Engagement PROFESSIONAL SERVICES Bill Thru

1Header | 2Addmses | 3 Detal } 4Tads | Batch: 0000

Eill Option HourséUnits /1P Amount *wiite Up/Down  Bill Amount Tax Class

Mo v 00 I | [NT [ SE [4] BillUnbil
Billable Transaction 0000027 M [

Rev Account | 400-01 % Accounting Fees

Line Date/Category  Emply W.C. Bil? HouwsUnits  \WIP Amount  ‘wiite Up/Down  Bill Smount
1 06/01/98 0220 MON N E£.00 900.00 i RUES
Comment. MONTHLY ACCOUN ERVICES
[

3 052398 O 1 500
ALD Comment MEETING AT 4BLE MANUFACTURING “Estended
4 oeOiAE o0 MTG N am 800.00

AUD Comment; CLIENT MEETINGS - AUDIT b
Sales Tax 00 | wiite Up/Downs 00 | Tatal Billed il
woe/s) = [_pdee
Enter Amaunt o be: billed HTI | w2 8/7/2007

T/2 Billing Data Entry Window - Detail Tab

2 Click the transaction line you want to change. The details about the transaction
appear in the fields of the Detail tab.

3 Select whether or not the line will be billed from the Bill Option field. Options
include:

* Yes - To bill the work in process line

* No - To not bill the line

« Partial - To bill only part of the line

If you select Partial, the Hours/Units and WIP Amount fields become
available.

4 Enter the number of hours or time units being billed in the Hours/Units field.
This field is available only if Partial is selected in the Bill Option field.

5 Enter the portion of the work in process amount being billed in the WIP Amount
field.
This field is available only if Partial is selected in the Bill Option field.

I:Jj HINT: You can toggle the Bill Option field to Yes/No by clicking the
Billdunbil | button.

6 Enter the amount to add or subtract from the bill in the Write Up/Down field.
This field will automatically display the difference between the WIP Amount and
the Bill Amount for the line item.

» To write up the line item, enter a positive amount. The Bill Amount will be
calculated as the WIP Amount added to the write-up amount.

+ To write down the line item, enter a negative amount by entering the amount
followed by a minus sign. The Bill Amount will be calculated as the write-down
amount subtracted from the WIP Amount.
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7 Enter the amount to be billed for the line item in the Bill Amount field.

* The Bill Amount and the Write Up/Down amount will always equal the WIP
Amount.

* The Write Up/Down amount will be automatically calculated based on what is
entered into the Bill Amount field.

8 Select the sales tax class for the detail line from the Tax Class field.

9 Select the General Ledger account used to post revenue or expenses from the
Revenue Account field.

10Check SE to use sales tax exemptions for the client/engagements. The
exemption numbers must be defined for the client/engagement.

11Check CM if this line item is subject to commission.

12Add comments (see page 204) about a line by clicking the button and
opening the Billing Entry Text Editor window.

13Click OK to add the changes to the line.

When you update a line, the Sales Tax, Write Ups/Downs, and Total Billed
fields are updated.

14Click the next tab to continue.
Determine the Total Amount for the Bill on the Totals Tab

1 Click the Totals tab of the T/2 Billing Data Entry window to access the total fees
and expenses for the bill.

[ T/2 Billing Data Entry

Client ABLE MANUFACTURING Quick Print | Customer
Engagement NETWORK INSTALLATION Bill Thiu
1. Header 1 2 Addresses 1 3 Detail 1 A Totals W Batch: 00001
Fee Amrangement
Totals Bill by Categony
Fees Expenses

Billable WP Total 297500 oo | | Cetegon Code %

Billed WIP Tatal 2.975.00 0o

Wwiite Up/Down il il WP Total il

Bill Amaunt 257,00 00| | e Up/Down =

Sales Ta oo 0] | il amaunt

Progress Balance il

Bill Total 2.975.00

Commission Fiats ooz Urpil
eeo[e)

HTI | Lwi2 | 7/23/2007

T/2 Billing Data Entry Window - Totals Tab

» Most of the fields are view only and display the total amount for the bill per
billing category.
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2 Change the billable amount for Fees or Expenses in the enabled Bill Amount
field.

3 Change the sales tax for Fees or Expenses in the Sales Tax field.

4 Click the button in the Totals section. The following dialog appears.

[ Sage MAS 90 [ %]

l’
2

Edit Fees or Expenses?

Expenses

Sage MAS 90 Dialog

a Click Fees to change the taxes for billable fees.
OR
b Click Expenses to change the taxes for billable expenses.

The Tax Detail (Fees) or Tax Detail (Expenses) window appears.
[ Tax Detail (Fees) | 7 x|

Categomy Tar Amount

ACC oo
AUD .o
CLE i)

Tax Detail (Fees) Window

¢ Select the work category to change the taxes for, and click OK.

The Tax Detail window appears.

{5 Tax Detail EHE
Client 01-4BLEMAN Engagement 00000000000000000000 Categomy MIC
Schedule CA California Type FEE

Tax Code Description
CA Califormia
o
Taxable Sales Taxable Freight Taxable Tax Tax Amount
.00 .00 .00 2.00 Unda
MNon-Taxable Sales MNan-T axable Freight Erempt Sales Eremption Mumber
200.00 .00 .00

Tax Code Tazable MNon-T axable E rempt Tax Amount
A 800.00

Tatal 2.00

Tax Detail Window

d Make any changes on the Tax Detail window.

If you enter a new tax amount in the Tax Amount field, the Sales Tax field on
the Totals tab of the T/2 Billing Data Entry window will be updated.

e Click Accept on the Tax Detail window when finished.
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5 Change the total Fees or Expenses for the bill in the Bill Total field.

6 Enter the commission rate for the client/engagement in the Commission Rate
field.

7 To change the cost for a specific category being billed, select the category from
the Category Code field.

The Bill Amount field, the Unbill button, the Text button, and the Finished
button become available.

Bill by Categony
Category Code “FEE*
GEMER&L ACCOUNTING SERVICES
WP Total
‘wiite Up/Down
| Bill Amount 1.500.00] | -
e

T/2 Billing Data Entry Window - Bill by Category Section

8 Change the amount being billed for the work category in the Bill Amount field.

9 Change the comments (see page 204) for the work code category by clicking the
Text | button and launching the Billing Entry Text Editor window.

10To remove a work category from the bill, click the m button.
You can also use the Unbill feature for the entire engagement (see page 201).

The following dialog appears.

{if Sage MAS 90
9 Froceed with Unbill for ACC?

E

Sage MAS 90 Dialog

11Click Yes to remove the work code.
The information in the Totals section of the Totals tab will be updated.

12Click when you are finished updating the work category.
The billable amounts are updated in the Totals section of the Totals tab.

13Click Accept to save the changes.
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Not Billing a Client for an Entire Engagement

You can use the Totals tab to not bill a client for an entire engagement.

{5k 142 Billing Data Entry

Clert ABLE MANUFACTURING Credt
Engagement PROFESSIONAL SERWICES Bill Thru
1. Header ] 2 Addresses ] 3 Detail ] & Totals ] Batch: 00001
Fee Arangement
Totals Bill by Categary
Fees

Bilable WIP Totel 404350 Category Cade FEE

Billed ‘wIP Total 4043 60 GENERAL ACCOUNTING SERVICES

Write Up/D own .on WIP Total

Bill Amaunt Wirite: Up/D own

Sales Tax 0 Bil Amount 1500.00]

Bill Total

Commission R ate Unbil “\
Enter Amount to be billed HTI | Lw2 | B/22/2007

T/2 Billing Data Entry - Totals Tab

1 Click the Unbill button for the entire Totals tab. The following dialog appears.

i Sage MAS 90 [ x]

% , Proceed with Linkil?
</

Sage MAS 90 Dialog

2 Click Yes to not bill the client.
The total fields available on the Totals tab and Detail tab are set to zero (0).

3 Click Accept to save the changes.
Process a Final Bill

Once the engagement or job is completed for a client, you can process a Final bill
to bill any unbilled balance and to clear the Work in Process from the Totals tab.

1 To process a final bill, click the button on the T/2 Billing Data Entry
window. Use this feature to calculate the bill amount for a final billing by
subtracting the progress bill balance from the WIP Total.

2 When the Proceed with Final Bill dialog box appears, click Yes to proceed
ahead.

OR
Click No to cancel the final bill.
Print the Current Client/Engagement Only

You can use the Quick Print feature on any of the tabs of the Billing Data Entry
window to print the current bill only.
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1 Click the |Quick Print | button. The following dialog appears reminding you to save

changes.
i Sage MAS 90

“» | Do youwant to save changes?
=/

LCancel

Sage MAS 90 Dialog

2 Click Yes to save the changes. The Invoice Printing window appears.

I:i Invoice Printing [z _[C]x]

Invoice Type to Print | &/ ﬂ Frint Invoices élready Printed

Message Line 1 ‘

Message Line 2 ‘

Irwaice Date 0340772005 [] Overide Date ‘
{ Biling Frequency | al = Batch: 00002 ]

Selection All Starting Ending

Client Code [ |m-&BLEMaN | -4BLEMAN |~

Engagement Code [] [n000o0o00aoooooooon0 |- [o0000000000000000000 | -
‘Eanﬂn Sales | [ Frint l Prexiew | Frinter Setup... | @

[ Lw2 | 9/7/2005

Invoice Printing Window

3 You can change the date of the invoice in the Invoice Date field. This change

appears ONLY on the printed invoice.

4 To change the date throughout Time and Billing to this new date, check the

Override Date field.

5 Click Print to print the invoice or Preview to print preview the invoice.
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[ Invoice Printing [_ O]
ABLE MANUFACTURING INWOICE No.: 0000070-IN J
9445 HIGHLAND AVE. DATE: 05/31/98
CLIENT CODE: 01-ABLEMAN
IRVINE, CA 92718
CONTACT: MARTIM ABL PAGE NO.: 1
TERMZ: NO TERMZ
FOR FROFESSICNAL SERVICES RENDERED: HOURS AMOUNT J
PROFESSICNAL SERVICES
Thiz invoice reflects the changes discussed with
Drew Leeder on May 24, 1998,
03/04/98 RACHEL SCOTT 8.00 800.00
ON SITE REQUIREMENT ANALYSIS.
04/11/98 BETH CLARK 5.00 £9.25
CLERICAL SERVICES
04/12/98 BETH CLARK 3.00 41.55
DOCUMENT PREPARLTICH
05/29/98 PATRICIA HARRISCON 5.00 375.00
MEETING AT ABLE MANUFACTURING WITH ACCOUNTING
STAFF TO DISCUSS AUDIT PROCEDURES.
05/31/98 BETH CLARK 4.00 £5.40
DOCUNENT PREPARATICH
06/01/98 DREW LEEDER 4.00 §00.00
CLIENT MEETINGS - AUDIT
06/01/98 BETH CLARK 4.00 £5.40
CLERICAL SERVICES
TOTAL FEES: z196.60
03/04/98 TELEPHONE EEPENZES z0.00
04/17/98 MISCELLANEQUS EXPENSES i0.00
04/19/98 AUTO EXPENZES £0.00
06/01/98 AUTO EXPENZES 35.00
TOTLL EXFENSES: 115.00
i o
B[] = [C) [)

Invoice Printing Window - Invoice

Split a Commission Between Salespeople

Upon selecting Yes from the Split Commission field or clicking the on
the Header tab of the Billing Data Entry window (see page 191), the Split
Commission Entry window appears. Use this feature to select how to split the
commission between salespeople and change the commission percentages on
the Split Commission Entry window. You can enter information for up to five

salespersons.

[ Split Commission Entry EJ@|
Salesperson % of Commigsion
01-0200 Shelly Westland 100.000%
00100 | S Jim Fertley [ 000z

Q,

Split Commission Entry Window

1 Select the salespeople to split the commission between in the available

Salespersons fields.

2 Change the commission percentage in the % of Commission field.

3 Click OK to save the changes.
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Override a Commission

Upon selecting Override from the Split Commission field on the Header tab of
the Billing Data Entry window (see page 191), the Override Commission Entry
window appears. Use this feature to post the standard commission to the primary
salesperson via the Override Commission Entry window. The override commission
is posted to the salesperson specified on the Split Commission Entry window (see
page 203).

E:ﬁ Override Commission Entry

Salesperson Commizsion %

01-0200 Shelly Westland 8.000%

010100 [y Jim Kentley 000z

Override Commission Entry Window

1 Select the salesperson for whom to override commission from the Salesperson
field.

2 Enter the desired percentage in the Commission % field.

3 Click OK to save the changes.
Enter Additional Text/Comments

To enter additional text to appear on billing invoices, click the Bill Text button on
the Header tab, or the Comment button on the Detail tab of the Billing Data Entry
window (see page 191). The Billing Entry Text Editor window appears.

& Billing Entry Text Editor [ 7] %]

Crllie)

POSTING TO GENERAL LEDGER AND BEVIEW OF ACCOUNTS |
THROUGH _ /_ /

Billing Entry Text Editor Window

1 Click to select a standard billing comment or enter the comment in the text
box.

OR

Enter the comment in the text box.
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You can enter up to 75 characters per line for as many lines as necessary
depending upon the setting in the Billing Text Display/Print Width field on the
Billing tab in Time and Billing Professional Options (see page 80).

To indicate that any text should not be printed on the invoice, type I* before the
specified text and type */ after the end of the text.

2 To cancel the changes, click the button.

3 Click OK when finished.

Credit Memo Entry

The Credit Memo Entry feature allows you to credit invoices that have been
created through Time and Billing Professional. The Credit Memo Entry pulls the
details of the invoice you are crediting from history. You will then be able to adjust
or remove detail lines on the credit memo. Credit memos cannot be created for
invoices that were not created in Time and Billing Professional.

Time and expense detail entered through Credit Memo Entry can be posted back
to Work in Process if it is to be billed again at a later time. If Post to WIP is not
selected, the detail can be just a dollar credit that will have no affect on the Work in
Process.

®WARNING: Credit memos CANNOT be created for invoices entered
through Time and Billing and migrated to Time and Billing Professional. Time
and Billing does not maintain enough history detail to create the credit memo.

The Credit Memo Entry window consists of four tabs for credit memo data: the
Header, the Addresses, the Detail, and the Total tab.

Create a Credit Memo Entry

When you select Credit Memo Entry from the Billing menu of the Time and Billing
Professional Billing module, the Billing Data Entry Batch window appears if you set
the option for batch entries. Use this window to create, change, or delete a billing
batch entry.

1 From the Billing menu of the Time and Billing Professional module, select
Credit Memo Entry. The T/2 Billing Data Entry Batch window appears.

{i T/2 Billing Data Entry Batch

Batch Number | 00002 |Gl User ID

Private Batch ]

| oK | Modify I Lancel I Delete }

T/2 Billing Data Entry Batch Window
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The Batch Entry Method allows multiple entry sessions to take place
simultaneously, each with unique batch numbers assigned automatically by the
system, or manually by the user. Each batch can be printed and updated
individually, without affecting other batches. Batches can be specified as private,
accessible only by the user who created them, unless the override password is
known.

2 Select an existing batch entry number or create a new batch number from the
Batch Number field.

+ Click the E] button to search for an existing batch number.
* Click the button to create a new batch number.

3 Check Private Batch if this billing batch is only available for you. The T/2 Credit
Memo Entry window appears.

(5 T/2 Credit Memo Entry

Client ABLE MANUFACTURING Quik Print | Customer | Credi
Engagement PROFESSIOMAL SERYICES Memo Na.
1 Header ] 2 Addresses ] 3 Detail ] 4 Totals ] Batch: 00001
Apply Tar Q Bil Ta Q
Invoice Date 08/07/2007 Temms Code | 00 C% NO TERMS
Due Date 08/07/2007 Bill Format A % Detail Bill by Date
Digcount Date 084072007 Salesperson | 0200 C% Shellyp \Westland
Split Comm | Mo -
Sales Tax Print |mvoice Fax | 714-055-9130
Schedue ce @, || CorfimTa Q
Califomia
[[% Memos. l Bill Text ]
00w
HTI | L2 84742007

T/2 Credit Memo Entry Window - Header Tab

The Header tab of the T/2 Credit Memo Entry window contains the basic billing
invoice information.

4 Select a client for the credit memo from the Client field.
* Click the E] button to select an existing client from the Lookup.

* Click the button to change the Time and Billing Professional information
for the client on the Client Maintenance window (see page 144).

5 Once you select a client, the | Customer | and  Ciedit | buttons become available.
» Click Customer to access the Accounts Receivable Client Maintenance window.

+ Click Credit to access the Accounts Receivable Customer Credit History
window.
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6 Select an engagement for the credit memo from the Engagement field.
* Click the E] button to select an existing client from the Lookup.
7 Create or select a credit memo from the Memo No. field.

+ Click the E] button to select an existing memo from the Lookup.

OR

+ Click the button to create a new memo.

8 Once you select a memo number, the |24k Pt | hutton becomes available. Click

this button to print the current memo only (see page 213).

9 Select the invoice number to apply the credit to from the Apply To field.

|Z[NOTE: A credit memo CANNOT be created without selecting an existing
Time and Billing Professional invoice.

The selected invoice must have detail for the current client and engagement. If
not, Credit Memo Entry will not allow you to select the invoice. Once an invoice
is selected, all header and detail information for the current client and
engagement will be pulled from the invoice and added to the credit memo. You
will then be able to make any desired changes.

10Change the invoice creation date in the Invoice Date field.
11Change the invoice due date in the Due Date field.
12Change the invoice discount date in the Discount Date field.

13Check On Hold if this credit memo is not to be used immediately.

|Z[NOTE: The On Hold field is not available if the Allow Batch Entry option
is selected in Time and Billing Professional Options.

14Select the tax schedule for the credit memo from the Sales Tax Schedule field.
15Enter or select a billing address in the Bill To field.
* Click the E] button to select an existing address from the Lookup.

» Create a new address by entering a new code. A dialog box will appear
allowing you to create a new code by clicking Yes and launching the Client Bill
To Address Maintenance window (see page 156).

* Click the button to update an address.
16Select the billing terms from the Terms Code field.
17Select the billing format from the Bill Format field.

18Select the salesperson for the credit memo from the Salesperson field.

Chapter 8: Using the Billing Menu Time and Billing Professional Manual Page 207



Chapter 8

19Select whether or not to split the commission between salespeople from the
Split Commission field.
This field is available if the Split Commissions Between Salespersons check
box is selected on the Billing tab of the Time and Billing Professional Options
window (see page 85). Options include: Yes, No, and Override.

+ Select Yes to distribute the total commission amount among up to five
salespersons on the Split Commission Entry window (see page 203).

» Select Override to post an override commission from the Override Commission

Entry window (see page 204).

If the Override option is selected, the standard commission is posted to the
primary salesperson. The override commission is posted to the salesperson
specified on the Split Commission Entry window (see page 203).

» Select No to post the commission only to the primary salesperson on the order.

20Click the button to change the commission percentages previously
entered on the Split Commission Entry window (see page 203).
This field is available if the Split Commissions Between Salespersons check
box is selected on the Billing tab of the Time and Billing Professional Options
window (see page 85).

21Check Print Invoice to print an invoice for this client/engagement memo.
22Enter the customer’s fax number in the Fax field.

23Enter or select the name of the person to contact regarding invoices in the
Confirm To field.

24Click the Memas... | button to create an engagement memo through the
Engagement Memo Maintenance window.

See the Create an Engagement Memo section (see page 153) for more
information.

25Click the button to enter additional text (see page 204) to appear

on billing invoices.

26Click the next tab to continue.
Enter the Billing Address on the Addresses Tab

Use the Addresses tab to enter specific information for the customer and the
desired bill to address.

Page 208 Time and Billing Professional Manual Chapter 8: Using the Billing Menu



Chapter 8

1 Click the Addresses tab of the T/2 Credit Memo Entry to view the client’s
standard and billing addresses.

5 T2 Credit Memo Entry

Cliert ABLE MANUFACTURING Quick Print | Customer | Cradi
Engagement PROFESSIONAL SERWICES Memo No.
LHeader | T abes | 4Toms | Betch ooom
Bill To Address Q Copy Bill Ta
Address Eill To Address
Name | ABLE MANUFACTURING Name  |ABLE MANUFACTURING
Addiess | 9445 HIGHLAND &VE Address | 9445 HIGHLAND &VE
ZIP Code | 92718 ZIP Code | 92718
City IRVIME State | CA City IRVIME State  |Ca
Country % Country %
@le]e|®)
HTI [ Lw2 | 8/7/2007

T/2 Credit Memo Entry Window - Addresses Tab

2 Select the billing address from the Bill To Address field.
« Click the [& button to select an existing address from the Lookup.

+ Create a new address by entering a new code. A dialog box will appear
allowing you to create a new code by clicking Yes and launching the Client Bill
To Address Maintenance window (see page 156).

* Click the button to update an address. The address appears in the Bill To
Address section of the Addresses tab.

 Click the button and the address will also appear in the
Address section of the Addresses tab. You will then be finished with entering
the addresses.

3 Enter the client’s name in the Name field.

4 Enter the client’s address for the engagement in the Address field.
5 Enter the client’s zip code in the Zip Code field.

6 Enter the client’s city in the City field.

7 Enter the client’s state in the State field.

8 Select the client’s country in the Country field.

9 Enter the name of the client in the Bill To Name field.

10Enter the client’s billing address in the Bill To Address field.
11Enter the client’s billing zip code in the Bill To Zip Code field.

12Enter the client’s billing city in the Bill To City field.
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13Enter the client’s billing state in the Bill To State field.
14Enter the client’s billing country in the Bill To Country field.
15Click the next tab to continue.

Enter Details about Each Transaction on the Detail Tab

The Detail tab displays detailed information by line item for the client/engagement
memo. The Detail tab allows you to modify lines in an invoice, or delete lines from
an invoice that you do not want to be part of the credit memo.

|Z[NOTE: Deleting a line in Credit Memo Entry will not delete it from the
original invoice.

1 Click the Detail tab of the T/2 Credit Memo Entry window to view the transaction
details for the invoice being credited.

5 T2 Credit Memo Entry

Clert ABLE MANUFACTURING Quick Prirt | Customer
Engagement PROFESSIONAL SERYICES Memo No.
1Heater | 2addesses | 3 Detail ] £Toae | Batch 00O
Date Employee Wark Rate Code Revenue Account
402 <,
Camment Billable Tax Class SAEE
IMPLEMENTATION AND TRAINING ON | ubi Exempt []
Hours Rate WP Amnaunt wirte Up/Down  Bill Amount Commission ]
8 3062 7EI38 | Postto WP —
Line Date/Category  Emply WL WIP? Hours/Units  WIP Amount Write Up/Down Bill Amount

04/17/98 0130 125.00 12022 A

MIC
05/08/98 MEB 4.00 oo
NOE CLIEMT - NOM-BILLABLE TIME

Cl
Cornment:
20

05/08/98 ) 120000 4593 115407
ACC Comment: MONTHLY ACCOUNTING SERVICES v
Sales Tan 00 | wiite Up/Downs 198.00-| Total Biled 5000.00
BB
Enter *ite Up/Down Adjustment HTI L2 8/7/2007

T/2 Credit Memo Entry Window - Detail Tab

2 Click the transaction line you want to change or delete. The details about the
transaction appear in the fields of the Detail tab.

3 Change any comments for the line in the Comment field.
4 Enter the number of hours being billed in the Hours field.

5 Enter the amount to add or subtract from the bill in the Write Up/Down field.
This field will automatically display the difference between the WIP Amount and
the Bill Amount for the line item.

» To write up the line item, enter a positive amount. The Bill Amount will be
calculated as the WIP Amount added to the write-up amount.

+ To write down the line item, enter a negative amount by entering the amount
followed by a minus sign. The Bill Amount will be calculated as the write-down
amount subtracted from the WIP Amount.
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6 Enter the amount to be billed for the line item in the Bill Amount field.
» The Bill Amount will always equal the WIP Amount plus the Write Up/Down.

* The Write Up/Down amount will be automatically calculated based on what is
entered into the Bill Amount field.

7 Check Subj. Exempt to use sales tax exemptions for the
client/engagement/memo. The exemption numbers must be defined for the
client/engagement/memo.

8 Check Commission if this line item is subject to commission.

9 Check Post to WIP to post the line item as a work in process.

When you update the credit memo, the WIP (work in process) is created, which
can be billed to the client/engagement in the same manner as a WIP created
through Time/Expense Entry (see page 168). If this option is not selected, the
WIP will not be created from this detail line.

10Add comments (see page 204) about a line by clicking the Extended
Comments (@) button and launching the Billing Entry Text Editor window.

11Click OK to add the changes to the line.

When you update a line, the Sales Tax, Write Ups/Downs, and Total Billed
fields are updated.

12To delete the transaction line from the credit memo, click the button .
13Click the next tab to continue.

Determine the Total Amount for the Bill on the Totals Tab

1 Click the Totals tab of the T/2 Credit Memo Entry window to access the total
fees for the bill.

[ T2 Credit Memo Entry

Clent ABLE MANUFACTURING Quicks Piint | Customer |  Credit
Engagement PROFESSIOMAL SERVICES Mema Ma.
1. Header ] 2. Addresses 1 3 Detail ] ] Batch: 00001
Fee Amrangement
Totals
Fees

Billable WIP Total 5,199.00

Billed "WIP Tatal 5,199.00

Wiite Up/Dovin 199.00-

Bill Amount 5,000.00

Sales Tax .00

Bill Total

Commission Rate .000%
PEOO

Enter the Hours for this \work Code HTI | w2 8472007

T/2 Credit Memo Entry Window - Totals Tab

» Most of the fields are view only and display the total amount for the entire bill.
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2 Change the billable amount for Fees in the Bill Amount field.
3 Change the sales tax for Fees in the Sales Tax field.

4 Click the button. The following dialog appears.

i Sage MasS 90 %]

Edit Fees or Expenses?

Expenses

Sage MAS 90 Dialog

a Click the | button to change the taxes for billable fees. The Tax Detail
(Fees) window appears.
ﬂ*ﬁTax Detail (Fees) HE
Category Tar Amount
ACC an
AUD i)
CLE .00

Tax Detail (Fees) Window

b Select the work category to change the taxes for, and click OK. The Tax Detalil
window appears.

ﬂ*ﬂTax Detail [ 7]
Client 01-ABLEMAN Engagement 00000000000000000000 Categom Mas
Schedule Ca California Type FEE

Tax Code Description
Ca Califormia
Taxable Sales Taxable Freight Taxable Tax Tax Amount -
.00 .00 .00 8.00 Unda
Mon-T axable Sales Mon-T axable Freight Exempt Sales E xemption Mumber
87561 .00 .00

Tax Code Taxable MNan-T axable Erempt Tax Amaount

Total 8.00

Tax Detail Window
¢ Make any changes on the Tax Detail window.

If you enter a new tax amount in the Tax Amount field, the Sales Tax field on
the Totals tab of the T/2 Billing Data Entry window will be updated.

d Click Accept on the Tax Detail window when finished.
5 Change the total Fees for the bill in the Bill Total field.

6 Enter the commission rate for the client/engagement/memo in the Commission
Rate field.

7 Click Accept to save the changes.
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Print the Current Memo Invoice Only

You can use the Quick Print feature on any of the tabs of the Credit Memo Entry
window to print the current memo only.

1 Click the |Quick Print | button. The following dialog appears to remind you to save
changes.

[ Sage MAS 90 x|
“» | Doyouwant to save changes?
</

Cancel

Sage MAS 90 Dialog

2 Click Yes to save the changes. The Invoice Printing window appears.
iy Invoice Printing [ M= 3

Irvoice Type to Print | 201 j Print [nvoices Already Printed

Message Line 1 | |

Message Line 2 | |

Imvoice Date 09/07/2005 [] Ovenide Date ‘
[ Billing Frequency Al j Batch: 00002 ]
Selection All Starting Ending
Client Code [ [o1-4BLEMAN |- 01-ABLEMaN |-
Engagement Code [] |DDUDUDUDDUDUDUDDUDDD |-r - |DDUDUDUDDUDUDUDDUDDD |-r -
| Canon Sales | I Print I Prewview | Printer Setup...i| (33

[ Lw2 | 9/7/2005

Invoice Printing Window

3 Click Print to print the invoice, or Preview to print preview the invoice.
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The system creates an invoice for the current client/engagement memo only.

fif Invoice Printing M=l E3
Office Number One INVOICE NO.: 0000001-CIH
55 W. 55th Avenue DATE: D04/15/98
CLIENT CODE: O1-AELEMAN
Foung Awerica, MW 55555
CONTACT: MARTIN AEL PAGE NO.: 1
TERMZ: NO TERMS
FOR PROFESSICNAL SERVICES RENDERED: HOUES AMOUNT J
PROFESSIONAL SERVICES
03/04/398 BETH CLARK 3.25- 175.17-
CLERICAL SERVICES
03/16/98 EAREARA REYNOLDS 8.00- TI8.32-
TELEPHONE SUPPORT OF YOUR ACCOUNTS PAYAELE
SOFTUARE
03/z20/98 JENMNIFER HLAS 25.00- 2432 .25-
CUSTOM REPORT DEZIGN AND DEVEL
04/10/398 E.L. WINNUR 5.00- 875.861-
CLIENT CCONFERENCES
04/10/98 MNANCY COOK 8.00- 583 .74-
PREPARATION OF PAYROLL TAX RETURNS FOR THE QULRTER
ENDED 3/31/98
04/10/98 DAVID CAZEY §.00- 1187.45-
MCNTHLY ACCOUNTING IERVICES
04/11/98 DAVID CLSEY 6.00- 875.61-
MCNTHLY ACCOUNTING SERVICES
04/11/38 JOSEPH WILSON 8.00- 1011.82-
PREPLRATION OF PAYROLL TAX RETURNS FOR THE QUARTER
ENDED 3/31/98
TOTAL FEES: 7900.00-
SALES TAX: 8.00-
ANOUNT DUE: 7908.00-
< 3
[0 == C)0)

Invoice Printing Window - Invoice

Entering Write-Ups and Write-Downs

» A write-up is an increase in the book value of an asset not due to a cash
payment or other asset. Use write-ups to increase the bill amount by adjusting
the work in process during the billing process.

» A write-down is a reduction of the balance of an asset by charging an expense
or loss account due to the diminished value of the asset. Use write-downs to
reduce the bill amount by adjusting the work in process during the billing

process.

* In contrast, a write-off is the elimination of a specific client’s invoice(s), as in the
case of bankruptcy. Use write-offs to reduce receivables after billing and

updating.

Enter write-ups and write-downs for the client/engagement total, for the category
total, or for individual transactions.

Write-Ups/Write-Downs by Client/Engagement

When you enter write-ups/write-downs for the client/engagement, the
write-up/write-down amount for each billed line item is calculated automatically
using a two-step process.
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First, the client/engagement write-up/write-down percentage is calculated by
dividing the write-up/write-down amount for the entire bill by the billed work in
process total:

WRITE UP/DOWN = CInt/Eng Write-Up/Dn %
BILLED WIP TOTAL

Then, the write-up/write-down amount for each billed line item is calculated by
multiplying the client/engagement write-up/write-down percentage by the work in
process amount for each billed line item:

CInt/Eng Write-Up/Dn % x WIP AMOUNT = WRITE UP/DN

Write-Ups/Write-Downs can be based on the total bill amount for fees and
expenses or on separate bill amounts for fees and expenses, depending if the
Include Expenses field is checked on the Client Maintenance window Billing tab
(see page 156).

Write-Ups/Write-Downs by Category

When you enter write-ups/write-downs for the category, the write-up/write-down
amount for each billed line item in the selected category is calculated
automatically using a two-step process.

First, the category write-up/write-down percentage is calculated by dividing the
write-up/write-down amount for the selected category by the work in process total:

WRITE UP/DN = Category Write-Up/Dn %
WIP TOTAL

Then, the write-up/write-down amount for each billed line item in the selected
category is calculated by multiplying the category write-up/write-down percentage
by the work in process amount for each billed line item:

Category Write-Up/Dn % x WIP AMOUNT = WRITE UP/DN

The total bill amount for the client/engagement, as well as the total
write-up/write-down amount for the bill, will be adjusted automatically as well.

Write-Ups/Write-Downs by Transaction

When you enter write-ups/write-downs for individual transactions, you can enter
the actual write-up/write-down amount manually for each transaction, or you can
enter the bill amount to calculate the write-up/write-down amount automatically
using the difference between the bill amount and the work in process amount:

BILL AMOUNT - WIP AMOUNT = WRITE UP/DN

The total bill amount for the client/engagement as well as the total
write-up/write-down amount for the bill will be adjusted automatically as well.
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Invoice Printing

Use the Invoice Printing feature to produce printed invoices to mail to your clients
based on the information available in the Billing Selection or Billing Data Entry
features. Invoices are printed according to the format specified in the Billing
Format Maintenance program and assigned to each client/engagement. You may
print all of your clients using the same invoice format, or you may assign a different
invoice format to each client/engagement based on the client's requirements or
the nature of the services provided.

Print Invoices for Clients/Engagements
1 From the Billing menu of the Time and Billing Professional module, select

Invoice Printing. The T/2 Invoice Batch Print window appears if you set the
option for batch entries.

(i T2 Invoice Batch Print

Print &l Batches
Batch Number " User D

O

T/2 Invoice Batch Print Window
a Check Print All Batches to print all invoice batches,
OR

Clear this field and select the existing batch entry number from the Batch
Number field.

b Check Private Batch if the invoice batch is only available to you.
c Click OK.

The Invoice Printing window appears.

[ Invoice Printing

Invoice Type to Print | 411 j Print Invoices Alieady Printed
Meszage Line 1

Message Line 2

Irvoice Date (09/07/2005 [] Ovenide Date ‘

Nest Invoice No 0000070

[ Billing Frequency All j Batch ALL
Selectian All Starting Ending
Cliert Code - Q, fEFrrrrrilioN
Engagement Code
Canon Sales [ Eriet l Preyiew | Prifiter Setup... | @

[ Lwz | 9/7/2005

Invoice Printing Window
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2 Select the invoice types to print from the Invoice Type To Print field. Options
include:

All
Standard Invoice
Credit Memo

3 Check Print Invoices Already Printed to print invoices that have already been
printed.

4 Enter up to two lines of messages using up to 50 characters per line to be
printed on invoices in the Message Line 1 and Message Line 2 fields. These
messages appear if the [INVC_MSSG1] and [INVC_MSSG2] data items are
included on the billing format used.

5 Enter the invoice date using the MMDDYY format in the Invoice Date field. This
date will be assigned only to transactions that did not have an invoice date
assigned during Billing Data Entry (see page 191).

6 Check the Override Date field if you want to override the original invoice date
with a new date.

7 Change the date in the Invoice Date field and check the Override Date to post
the new date on the printout.

8 Enter the number to be used for the next invoice in the Next Invoice Number
field. This number can be up to seven alphanumeric characters.

This number will only be assigned to transaction that did not have an invoice
number assigned during Billing Data Entry (see page 191).

* If you are using an invoice form with a preprinted invoice number, be sure to
enter the invoice number to match the preprinted number.

+ If you are reprinting previously printed invoices, the Next Invoice Number field
will display the original number entered. This number is not incremented until
after the Billing Register is updated.

9 Select the billing frequencies to include from the Billing Frequency field.
Options include: All and Selected Frequencies.

10If you choose Selected Frequencies, a text field appears to the right of the
Billing Frequency field. Enter the frequency to include in this field.

I:Jj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

11Select the clients to include from the Client Code field.
12Select the engagements to include from the Engagement Code field.

13Click Print to print the invoices, or Preview to print preview the invoices.
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Invoice Printing includes the billing address of the client, the invoice number,
invoice date, client code, the dates of billable services, the details of each service,
the rate and cost of each service, and the total for the invoice.

i Invoice Printing M=l E3
Time and Billing Professional Demo j
CANYON RIDGE APARTHENTS INVOICE NC.: 0000072-IN
1427 EL CALJON BLVD. DATE: 08/07/05
SUITE 101 CLIENT CODE: 0Q1-CANRIDG

EL CAJON, CR 91556
CONTACT: CONNIE LAM PAGE NO.: 1
TERM3: NO TERM3

FOR PROFESSTONAL SERVICES RENDERED: HOTRS AMOTNT

PROFE3IZICNAL 3ERVICES

05/25/98 JOSEPH WILSCH 2.00 Z00.00
CLIENT CONFERENCES

0s5/26/98 BEETH CLARK 4.00 1z20.00
CLERICAL SERVICES

05/26/98 HANCY COOK 3.00 2z5.00
MONTHLY ACCOUNTING SERVICES

05/26/98 JACOE GREENEERG &.00 600.00

PREPARATION OF COMPILATION FINANCIAL STATEMENT FOR
THE PERIOD ENDING 4/30/98

05/26/98 JOSEPH WILICH §.00 §00.00
MONTHLY ACCOUNTING SERVICES

05729798 PATRICIA HARRISON §.00 600.00
MONTHLY ACCOUMNTING SERVICES

05/31/98 PATRICIA HARRIZON 3.00 2z25.00

ADJUSTING ENTRIES

05/31/98 PATRICIA HARRIZON 5.00 375.00
MONTHLY ACCOUNTING SERVICES

TOTAL FEE3: 3145.00

05/25/96 AUTO EXPENSES 30.00

TOTAL EXPENIES: 30.00

|

g
(@[©] s [

Invoice Printing Window - Invoice

After the invoices print, the following dialog box appears.
i Sage MAS 90 [ x]

‘?
2

Da pou want to print the Billing Register?

Sage MAS 90 Dialog Box

14Click Yes to print the Billing Register.

If you click No, you can print the Billing Register at another time.

See the Billing Register section (see page 219) for more information.
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Use the Billing Register to provide an audit report for all bills printed using the
Invoice Printing feature. Printing this report is the first step in the file update
process. It provides an opportunity to check invoice data for errors before the
information is posted to the permanent files.

|Z[NOTE: The Time and Billing Professional module now supports Sage
Software Extended Solutions Paperless Office: Journals and Registers
(LM-1018).

The Paperless Office solution allows printing of journals and registers in PDF
format, and provides a Viewer utility for the viewing and deleting of PDF
documents.

Print the Billing Register

1 From the Billing menu of the Time and Billing Professional module, select
Billing Register. The Billing Register window appears.

ﬂ*ﬁﬂilling Register HE
Current General Ledger Period |s: 5 Ending: 054311938
Time and Biling Professional Posting Da | 05/31/1938
Canon Sales Print I Preview l Printer Setup..
[ Lw2 | 9/7/2005

Billing Register Window

2 Make sure the date in the Time and Billing Professional Posting Date field is
correct, and click Print.

The Invoice Batch Print window appears if you set the option for batch entries.

gﬁT,.-"Z Invoice Batch Print

Fritit All Batches
Batch Mumber c User ID

L

T/2 Invoice Batch Print Window
3 Check Print All Batches to print all invoice batches
OR

Clear this field and select the existing batch entry number from the Batch
Number field.

4 Check Private Batch if the invoice batch is only available to you.

5 Click OK. The Billing Register prints.
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The Billing Register includes the invoice number and date, work in process
amount billed, write-up or write-down amount, billed fees, billed expenses, taxable
amount, sales tax, invoice amount, client code, client name, and engagement

code, if applicable.

JH[=] E3
BILLING REGISTER
REGISTER NC: T2-0000  BATGH NO: ALL BATCHES

INVC HOL DATE WIP WEITE EBILLED EBILLED PROGEET SALES INVOICE
Clnt Engmt AMOUNT TRDH FEES EXPENSES APPLIED TAX AMOTNT
0000072-[F 020705 3,175.00 X 3,145.00 3000 0.00 0.00 3,175.00
01-CANRIDG  00000000000000000000 CANYTON RIDGE APARTMENTS

0000073-IK - 090705 3,982.00 X 3,150.00 212.00 0.00 47.94 4,018.94
0I-EDWAELE 00000000000000000000 EDWARDSON ELECTRIC COMPANY

0000074-TH 090705 £,810.00 0.00 6,730.00 2000 000 000 £,810.00
01-GENECOM 00000000000000000000 GENERATION/2 COMPUTER DIST.

0000074-TH 090705 Aa0.00 0.00 0.00 000 000 000 Aa0.00
01-GENECOM 00000000000000000001 GENERATION/2 COMPUTER DIST.

0000075-TH 090705 2,170.00 2,170.00 000 000 000 2,170.00
01-HIDDBEA 00000000000000000000 HIDDEN BEACH HOTEL

0000078-IF - 020705 2,685.00 X 0.00 0.00 0.00 0.00 2,685.00
01-HOWARD  00000000000000000000 HOWARD, FINE, & HOWARD, DD3

0000077-IF 020705 11,933.00 .00 11,835.00 22,00 0.00 0.00 11,933.00
01-MASTMIC 00000000000000000000 MASTER MICRO MANUFACTURING

0000078-IN 020705 £,635.00 X 0.00 0.00 0.00 0.00 £,635.00
01-0L30W 00000000000000000000 OLIOW SPORTS CENTERS

0000072-[F 020705 0.00 0.00 0.00 0.00 0.0 0.00 4,000.00
01-REEDADYV 00000000000000000000 REED ADVERTISING PROGRESS

0000020-IF - 090705 2,041.00 L 5,050.00 3,991.00 0.00 23948 9,280.48
01-SCHWPES  00000000000000000000 SCHWARZKOPF PEST EXTERMINATORS

00000z1-IN - 090705 2,050.00 2,050.00- 0.00 0.00 0.00 0.00 0.00
OI-ZZZFIFM  00000000000000000000 FIRM ACTIVITIES

0000001-Ch - O4/15/98 2,120.05- 22005 7,200.00- 0.00 0.00 2.00- 7,208.00-
01-ABLEMAN 00000000000000000000 ABLE MANUFACTURING

FEPORT TOTAL: 49,407.95 8,820.95- 24,300.00 495800 0.00 279 40 44,857.40 I
o v
) ) M= [ )

Billing Register
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The next register that prints is the Tax Journal Detail. This register includes tax
code, client, engagement, sales amount, taxable sales, non-taxable sales, taxable
freight, non-taxable freight, taxable tax, exempt sales, and sales tax amount.

i Billing R [_TO[x]
TIME AND BILLING PROFESSIONAL TAX JOURNAL DETAIL
REGISTER NO: T2-0001  BATCH NO: ALL BATCHES
SALES TAXAELE NON-TAXABLE TAXAELE MNON-TAXAELE TAXAELE  EXEMPT  SALESTAX
TAX CODE DESCRIFTION AMOUNT SALES SALES FEEIGHT FREIGHT TaX SALES AMOUNT
Clnt Engmt
Ch
01-AELEMAN 00000000000000000000 363865 ] 3,638.65- w i} ] i} ]
01-ABLEMAN 00000000000000000000 17517 i} 175.17- o oo i} oo i}
01-ABLEMAN 00000000000000000000 BIS61- i} BIS61- 0o oo i} oo B8.00-
01-AELEMAN 00000000000000000000 3,210.57- oo 3,210.57- oo oo oo oo oo
01-CANRIDG  00000000000000000000 2,82500 i} 2,82500 0o oo i} oo i}
O1-CANRIDG  00000000000000000000 12000 a0 12000 00 oo a0 oo a0
01-CANEIDG 00000000000000000000 30.00 o 30.00 ] il o il o
01-CANRIDG  00000000000000000000 20000 il 200,00 0o oo il oo il
01-EDWAELE 00000000000000000000 15000 a0 15000 00 oo a0 oo a0
01-EDWAELE 00000000000000000000 1,20000 a0 1,200.00 00 oo a0 oo a0
01-EDWAELE 00000000000000000000 2000 i} 2000 o oo i} oo i}
01-EDWAELE 00000000000000000000 120000 i} 180000 0o oo i} oo i}
01-EDWAELE 00000000000000000000 79900 799,00 it ] a a0 a 4794
01-GENECOM 00000000000000000000 2,20000 il 2,200000 0o oo il oo il
01-GENECOM 00000000000000000000 24000 a0 24000 00 oo a0 oo a0
01-GENECOM 00000000000000000000 2000 a0 2000 00 oo a0 oo a0
01-GENECOM 00000000000000000000 2,25000 a0 2,250000 w0 il a0 il a0
01-GENECOM 00000000000000000000 150000 i} 1,500.00 o oo i} oo i}
01-GENECOM 00000000000000000001 &000 i} £0.00 o oo i} oo i}
01-HIDDEEA  00000000000000000000 160000 a0 1,600.00 00 oo a0 oo a0
01-HIDDEEA  00000000000000000000 12000 i} 12000 o oo i} oo i}
01-HIDDEEA  00000000000000000000 45000 i} 45000 o oo i} oo i}
01-MASTMIC 00000000000000000000 2,72500 i} 2,725.00 0o oo i} oo i}
O1-MASTMIC 00000000000000000000 1,00000 oo 1,000.00 oo oo oo oo oo
O1-MASTMIC 00000000000000000000 36000 oo 360,00 oo oo oo oo oo
01-MASTMIC 00000000000000000000 2200 i} 2300 0o oo i} oo i}
01-MASTMIC 00000000000000000000 234000 a0 2,34000 ] a a0 a a0
01-MASTMIC 00000000000000000000 541000 il 5,410000 0o oo il oo il
O1-SCHWPES  00000000000000000000 20000 i} 200,00 o oo i} oo i}
01-SCHWPES  00000000000000000000 3,25000 a0 3,250.00 00 oo a0 oo a0
01-§CHWPES  00000000000000000000 3,981.00 3,991.00 oo oo oo oo oo 23946
01-3CHWPES  00000000000000000000 20000 i} 200,00 0o oo i} oo i}
TAX CODE CA TOTAL 29,25800 4,790.00 24,4658.00 0o oo il oo 27240
EEPORT TOTAL: 27940 J
v

Billing Register - Tax Journal Detail

After the Billing Register displays the information, the following dialog box
appears.

9 Do you want to update the Biling R egister?
.

Sage MAS 90 Dialog

6 After ensuring the register is accurate, click Yes to update Sage MAS 90 or 200
with the information. The following dialog box appears.

fiSage MAS 90 [ <]

N

Do pou want to print & Daily Transaction Register?

Sage MAS 90 Dialog
7 Click Yes to print the Daily Transaction Register.

If you click No, you can print the Daily Transaction Register at another time.

See the Daily Transaction Register section (see page 177) for more information.
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Transfer Work in Process

Page 222

The Transfer Work in Process feature allows you to transfer unbilled work in
process information from one client/engagement to another client/engagement for
a range of dates. You may also print an audit report to track the work in process
being transferred.

|Z[NOTE: Use the Transfer Work in Process function on work in process
entered during the current accounting period. Transferring work in process for a
period other than the current one will affect the current period’s analysis
reports.

|Z[SPECIAL NOTE: This option CANNOT be used when any of the following
options are in progress: the Time/Expense Journal update (see page 173),
Billing Data Entry (see page 191) and Billing Register update (see page 219),
Transfer Work in Process (see page 222) and Audit Report update, Delete
Work in Process (see page 224) and Register update, Edit Work in Process
Selection (see page 228) and Register update, Edit Work in Process Journal
update (see page 235), Manual Check Register update (see page 347), or_

Invoice Reqister update (see page 343).

Transfer Work in Process from One Client to Another

1 From the Billing menu of the Time and Billing Professional module, select
Transfer Work in Process. The Transfer Work in Process window appears.

gﬁTrans[er Work in Process EH W= R
o TransferWork in Process Fro
Clignt Code 01-4BLEMAN | S ABLE MAMUFACTLRING
Engagement Code 00000000000000000001 G, NETWORK INSTALLATION
Employes Code o100 % WINNLUR
‘work Code Q All'work Codes
Transaction Murnber All Transaction Mumbers
Selection Al Starting Ending
Date 1243142339 }
—TransferwWork in Process Ter
Clignt Code 01-ACME Q ACME WELDING COMPANY
Engagement Code 00000000000000000000 O, NETWORKING SERVICES
Canon Sales Frint I Freview l Frinter Setup...
I Lw2z | 9/7/2005

Transfer Work in Process Window

I:gj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.
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2 Select the client that has the work in process engagement to be transferred from
the Client Code field.

3 Select the work in process engagement to transfer from the Engagement Code
field.
If you leave this field blank, all engagements will be transferred.

4 Select the employee involved in the work in process being transferred from the
Employee Code field.
If you leave this field blank, all employees will be transferred.

5 Select the task involved in the work in process being transferred from the Work
Code field.
If you leave this field blank, all work codes will be transferred.

6 Enter the transaction number of the work in process being transferred in the
Transaction Number field.
If you leave this field blank, all transaction numbers will be transferred.

7 Select the dates of the work in process records to transfer in the Date field.

* Check All for all dates.

OR
» Enter a range of dates in the Starting and Ending fields.

8 Select the client to whom to transfer the work in process information from the
Client Code field.

9 Select the engagement to which to transfer the work in process information from
the Engagement Code field.

10Click Print to print the transfers, or Preview to print preview the information.
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The Transfer Work in Process Audit Report prints the client information set in the
Transfer Work in Process window. This report also prints the date, engagement
code, employee code, work code, category, transactions, hours, rates, and
amounts being transferred.

(& Transfer Work in Process Audit Report =] E3
Time: andl Biling
TRANGF ER WORKIN PROCESS AUDIT REFORT
FROM Cliznt CODE 01-ABLEMAN ABLE MANUFACTURING
Engagement CODE 00000000000000000001  NETWORK INSTALLATION
Enployee CODE 0100 WINNUR IMA
Work CODE ALL Work Codes
TRANSACTION HO ALL TRANSACTION NUMEERS
DATE RANGE ALL DATES
TO Client CODE 01-ACME ACMWE WELDING COMPANY
Engagement CODE. 00000000000000000000 NETWORKING SERVICES
TRANS HOUES!
DATE Engmt Emply WC. CAT NUMBER TYPE TAXUNITS  RATE AMOUNT
051558 00DOOOODOODOOOOOOOD] 0100 ARA AUD 000003% B T 100  230.000 23000
REPOET TOTALS 23000
I | >
O = o)

Transfer Work in Process Audit Report

After the report prints, the following dialog appears.

5§ MAS 90 [ %]
‘)/ Do you want to update the Transter Work in Process Audit Repart?
-
o

Sage MAS 90 Dialog

11Click Yes to update the system with the changes. The work in process
engagements are moved from one client to the other.

Delete Work in Process

The Delete Work in Process feature allows you to delete unbilled work in process
information by client and/or engagement for a range of dates, employee codes,
work codes, or transaction numbers. After deleting work in process information,
you may print the Delete Work In Process Register and update the work in process
balances. In addition, if you selected the Post Work in Process to G/L option in
Time and Billing Professional Options (see page 83), work in process information
will be updated to the General Ledger.
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Delete Work in Process Transactions for a Client/Engagement

1 From the Billing menu of the Time and Billing Professional module, select
Delete Work in Process. The Delete Work in Process window appears.

ﬂ*ﬁbelete Work in Process H BE B
Client Cade O1-ABLEMAN % ABLE MANUFACTURING
Engagement Code: 00000000000000000001 % HETWORK INSTALLATION
Selection All Starting Ending
Date 12/3142333
Employee Code Q 7777 |y
‘wark Code Q 777 [Q
Transaction Murmber s
| Proceed I Cancel ] Clear
[ DCO | Lw2 | 9/7/2005

Delete Work in Process Window

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

2 Enter the client that contains the work in process information to delete from the
Client Code field.

3 Enter the engagement that contains the work in process information to delete
from the Engagement Code field.

4 Select the dates for the work in process transactions in the Date field.
» Check All for all dates.
OR
* Enter a range of dates in the Starting and Ending fields.

5 Select the employees involved in the work in process transactions in the
Employee Code field.

» Check All for all employees.
OR
» Enter a range of employee code numbers in the Starting and Ending fields.

6 Select the work categories involved in the work in process transactions in the
Work Code field.

» Check All for all work codes.

OR

» Enter a range of work code numbers in the Starting and Ending fields.
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7 Select the transaction numbers that contain work in process data from the
Transaction Number field.

» Check All for all transaction numbers.

OR
* Enter a range of all numbers in the Starting and Ending fields.

8 Click Proceed to delete the work in process information. The following dialog
box appears when you are finished deleting the transactions.

i Sage MAS 90

9
<

Do you want bo print the Delete Work in Process Register?

Sage MAS 90 Dialog

9 Click Yes to print the register. The Delete Work in Process Register window

appears.
{fiDelete Work in Process Register | 7 x|
Cunent General Ledger Period |s. 5 Ending: 0543141933
Time and Biling Professional Posting Da | 05./31/1998
Canon Salss 8 Print | Preview l Pririter Setup.
[ Lw2 | 9/7/2005

Delete Work in Process Register Window

10Make sure the date in the Time and Billing Professional Posting Date field is
correct, and then click Print. The register prints.

|Z[NOTE: The Time and Billing Professional module now supports Sage
Software Extended Solutions Paperless Office: Journals and Registers
(LM-1018).

The Paperless Office solution allows printing of journals and registers in PDF
format, and provides a Viewer utility for the viewing and deleting of PDF
documents.
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The Delete Work in Process Register prints the client information set on the Delete
Work in Process window. This report also prints the date, engagement code,
employee code, work code, category, transactions, hours, rates, and amounts
being deleted.

{fiDelete Work in Process Register [_1o]x]

Time and Billing P : :I
DELETE WORK IN PROCESS REGISTER
REGISTER NO: TD-0001
TRANS  BILL TAX HOURS/
DATE Emply ~ WC CATEC NUMBER TYPE CLASS UNITS RATE AMOUNT
Chent CODE 01-ABLEMAN ABLE MANUFACTURING
Engagement CODE: 00000000000000000001 NETWORK INSTALLATION
05/18/93 0130 NET MIC 0000024 B NT 7.00 125.000 875.00
05/15/93 0130 NET MIC 0000024 B NT 4.00 125.000 500.00
05/15/93 0270 NET MIC 0000024 B NT 10.00 100.000 1,000.00
05/22/93 0270 NET MIC 0000024 B NT 6.00 100.000 600.00
Engagement 00000000000000000001 TOTAL 2,975.00
Client 01-ABLEMAN TOTAL 2,975.00
REPORT TOTAL: 2,975.00
I i C
[ == [0 ()

Delete Work in Process Register

After the report prints, the following dialog appears.

i Sage MAS 90 [ x]
l’
</

Do you want to update the Delete Work in Process Fegister?

Sage MAS 90 Dialog

11Click Yes to update the system with the changes. The work in process
transactions are deleted.

The following dialog appears.

2 Do you want to print a Daily Transaction Register?
</

Sage MAS 90 Dialog
12Click Yes to print the Daily Transaction Register.

If you click No, you can print the Daily Transaction Register at another time.

See the Daily Transaction Register section (see page 177) for more information.
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Clear Work in Process Deletions

If you deleted work in process information that should not be deleted, you can
clear the deletion process and reinstate the work in process transactions. You can
only reinstate deleted files that have not been completely deleted from the system
through the Delete Work in Process Register.

1 Select the information you deleted from the fields on the Delete Work in Process
window.

You can leave all of the fields blank to remove all the transactions that are set to
be deleted.

2 Click Clear. The deleted transactions are reinstated.

Edit Work in Process Selection

Use the Edit Work in Process Selection feature to select unbilled work in process
transactions to be edited for a specific client/engagement.

Once you select work in process information, you can choose to print and update
the Edit Work in Process Selection Register. .

|Z[NOTE: The Time and Billing Professional module now supports Sage
Software Extended Solutions Paperless Office: Journals and Registers
(LM-1018).

The Paperless Office solution allows printing of journals and registers in PDF
format, and provides a Viewer utility for the viewing and deleting of PDF
documents.

Select Work in Process Transactions to Edit

1 From the Billing menu of the Time and Billing Professional module, select Edit
Work in Process Selection. The Edit Work in Process Selection window

appears.
ﬂ*ﬁEdit Work in Process Selection H BE B
Client Code 01-GENECOM QQ GENERATION/2 COMPUTER DIST

Engagement Code 00000000000000000000 % PROFESSIONAL SERVICES

Selection

E

Starting Ending

Date 1243142933

Employee Code % ZZZ7 %
Work Code Q 777 @
Tranzaction Mumber frrrrsr

[ Proceed I Cancel I Clear
[ Lwz | 9/7/2005

Edit Work in Process Selection Window
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I:gj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

2 Enter the client that contains the work in process information to edit from the
Client Code field.

3 Enter the engagement that contains the work in process information to edit from
the Engagement Code field.

4 Select the dates for the work in process transactions in the Date field.

« Check All for all dates.

OR
* Enter a range of dates in the Starting and Ending fields.

5 Select the employees involved in the work in process transactions in the
Employee Code field.

» Check All for all employees.

OR
» Enter a range of employee code numbers in the Starting and Ending fields.

6 Select the work categories involved in the work in process transactions in the
Work Code field.

« Check All for all work codes.

OR
» Enter a range of work code numbers in the Starting and Ending fields.

7 Select the transaction numbers that contain work in process data from the
Transaction Number field.

« Check All for all transaction numbers.

OR
» Enter a range of of numbers in the Starting and Ending fields.

8 Click Proceed to edit the work in process information. The following dialog box
appears when you are finished selecting the transactions.

i Sage MAS 90

9
<

Do you want bo print the Edit Work in Process Selection Register?

Sage MAS 90 Dialog
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9 Click Yes to print the Edit Work in Process Journal.

If you click No, you can print the journal at another time.

See the Edit Work in Process Journal section (see page 235) for more information.

10Click the button to access the Edit Work in Process Selection Register.

{%% Edit Work in Process Selection Register

Current General Ledger Period |s: Ending: 05/31/1998

Time and Biling Professional Posting D a

g MNotice:  This Time and Biling Professional posting date falls into a future General Ledger p

‘Eanon iR330-400 PS Yer 1.0 | [ Frrint I Preview I Printer Setup...

Enter the date to be used to post this register. HTI Lw2 B/22/2007

Edit Work in ProcessSelection Register

11 Make sure the date in the Time and Billing Professional Posting Date field is
correct, and then click Print. The register prints.

The Edit Work in Process Selection register prints the client information set on the
Edit Work in Process Selection window. This report also prints the date,
engagement code, employee code, work code, category, transactions, hours,
rates, and amounts being edited.

£23 Edit Wark i Process Salection Regisiar

EDIT WORK M FROCESS SELECTION REGISTER

FEGISTER WO T2-0001
TRAMS  BILL TAX  MOURSS
DATE Emply W CATEG NUMBER TYPE CLASS UNITS RATE AMOUNT
Chent CODE 0L ABLEMAN ABLE MANUFACTURING
Engagement CODE COGI0AOEAA0I0NNI0L HETWORK INSTALLATION
o®m MET  MIC 00onM B ONT 100 124 000 8w
om MET  MIC 0omnM B ONT a0 124,000 500,00
oM MET  MIC 00onM B ONT 10.00 100,000 L000.00
oM MET  MIC 0oonM B ONT 400 100,000 400,00

Engagement H0000000000000000001 TOTAL:

Chent 01 ABLEMAN TOTAL

REPORT TOTAL 297,00
— A
i1 | =
5[

Edit Work in Process Register

12After the report prints, click Yes at the Sage MAS 90 dialog to update the
system with the changes.
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Edit Work in Process Entry

Use the Edit Work in Process Entry feature to edit, delete, and add work in
process transactions previously selected during Edit Work in Process Selection
(see page 228). All work in process information edited is updated to the Time and
Billing Professional Work in Process file during the Edit Work in Process Journal
update (see page 235).

|Z[NOTE: You can only use the Edit Work in Process Entry feature AFTER
using the Edit Work in Process Selection feature (see page 228).

Edit a Work in Process Transaction

1 From the Billing menu of the Time and Billing Professional module, select Edit
Work in Process Entry. The Edit Work in Process Entry window appears.

ﬂ*ﬁEdit Work in Process Entry H BE B
Cliert Code D1-4BLEMAN | O ABLE MANUIFACTURING
Engagement Code 00000000000000000000 % PROFESSIONAL SERVICES
Transaction Murber | 0000036 Date | 05/3141933

Employee Client Engagement Warl,
RACHEL 5COTT ABLE MANUFACTURING PROFESSIONAL SERVICES OM-SITE SUPPOR
Q. D1-ABLEMAN |C, 000000N00N000N0NAoD |, ams [
Date Rate Code Revenue Account Billable
03/04/1938 ||3-Phone Suppot || 41702 Q. Houwrs 500
Comment TaxClass |MT % Subject to Exemption Rate 125.000
OM SITE REQUIREMENT AMALYSIS (2] Amount 1.000.00
Line Date Emply  Clnt Engmt W.C HoursUnits Rate
Comment Amount
1) El ]l 00000000000000000000 PHM 4.00 .
TELEFHOME EXPEMSES 2000
3 03/04/98 MED  OT-ABLEMAN  00000000000000000000 CLR 13.00 13.880
CLERICAL SERVICES 180.05 LI
Ins | Del Duick Ling Total Hours 136.00 | Total &mt 1242365

@@ Industry Hash a [ Accept l Cancel l Delete

[ Lw2 | 9/7/2005
Edit Work in Process Entry Window

2 Select the client that has the work in process transaction you want to change
from the Client Code field.

« Click the [G] button to select an existing client from the Lookup.
* You can use the (TIRCREDAC) buttons to access the desired information.

3 Select the engagement that contains the work in process transaction you want
to change from the Engagement Code field.

* Click the E] button to select an existing engagement code from the Lookup.

4 Enter the number of the work in process transaction in the Transaction Number
field.

5 Change the transaction date of this transaction in the Transaction Date field.
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6 Enter or select an employee for the transaction in the Employee Code field.

* Click the E] button to search for an employee that is already enabled in Time
and Billing Professional.

» Create a new employee by entering a new code. A dialog box will appear
allowing you to create a new employee by clicking Yes and launching the
Employee Maintenance window (see page 92).

* You can also launch the Employee Maintenance window by clicking the
button.

7 Select a client to be billed for the transaction from the Client field.

* Click the E] button to search for a client that is already enabled in Time and
Billing Professional.

» Create a new client by entering a new code. A dialog box will appear allowing
you to create a new client by clicking Yes and launching the Client
Maintenance window (see page 144).

* You can also launch the Client Maintenance window by clicking the button.
8 Select an engagement for the transaction from the Engagement field.

+ Click the E] button to search for an engagement that is already enabled in
Time and Billing Professional.

» Create a new engagement by entering a new code. A dialog box will appear
allowing you to create a new engagement by clicking Yes and launching the
Engagement Memo Maintenance window (see page 153).

+ After you select the engagement, you can also launch the Engagement Memo
Maintenance window by clicking the button.

9 Enter or select a work code for the transaction from the Work field.

+ Click the E] button to search for a code that is already enabled in Time and
Billing Professional.

+ Create a new work code by entering a new code. A dialog box will appear
allowing you to create a new work code by clicking Yes and launching the
Work Code Maintenance window (see page 99).

+ After you select the work code, you can also launch the Work Code
Maintenance window by clicking the button.

10Change the transaction date of this transaction in the Date field.
This date is not the date of the original transaction that you are editing, but the
date you are actually making the change.

11Select the rate code associated with this transaction from the Rate Code field.
This field defaults to the rate code assigned to the employee or work code.

Page 232 Time and Billing Professional Manual Chapter 8: Using the Billing Menu



Chapter 8

12Select the revenue account for the transaction from the Revenue Account
field.
This field defaults to the revenue account assigned to the work code.

13Select the sales tax class for the transaction from the Tax Class field.

14Check Subject to Exemption to use exemptions defined for the
client/engagement. Specific exemption numbers determine whether sales tax
will be calculated for the transaction.

15Enter a comment to be associated with this transaction in the Comment field.
This field defaults to the comments assigned to a work code.

16Click the @ button to add extended comments (see page 234) by launching
the Extended Comment Maintenance window.

17Enter the number of hours associated with this transaction in the Hours field.

18Enter the rate for the transaction in the Rate field.
This field defaults to the rate assigned to the work code.

19Enter the total amount for the transaction in the Amount field.
This field automatically displays the calculated amount based on the data
entered in the Hours and Rate fields.

20Click OK to add the line to the transaction. The information appears in the list on
the Edit Work in Process Entry window (see page 231).

The window updates the Total Hours and Total Amount fields with each
transaction.

21Repeat steps 5 - 20 for each line in the work in process transaction.

22If you need to quickly access an entry in the list, enter the number of the line in
the Quick Line field.

23Click the button to set tab defaults on the window (see current page).

24Click Accept to save the entire transaction.
Set Tab Defaults for the Edit Work in Process Entry Window

You can set tab defaults for the Edit Work in Process Entry window. When you
press the TAB key, the cursor will move to the selected field on the window.
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1 Click the Tabs button. The Tab Setup window appears.

E-j'lab Settings
Field Tah Set
Hate
Mark Up Percent
Rate Code
Subiject ta Tax Exemption
Tax Class [
General Ledger Account [
Camment [

Tab Settings Window

2 Check all the fields you want to see in a tab sequence during data entry.
3 Click OK. The system saves the changes and closes the Tab Settings window.
Add Extended Comments

1 Click the @] button to add extended comments by launching the Extended
Comment Maintenance window.

(i Extended Comment Maintenance

]

ADJUSTING ENTRIES]

Extended Comment Maintenance Window

2 Review the information or make the necessary changes on the Extended
Comment Maintenance window using the appropriate command buttons.

a Click to select a standard billing comment or enter the comment in the
text box.

OR
Enter the comment in the text box.
- You can enter up to 75 characters per line for as many lines as necessary

depending upon the setting in the Billing Text Display/Print Width field on
the Billing tab in Time and Billing Professional Options (see page 80).

- To indicate that any text should not be printed on the invoice, type /* before the
specified text and type */ after the end of the text.

b To cancel the changes, click the button.
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3 Click OK or Cancel when finished.

Edit Work in Process Journal

Use the Edit Work in Process Journal to provide an audit report for all work in
process transactions edited using the Edit Work in Process Entry window (see
page 231). Printing this journal is the first step in the file update process. It
provides an opportunity to check work in process data for errors before the
information is posted to the permanent files.

|Z[SPECIAL NOTE: This option CANNOT be used when any of the following
options are in progress: the Time/Expense Journal update (see page 173),
Billing Data Entry (see page 191) and Billing Register update (see page 219),
Transfer Work in Process (see page 222) and Audit Report update, Delete
Work in Process (see page 224) and Register update, Edit Work in Process
Selection (see page 228) and Register update, Edit Work in Process Journal
update (see page 235), Manual Check Register update (see page 347),

or Invoice Register update (see page 343).

Print the Edit Work in Process Journal

1 From the Billing menu of the Time and Billing Professional module, select Edit
Work in Process Journal.

2 If the Update by User Code field is checked in Time and Billing Professional

Options (see page 80), you will be asked if you want to print and update by user
code. .

PFrint and Update by User Code?

2
\_‘\/ )

Sage MAS 90 Dialog

3 Click Yes to print by user code.
OR
Click No to decline the printing by user code.

The Edit Work in Process Journal window appears .

{5k Edit work in Process Journal HE
Current General Ledger Period |5 5 Ending: 0543171998
Time and Biling Professional Posting Da | 05/15/1338
Canon Sales i Print | Freview l Frinter Setup...
I Lw2 | 9/7/2005

Edit Work in Process Journal Window
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4 Make sure the date in the Time and Billing Professional Posting Date field is

correct, and click Print. .

|Z[NOTE: The Time and Billing Professional module now supports Sage
Software Extended Solutions Paperless Office: Journals and Registers
(LM-1018).
The Paperless Office solution allows printing of journals and registers in PDF
format, and provides a Viewer utility for the viewing and deleting of PDF
documents.

The Edit Work in Process Register prints the client information set on the Edit
Work in Process Entry window (see page 231). This report also prints the date,

engagement code, employee code, work code, category, transactions, hours,

rates, and amounts being selected.

(i Edit Work in Process Selection Register

EDITVWORKIN FROCESS SELES TN REGISTER

Time anct Billing Pr

REGISTER N 0: 72000

Client CODE:
Engagement CODE:

0304/38 0130
03i04/98 0140
03i04/38 0150
0318/98 0z10
03620/38 0240
0410/38 0120
04i10/98 0180
04/10/38 0220
04511/98 0130
04/11/98 0220
04111/98 0250
04712/98 0130
04114/38 0250
04117/28 0130
04/19/98 0210
05629/98 0260
05131098 0130
06i01/38 0110
06i01/38 0110
D&01/98 0110
06i01/38 0150
D&01/98 0220
0&01/98 0220
06i01/38 0260

DATE Emply

TRANS BILL TAX HOURS!

WLC CATEG NUMEBEE TYPE CLASS UNITS EATE
01-ABLEMAN ABLE MANUFACTURING
00000000000000000000 PECFESSIONAL SERWICES

OHE MIC nooooLo B HT 200 125,000

PHN  EZP 0000010 E HT 400 5000

CLE CLE 0000001 B HT 1300 13850

TEL MIC 0000001 B HT 200 100,000

REP MIC 0000001 B HT 2500 100.000

CLI MAS 0000001 B HT 500 120,000

QPR ACC 0000001 B HT 200 75000

MOW ACC 0000001 B HT 200 150000

CLE CLE 0000017 B HT 500 13,830

MOM  ACC 0000001 B HT 6.00 150000

QPR ACC 0000001 B HT £.00 130,000

Do CLE 0000017 B HT 300 13,830

CNB HOBE 0000001 oy HT 200 130000

MaC EXP 0000017 E HT

CAR  EEP 0000017 E HT 5000 1.000

MTG AUD 0000026 B HT 500 75000

Do CLE 000002e B HT 4.00 13,830

CAR EXP 0000027 E HT 3500 1.000

CHE HOB 0000027 oy HT 300 0.000

MTG AUD 0000027 B HT 4.00 200,000

CLE CLE 0000027 B HT 4.00 13850

CHE HOE 0000027 N HT 300 0.000

MOH  ACC 0000027 B HT 6.00 150000

MOW ACC 0000027 B HT 200 75000

REPORT TOTAL:

Client 01-ABLEMAN TOTAL:

Engagement 00000000000000000000 TOT AL

1242385

AMOUNT

1,000.00
20.00
180.05
80000
2,500.00
500,00
£00.00
1,200.00
69.25
%00.00
1,040.00
4155
260.00
42,00
50.00
37500
5540
35.00
0.00
800,00
5540
0.00
%00.00
00.00

12,423.85

1242385

I
QO] _reer. [O]E)

Edit Work in Process Register

After the report prints, the following dialog appears.

[ Sage MAS 90 [ <]

Do you want to update the Edit"ork in Process Jourmal?

l)
.y

‘fes

Sage MAS 90 Dialog

5 Click Yes to update the system with the changes. The work in process

transactions are selected.
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The following dialog box appears.

{if Sage MAS 90

¥,  Doyouwant to print a Daily Transaction Fegister?
-

Sage MAS 90 Dialog

6 Click Yes to print the Daily Transaction Register.

If you click No, you can print the Daily Transaction Register at another time.

See the Daily Transaction Register section (see page 177) for more information.

This concludes Chapter 8: Using the Billing Menu of the Time and Billing
Professional manual.
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Using the Reports Menu

Chapter 9: Using the Reports Menu contains instructions on how to print reports
based on the information available in the Time and Billing Professional module.
This module provides a variety of timely, informative reports that help you analyze
work in process and open invoices. In addition to management reports, you can
also produce client listings and mailing labels to improve communication and
service to your clients.

How to Use the Reports Menu

Page 238

The options available in the Reports menu allow your company to print or preview
different reports. You can select the type of data to include in a report and
determine how to sort the report.

Open a Window from the Reports Menu

1 Double-click the Time and Billing Professional module from the Modules tab.
The module expands to display all the menu options available in the Time and
Billing Professional module.

2 Click the Reports menu. The names of the windows available in the menu
appear on the right side of the Sage MAS 90 or 200 window.

Time and Biling Professional - Reparts
5] Up one lewel...

[E]<lient Listing

[E]eneral Ledger Posting Recap
[E=]lient Mailing Labels

[E2]client Memo Printing
[BZ]Client Referral Listing
Emplﬂyea Merno Prinking
[E5]aged Irvaice Report
[E£]a0ed Work in Process Report
[E=]Detail Work in Process Report
[E] Trial Balance Report
[EE]Monthly Biling Report
[EZ1Billng Histary Repart
Reta\ner Transaction Report

Windows Available in the Reports Menu

3 Double-click the name of the window to open. The system displays the selected
window.
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Select Data for a Report

The sections in this manual detail the different types of information you can include
in an individual report. The following steps teaches you how to select the
information from the fields. When you open a Report window it contains fields
similar to the following picture.

(i Aged Work in Process Report E W= B3
Sort Options Clignt Code j
Aging Date 09/07/2005 D Page Break by Sart Option
Detail Option ta Print Detail j D Print &/F Aging |nformation
Aging Dption ta Print Only"/IP 30 Daps Past Duej D Print Engagement Description
Selection All Starting Ending
Client Cade 0o- Q, ey |G,
Engagement Code 2RI EIIEEIZ |
[
[
[
[
[
[
Canon Salss [ Print [ Preview | Printer Setup
Lw2 | 9/7/2005

Aged Work in Process Report Window

1 Select how to sort the report from the drop-down list in the Sort Options field.

2 Select the type of information to include in the report from the remaining fields
on the Report window. For many fields, you can select all records or a range of

information.

For example, in the previous picture you can check All to print all clients, or you
can use the Lookup windows in the Starting and Ending fields and select
specific client codes. If there is a date field available in a Report window and you
want to print information for a particular date, enter the same date in the
Starting and Ending fields.

3 Click the Print button to print the list, or the Preview button to preview the

report.

Client Listing

Use the Client Listing feature to obtain information on clients and engagements
contained in the Client and Engagement Master files. You can choose to print
client and engagement information for all, or a group of clients and engagements.
You can also specify the amount of detail to be printed.

Chapter 9: Using the Reports Menu
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Print the Client Listing

1

From the Reports menu of the Time and Billing Professional module, select
Client Listing. The Client Listing window appears.

{i Client Listing []-[Cx]
Sart Optians Client Code ﬂ
Report Type to Print Complete Clisnt File with Balance Data = [ Print Custom Biling Rates
Clients ko Print Clients Only ﬂ D Frint 5 chedule/Budget |nformation
Frint M emoz
[
Selection All Starting Ending
Client Code 00- G $977zzzzz |Gy
Engagement Cods i
[
[]
[
[]
[
[]
Canon Sales ‘ Frint | Prewview I Frinter Setup...
Lw2 | 9/7/2008

Client Listing Window

2

3

Select how to sort the report from the Sort Options field. You can sort the report
by:

Client Code

Client Name

Sort Field

Zip Code

Client Type

Client Partner

Client Employee
Engagement Partner
Engagement Employee

You can also sort the report by any of the user-defined fields created on the
Time and Billing Professional Options window (see page 80).

Select the type of reports to print from the Report Type to Print field. You can
select:

Complete Client File with Balance Data
Client File without Balance Data

Client Name Listing

Client Name and Address Listing
Client and Engagement Name Listing

If you select Complete Client File with Balance Data or Client File without
Balance Data, the following fields become available:

- Print Custom Billing Rates field
- Print Schedule/Budget Information field

- Print Memos field
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4 Select the type of clients to print from the Clients to Print field. You can select:

Clients Only
Clients and Prospects
Prospects Only

5 Check Print Custom Billing Rates to include clients’ custom billing rates in the
report.
This field is available only if Complete Client File with Balance Data or Client
File without Balance Data is selected in the Report Type to Print field.

I:Jj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

6 Enter the clients to include in the Client Code field.

» Check All to include the information for all clients.

OR
» Enter the client codes to include in the Starting and Ending fields.
7 Enter the client engagements to include in the Engagement Code field.

» Check All to include the information for all engagements.

OR
» Enter the engagement codes to include in the Starting and Ending fields.

8 Enter the names of clients to include in the Client Name field.
This field is available only if Client Name is selected in the Sort Options field.

9 Enter sort data to include in the Sort Field field.
This field is available only if Sort Field is selected in the Sort Options field.

10Enter the clients’ zip code to include in the Zip Code field.
This field is available only if Zip Code is selected in the Sort Options field.

11Enter the types of clients to include in the Client Type field.
This field is available only if Client Type is selected in the Sort Options field.

12Enter the employee partners to include in the Client Partner field.
This field is available only if Client Partner is selected in the Sort Options field.

13Enter the employees to include in the Client Employee field.
This field is available only if Client Employee is selected in the Sort Options

field.

14Enter the employee partners for the engagement to include in the Engagement
Partner field.
This field is available only if Engagement Partner is selected in the Sort
Options field.
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15Enter the employees for the engagement to include in the Engagement

Employee field.

This field is available only if Engagement Employee is selected in the Sort

Options field.

16Enter the miscellaneous data to include in the Miscellaneous field.
This field is available only if one of the user-defined fields created on the Time
and Billing Professional Options window (see page 80) is selected in the Sort

Options field.

17Click Print to print the report, or Preview to preview the report.

The Client Listing report result depends upon the settings selected for the report.
For example, you can create a list of addresses for prospects, or you can create a
detailed report of all current clients that includes the engagements available for
clients and the current billing rates. The following is a Complete Client File with
Balance Data report, sorted by Client Code, and includes custom billing rates,
schedule and budget information, and memos.

(i Client Listing [_ O] <]
CLIENT LETING
SORTED BY Gt OO0
Client CODE 01-ABLEMAN NAME:  ABLE MANUFACTURING
ADDRESS: 9445 EIGHLAND AVE. BILL SEPARATE? ¥
SORT FIELD: ABLE
Clut TYPE: CORP
cITY IRVINE OPEN ITEM?: ¥
STATE: ca ZIPCODE: 92718 STATEMENT CYCLE: M
COUNTRY: PRINT DUN M35G? ¥
TELEPHONE: (714) 5554660 EXT: 8050
CONTACT: MARTIN ABLE
FAX: 714-555-9130
TAX SCHEDULE - STATE: ca CHTY: LoC:
TAX EXEMPT# REFEREED BY. MARTIN AEL
Clnt PARTNER: 0120 B.A WINHUR Industry: MANUFACTURING
Clnt Emply: 0250 JOSEPH WILSOH Acct Soft?: ¥
COMMENT 1 Fear End: 1231
COMMENT 2 Wewslatter: ¥
AGED 45 OF 090705 AR BALANCE: £735.05
CUREENT 30 DAYS &0 DAYS 90 DAYS 120 DAYS
7,908.00- a0 a0 oo 14,643.05
E CODE: 00000000000000000000 DESC:  PROFESSIONAL SERVICES
Engnt PARTHEE: 0120 B.A WINHUR
Engt Emply: 0250 JOSEPH WILSOH
FEE ARRANGEMENT: S STANDARD DATE OPENED: 010157
INCLUDE EXPENSES?. ¥ DATE STARTED: 011587
EILL RATE CODE 7 TaxRet-Corp DATE COMPLETED:
BUDGET HOUES: 5500
STATUS: © OPEN BUDGET AMOUNT 66,299.75
BILL FREQUENCY: M
BILLING FORMAT: A Detail Bill by Date
FEV ACCOUNT:
CMHNT 1: CLEAR EILL TEXT?: H
CMNT 2:
DATE LAST STATEMENT: 053198 HIGHEST BALANCE: 16,683.00 ]
: |
[ 0] == [0) 0] 7

Client Listing

General Ledger Posting Recap

Page 242

The General Ledger Posting Recap provides a detailed report of all time and
billing postings by General Ledger account number. This report was designed for
users who do not have the General Ledger module installed. Printing the report at
the end of each period provides a convenient summary of time and billing
transactions used to post to a manual General Ledger. This report itemizes each
entry and lists the corresponding debit and credit amounts.

Time and Billing Professional Manual
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Print the General Ledger Posting Recap BEFORE processing the period end. The
period end process purges the detailed information for this report. If the Time and
Billing Professional is installed without integrating with General Ledger, the
information is purged during Time and Billing Professional’s period end processing
(see page 328). If Time and Billing Professional is integrated with General Ledger,
the information is purged during General Ledger’s period end processing.

Print a General Ledger Posting Recap

1 From the Reports menu of the Time and Billing Professional module, select
General Ledger Posting Recap. The General Ledger Posting Recap window
appears.

ﬂ*ﬂﬁeneral Ledger Posting Recap {LW2)9,/7/2005
RepoitSeling | STANDARD Q, [save |-]
Description General Ledger Posting Recap
~—Setting Optior
Type Public: j Print Report Settings D Mumber of Copies 1 ﬂ
Default Report Three Hole Punch [
Summarize Postings ] ]
Select Field | Operand | Walue |
Posting Date All j
Canon Sales 4] [ Eint l Preview l Setup

General Ledger Posting Recap Window

2 Enter a report setting, or click the E] button to select from the list of all saved
report settings. The Standard report setting provides a set of default options,
sort criteria, and selection criteria for each report.

3 Enter a description for the output of the report. The description can be up to 40
characters.

4 Check Default Report to set the current report setting as the default report
setting. The default report setting is the first report setting displayed when the
report is accessed.

Clear this check box if you do not want this report setting to be the default. When
a default report setting is not selected, the Report Setting field displays the
Standard report setting.

5 Check Print Report Settings to print the options, sort criteria, and selection
criteria for the selected report setting. This information prints on a separate
cover page when the report is printed.

Clear this check box if you do not want to print the report settings.

6 Check Three Hole Punch to print the report with a larger margin. This allows
enough space for you to three-hole punch the report.

Clear this check box if you do not want a larger margin for this purpose.

7 Select the number of report copies to print. This allows you to print multiple
copies of the report without accessing Printer Setup.
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8 Check the Summarize Postings to view a summary report. The summary
includes the account number and description, debit, credit, and report total.

Clear this check box to include details about each posting such as the date,
reference number, posting remarks, and posting totals.

9 Enter the posting dates to include in the Posting Date field.
10Click Print to print the report, or Preview to preview the report.

The General Ledger Posting Recap displays the account number and description,
debit, credit, and report total. Detailed reports also include the posting date,
reference number, posting remarks, and posting totals.

i Yiew G/L Posting Recap Report [_1o]x]
| % & @iz =] || 1 4 1z »or|| A | ~Erystal e

Preview |
H

GJL Posting Recap Report
Posting Date: All
Time and Billing Professional Demo {(L'W2) [

Zccount Number/Description

Posting Reference
Date Humber Comments Debit Credit

11000 Apsounts Receivable
521888 T2 000001 44,857 .40
Toral Postings: 44,857 40 0.00

11500 Work In Frocess
5217988 T2 000001 43,407 35

S/31M998  TD 000001 2.975.00
5198 TT 000001 TIME/EXPENS E JOURNAL 875.00

Total Postings: 875.00 52,362.95

11600 #ork In Process Offset

S/a1M99 T2 000001 43,407 95
5217988 TD 000001 2.975.00
5217988 TT 000001 TIME/EXPENS E JO URNAL 275.00

Toral Postings: 52,382 85 27500
20700 Sales Tax Payable
521888 T2 000001 273 .40
Toral Postings: 000 279 40
220400 Deferred Revenue
521888 T2 000001 4,000 00
Toml Postings: ~ gan 400000
40001 Aecounting Fees

S/a1M99 T2 000001 15.071.18
Total Postings: 0.00 1507118

40101 Audit Fees

53101998 T2 000001 4.900.00
Tokal Postings - 0.00 4,300 00

General Ledger Posting Recap Report

Client Mailing Labels

Page 244

Use the Client Mailing Labels feature to print client information on labels. You can
align the data to fit each label and specify the arrangement of labels on your label
sheets. You can also choose to print multiple labels for each client.

The Client Mailing Labels window does include the Sage MAS 90 or 200 Form
button. The Sage MAS 90 or 200 Forms file contains the standard default format
for Client Mailing Labels. You can modify this format or create new formats using
the Forms Customization feature. Using the many customizing options, you can
create almost any type of format for printing customer information on a variety of
forms.

For example, you can print one type of label for correspondence and a different
type of label to be used on file folders or other internal records. You can also
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create formats to accommodate Rolodex" cards, envelopes, or even personalized
business letterhead. In addition to names and addresses, you can print any
information contained in the Customer Masterfile, including phone numbers,
contacts, reference numbers, and receivable balances.

Print Client Mailing Labels

1 From the Reports menu of the Time and Billing Professional module, select
Client Mailing Labels. The Client Mailing Labels window appears.

ﬂ-ﬁtlient Mailing Labels

Sart Options Client Code ﬂ

[ Client Type ta Frint Clierts Only ﬂ } Tabto 1)
Mo. of Labels ficross Page 1
Label Form Code 3 % STANDARD LaBELS Spaces Between Labels 0
Mo. of Labels Per Client 1
Selection All Starting Ending
Clierkt Code - Q 997777777 |G,
|
Ll
|
Ll
|

Canon Sales [ FBrint I Prexvigw I Frinter Setup... @

\ Lwz | 97/2005
Client Mailing Labels Window

2 Select how to sort the report from the Sort Options field. You can sort the report
by:
Client Code
Client Name
Sort Field
Zip Code
Client Type
Client Partner
Client Employee

You can also sort the report by any of the user-defined fields created on the
Time and Billing Professional Options window (see page 80).

3 Select the type of clients to print from the Clients to Print field. You can select:

Clients Only
Clients and Prospects
Prospects Only

4 Select the form to use for printing from the Form Code field.

5 You can modify an existing format or create new formats using the Sage MAS 90
or 200 Forms Customization feature. To access this feature, click the

button.
See your Library Master Online Help by Sage Software for more information
about this feature.
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6 Enter the number of tabs for the application to tab to the next label in the Tab to
field.

7 Enter the number of labels available across one page in the No. Labels Across
Page field.

8 Enter the number of spaces the application will set between labels in the
Spaces Between Labels field.

9 Enter the number of labels to print for each client in the No. Labels Per Client
field.

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

10Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR
» Enter the client codes to include in the Starting and Ending fields.

11Enter the names of clients to include in the Client Name field.
This field is available only if Client Name is selected in the Sort Options field.

12Enter sort data to include in the Sort Field field.
This field is available only if Sort Field is selected in the Sort Options field.

13Enter the clients’ zip code to include in the Zip Code field.
This field is available only if Zip Code is selected in the Sort Options field.

14Enter the types of clients to include in the Client Type field.
This field is available only if Client Type is selected in the Sort Options field.

15Enter the employee partners in the Client Partner field. This field limits the
clients being printed to the ones by the selected employees contact.
This field is available only if Client Partner is selected in the Sort Options field.

16Enter the employees in the Client Employee field. This field limits the clients
being printed to the ones by the selected employees contact.
This field is available only if Client Employee is selected in the Sort Options
field.

17Enter the miscellaneous data to include in the Miscellaneous field.
This field is available only if one of the user-defined fields created on the Time
and Billing Professional Options window (see page 80) is selected in the Sort
Options field.

18Click Print to print the report, or Preview to preview the report.
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The number and format of the labels depends upon the settings you selected on
the Client Mailing Labels window. The following is an example of mailing labels
based on a particular employee’s client list printing on Form A labels.

[ Client Mailing Labels =] 3

ABELE MANUFACTURING j
9445 HIGHLAMD AVE.
IRVINE Ch

92713

ACHME WELDING COMPANY
55 W. S55th Avenue
Young America m
55555

EDWARD AND SU3IAN ALEXANDER
12392 RAINTREE CIRCLE
ORANGE CA

SZE65

CANYON RIDGE APARTMENTS
1427 EL CAJON BLVD.
SUITE 101

EL CALJON Ch
91556
EDWARDION ELECTRIC COMPANY
3545 HOWARD WAY

CO3TL MESL Ch
QZ626

GEMERATION/Z COMPUTER DIST.
G800 IRVINE CENTER DRIVE

IRVINE cL
32715
M|
[Ein =
(@@ rae1 JO[@)

Client Mailing Labels

Client Memo Printing

Use the Client Memo Printing option to print any memos containing information
pertinent to specific clients or engagements. These memos can contain recaps of
client correspondence or specific instructions regarding the handling of individual
engagements. Print this information before processing period-end data.

Print Client Memos

1 From the Reports menu of the Time and Billing Professional module, select
Client Memo Printing. The Client Memo Printing window appears.

Ei Client Memo Printing E EE E3
Frint Mema Detail Frint Prospect Clients No ﬂ
[] Page Break by Memo
Selection All Starting Ending
Cliertt Code: - Q, Ty (G
Engagement Cods i
Mema Code g
Mema Date 1273142939
Reminder Date: 12/31/2359
Canan Sales [ Frint | Fieview | PFrinter Setup...

[ Lw2 | 9/7/2005

Client Memo Printing Window

2 Check Print Memo Detail to include the actual memo text in the report.
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3 Check Page Break by Memo to print each memo on a separate page.

4 Select whether or not to include prospective clients’ memos from the Print
Prospect Clients field. You can select:

Yes
No
Prospects Only

I:gj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

5 Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR
 Enter the client codes to include in the Starting and Ending fields.
6 Enter the client engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.
7 Enter the memos to include in the Memo Code field.
* Check All to include the information for all memos.
OR
» Enter the memo codes to include in the Starting and Ending fields.
8 Enter the start dates of the memos to include in the Memo Date field.
» Check All to include the information for all start dates.
OR
+ Enter the start dates to include in the Starting and Ending fields.
9 Enter the reminder dates of the memos to include in the Reminder Date field.
» Check All to include the information for all reminder dates.
OR
» Enter the reminder dates to include in the Starting and Ending fields.

10Click Print to print the report, or Preview to preview the report.
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The amount of information printed depends upon the settings you selected on the
Client Memo Printing window. Each memo includes a Header section, a Memo
Code, Subject Description, Memo Date, and Reminder Date. The following is an
example of a report with the full memo details.

& Client Memo Printing =]

Time and Billing P

Client Mema Printing
DETAIL OPTION

Client CODE:  D1-ABLEMAN MAME: ABLE MANUFACTURING
Engagement CODE:  00000000000000000000 DESC: PROFESEIOMAL SERVICER
MEMO:  MAS APPT FINANCIAL PLANNING CONFERENCE 05/10/98 REMIND: 06/10/98

Martin Able has an appointment with B. A, Winnur and Joseph Wilson to discuss
financial planning for 1996, Current financial statements and prelitninary
budget plans should be prepared for this meeting.

There will be a staff meeting on June 15, 1995 at 10:00 A M. in my office to
discuss all issues relating to Mr. Able's concerns. Mr. Able will be at our
offices at 200 P.M.

MEMO: MISC NOTES MISCELLANEOUS NOTES 05/01/98 REMIND: 05/31/98
Mr. Martin Able requires that we contact him personally regarding any

financial questions. Mo other personnel at Able Manufacturing may be
contacted without specific avthorization from Mr. Able.

|
i | o
5 (51 =2 [C) (5]

Client Memo Printing

Client Referral Listing

Use the Client Referral Listing to obtain a listing of clients in order by referral
source for a range of referrals. A referral can be a person's name or the client code
associated with one of your existing clients. This report is particularly useful for
analyzing the status of prospective clients by referral source.

Print the Client Referral Listing

1 From the Reports menu of the Time and Billing Professional module, select
Client Referral Listing. The Client Referral Listing window appears.

{i Client Referral Listing [ 74 -1C]
Clients to Print Clients Only = Frint Referal Detail
Selection All Starting Ending
Referral Code - Q, [ lie
Referral Hame
Canon Sales [ Frint | Prewview | Frinter Setup...
[ DCD | Lw2 | 9/7/2008

Client Referral Listing Window

2 Select the type of clients to print from the Clients to Print field. You can select:

Clients Only
Clients and Prospects
Prospects Only
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3 Check Print Referral Detail to include the actual contact and company being
referred.

4 Enter the referral clients to include in the Referral Code field.
» Check All to include the information for all referral clients codes.
OR

» Enter the referral clients codes to include in the Starting and Ending fields.

I:Jj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

5 Enter the name of the person that referred the information in the Referral Name
field.

+ Check All to include the information for all referral clients.
OR
» Enter the referral clients to include in the Starting and Ending fields.
6 Click Print to print the report, or Preview to preview the report.

The amount of information printed depends upon the settings you selected on the
Client Referral Listing window. The following is an example of a report with the full
referral details.

[ Client Referral Listing =]
Time and Biling P

CLIENT REFERRAL LISTING

Client DATE FHONE

CODE NAME OPENED CONTACT NAME NUMBER

REFERRED BEY: ANDREA MIL CD (619) 555-7644

01-HIDDBEA HIDDEN BEACH HOTEL 010198 ANDREA MIL (619) 555-7644

REFERRED BY: CONNIE LAM CD (619) 555-9912

01-CANRIDG  CANYON RIDGE APARTMENTS 01/01/98 CONNIE LAM (619) 555-9912

REFERRED BY: EDWARD ALE CD (714) 555-9177

01-ALEXEDW EDWARD AND SUSAN ALEXANDE 01/01/98 EDWARD ALE (714) 555-9177

REFERRED BY: JERRY THOM CD: (714) 555-0131

01-GENECOM  GENERATION/2 COMPUTER DIS L1/oL/e7 JERRY THOM (714) 555-0131

REFERRED BY: LARRY FINE CDr (818) 555-1731

01-HOWARD HOWARD, FINE, & HOWARD, D 01/01/9% LARRY FINE (818) 555-1731

il | o
Client Referral Listing
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Employee Memo Printing

Use the Employee Memo Printing feature to print any memos containing
information pertinent to specific employees.

For example, these memos can contain reminder notes, recaps of
correspondence, and special instructions related to the employee.

Print Employee Memos

1 From the Reports menu of the Time and Billing Professional module, select
Employee Memo Printing. The Employee Memo Printing window appears.

Ei Employee Memo Printing [z _[C]x]

Frint Mema Detail
[] Page Ereak by Memo

Selection

&

Starting Ending

Q, zZzz |Q,
12/31/2999
12/31/2999

Canan Sales [ Frint Prexiew | Frinter Setup...
| Lwz | 9/7/2008

Employee Memo Printing Window

Employee Code
temo Code

Memo Date

HEEE

Reminder Date:

2 Check Print Memo Detail to include the actual memo text in the report.

3 Check Page Break by Memo to print each memo on a separate page.

I:gj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

4 Enter the employees to include in the Employee Code field.
» Check All to include the information for all employees.
OR
» Enter the employee codes to include in the Starting and Ending fields.
5 Enter the memos to include in the Memo Code field.
» Check All to include the information for all memos.
OR

» Enter the memo codes to include in the Starting and Ending fields.
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6 Enter the start dates of the memos to include in the Memo Date field.

» Check All to include the information for all start dates.

OR
» Enter the start dates to include in the Starting and Ending fields.
7 Enter the reminder dates of the memos to include in the Reminder Date field.

* Check All to include the information for all reminder dates.

OR
» Enter the reminder dates to include in the Starting and Ending fields.
8 Click Print to print the report, or Preview to preview the report.

The amount of information printed depends upon the settings you selected on the
Employee Memo Printing window. Each memo includes a Header section, a
Memo Code, Subject Description, Memo Date, and Reminder Date. The following
is an example of a report with the full memo details.

i Employee Memo Printing H[=]

Time and Billing P nal Demo

Ermployee Memo Printing
DETAIL OPTION

Employee CODE: 0100 MNAME: IMA WINNUR
MEMO:  MAE 90 MAS 90 PRODUCT TRAINING 05/10/98 REMIND: 06/01/98

Lisa McCarthy with State Of The Att, Inc. called today to confirm that Ima
Winnur and Rachel Scott are registered for the June 14th, 5 day, Product
Traiting Module

All hotel reservations have been made. Lisa said transportation to and from
the seminar is included. Lunch will be provided by State Of The Ast.

A Training Manval and Case Study diskettes will be provided. No other
matetials will be needed.

MEMO:  VACATION VACATION 05/27/98 REMIND:

Imais scheduled for vacation August 3rd - August 10th. Please do not
schedule any appointments for her during this weel.

Employee CODE: 0110 MNAME: DREW LEEDER
MEMO: AICPA CONF AICPA CONFERENCE SPEECH 05/01/98 REMIND: 15/31/98

Mr. Leeder will be a keynote speaker for the AICPA Conference in Los Angeles
on June 15, 199 draft cow ofimle neech must be submitted to the AICE, ]

[0 == 1[0

Employee Memo Printing

Aged Invoice Report

Use the Aged Invoice Report feature to obtain a detailed list of invoices by client
and/or engagement. Using this report, you can obtain a concise overview of
outstanding receivable balances, which is useful for managing collections.
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Print the Aged Invoice Report

1 From the Reports menu of the Time and Billing Professional module, select
Aged Invoice Report. The Aged Invoice Report window appears.

{i /2 Aged Invoice Report

Sort Oplions Cliert Partrer ﬂ D Page Break by Sort Option
Aging Date 09/07 /2005 D Include Paid Invoices
Detail Option to Print |rivoice ﬂ D Print ‘P Aging Infoimation
Aging Option to Print All Open Invaices j Exclude Future Transactions
Include A/R Invoices
Selection All Starting Ending
Client Code - Q, 9 zzzzzzz |G
Engagement Code e
L
L
L
Client Partner O oo |@ moo |G
L
Canion Sales Frint. Preview I Printer Setup.

[ Lw2 | 9/7/2005

T/2 Aged Invoice Report Window

2 Select how to sort the report from the Sort Options field. You can sort the report
by:
Client Code
Client Name
Sort Field
Zip Code
Client Type
Client Partner
Client Employee

You can also sort the report by any of the user-defined fields created on the
Time and Billing Professional Options window (see page 80).

3 Check Page Break by Sort Option to print each invoice data on a separate
page.

4 Enter the date the invoice was aged using the MM/DD/YY format in the Aging
Date field.

5 Select the amount of information to print from the Detail Option to Print field.
» The Invoice option prints the invoice.
» The Detail option prints detailed information about each item on the invoice.

+ The Summary option prints the summary of each item on the invoice.
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6 Select the types of invoices to include from the Aging Option to Print field.
Options include:

All Open Invoices

Only Invoices 30 Days Past Due
Only Invoices 60 Days Past Due
Only Invoices 90 Days Past Due
Only Invoices 120 Days Past Due

7 Check Include Paid Invoices to include invoices that were paid in the report.

8 Check Print WIP Aging Information to include work in process information in
the report.

9 Check Exclude Future Transactions to exclude future work for the client from
the report.

10Check Include A/R Invoices to include Accounts Receivable invoices in the
report.

I:Jj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

11Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR
 Enter the client codes to include in the Starting and Ending fields.

12Enter the names of clients to include in the Client Name field.
This field is available only if Client Name is selected in the Sort Options field.

13Enter sort data to include in the Sort Field field.
This field is available only if Sort Field is selected in the Sort Options field.

14Enter the clients’ zip code to include in the Zip Code field.
This field is available only if Zip Code is selected in the Sort Options field.

15Enter the types of clients to include in the Client Type field.
This field is available only if Client Type is selected in the Sort Options field.

16Enter the employee partners in the Client Partner field. This field limits the
invoices being printed to the ones by the selected employee partner.
This field is available only if Client Partner is selected in the Sort Options field.

17Enter the employees in the Client Employee field. This field limits the invoices
being printed to the ones by the selected employee contact.
This field is available only if Client Employee is selected in the Sort Options
field.
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18Enter the miscellaneous data to include in the Miscellaneous field.
This field is available only if one of the user-defined fields created on the Time
and Billing Professional Options window (see page 80) is selected in the Sort
Options field.

19Click Print to print the report, or Preview to preview the report.

The amount of details that prints depends upon the settings you selected on the
Aged Invoice Report window. The following is an example of a report based on
open invoices, including Accounts Receivable invoices, but excluding invoices for
future transactions.

% Time and Billing Professional Aged Invoice Report
Time and Billing
TIME AND BILLING PROFESSIONAL AGED INWDICE REPORT
T/2 CLIENT INVOICES - AGED AS OF: D907/05
SORTED BY Client PARTMER
INWOICENO  IHW DISC DIECOUHT DAaYE
ENGAGEMENT IHVDATE ‘*=ARINV DUE DUE AMOUNT BALMHCE CURRENT 30 DAYS 60 DAYS 0 DAYS 120 DAYS DELQ
Cliszrt PARTHER: 0100 A WRNHUR
01-EDWAFLE EDWARDSOH ELECTRIC CONP ANV CONTACT: MEREDITH ANDREWS PHOHE: (714)555-0111
043008 APRDOD1FC 0430 0430 oo 250 250
0000000 0000000000000 020705 0000073 IH 0807 oo 401694 401694
4LL CODES 0471598 0000046 TH 04715 04715 oo 4000 4000
ALL Bugngement CODES 051598 0000061 TH  0&15 0515 oo 220000 220000
Clisre 01-EDWAELE TOTALS: TOE194 TOE194 o0 o0 o0 oo
01-GENECOM  GENERATION/2Z COMPUTER DIST. CONTACT: TERRY THOMAS PHONE: (7145550131
0271598 0000017 TH 015 02715 oo 272500 2500
0371598 0000030 TH 03715 03715 ) 4660 00 4660 00
033198 MARMOIFC 0331 0331 oo 4058 4058
043008 APRDOD FC 0430 04730 oo 3000 3000
ALL Bugmzement CODES 0471598 0000047 TH  04/15 0415 oo 473300 473300
ALL Bugngement CODES 051598 0000039 TH  0X15 0515 oo TR50.00 TR50.00
ALL Engnzement CODES 090705 0000074 TH 0907 o 627000 627000
Clisre 01- GENEC O TOTALS: 2686058 2686058 o0 o0 o0 oo
O1-MASTMIC — MASTER MICRO MAHUFACTURDNG CONTACT: PHONE: (7145558800
00000000000000000000 090705 0000077 TH 0907 ) 1193200 1193200
Clisre 01-MASTMIC TOTALS 1193300 1193300 o0 o0 o0 oo
01-5CHWPES  SCHWARZEOPF PEST EXTERMHATORS CONTACT: MORMAH PHONE: (714 555-2036
043098 APRO0OOT FC - 0430 0430 o 1000
0000000 0000000000000 020705 00000E0 IH 0807 oo 228046 228046
4LL los) 0471598 0000054 TH  04/15 04715 oo 720000 720000
ALL Bugngement CODES 051598 0000066 TH  0X15 0515 oo 236300 236300
Cliert 01-8CHWPES TOTALS: 1885546 1885546 n n oo o j
TR
5[0 == [C) 0]

Time and Billing Professional Aged Invoice Report

Aged Work in Process Report
Use the Aged Work in Process Report feature to obtain an overview of work in

process balances by client and/or engagement. You can also choose to print aged
Accounts Receivable information for each client.

Print the Aged Work in Process Report
1 From the Reports menu of the Time and Billing Professional module, select

Aged Work in Process Report. The Aged Work in Process Report window
appears.

Chapter 9: Using the Reports Menu Time and Billing Professional Manual Page 255



Chapter 9

[ Aged Work in Process Report EH M= B
Sort Optiohs Client Code hdl
Aging Date 03/07 /2005 |:| Page Break by Sort Option
Detail Option to Print Detail hdl [] Frint &/R Aging Information
Aging Optiar to Print Only "wIP 30 Days Past Dueﬂ |:| Print Engagement D escription
Selection All Starting Ending
Cliert Code - Q, Wy (G
Engagement Code i b
[
[
[
[
[
[
Canon Sales [ PBrint [ Previen | Pinter Setup
I Lwz | a/7/2008

Aged Work in Process Report Window

2 Select how to sort the report from the Sort Options field. You can sort the report
by:
Client Code
Client Name
Sort Field
Zip Code
Client Type
Client Partner
Client Employee

You can also sort the report by any of the user-defined fields created on the
Time and Billing Professional Options window (see page 80).

3 Enter the date the transaction was aged using the MM/DD/YY format in the
Aging Date field.

4 Select the amount of information to print from the Detail Option to Print field.

» The Detail option prints detailed information about each item on the work in
process transaction.

+ The Summary option prints the summary of each item on the transaction.

5 Select the types of transactions to include from the Aging Option to Print field.
Options include:
All WIP
Only WIP 30 Days Past Due
Only WIP 60 Days Past Due
Only WIP 90 Days Past Due
Only WIP 120 Days Past Due

6 Check Page Break by Sort Option to print each transaction on a separate
page.

Page 256 Time and Billing Professional Manual Chapter 9: Using the Reports Menu



Chapter 9

7 Check Print A/IR Aging Information to include Accounts Receivable work in
process data in the report.

8 Check Print Engagement Description to include a description of the
engagement the work in process is included in.

I:Jj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

9 Enter the clients to include in the Client Code field.
+ Check All to include the information for all clients.
OR
» Enter the client codes to include in the Starting and Ending fields.
10Enter the engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.

11Enter the names of clients to include in the Client Name field.
This field is available only if Client Name is selected in the Sort Options field.

12Enter sort data to include in the Sort Field field.
This field is available only if Sort Field is selected in the Sort Options field.

13Enter the clients’ zip code to include in the Zip Code field.
This field is available only if Zip Code is selected in the Sort Options field.

14Enter the types of clients to include in the Client Type field.
This field is available only if Client Type is selected in the Sort Options field.

15Enter the employee partners in the Client Partner field. This field limits the
transactions being printed to the ones by the selected employee partner.
This field is available only if Client Partner is selected in the Sort Options field.

16Enter the employees in the Client Employee field. This field limits the
transactions being printed to the ones by the selected employee contact.
This field is available only if Client Employee is selected in the Sort Options
field.

17Enter the engagement partners in the Engagement Partner field. This field
limits the transactions being printed to the ones by the selected engagement
partner.
This field is available only if Engagement Partner is selected in the Sort
Options field.
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18Enter the engagement employees in the Engagement Employee field. This
field limits the transactions being printed to the ones by the selected employee.
This field is available only if Engagement Employee is selected in the Sort
Options field.

19Enter the miscellaneous data to include in the Miscellaneous field.
This field is available only if one of the user-defined fields created on the Time
and Billing Professional Options window (see page 80) is selected in the Sort
Options field.

20Click Print to print the report, or Preview to preview the report.

The amount of details that prints depends upon the settings you selected on the
Aged Work in Process Report window. The following is an example of a report
based on all work in process transactions, excluding Accounts Receivable
transactions.

{ Aged Work in Process Report [_ O]
Time and Billing Pr
AGED WORK IN PROCESS REFORT
ONLY WIP 30 DAYS PAST DUE - AGED AS OF: DG07/05
SORTED BY Chent CODE
Client RETAINER
Engagement BALANCE BALANCE CUREENT 30 DAYS 60 DAYS 90 DAYS 120 DAYS
0-ACME  ACME WELDING COMPANT CONTACT: JANE SMITH
00000000000000000000 0.00 81500 0.00 0.00 0.00 1500
Client 01-ACME TOTALS 0.00 815,00 0.00 0.00 0.00 81500
01-REEDADY REED ADVERTISING CONTACT: RUSS REED (818) 535-6614
00000000000000000000 0.00 22,048.50 0.00 0.00 0.00 22,048.50
Client 01-REEDADY TOTALS 0.00 22,048.50 0.00 0.00 0.00 22,04%.50
REPOET TOTALS 0.00 22,863.50 0.00 0.00 0.00 22,863.50
s |
5[0 == [C) 0]

Aged Work in Process Report

Detail Work in Process Report

Page 258

Use the Detail Work in Process Report feature to obtain a detailed listing of all
unbilled time/expense entries. You can choose to print the aged work in process
balance for each client/engagement, and you can include the aged Accounts
Receivable balance for each client. You can also choose to print extended
comments for each entry.

Print the Detail Work in Process Report
1 From the Reports menu of the Time and Billing Professional module, select

Detail Work in Process Report. The Detail Work in Process Report window
appears.
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ff Detail Work in Process Report EH M= B
Sort Options Cliert Code dl
Print Detail by Date - [] Print MonBillable Lines
Page Bieak by Sort Optian ] [] Print Extended Comments
|:| Print "WIP Aging Information
|:| Print &/8 Aging Information
Selection All Starting Ending
Cliert Code - Q, werrrr |G
Engagement Code ) e
Time/E spense Date 12/31/29593
Time/E spense Employes % v %
[
[
[
[
Canon Sales [ FPriet I Preview I Printer Setup.

I Lwz | a/7/2008

Detail Work in Process Report Window

2 Select how to sort the report from the Sort Options field. You can sort the report
by:
Client Code
Client Name
Sort Field
Zip Code
Client Type
Client Partner
Client Employee.

You can also sort the report by any of the user-defined fields created on the
Time and Billing Professional Options window (see page 80).

3 Select how to print the detail by from the Print Detail by field. You can select:

Date
Category
Employee
No Detail

4 Check Page Break by Sort Option to print each transaction on a separate
page.

5 Check Print Non-Billable Lines to include transactions that are not billable.
This option is NOT available if No Detail is selected in the Print Details by field.

6 Check Print Extended Comments to include the extended comments for
transaction lines.

This option is NOT available if No Detail is selected in the Print Details by field.

7 Check Print WIP Aging Information to include aged work in process
transactions in the report.
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8 Check Print A/R Aging Information to include aged Accounts Receivable work
in process data in the report.

9 Check Print Engagement Description to include a description of the
engagement the work in process is included in.

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

10Enter the clients to include in the Client Code field.
+ Check All to include the information for all clients.
OR
» Enter the client codes to include in the Starting and Ending fields.
11Enter the engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.
12Enter the time/expense transaction date in the Time/Expense Date field.
» Check All to include the information for all transaction dates.
OR
+ Enter the transaction dates to include in the Starting and Ending fields.

13Enter the employee involved in the time/expense transaction in the
Time/Expense Employee field.

» Check All to include the information for all employees.
OR
» Enter the employee codes to include in the Starting and Ending fields.

14Enter the names of clients to include in the Client Name field.
This field is available only if Client Name is selected in the Sort Options field.

15Enter the employee partners in the Client Partner field. This field limits the
transactions being printed to the ones by the selected employee partner.
This field is available only if Client Partner is selected in the Sort Options field.

16Enter the employees in the Client Employee field. This field limits the
transactions being printed to the ones by the selected employee contact.
This field is available only if Client Employee is selected in the Sort Options
field.

Time and Billing Professional Manual Chapter 9: Using the Reports Menu



partner.

Chapter 9

17Enter the engagement partners in the Engagement Partner field. This field
limits the transactions being printed to the ones by the selected engagement

This field is available only if Engagement Partner is selected in the Sort

Options field.

18Enter the engagement employees in the Engagement Employee field. This
field limits the transactions being printed to the ones by the selected employee.
This field is available only if Engagement Employee is selected in the Sort

Options field.

19Enter the miscellaneous data to include in the Miscellaneous field.
This field is available only if one of the user-defined fields created on the Time
and Billing Professional Options window (see page 80) is selected in the Sort

Options field.

20Click Print to print the report, or Preview to preview the report.

The amount of details that prints depends upon the settings you selected on the
Detail Work in Process Report window. The following is an example of a report
based on all work in process transactions, with extended comments for the

transactions.

{k Detail Work in Process Report M=l E3
Time
DETAIL WORK IN PROCESS REFORT
SORTED BY Chent CODE - DETAIL BY DATE
ET
DATE  Emply NAME CATEG W.C. DESCRIFTION TX COMMENT HOUES RATE AMOUNT
Client CODE 01-ACME ACME WELDING COMPANY

Engagement CODE 00000000000000000000 NETWORKING SERVICES STANDARD
090705 0280 DOET. EXP CAR AUTO EXPENSES E NT AUTO EXPENSES 35.00
090705 0280 DOET. NET HPA HIPPACOMPLIANCES B NT Review of the network server™ £50 120000 780,00

Engagement 00000000000000000000 TOTALS: 650 815,00

Client 01-ACME TOTALS 650 815,00

Client CODE 01-REEDADY REED ADVERTISING
E CODE: 00000000000000000000 PROFESSIONAL SERVICES PROGRESS PROGEESS EILL BALANCE: 18000.00
011058 0190 GREENBERGJ EXF CAR AUTO EXPENSES E NT AUTO EXPENSES 20.00
01058 0190 GREEMEERGJ ACC CNF CLIENT CONFERENCES B NT CLIENT CONFERENCES 200 100000 20000
011058 0190 GREEMEERGJ ACC FYE FISCAL YEAREND WO B NT PROFESSIONAL SERVICES RENDER™* 1500 100000 150000
011058 0190 GREENBERGJ ACC MON MONTHLY ACCOUNTING B NT MONTHLY ACCOUNTING SERVICES 1000 100000 1000.00
011258 0180 MUELLERF ACC MON MONTHLY ACCOUNTING B NT MONTHLY ACCOUNTING SERVICES 1000 75000 75000
011758 0150 CLARKE. CLE CLR CLERICAL SERVICES B NT CLERICAL SERVICES 300 30,000 90.00
012458 0180 MUELLERF ACC ATE  ADJUSTING ENTRIES B NT ADJUSTING ENTRIES 500 75,000 375.00
0211558 0170 WELLSE. ACC MON MONTHLY ACCOUNTING B NT MONTHLY ACCOUNTING SERVICES 1500 75000 112500
022758 0210 REYNOLDS B. MIC ONS OMN-SITE SUPPORT SE B NT ON-SITE SUPPORT SERVICES 400 100000 40000
022758 0230 BERGERY. CLE CLE CLERICAL SERVICES B NT CLERICAL SERVICES 7.00 30,000 21000
022758 0230 BERGERY. CLE DOC DOCUMENT PREPARATI E NT DOCUMENT PREPARATION 300 30,000 90.00
035058 0120 WINNURE. TEP COR TAX PREPARATION - B NT PROFESSIONAL SERVICES RENDER™* 000 170000 3400.00
0365058 0130 SCOTTE. MIC TEL TELEFHONESUFPORT B NT MICROCOMPUTER CONSULTINGSER*  £00 125000 1000.00
035058 0150 CLARKE. CLE CLR CLERICAL SERVICES B NT CLERICAL SERVICES £00 30,000 24000 -
[ r
[ == [0 () 22

Detail Work in Process Report

Trial Balance Report

Use the Trial Balance Report feature to obtain a complete recap of Time and
Billing Professional invoices detailing all receipts, adjustments, or write-offs that
affect the receivable balances during a specified period.

You can select a range of client/engagement codes to be included on the report. In
addition, you can choose to include all invoices on file, or select either open or
paid invoices. You can choose to print the transaction information in detail or

summary format.

Chapter 9: Using the Reports Menu
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Print the Trial Balance Report

1 From the Reports menu of the Time and Billing Professional module, select
Trial Balance Report. The T/2 Trial Balance Report window appears.

ﬂ*ﬁT;’Z Trial Balance Report H BE B
Print Trial Balance as Of | 03/07/2005 Print Tramsaction D etail
Invoices ta Frint Open =/ Include A¢F Invaices
Selection All Starting Ending
Cliert Code o Q, fliErrrrrrd] SN
Engagement Cade e T |
Canon Salss [ Print I Preview I Printer Setup..

[ Lw2 | 9/7/2005

T/2 Trial Balance Report Window

2 Enter the last date to print on the trial balance report in the Print Trial Balance
As Of field.

3 Select the invoices to print on the report from the Invoices to Print field. You
can select:
Open
Paid
All

4 Check Print Transaction Detail to print the details of each transaction.

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

5 Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR
» Enter the client codes to include in the Starting and Ending fields.
6 Enter the engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.

7 Click Print to print the report, or Preview to preview the report.
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The amount of details that prints depends upon the settings you selected on the
Trial Balance window.

(i Time and Billing Professional Trial Balance Report
Time and Billing Prt
TIME AND BILLING PROFESSIONAL TRIAL BALANCE REFORT
ALL OPEN INVOICES
DIVISION HO: 01
Clisnt/ INVOICE HO DATES INVOICE  DISCOUNT IHVOICE TRANSACTION CK.NO.  DEPOSIT
Engagement #=ARINV  INVOICE DUE DSCHT AMOUNT  AMOUNT BALANCE TYPE DATE AMOUNT  TYFE DATE
ABLEMAN  AELE MANUFACTURING
0000D0000DO0DO0000O0 0000027 IN 03558 0315 03115 8,683.00 oo 168300 INV 033198 8,683.00
PMT 0412755 2,00000- 10633 0412798
PMT 050398 500000- 10442 0503598
00000000000000000000 0000042 IH 0441558 04115 04/15 7,900.00 oo 8.00- INV 0473098 7,900.00
CM 053158 7,90800-  REFENC: 0000001
00000000000000000000 0000058 IM OSASPE 0SS 0515 506005 oo 506005 INV 0553198 506005
Engmt 00000000000000000000 TOTALS 21,643.05 oo £735.05 £,735.05
Cliznt AELEMAN TOTALS: 21,643.05 oo £735.05 673505
ALEXEDW  EDWARD AND SUSAN ALEXANDER
ALL Engagement CODES 0000059 IN OS/1SP8 0S5 05/ 24500 oo 44500 INV 053198 24500
AFE309SEF O4/3088 04130 0430 £35.00- oo £3500- BF 0413088 £35.00-
Client ALEXEDW TOTALS: 190.00- oo 190.00- 190.00-
CANRIDG ~ CANYON RIDGE AFARTMENTS
ALL Engagement CODES 0000050 IN OS/SP8 0SS 0515 20000 oo 40000 INV 053198 20000
0000D0000DO0DO000000 0000072 IN 0SM705 097 3,175.00 oo 317500 INV 053188 3,175.00
| |
) ) == [O1[C) y
4

Time and Billing Professional Trial Balance Report

Monthly Billing Report

Use the Monthly Billing Report feature to obtain a recap of all billing activities for
the period recorded through the Time and Billing Professional module. All invoices
recorded through Billing Data Entry (see page 191) appear on this report.

Print the Monthly Billing Report

1 From the Reports menu of the Time and Billing Professional module, select
Monthly Billing Report. The T/2 Monthly Billing Report window appears.

{5 1/2 Monthly Billing Report

Sort Options Customer Nurber |

Period 05 05/01/98 Thiu 05/31/98

Frirt Irrvoice Detai

Selection All Starting Ending

Client Code 0o- Q, WZzzzrrz |G,

Canon Sales [ Print Preview | Frinter Setup...

[ Lw2 | 9/7/2005

T/2 Monthly Billing Report Window

2 Select how to sort the report from the Sort Options field.
You can sort the report by Customer Number or Invoice Number.

3 Check Print Invoice Detail to print each individual transaction on the report.
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I:Jj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

4 Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR
 Enter the client codes to include in the Starting and Ending fields.

5 Enter the invoices to include in the Invoice Code field.
This field is available only if Invoice Number is selected in the Sort Options
field.

6 Click Print to print the report, or Preview to preview the report.

The amount of details that prints depends upon the settings you selected on the
Monthly Billing Report window. The following is an example of a report based on
transactions by customer number, with the details of each transaction.

(i Monthly Billing Report M=l E3
Time and Biling P
MONTHLY BILLING REPORT
PERIOD: 05 0%01/98 Thru 02°31/98

DIVIZION NO: 01
CUSTOMER/ DATES TRANSACTION
INVOICE NO. INVOICE DUE DSCNT TYFE DATE AMOUNT
ABLEMAMN ABLE MANUFACTURING

onooo42 04/15/33 04/15 04/15 C/M 05/31/98 7,908.00-

0000058 05/15/33 0515 05/15 INWV 05/31/98 5,060.05

CUSTOMER ABLEMAN TOTALS 2,847.95-

ALEEEDW EDWARD AND SUSAN ALEXANDER

0000059 05/15/33 0515 05/15 INWV 05/31/98 445.00

CUSTOMER ALEXEDW TOTALS: 445.00

CANRIDG CANYON RIDGE APARTMENTS

00000&0 05/15/33 0515 05/15 INWV 05/31/98 400.00

Onooo72 09/07/05 08/07 INWV 05/31/98 3,175.00

M
_ =l
%

Monthly Billing Report

Billing History Report

Page 264

Use the Billing History Report feature to obtain a recap of all billing information
recorded through the Billing Register update (see page 219). The client code and
name, engagement code, work in process total, write-up/downs, and billed fees
and expenses appear for each invoice. You can also include line item detail
information for each invoice.
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Print the Billing History Report

1 From the Reports menu of the Time and Billing Professional module, select
Billing History Report. The Billing History Report window appears.

ﬂ*ﬁﬂilling History Report E W& B
Sart Dptions Client Cade j
|:| Prirt Biling D etai |:| |:| Page Break by Sart Option
[ [] Frint Bill Text Comments
Selection All Starting Ending
Cliert Code o Q, fliErrrrrrd] SN
Engagement Cade T |
Invaice Mumber prrrrrrZBl '
Invoice Date 1243142393
L
L
L
L
L
Canon Salss [ Prirt I Presiew I Printer Setup..
[ Lw2 | 9/7/2005

Billing History Report Window

2 Select how to sort the report from the Sort Options field. You can sort the report
by:
Client Code
Invoice Number
Client Name
Sort Field
Zip Code
Client Type
Client Partner
Client Employee.

You can also sort the report by any of the user-defined fields created on the
Time and Billing Professional Options window (see page 80).

3 Check Print Billing Detail to print each individual work code details for each
entry on the report.

The Print Extended Comments and Print Non-Billable Lines fields become
available.

4 Check Print Extended Comments to include the extended comments for
transaction lines.
This option is only available if the Print Billing Detail field is selected.

5 Check Print Non-Billable Lines to include transactions that are not billable.
This option is only available if the Print Billing Detail field is selected.

6 Check Page Break by Sort Option to print each transaction on a separate
page.
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I:Jj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

7 Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR

+ Enter the client codes to include in the Starting and Ending fields.

I:Jj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

8 Enter the engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.
9 Enter the invoices to include in the Invoice Number field.
» Check All to include the information for all invoices.
OR
» Enter the invoices to include in the Starting and Ending fields.
10Enter the invoice date in the Invoice Date field.
» Check All to include the information for all invoice dates.
OR
» Enter the invoice dates to include in the Starting and Ending fields.

11Enter the names of clients to include in the Client Name field.
This field is available only if Client Name is selected in the Sort Options field.

12Enter sort data to include in the Sort Field field.
This field is available only if Sort Field is selected in the Sort Options field.

13Enter the clients’ zip code to include in the Zip Code field.
This field is available only if Zip Code is selected in the Sort Options field.

14Enter the types of clients to include in the Client Type field.
This field is available only if Client Type is selected in the Sort Options field.
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15Enter the employee partners in the Client Partner field. This field limits the
transactions being printed to the ones by the selected employee partner.
This field is available only if Client Partner is selected in the Sort Options field.

16Enter the employees in the Client Employee field. This field limits the
transactions being printed to the ones by the selected employee contact.
This field is available only if Client Employee is selected in the Sort Options
field.

17Enter the miscellaneous data to include in the Miscellaneous field.
This field is available only if one of the user-defined fields created in the Time
and Billing Professional Options window is selected in the Sort Options field.

18Click Print to print the report, or Preview to preview the report.

The amount of details that prints depends upon the settings you selected on the
Billing Report window. The following is an example of a report based on all client
codes, engagement codes, invoice numbers, and invoice dates, with details for

{5 Billing History Report 1 [=]
Time and Billing P
BILLING HISTORY REFORT
SORTED BY Chent CODE
Client INVOICE  INVOICE WIP BILLED BILLED SALES INVOICE
CODE HAME WUMEER DATE TOTAL FEES EXPENSES TAX AMOUNT
01-ABLEMAN ABLE MANUFACTURING 0000001 D4/15/98 813005 7,900.00- 000 8.00- 7,908.00-
01-ABLEMAN ABLE MANUFACTURING 0000042 D4/159E 812005 7,900.00 000 000 7,900.00
01-ABLEMAN ABLE MANUFACTURING 0000058 DS/159E 5,199.00 3,943.07 1,056.93 005 5,060.05
Client 01-4BLEMAN TOTALS 5,199.00 394307 1,056.93 5205 505205
01-ALEXEDW EDWARD AND SUSAN ALEXANDER 0000044 O4/1598 350.00 350.00 000 000 350.00
0l-ALEXEDW EDWARD ANDSUSAN ALEXANDER 0000053  OS/588 44500 44500 000 000 44500
Client 01-ALEXEDW TOTALS: 795.00 795.00 000 000 795.00
01-CANRIDG ~ CANYON RIDGE AFARTMENTS 0000045 D4/15/98 17,125.00 10,208.76 729124 464.96 17,964 96
O1-CANRIDG ~ CANYON FIDGE APARTMENTS 00D00E0 DS/15/98 400.00 400.00 0o oo 400.00
O1-CANRIDG ~ CANYON FIDGE APARTMENTS 0000072 0075 3,175.00 3,145.00 30.00 000 3,175.00
Client 01-CANRIDG TOTALS 20,700.00 13,753.76 732124 464.96 21,539.95
OI-EDWAELE EDWARDSON ELECTRIC COMPANY 0000046 04/15098 10,340.00 10,825.00 1500 000 10,340.00
OI-EDWAELE EDWARDSON ELECTRIC COMPANY 0000051 OS/1588 2,440.00 2,300.00 000 000 2,300.00
OI.EDWAELE EDWARDSON ELECTRIC COMPANY 0000073 090705 3,969.00 3,150.00 819.00 4794 401694
Client 01-EDWAELE TOTALS 17,249.00 16,175.00 34.00 4794 17,056 94
01-GENEGOM GEWERATION/2 COMPUTER DIST 0000047 D4/15/98 4,785.00 4,675.00 11000 000 4,785.00
01-GENECOM GEWERATION/2 COMPUTER DIST 0000059 DS/15/98 751500 7455.10 29490 000 7,750.00
01.GENECOM GEWERATIOHN/2 COMPUTER DIST. 0000074 OR07S &,870.00 &,850.00 2000 000 &,870.00 L
| |
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Billing History Report

Retainer Transaction Report

The Retainer Transaction Report tracks detail transactions for clients and/or
engagements with retainer fee arrangements. You should print it prior to period
end processing (see page 328). You can use this report to reconcile your client's
retainer balances at any time within the current period. It shows the retainer
balance at the beginning of the period as well as detailed activity for the period
through the date specified for printing.
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Print the Retainer Transaction Report

1 From the Reports menu of the Time and Billing Professional module, select
Retainer Transaction Report. The Retainer Transaction Report window

appears.
ﬂj Retainer Transaction Report H !El
Print Retainer Transactions Thu | 09/07/2005
Page Break by Client
Selection Al Starting Ending
Cliert Code - Q, irrrrrrriiiey
Engagement Code T T
Canan Sales [ FErint | Preyiew | Printer Setup...
[ Lw2 | 9/7/2008

Retainer Transaction Report Window

2 Enter the last date of the retainer to include in the report in the Print Retainer
Transactions Thru field.

3 Check Page Break by Client to print each client’s retainer on a separate page.

I:gj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

4 Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR
 Enter the client codes to include in the Starting and Ending fields.
5 Enter the engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.

6 Click Print to print the report, or Preview to preview the report.
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5 Retainer Transaction Report

Chapter 9

The Retainer Transaction Report includes the retainer fees and the amount

Time and Biling Pr nal Demo
RETAINER TRANSACTION REPORT
THRU: DEMED4
Client/ TRANS UNCOLLECTED FRETAIMER
Engmt DATE TYPE COMMENT RETAINER BALANCE
01-MASTMIC MASTER MICRO MANUFACTURING
00000000000000000000 06/11104 P CHE: 55555  AR-FACTU 1,500.00- 1,500.00
Engagement 00000000000000000000 TOTAL: 1,500.00- 1,500.00
Client 01MASTMIC TOTAL 1,500.00- 1,500.00
. ;

) ) M= [ [

Retainer Transaction Report

This concludes Chapter 9: Using the Reports Menu of the Time and Billing

Professional manual.
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Chapter 10
Using the Analysis Menu

Chapter 10: Using the Analysis Menu contains instructions on how to print reports
based on the information available in the Time and Billing Professional module.
Time and Billing Professional offers extensive management reporting capabilities
to help you better analyze the profitability of your clients/engagements and the
productivity of your employees. You can determine how your time is spent,
examine the aging of client invoices and work in process, and develop
comprehensive schedules and budgets.

For more information about how posting dates affect analysis report data, see the
Posting to Analysis Reports by Period section (see page 49).

How to Use the Analysis Menu

The options available in the Analysis menu allow your company to print or preview
different reports. You can select the type of data to include in a report and
determine how to sort the report.

Open a Window from the Analysis Menu

1 Double-click the Time and Billing Professional module from the Modules tab.
The module expands to display all the menu options available in the Time and
Billing Professional module.

2 Click the Analysis menu. The names of the windows available in the menu
appear on the right side of the Sage MAS 90 or 200 window.

Time and Eilling Professional - Analysis

] Up one level...

(B2 Productivity Reports

(B2 Profitability Reports

[BZIFee analysis Reports

(B2 Time Analysis Reports

(B2] Client: Billing Analysis Repork
(EZBudget Reports

(BEZEmplayee Scheduling Report

[BE Emplayee Hourly Analysis Report
B2 afr and WIP Reconciliation Report

Windows Available in the Analysis Menu

3 Double-click the name of the window to open. The system displays the selected
window.
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Select Data for a Report

The sections in this manual detail the different types of information you can include
in an individual report. The following steps teaches you how to select the
information from the fields. When you open a Report window it contains fields
similar to the following picture.

ﬂﬁFEE Analysis Report by Client EH HE B
Sort Optiohs: Client Code ﬂ
Print D etail by Client Totals Only ﬂ Frint Period to D ate Data
Print Expense Analysis Data ] Print ¥ear to Date Data
Selection All Starting Ending
Clierkt Code - Q 997777777 |G,
Engagement Code i
Ll
Ll
Ll
Ll
Ll
Ll
Canon Sales [ FPiint I Freview I Printer Setup...
I Lw2z | 9/7/2005

Fee Analysis Report by Client Window

1 Select how to sort the report from the drop-down list in the Sort Options field.

2 Select the type of information to include in the report from the remaining fields
on the Report window. For many fields you can select all records or a range of
information.

For example, in the previous picture you can check All to print all clients, or you
can use the Lookup windows in the Starting and Ending fields and select
specific client codes. If there is a date field available in a Report window and you
want to print information for a particular date, enter the same date in the
Starting and Ending fields.

3 Click the Print button to print the list, or the Preview button to preview the
report.

Productivity Reports

The Productivity Reports feature consists of three separate reports:

» Productivity Report by Client (see page 272)

» Productivity Report by Employee (see page 275)

» Productivity Report by Category (see page 277)

These reports provide a recap of billable hours, non-billable hours, billable fees,
and billable expenses, and compare them to the amounts actually billed. (See the
Productivity Reports Calculations section, see page 53.) The program calculates
the standard billing rate and the actual billed rate. You can obtain both
period-to-date and year-to-date information. You can use sort options can be used
to select the information to be included on applicable reports.
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» Select Productivity Reports from the Time and Billing Professional Analysis

menu to access this option.
& i E3

[ Productivity Reports

Optiot
3 iEroductivite Beno e Cliznk
3 Productivity Report by Employes

(3 Productivity Report by Categany

[ Pioceed I LCancel

[ Lw2 | 9/7/2005

Productivity Reports Window

Print a Productivity Report by Client

Use the Productivity Report by Client to print productivity information recapped by
client/engagement. You can detail information further by employee code, work
code, or category code. You can also choose to print information for the
period-to-date and year-to-date.

1 Select Productivity Report by Client from the Productivity Reports window.
The Productivity Report by Client window appears.

i Productivity Report by Client E W= 3
Sort Optiores Client Cade =
Fiint Detail by Client Totals Only - Fiint Period to Date Data
Pririt Year to Date Data
Selection All Starting Ending
Cliert Code o Q, fliErrrrrrd] SN
Engagement Code I r T r T |
L]
[
L]
[
L]
[
Canon Salss [ Print Preview I Printer Setup..

Lw2 | 9/7/2005

Productivity Report by Client Window

Time and Billing Professional Manual
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2 Select how to sort the report from the Sort Options field. You can sort the report
by:
Client Code
Client Name
Sort Field
Zip Code
Client Type
Client Partner
Client Employee
Engagement Partner
Engagement Employee

You can also sort the report by any of the user-defined fields created on the
Time and Billing Professional Options window (see page 80).

3 Select how to print the detail by from the Print Detail by field. You can select:

Client Totals Only
Employee Code
Work Code
Category Code

4 Check Print Period to Date Data to include data from the current period in the
report.

5 Check Print Year to Date Data to include data from the current year in the
report.

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

6 Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR
 Enter the client codes to include in the Starting and Ending fields.
7 Enter the client engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.

8 Enter the names of clients to include in the Client Name field. This field is
available only if Client Name is selected in the Sort Options field.

9 Enter sort data to include in the Sort Field field.
This field is available only if Sort Field is selected in the Sort Options field.
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10Enter the clients’ zip code to include in the Zip Code field.
This field is available only if Zip Code is selected in the Sort Options field.

11Enter the types of clients to include in the Client Type field.
This field is available only if Client Type is selected in the Sort Options field.

12Enter the employee partners to include in the Client Partner field.
This field is available only if Client Partner is selected in the Sort Options field.

13Enter the employees to include in the Client Employee field.
This field is available only if Client Employee is selected in the Sort Options
field.

14Enter the employee partners for the engagement to include in the Engagement
Partner field.
This field is available only if Engagement Partner is selected in the Sort
Options field.

15Enter the employees for the engagement to include in the Engagement
Employee field.
This field is available only if Engagement Employee is selected in the Sort
Options field.

16Enter the miscellaneous data to include in the Miscellaneous field.
This field is available only if one of the user-defined fields created on the Time
and Billing Professional Options window (see page 80) is selected in the Sort
Options field.

17Select the employees to include in the Employee Code field.
This field is available only if Employee Code is selected in the Print Detail by
field.

18Enter the work codes to include in the Work Code field.
This field is only available if Work Code is selected in the Print Detail by field.

19Enter the category codes to include in the Category Code field.
This field is only available if Category Code is selected in the Print Detail by
field.

20Click Print to print the report, or Preview to preview the report.
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The Productivity Report by Client result depends upon the settings selected for the
report. The following report is sorted by client code, and includes work code
details, year to date, and period to date information.

(5 Productivity Report by Client [_1o]x]
Time and Billing Pro
PRODUCTIVITY REPORT BY CLIENT
SORTED BY Glient GODE
EBILLAELE HNON-BILLAELE TOTAL EBILLABELE STANDARD EBILLAELE EBILLED EILLED EBILLED
£ HOURS Y HOURS E: RATE EXPENSES HOURS FEES E

Client CODE: 0l-ABLEMAN ABLE MANUFACTUEING

Engagement CODE 00000000000000000000 PROFESSION AL SERVICES

FTD 3 00- 96.03%. 4.00- 392% 102.00- BIB6 25- B3 A5A 147.00- 52.00- 4437 80- 85342

YTD: 290,00 BE B3 44.00 13.17% 334.00 343508.58 118.988 27.00- 320.00 32631 40 101,973
Clnt-PTD 3 00- 96.03%. 4.00- 392% 102.00- BIB6 25- B3 A5A 147.00- 52.00- 4437 80- 85342

YTD! 29000 BEB3% 4400 1317% 334.00 34506 58 118938 27.00- 320.00 32631 40 101 373

Client CODE 01-ACME ACME WELDING COMPANY

Engagement CODE 00000000000000000000 HETWORKING SERVICES

PTD .30 BEETY 100 13.33% 7.50 780.00 120,000 3500 0.00 0.00 0.000

YTD: .30 BEETY 100 13.33% 7.50 780.00 120,000 3500 0.00 0.00 0.000
Clnt-PTD A.50 BE ATV 100 1333% .50 780.00 120000 3500 0.00 000 0.000

YTD: .30 BEETY 100 13.33% 7.50 780.00 120,000 3500 0.00 0.00 0.000

Client CODE 01-ALEXEDW EDWARD AND SUSAN ALEXANDER

E CODE: 00000000000000000000 PROFESSIONAL SERVICES

PTD 530 73.33% 2.00 26.57% 7.50 445.00 B80.202 0.00 5.50 44500 20,509

YTD! 2150 78.18%. £.00 21.82% 27.50 203500 4 A51 0.00 21.50 179500 83488
Clnt-PTD 530 73.33% 2.00 26.57% 7.50 445.00 B80.202 0.00 5.50 44500 20,509

YTD! 2150 78.18%. £.00 21.82% 27.50 203500 4 A51 0.00 21.50 179500 83488
Client CODE: 01-CANEIDG CANYON FIDGE APARTMENTS
Engagement CODE 00000000000000000000 PROFESSION AL SERVICES

PTD 43,00 97.73% 1.00 2.27% 44.00 3545.00 B2.442 30.00 43.00 354500 82442 |

[ r
[ == [0 ()

Productivity Report by Client

Print a Productivity Report by Employee

Use the Productivity Report by Employee to print productivity information
recapped by employee. Information can be further detailed by client code, work
code, or category code. You can also choose to print information for the
period-to-date and year to date.

1 Select Productivity Report by Employee from the Productivity Reports
window. The Productivity Report by Employee window appears.

Gﬁprnductivity Report by Employee I M= 3
Sart Options Employes Code ﬂ
Piint Detail by Ermploges Totals Only - Fiint Period to Date Data

Fririt 'Year to Date Data

Selection All Starting Ending
Employes Code Q 7777 By
Dffice Code Q, = |,
L]
[

Canon Sales [ Print | Preview | Printer Setup...

\ Lw2 | 9/7/2005
Productivity Report by Employee Window
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2 Select how to sort the report from the Sort Options field. You can sort the report
by:
Employee Code
Employee Last Name
Office Code
Employee Level

3 Select how to print the detail by from the Print Detail by field. You can select:

Employee Totals Only
Client Code

Work Code

Category Code

4 Check Print Period to Date Data to include data from the current period in the
report.

5 Check Print Year to Date Data to include data from the current year in the
report.

I:Jj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

6 Enter the employees to include in the Employee Code field.
» Check All to include the information for all employees.
OR
+ Enter the employee codes to include in the Starting and Ending fields.
7 Enter the offices to include in the Office Code field.
» Check All to include the information for all offices.
OR
 Enter the office codes to include in the Starting and Ending fields.

8 Enter the employees to include by last name in the Employee Last Name field.
This field is only available if Employee Last Name is selected in the Sort
Options field.

9 Enter the level of employees to include in the Employee Level field.
This field is only available if Employee Level is selected in the Sort Options
field.

10Enter the clients to include by their codes in the Client Code field.
This field is only available if Client Code is selected in the Print Detail by field.

11Enter the work codes to include in the Work Code field.
This field is only available if Work Code is selected in the Print Detail by field.
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12Enter the category codes to include in the Category Code field.
This field is only available if Category Code is selected in the Print Detail by

field.

13Click Print to print the report, or Preview to preview the report.

The Productivity Report by Employee result depends upon the settings selected
for the report. The following report is sorted by employee code, and includes year

to date and period to date information.

(5 Productivity Report by Employee [_1o]x]
Time and Billing
PRODUCTMITY REFPORT BY EMPLOYEE
SORTED BY Empioyee CODE
BILLAELE NON-EILLABLE TOTAL BILLAELE STANDARD  BILLAELE  BILLED BILLED  EILLED
3 HOURS % HOUES E: RATE EXFENSES ~ HOURS FEES RATE
Employes CODE: 0100 IMA WINNUR OFFICE CODE MCC  MICROCOMPUTER CONSULTING
PTD 5800 84.62% 16.00 1539% 104.00 1584000 180.000 3500 88.00 1584000 180000
YTD 325.00 65.26% 173.00 34.74% 438.00 SB50000  180.000 35.00 325.00 5454736 168148
Employes CODE: 0110  DREW LEEDER OFFICE CODE GAS  GENERAL ACCOUNTING SERVICES
PTD 7500 8523% 13.00 1477% 88.00 1660000 221333 35.00- 91.00 1990277 218712
YTD 351.00 7120% 142,00 2880% 493.00 7484400 213231 0.00 367.00 TI6E85 200735
Employes CODE 0120 B4 WINNUR OFFICE CODE GAS  GENERAL ACCOUNTING SERVICES
4700 60.26% 31.00 39.74% 78.00 845000 180.000 0.00 41.00 740435 180.595
YTD: 327.00 TLET% 128.00 28.13% 45500 5584000 170.763 160.00 30100 1800264 159477
Employes CODE 0130 RACHELSCOTT OFFICE CODE MCC  MICROCOMPUTER CONSULTING
3300 40.74% 48.00 59.26% 81.00 412500 125.000 4768.00 59.00 737500 125000
YTD: 38000 7103% 155.00 2B97% 53500 4750000 125000 12914.00 367.00 4349392 118512
Employes CODE 0140 GEORGE ROGERS OFFICE CODE GAS  GENERAL ACCOUNTING SERVICES
7200 86.75% 11.00 13.25% §3.00 900000 125.000 20.00- 86.00 1054000 122338
YTD: 366.50 75.96% 11600 24.04% 482.50 4551300 12483 7014.00 386.50 4269003 116480
Emgployes CODE: 0150 BETHCLARK OFFICE CODE GAS  GENERAL ACCOUNTING SERVICES
125.50 94.01% .00 5.99% 133.50 416875 33217 34.00 155.50 186248 31270
YTD 561.00 84.62% 102,00 1539% £63.00 1635358 29.151 353.00 585,00 1545710 27.358
Employes CODE: 0160 HANCY COOK OFFICE CODE GAS  GENERAL ACCOUNTING SERVICES
PTD 2500 72.52% 36.00 2748% 131.00 7125.00 75.000 0.00 95,00 716210 75,351
YTD: 579.00 TBETH 157.00 21.33% 73500 43345.00 74862 50.00 552.00 39513.39 meEEE |~
[ r
o) e o8] =2,
4

Productivity Report by Employee

Print a Productivity Report by Category

Use the Productivity Report by Category to print productivity information recapped
by the category of the work code. You can detail information further by client code,

employee code, or work code. You can also choose to p
period-to-date and year-to-date.

rint information for the

1 Select Productivity Report by Category from the Productivity Reports window.

The Productivity Report by Category window appears.

gﬁpruductivity Report by Category

Print Detail by Category Tatals Onily ﬂ Print Period to D ate Data
Fririt Year to Date Data
Selection All Starting Ending
Categary Code Q 77z @y
Canon Sales [ Piint I Preview I Fiinter Setup...

1 = 3

I Lw2z | 9/7/2005

Productivity Report by Category Window
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2 Select how to print the detail by from the Print Detail by field. You can select:

Category Totals Only
Client Code
Employee Code
Work Code

3 Check Print Period to Date Data to include data from the current period in the
report.

4 Check Print Year to Date Data to include data from the current year in the
report.

5 Enter the categories to include in the Category Code field.
» Check All to include the information for all categories.
OR

» Enter the category codes to include in the Starting and Ending fields.

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

6 Enter the clients to include by their codes in the Client Code field.
This field is only available if Client Code is selected in the Print Detail by field.

7 Select the employees to include in the Employee Code field.
This field is available only if Employee Code is selected in the Print Detail by
field.

8 Enter the work codes to include in the Work Code field.
This field is only available if Work Code is selected in the Print Detail by field.

9 Click Print to print the report, or Preview to preview the report.
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The Productivity Report by Category result depends upon the settings selected for
the report. The following report contains all the categories and includes year to
date and period to date information.

(5 Productivity Report by Category [_1o]x]
Time and Billing

PRODUCTIVITY REPORT BY CATEGORY

EBILLAELE HNON-BILLAELE TOTAL EBILLABELE STANDARD EBILLAELE EBILLED EILLED EBILLED

£ HOURS Y HOURS FEES RATE EXPENSES HOURS FEES RATE
CATEGORY CODE: ACC GENERAL ACCOUNTING SERVICES EBILLAELE
FTD #6500 100 .00%. 0.00 0.00% A65.00 58715.00 BR293 0.00 823.00 71942 87 &7423
YTD! 297050 100 .00%. 0.00 0.00% 287050 265793.00 B3 478 0.00 2876.50 245420 57 85318
CATEGORY CODE: AUD AUDIT SEEVICES EBILLAELE
FTD 2700 100 .00%. 0.00 0.00% 27.00 2500.00 7938 0.00 127.00 1300000 102362
YTD! #6500 100 .00%. 0.00 0.00% A65.00 27505.00 116549 0.00 A75.00 74496 53 110365
CATEGORY CODE. CDS CLIENT DEVELOPMENT WON-BILLABLE
FTD 000 0.00% 0.00 0.00% 0.00 0.00 0.000 0.00 0.00 000 0.000
YTD: 0.00 0.00% £7.00 100.00% £7.00 0.00 0.000 0.00 0.00 0.00 0.000
CATEGORY CODE. CLE CLERICAL BILLABLE
FTD 22250 100 .00%. 0.00 0.00% 222,50 707875 31815 0.00 258 50 790203 30563
YTD: 298,00 100.00% 0.00 0.00% 298,00 2941513 29474 0.00 286.00 2741350 27.803
CATEGORY CODE. EXP BILLABLE EXPEMSES EXPENSE
PTD 0.00 0.00% 0.00 0.00% 0.00 0.00 0.000 3747.50 0.00 0.00 0.000
YTD: 0.00 0.00% 0.00 0.00% 0.00 0.00 0.000 10144.50 0.00 0.00 0.000
CATEGORY CODE: FPS FINANCIAL PLANNING SEEVICES EBILLAELE
PTD 500 100.00% 0.00 0.00% 5.00 B875.00 175.000 0.00 l2.00 153583 129 838
YTD! 2700 100 .00%. 0.00 0.00% 27.00 384000 142222 0.00 27.00 335213 142671
CATEGORY CODE: MAS MANAGEMENT ADVISORY SERVICES EBILLAELE
FTD 151.00 100 .00%. 0.00 0.00% 151.00 2375500 157318 0.00 147.00 2358526 160 444
YTD: 52400 100.00% 0.00 0.00%% 524.00 BE245.00 165.735 0.00 520.00 81359 40 156845 |
[ r
el o)

Productivity Report by Category

Profitability Reports

The Profitability Reports feature consists of three separate reports:

« Profitability Report by Client (see page 280)

« Profitability Report by Employee (see page 282)

+ Profitability Report by Category (see page 285)

These reports provide billed-to-date, total cost, gross profit, and profit percentage
information by client, employee, or category. (See the Profitability Reports
Calculations section, see page 54.)You can obtain both period-to-date and
year-to-date information.

» Select Profitability Reports from the Time and Billing Professional Analysis
menu to access this option.
Ei Profitability Reports [2]_[C]

Optiot

@8
(3 Profitability Report by Emplopes
(3 Profitability Report by Categony

[ Proceed I Lancel

[ Lwa | 9/7/2008
Profitability Reports Window
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Print a Profitability Report by Client

Use the Profitability Report by Client to print profitability information recapped by
client/engagement. You can detail information further by employee code, work
code, or category code. You can also choose to print period-to-date and
year-to-date information.

1 Select Profitability Report by Client from the Profitability Reports window. The
Profitability Report by Client window appears.

ﬂj Profitability Report by Client

Sart Optians Client Code ﬂ

Frint Detail by Client Tatals Orly ﬂ Frint Period to Date Data
PFrint ‘rear to Date Data
Selection All Starting Ending
Client Code 00- G $977zzzzz |Gy
Engagement Cods i
L
L
L
L
L
L
Canan Sales [ Frint | Preview | Frinter Setup...

[ Lw2 | 9/7/2008

Profitability Report by Client Window

2 Select how to sort the report from the Sort Options field. You can sort the report
by:
Client Code
Client Name
Sort Field
Zip Code
Client Type
Client Partner
Client Employee
Engagement Partner
Engagement Employee.

You can also sort the report by any of the user-defined fields created on the
Time and Billing Professional Options window (see page 80).

3 Select how to print the detail by from the Print Detail by field. You can select:

Client Totals Only
Employee Code
Work Code
Category Code

4 Check Print Period to Date Data to include data from the current period in the
report.
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5 Check Print Year to Date Data to include data from the current year in the
report.

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

6 Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR
+ Enter the client codes to include in the Starting and Ending fields.
7 Enter the client engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.

8 Enter the names of clients to include in the Client Name field.
This field is available only if Client Name is selected in the Sort Options field.

9 Enter sort data to include in the Sort Field field.
This field is available only if Sort Field is selected in the Sort Options field.

10Enter the clients’ zip code to include in the Zip Code field.
This field is available only if Zip Code is selected in the Sort Options field.

11Enter the types of clients to include in the Client Type field.
This field is available only if Client Type is selected in the Sort Options field.

12Enter the employee partners to include in the Client Partner field.
This field is available only if Client Partner is selected in the Sort Options field.

13Enter the employees to include in the Client Employee field.
This field is available only if Client Employee is selected in the Sort Options
field.

14Enter the employee partners for the engagement to include in the Engagement
Partner field.
This field is available only if Engagement Partner is selected in the Sort
Options field.

15Enter the employees for the engagement to include in the Engagement
Employee field.
This field is available only if Engagement Employee is selected in the Sort
Options field.
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16Enter the miscellaneous data to include in the Miscellaneous field.
This field is available only if one of the user-defined fields created on the Time
and Billing Professional Options window (see page 80) is selected in the Sort

17Select the employees to include in the Employee Code field.
This field is available only if Employee Code is selected in the Print Detail by

field.

18Enter the work codes to include in the Work Code field.

This field is only available if Work Code is selected in the Print Detail by field.

19Enter the category codes to include in the Category Code field.
This field is only available if Category Code is selected in the Print Detail by

field.

20Click Print to print the report, or Preview to preview the report.

The Profitability Report by Client result depends upon the settings selected for the
report. The following report is sorted by client code, and includes engagement

code details, year to date, and period to date information.

(i Profitability Report by Client

Time and Billing P
PROFITABILITY REPORT BY CLIENT
SORTED BY Ciisnt CODE
EBILLED HNON-BILL EBILLED Emply EBILLED EXPENSE TOTAL TOTAL GROSE
HOURS HOURS FEES COST EXPENSES COST BILLED COST PROFIT £
Client CODE: 0l-ABLEMAN ABLE MANUFACTUEING
Engagement CODE 00000000000000000000 PROFESSION AL SERVICES
FTD 52.00- 200 4437 20- 7813 0.00 000 4437 20- 7813 521583 117.53%
YTD: 32000 5000 32631.40 16834 97 40.93 1605.00 3267233 1843997 1423238 43.56%
Clnt-PTD 52.00- 200 4437 20- 7813 0.00 000 4437 20- 7813 521583 117.53%
YTD! 32000 5000 3263140 16834 97 4093 160500 3267233 13439 97 1423236 43 56%
Client CODE 01-ALEXEDW EDWARD AND SUSAN ALEXANDER
Engagement CODE 00000000000000000000 PROFESSION AL SERVICES
PTD 530 200 445.00 19358 0.00 0.00 445.00 19358 25142 56.50%
YTD: 21.50 .00 1793.00 290 88 0.00 5500 1793.00 1045 88 74214 41.93%
Clnt-PTD 550 200 44500 193 58 0.00 000 44500 193 58 25142 56.50%
YTD: 21.50 .00 1793.00 290 88 0.00 5500 1793.00 1045 88 74214 41.93%
Client CODE 01-CANRIDG CANTON RIDGE APARTMENTS
E: CODE: 00000000000000000000 PEOFESSIONAL SEEVICES
PTD 43,00 1.00 3545.00 43308 30.00 3000 3575.00 46308 311194 87.05%
YTD! 23810 2900 2281072 7482 55 7464 28 417000 30275.00 11652 55 13622 45 al51%
Clnt-PTD 43,00 1.00 3545.00 43308 30.00 3000 3575.00 46308 311194 87.05%
YTD! 23810 2900 2281072 7482 55 7464 28 417000 30275.00 11652 55 13622 45 al51%
Client CODE: 0l-EDWAELE EDWAFDSON ELECTRIC COMPANY
Engagement CODE 00000000000000000000 PROFESSION AL SERVICES
PTD 57.00 0.00 533000 71189 £12.00 419,50 £1865.00 1131.3% S037.81 Bl .88% |
6 = v
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Profitability Report by Client

Print a Profitability Report by Employee

Use the Profitability Report by Employee to print profitability information recapped
by employee. You can detail information further by client code, work code, or
category code. You can also choose to print period-to-date and year-to-date
information.
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1 Select Profitability Report by Employee from the Profitability Reports window.
The Profitability Report by Employee window appears.

Ejprnfitahility Report by Employee I M= 3

Sart Options Employes Code ﬂ

Frint Detail by Employes Totals Only - Fririt Period to Date Data
Fririt 'Year to Date Data

=

Selection Starting Ending

Employes Code % 7 %
Office Code Q, =z |4,
[
[
Canon Sales [ PBrint [ Previen | Pinter Setup

I Lwz | a/7/2008

Profitability Report by Employee Window

2 Select how to sort the report from the Sort Options field. You can sort the report
by:
Employee Code
Employee Last Name
Office Code
Employee Level

3 Select how to print the detail by from the Print Detail by field. You can select:

Employee Totals Only
Client Code

Work Code

Category Code

4 Check Print Period to Date Data to include data from the current period in the
report.

5 Check Print Year to Date Data to include data from the current year in the
report.

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

6 Enter the employees to include in the Employee Code field.
» Check All to include the information for all employees.
OR

» Enter the employee codes to include in the Starting and Ending fields.
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7 Enter the offices to include in the Office Code field.
» Check All to include the information for all offices.
OR
 Enter the office codes to include in the Starting and Ending fields.

8 Enter the employees to include by last name in the Employee Last Name field.
This field is only available if Employee Last Name is selected in the Sort
Options field.

9 Enter the level of employees to include in the Employee Level field.
This field is only available if Employee Level is selected in the Sort Options
field.

10Enter the clients to include by their codes in the Client Code field.
This field is only available if Client Code is selected in the Print Detail by field.

11Enter the work codes to include in the Work Code field.
This field is only available if Work Code is selected in the Print Detail by field.

12Enter the category codes to include in the Category Code field.
This field is only available if Category Code is selected in the Print Detail by
field.

13Click Print to print the report, or Preview to preview the report.

The Profitability Report by Employee result depends upon the settings selected for
the report. The following report is sorted by employee code, and includes year to
date and period to date information.

{5 Profitability Report by Employee [_1o]x]
Time and Billing P
PROFITABILITY REFORT BY EMPLOYEE
SORTED BY Empioyee CODE
BILLED  NON-BILL BILLED Emply BILLED EXPENSE TOTAL TOTAL GROSS
HOUES  HOUES FEES COST EXFENSES COST BILLED COST PROFIT 3

Employes CODE: 0100 IMA WINNUR OFFICE CODE MCC  MICROCOMPUTER CONSULTING
PTD 5800 10%.00 15840.00 £100.00 35.00 3500 15875.00 £135.00 000 4B.76%
YTD 325.00 173.00 5464736 26160.00 35.00 55500 5466236 2671500 2196736 5115%
Employes CODE: 0110  DREW LEEDER OFFICE CODE GAS  GENERAL ACCOUNTING SERVICES
PTD $1.00 5200 1990277 £132.00 0.00 0.00 1990277 132.00 1377077 6215%
YTD 36700 145.00 7366975 36540.00 84.57 1490.00 7375432 38030.00 3572432 4844%
Employes CODE 0120 B4 WINNUR OFFICE CODE GAS  GENERAL ACCOUNTING SERVICES

41.00 £2.00 7404 39 5760.00 0.00 0.00 7404 39 5760.00 164435 2231%
YTD: 301.00 128.00 4800264 2490000 143.04 £75.00 4814568 2557500 2257068 46.88%
Employes CODE 0130 RACHEL SCOTT OFFICE CODE MCC  MICROCOMPUTER CONSULTING

5200 £8.00 7375.00 936,00 4810.00 2612.50 12185.00 354850 863650 8%
YTD: 367.00 157.00 4349392 15228.00 1141998 7525.89 54913.90 2275389 3206001 58.356%
Employes CODE 0140 GEORGE ROGERS OFFICE CODE GAS  GENERAL ACCOUNTING SERVICES

8600 5900 10540.00 3204.00 0.00 0.00 10540.00 3204.00 733600 E9E0%
YTD: 366.50 115.00 42690.03 15354.00 718329 3913.00 4987332 19267.00 3060632 6137%
Emgployes CODE: 0150  BETHCLARK OFFICE CODE GAS  GENERAL ACCOUNTING SERVICES

155.50 15.00 485248 209%.28 34.00 5400 4896.48 2182.28 271420 5543%
YTD 565.00 102.00 15457.10 596095 353.00 409,00 15816.10 936995 G461 4D.76%
Employes CODE: 0160 HANCY COOK OFFICE CODE GAS  GENERAL ACCOUNTING SERVICES
PTD 2500 44.00 7162.10 244,43 0.00 0.00 7162.10 2744.43 441781 61868%
YTD: 559.00 157.00 3951339 1351708 50.00 147.00 39563.39 13654.08 2589931 65dE% |-
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Profitability Report by Employee
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Print a Profitability Report by Category

Use the Profitability Report by Category feature to print profitability information
recapped by category. You can detail information further by client code, employee
code, or work code. You can also choose to print period-to-date and year-to-date
information.

1 Select Profitability Reports by Category from the Profitability Report window.
The Profitability Report by Category window appears.

Eﬁpruﬁtability Report by Category

Piint Detail by Category Tataks Orly x| Print Period to D ate Data
Fiint Year to Date Data

Selection Al Starting Ending

Category Code % zz %

Canon Sales [ PBrint [ Previen | Pinter Setup
I Lwz | a/7/2008
Profitability Report by Category Window

2 Select how to print the detail by from the Print Detail by field. You can select:

Category Totals Only
Client Code
Employee Code
Work Code

3 Check Print Period to Date Data to include data from the current period in the
report.

4 Check Print Year to Date Data to include data from the current year in the
report.

I:Jj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

5 Enter the categories to include in the Category Code field.
» Check All to include the information for all categories.
OR
+ Enter the category codes to include in the Starting and Ending fields.

6 Enter the clients to include by their codes in the Client Code field.
This field is only available if Client Code is selected in the Print Detail by field.

7 Select the employees to include in the Employee Code field.
This field is available only if Employee Code is selected in the Print Detail by
field.

8 Enter the work codes to include in the Work Code field.
This field is only available if Work Code is selected in the Print Detail by field.
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9 Click Print to print the report, or Preview to preview the report.

The Profitability Report by Category result depends upon the settings selected for
the report. The following report contains all the categories and includes year to
date and period to date information.

(i Profitability Report by Category [_1o]x]
Time and Billing
PROFITABILITY REPORT BY CATEGORY
EBILLED HNON-BILL EBILLED Emply EBILLED EXPENSE TOTAL TOTAL GROSE
HOURS HOURS FEES COST EXPENSES COST BILLED COST PROFIT £
CATEGORY CODE: ACC GENERAL ACCOUNTING SERVICES EBILLAELE
FTD #2300 000 71948 37 218788 0.00 000 71948 37 218788 A2760 31 8723%
YTD! 2876 50 000 245420 57 37628 94 0.00 000 245420 57 37628 94 207791 63 84.67%
CATEGORY CODE: AUD AUDIT SEEVICES EBILLAELE
FTD 12700 000 1300000 1246 50 0.00 000 1300000 1246 50 11753 50 20.41%
YTD 67500 non 74496 53 883630 o0 non 74496 53 883630 BSAAN 23 £5.14%
CATEGORY CODE. CDS CLIENT DEVELOPMENT WON-BILLABLE
FTD 000 &7.00 0.00 234000 0.00 000 0.00 234000 2340 00- 0.00%
YTD: 0.00 &7.00 0.00 234000 0.00 0.00 0.00 234000 2340.00- 0.00%
CATEGORY CODE. CLE CLERICAL BILLABLE
FTD 258 50 000 730209 324783 0.00 000 730209 324783 4654 26 53.80%
YTD: 286,00 0.00 27413.50 1332371 0.00 0.00 27413.50 1332371 14082 79 51.40%
CATEGORY CODE. EXP BILLABLE EXPEMSES EXPENSE
PTD 0.00 0.00 0.00 0.00 378599 5831.00 378599 5831.00 45.01- -0.78%%
YTD: 0.00 0.00 0.00 0.00 PER5ES 260050 PER5ES 260050 2513 0.98%
CATEGORY CODE: FPS FINANCIAL PLANNING SEEVICES EBILLAELE
PTD 1200 0.00 155583 166,20 0.00 0.00 155583 166,20 138945 B9.32%
YTD! 2700 000 385213 37395 0.00 000 385213 37395 347318 90.29%
CATEGORY CODE: MAS MANAGEMENT ADVISORY SERVICES EBILLAELE
FTD 147.00 000 2358526 167205 0.00 000 2358526 167205 2190721 9289%
YTD: 520,00 0.00 B1559.40 684410 0.00 0.00 B1559.40 684410 7471530 21.81% |
[ r
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Profitability Report by Category

Fee Analysis Reports

Page 286

The Fee Analysis Reports feature consists of three separate reports:

» Fee Analysis Report by Client (see page 287)

» Fee Analysis Report by Employee (see page 289)

» Fee Analysis Report by Category (see page 292)

These reports provide a recap of billed fees, write-up/write-downs, standard rates,
the billed rate, the expense rate, and the percentage realized. (See the Fee
Analysis Reports Calculations section, see page 54.) You can obtain both
period-to-date and year-to-date information. You can use sort options to select the
information to be included on applicable reports.

» Select Fee Analysis Reports from the Time and Billing Professional Analysis
menu to access this option.

ﬂ-ﬁFEE Analysis Reports K HiE

Optiar:
@ [FeeAnalysiz Heporf by Client
() Fee Analysis Report by Emplopee

() Fee Analysis Report by Category

[ Procesed I Cancel
I Lw2 | 9/7/2008

Fee Analysis Reports Window
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Use the Fee Analysis Report by Client to print fee analysis information recapped
by client or engagement. You can detail information further by employee code,
work code, or category code. You can also choose to print period-to-date and

year-to-date information.

1 Select Fee Analysis Report by Client from the Fee Analysis Reports window.
The Fee Analysis Report by Client window appears.

EﬁFee Analysis Report by Client

Sort Options Clignt Code

[

i s

Piint Expense Analysiz Data D

Print Detail by Cligrt Totals Orly

[

Print Period to D ate Data
Piint Year to Date Data

=

Selection

Starting

Ending

Client Code

Engagement Code

Oooo0odEE

00-

Q,

werrrr |G

TP TITEZ |

Canon Sales

FPrint

Freview I Printer Setup

Lwz | a/7/2008

Fee Analysis Report by Client Window

2 Select how to sort the report from the Sort Options field. You can sort the report

by:

Client Code

Client Name

Sort Field

Zip Code

Client Type

Client Partner

Client Employee
Engagement Partner

Engagement Employee

You can also sort the report by any of the user-defined fields created on the

Time and Billing Professional Options window (see page 80).

3 Select how to print the detail by from the Print Detail by field. You can select:

Client Totals Only
Employee Code
Work Code
Category Code

4 Check Print Expense Analysis Data to add expense data to the report,

including an expense total for each client or engagement.

5 Check Print Period to Date Data to include data from the current period in the

report.
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6 Check Print Year to Date Data to include data from the current year in the
report.

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

7 Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR
» Enter the client codes to include in the Starting and Ending fields.
8 Enter the client engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.

9 Enter the names of clients to include in the Client Name field.
This field is available only if Client Name is selected in the Sort Options field.

10Enter sort data to include in the Sort Field field.
This field is available only if Sort Field is selected in the Sort Options field.

11Enter the clients’ zip code to include in the Zip Code field.
This field is available only if Zip Code is selected in the Sort Options field.

12Enter the types of clients to include in the Client Type field.
This field is available only if Client Type is selected in the Sort Options field.

13Enter the employee partners to include in the Client Partner field.
This field is available only if Client Partner is selected in the Sort Options field.

14Enter the employees to include in the Client Employee field.
This field is available only if Client Employee is selected in the Sort Options
field.

15Enter the employee partners for the engagement to include in the Engagement
Partner field.
This field is available only if Engagement Partner is selected in the Sort
Options field.

16Enter the employees for the engagement to include in the Engagement
Employee field.
This field is available only if Engagement Employee is selected in the Sort
Options field.
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17Enter the miscellaneous data to include in the Miscellaneous field.
This field is available only if one of the user-defined fields created on the Time
and Billing Professional Options window (see page 80) is selected in the Sort
Options field.

18Select the employees to include in the Employee Code field.
This field is available only if Employee Code is selected in the Print Detail by
field.

19Enter the work codes to include in the Work Code field.
This field is only available if Work Code is selected in the Print Detail by field.

20Enter the category codes to include in the Category Code field.
This field is available only if Category Code is selected in the Print Detail by
field.

21Click Print to print the report, or Preview to preview the report.

The Fee Analysis Report by Client result depends upon the settings selected for
the report. The following report is sorted by client code, and includes engagement
code details, expense analysis data, year to date, and period to date information.

(fiFee Analysis Report by Client [_ O] <]
Time and Biling Pro lyle
FEE ANALYSIS REPORT BY CLIENT
SORTED BY Client CODE
EBILLED EBILLED WEITE STANDARD o EILLED WEITE STANDARD k3 TOTAL
HOURS ES TRDH FEES REALIZED EXPENSES URDH EXPENSES REALIZED BILLED

Client CODE: D1-ABLEMAN ABLE MANUFACTURING
E t CODE. PROFESSIONAL SERVICES
PTD 52.00- 4437 20- 8225 4520 05- 98.13% 000 000 000 0.00% 4437 20-
FTD 320.00 32631.40 5230.58- 37861 98 BE.19% 4093 207 5000 B1.88% 3267233
Clnt PTD! 52.00- 4437 20- 8225 4520 05- 98.13% 000 000 000 0.00% 4437 20-
FTD 320.00 3263140 5230.58- 37861 98 BE19%. 4083 207 5000 &1 BA% 3267233
Client CODE. 01-ALEEEDW EDWARD aND STTSAN ALEXANDER

t CODE. PROFESSIONAL SERVICES
PTD: 3.50 445.00 0.00 44500 100.00% 0.00 0.00 0.00 0.00% 445.00
FTD 21.50 1793.00 240.00- 203500 B8.21% 0.00 0.00 0.00 0.00% 1793.00
Clnt PTD! 5.50 44500 0.00 44500 100 .00%. 000 000 000 0.00% 44500
FTD 21.50 1793.00 240.00- 203500 B8.21% 0.00 0.00 0.00 0.00% 1793.00
Client CODE. O1-CANRIDG CANYTON RIDGE APARTMENTS

it CODE: PROFESSIONAL SERVICES
PTD: 43.00 3545.00 0.00 354500 100.00% 3000 0.00 3000 100.00% 3575.00
FTD 238.10 2281072 829 28 2364000 96.49% 7464 28 139 28 732500 101 30% 30275.00
Clut PTD: 43.00 3545.00 0.00 354500 100.00% 3000 0.00 3000 100.00% 3575.00
FTD 238.10 2281072 829 28 2364000 96.49% 7464 28 139 28 732500 101 30% 30275.00
Client CODE: DI-EDWAELE EDWARDSON ELECTRIC COMPANY
E t CODE. PROFESSIONAL SERVICES
PTD: 37.00 533000 240.00- 559000 P5.71% 212.00 0.00 212.00 100.00% £1865.00 |

(B 3
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Fee Analysis Report by Client

Print a Fee Analysis Report by Employee

Use the Fee Analysis Report by Employee to print fee analysis information
recapped by employee. You can detail information further by client/engagement
code, work code, or category code. You can also choose to print period-to-date
and year-to-date information.
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1 Select Fee Analysis Report by Employee from the Fee Analysis Reports
window. The Fee Analysis Report by Employee window appears.

Ei Fee Analysis Report by Employee [z _[C]x]
Sort Optiahs Emplayee Code ﬂ
Print Detall by Employee Totals Orly = Print Period to Date Data
Frint Expense Analysis Data ] Frint ‘fear to Date Data
Selection All Starting Ending
Employes Code Q prrrd o N
Difice Code Q prrdio N
L
L
Canan Sales [ Frint Preview | Printer Setup...
[ Lwz | 9/7/2008

Fee Analysis Report by Employee Window

2 Select how to sort the report from the Sort Options field. You can sort the report
by:
Employee Code
Employee Last Name
Office Code
Employee Level

3 Select how to print the detail by from the Print Detail by field. You can select:

Employee Totals Only
Client Code

Work Code

Category Code

4 Check Print Expense Analysis Data to add expense data to the report,
including an expense total for each client or engagement.

5 Check Print Period to Date Data to include data from the current period in the
report.

6 Check Print Year to Date Data to include data from the current year in the
report.

7 Enter the employees to include in the Employee Code field.
» Check All to include the information for all employees.
OR

» Enter the employee codes to include in the Starting and Ending fields.

I:gj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.
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8 Enter the offices to include in the Office Code field.
» Check All to include the information for all offices.
OR
 Enter the office codes to include in the Starting and Ending fields.

9 Enter the employees to include by last name in the Employee Last Name field.
This field is only available if Employee Last Name is selected in the Sort
Options field.

10Enter the level of employees to include in the Employee Level field.
This field is only available if Employee Level is selected in the Sort Options
field.

11Enter the clients to include by their codes in the Client Code field.
This field is only available if Client Code is selected in the Print Detail by field.

12Enter the work codes to include in the Work Code field.
This field is only available if Work Code is selected in the Print Detail by field.

13Enter the category codes to include in the Category Code field.
This field is only available if Category Code is selected in the Print Detail by
field.

14Click Print to print the report, or Preview to preview the report.
The Fee Analysis Report by Employee result depends upon the settings selected

for the report. The following report is sorted by employee code, and includes
expense data, year to date and period to date information.

(i Fee Analysis Report by Employee M=l E3
Time and Billing P!
FEE ANALYSIS REPORT BY EMPLOYEE
SORTED BY Employee CODE
BILLED  NON-BILLAELE BILLED WRITE STANDARD  STANDARD EILLED EFFECTIVE %
HOUES ~ HOURS FEES UPDN FEES RATE RATE RATE REALIZED
Employes CODE 0100 IMA WINNUE OFFICE CODE MCC  MICROCOMPUTER CONSULTING
5800 109.00 1584000 0.00 1584000 180000 150,000 80.406  100.00%
YTD: 325.00 173.00 5464736 3852.64- 5850000 180000 168145 109.734 93.41%
Employes CODE 0110 DREW LEEDER OFFICE CODE GAS  GENERAL ACCOUNTING SERVICES
91.00 5900 1990277 47.23- 1995000 219231 218712 132685 99.76%
YTD: 36700 145.00 7366973 4524.25- 7819400 213063 200733 143886 94.21%
Emgployes CODE: 0120 BA. WINNUR OFFICE CODE GAS  GENERAL ACCOUNTING SERVICES
41,00 £2.00 740439 2439 7380.00 180000 180.595 67313 10033%
YTD 301,00 122.00 48002 54 3357.36- 51360.00 170.631 159477 111894 93.46%
Emgployes CODE: 0130 RACHEL SCOTT OFFICE CODE MCC  MICROCOMPUTER CONSULTING
5900 §8.00 7375.00 0.00 7375.00 125000 125000 58.071 100.00%
YTD 36700 157.00 4349392 2381.08- 4587500 125000 118512 83.004 9481%
Employes CODE: 0140 GEORGE ROGERS OFFICE CODE GAS  GENERAL ACCOUNTING SERVICES
PTD 3600 5200 10540.00 0.00 1054000 12255 122.558 72690 100.00%
YTD 366,50 116.00 4269003 282297 4551300 124183 116480 88477 93580%
Employes CODE 0150  BETHCLARK OFFICE CODE GAS  GENERAL ACCOUNTING SERVICES
155.50 1500 486248 1247- 4874.95 31.350 31.270 28353 99.74%
YTD: 56500 102.00 1545710 951 88- 16408 98 29042 27338 23074 94.20%
Employes CODE 0160 HANCY COOK OFFICE CODE GAS  GENERAL ACCOUNTING SERVICES
9500 2400 7162.10 37.10 7125.00 75000 75391 51526 100.52%
YTD 559.00 157.00 39513.39 2331 61- 4184500 74857 566 55.186 94.43% =l
s =l
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Fee Analysis Report by Employee
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Print a Fee Analysis Report by Category

Use the Fee Analysis Report by Category to print fee analysis information
recapped by category. You can detail information further by client/engagement
code, employee code, or work code. You can also choose to print period-to-date
and year-to-date information.

1 Select Fee Analysis Report by Category from the Fee Analysis Report
window. The Fee Analysis Report by Category window appears.

{ifi Fee Analysis Report by Category [ 74 -1C]
Frint Detail by Category Taotals Only = Frint Period to Date Data
Print Expenze Analysiz Data I:‘ Print Year ko Date Data
Selection All Starting Ending
Category Code % =z % ‘
Canon Sales Erint. Prexiew I Printer Setup.
[ [ [owa [ wrz00s

Fee Analysis Report by Category Window

2 Select how to print the detail by from the Print Detail by field. You can select:

Category Totals Only
Client Code
Employee Code
Work Code

3 Check Print Expense Analysis Data to add expense data to the report,
including an expense total for each category.

4 Check Print Period to Date Data to include data from the current period in the
report.

5 Check Print Year to Date Data to include data from the current year in the
report.

I:gj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

6 Enter the categories to include in the Category Code field.
» Check All to include the information for all categories.
OR
+ Enter the category codes to include in the Starting and Ending fields.

7 Enter the clients to include by their codes in the Client Code field.
This field is only available if Client Code is selected in the Print Detail by field.
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8 Select the employees to include in the Employee Code field.
This field is available only if Employee Code is selected in the Print Detail by
field.

9 Enter the work codes to include in the Work Code field.
This field is only available if Work Code is selected in the Print Detail by field.

10Click Print to print the report, or Preview to preview the report.

The Fee Analysis Report by Category result depends upon the settings selected
for the report. The following report contains all the categories and includes
expense data, year to date and period to date information.

(i Fee Analysis Report by Category [_ [0 x]
Time and Biling P
FEE ANALYSIS REPORT BY CATEGORY
EILLED BILLED WRITE ~ STANDARD % BILLED WRITE ~ STANDARD % TOTAL
HOURS FEES UBDN FEES REALIZED EXPENSES URDH EXPENSES ~ REALIZED  BILLED
CATEGORY CODE: ACC  GENERAL ACCOUNTING SERVICES BILLAELE
PTD: 52300 7194887 86.13- 7203500 99.88% 0.00 0.00 000 0.00% 7194887
¥TD 2876.50 245420.57 1176743 257188.00 95.43% 0.00 0.00 000 000% 24542057
CATEGORY CODE: AUD  AUDIT SERVICES BILLAELE
PTD: 127.00 1300000 0.00 1300000 100.00% 0.00 0.00 000 0.00% 1300000
¥TD: 67500 74496 .53 5008 47- 79505.00 23.70% ooo o.oo ooo 0.00% 74496 .53
CATEGORY CODE! CLE CLERICAL BILLABLE
PTD: 258.30 790209 1441- 7916.50 99820 0.00 0.00 000 0.00% 790209
¥TD: 956,00 2741350 1577.05- 2595053 94.56% 0.00 0.00 000 0.00% 2741350
CATEGORY CODE! EXP BILLABLE EXPENSES EXPENSE
PTD: 0.00 000 0.00 000 0.00% 578599 45.01- 583100 9.23% 578599
¥TD: 0.00 000 0.00 000 0.00% 969565 215.35- 391100 97.83% 969565
CATEGORY CODE: FPS FINANCIAL PLANNING SERVICES EBILLABLE
PTD: 12.00 155565 19.35- 157500 98.77% ooo o.oo ooo 0.00% 155565
¥TD: 27.00 385213 1213 3B000  10032%4 0.00 0.00 000 0.00% 385213
CATEGORY CODE: MAS  MANAGEMENT ADVISORY SERVICES BILLABLE
PTD: 147.00 2358526 1974 23805.00 93 .92% ooo o.oo ooo 0.00% 2358526
¥TD: 52000 B1559.40 513580 BEEIS.00 94 08% ooo o.oo ooo 0.00% B1559.40
CATEGORY CODE MIC  MICROCOMPUTER CONSULTING BILLABLE
PTD 506.50 5025212 9022 85- 5927500 59.78% 0.00 0.00 000 0.00% 5025212
¥TD 1932.60 21294678 22267.32- 235214.00 90.53% 0.00 0.00 000 000% 21294678 -
B B D
D) C) == [0} ()

Fee Analysis Report by Category

Time Analysis Reports
The Time Analysis Reports feature consist of three separate reports:

» Time Analysis Report by Client (see page 294)

+ Time Analysis Report by Employee (see page 296)

+ Time Analysis Report by Category (see page 298)

These reports provide billable time and fee information for up to 13 periods by
client, employee, or category. (See the Time Analysis Reports Calculations
section, see page 55.) You can obtain both period-to-date and year-to-date
information. You can use sort options to select the information to be included on
applicable reports.

|Z[NOTE: Period 13 will only be displayed if your Sage MAS 90 or 200
General Ledger module is set to 13 periods.
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» Select Time Analysis Reports from the Time and Billing Professional Analysis
menu to access this option.
ﬂ-ﬁTime Analysis Reports K HE B

Optiar:
@ [Time Analvsis Henort by Client
(2 Time Analysis Report by Employes

() Time Analysis Report by Categony

[ Procesed I Cancel
I Lw2 | 9/7/2008

Time Analysis Reports Window

Print a Time Analysis Report by Client

Use the Time Analysis Report by Client to print time analysis information recapped
by client/engagement for up to 13 periods. You can choose to print information for
billable hours, non-billable hours, and billable fees.

1 Select Time Analysis Report by Client from the Time Analysis Reports
window. The Time Analysis Report by Client window appears.

EﬁTime Analysis Report by Client EH W= E3
Sort Options Clignt Code j
Print Billable Hours Print Mon-Billable Hours Print Billable Fees
Selection Al Starting Ending
Cliert Code - Q, fEFrrrrrilioN
Engagement Code s
[
[
[]
[
[]
[
Canon Salss [ Print [ Preview | Printer Setup.
[ Lwz | 9/7/2005

Time Analysis Report by Client Window

2 Select how to sort the report from the Sort Options field. You can sort the report
by:
Client Code
Client Name
Sort Field
Zip Code
Client Type
Client Partner
Client Employee
Engagement Partner
Engagement Employee

You can also sort the report by any of the user-defined fields created on the
Time and Billing Professional Options window (see page 80).
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3 Check Print Billable Hours to include billable hours in the report.
4 Check Print Non-Billable Hours to include non-billable hours in the report.
5 Check Print Billable Fees to include billable fees in the report.
6 Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR

» Enter the client codes to include in the Starting and Ending fields.

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

7 Enter the client engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.

8 Enter the names of clients to include in the Client Name field.
This field is available only if Client Name is selected in the Sort Options field.

9 Enter sort data to include in the Sort Field field.
This field is available only if Sort Field is selected in the Sort Options field.

10Enter the clients’ zip code to include in the Zip Code field.
This field is available only if Zip Code is selected in the Sort Options field.

11Enter the types of clients to include in the Client Type field.
This field is available only if Client Type is selected in the Sort Options field.

12Enter the employee partners to include in the Client Partner field.
This field is available only if Client Partner is selected in the Sort Options field.

13Enter the employees to include in the Client Employee field.
This field is available only if Client Employee is selected in the Sort Options
field.

14Enter the employee partners for the engagement to include in the Engagement
Partner field.
This field is available only if Engagement Partner is selected in the Sort
Options field.

15Enter the employees for the engagement to include in the Engagement
Employee field.
This field is available only if Engagement Employee is selected in the Sort
Options field.
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16Enter the miscellaneous data to include in the Miscellaneous field.
This field is available only if one of the user-defined fields created on the Time
and Billing Professional Options window (see page 80) is selected in the Sort
Options field.

17Select the employees to include in the Employee Code field.
This field is available only if Employee Code is selected in the Sort Options
field.

18Enter the work codes to include in the Work Code field.
This field is available only if Work Code is selected in the Sort Options field.

19Enter the category codes to include in the Category Code field.
This field is available only if Category Code is selected in the Sort Options
field.

20Click Print to print the report, or Preview to preview the report.

The Time Analysis Report by Client result depends upon the settings selected for
the report. The following report is sorted by client code, and includes engagement
code details, billable and non-billable hours, and billable fees.

(i Time Analysis Report by Client [_ O] <]
Time and Billing Pro
TIME ANALYSIS REPORT BY CLIENT
SORTED BY Client CODE
PER 1 PER2 PER3 PER &4 PER 3 PERE PERT PERE PER2? PER10 PEEI1] PER 12 TOTAL
Client CODE. 01-ABLEMAN ABLE MANUFACTURING
it CODE: PEOFESSIONAL SEEVICES
BILLABLE HOURS 1205 1000 1395 520 50- 0o oa oa 0o oa 0o oa 3170
NON-BILL HOUES 230 140 70 4.0 4.0- 0o oo oo 0o oo 0o oo 440
EBILLAELE FEES: 16527 10427 13863 SETE B411- o o o o o o o 37882
Client CODE. 01-ACME ACME WELDING COMPANY
it CODE: HETWORKING SEEVICES
BILLABLE HOURS 0o oa 0o oa 65 0o oa oa 0o oa 0o oa 65
NON-BILL HOUES 0o oo 0o oo 10 0o oo oo 0o oo 0o oo 10
EBILLAELE FEES: o o o o 780 o o o o o o o 780
Client CODE. 01-ALEEEDW EDWARD AND SUSAN ALEXANDER
E it CODE: PEOFESSIONAL SEEVICES
BILLABLE HOURS 0o 140 20 oa 55 0o oa oa 0o oa 0o oa 215
NON-BILL HOUES 0o 4.0 0o oo 20 0o oo oo 0o oo 0o oo &0
EBILLAELE FEES: o 1240 350 o 443 o o o o o o o 2035
Client CODE: OI-CANFIDG CANY¥ON FIDGE APARTMENTS
it CODE: PEOFESSIONAL SEEVICES
EBILLAELE HOURES: 42.0 48.1 8.0 370 430 0o oo oo 0o oo 0o oo 238.1
NON-BILL HOUES 70 oo 14.0 0 10 0o oo oo 0o oo 0o oo 250
BILLABLE FEES. 4580 5515 A250 3700 3545 o o o o o o o 23640
(B 3
5 ) A= () [ Y N £

Time Analysis Report by Client

Print a Time Analysis Report by Employee

Use the Time Analysis Report by Employee to print time analysis information
recapped by employee for up to 13 periods. You can choose to print information
for billable hours, non-billable hours, billable fees, target hours, and the variance
of total hours from target hours. You can also select whether you want the
variance based on billable hours only, non-billable hours only, or billable and
non-billable hours combined.
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1 Select Time Analysis Report by Employee from the Time Analysis Reports
window. The Time Analysis Report by Employee window appears.

EjTime Analysis Report by Employee EH W= E
Sort Options Employes Code j
Base Variance On Combined Rillsble/Non-Billable Houws =/ Prirt Billable Hours
Fririt Billable Fees Pritit Mon-Billable: Hours
Pt Variance Pt Target Hours
Selection All Starting Ending
Employes Code % 7 %
Dffice Code Q, zzz |9
[
[
Canon Salss [ Brit | Prewiew | Printer Setup.
[ Lw2 | 9/7/2005

Time Analysis Report by Employee Window
2 Select how to sort the report from the Sort Options field. You can sort the report
by:

Employee Code
Employee Last Name
Office Code
Employee Level

3 Select the type of hours to include in the report from the Base Variance On
field. You can select:

Combined Billable/Non-Billable Hours
Billable Hours
Non-Billable Hours

4 Check Print Billable Fees to include billable fees in the report.

5 Check Print Variance to include time variance in the report.

6 Check Print Billable Hours to include billable hours in the report.

7 Check Print Non-Billable Hours to include non-billable hours in the report.

8 Check Print Target Hours to include the number of target hours for the
employee in the report.

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

9 Enter the employees to include in the Employee Code field.
» Check All to include the information for all employees.
OR

» Enter the employee codes to include in the Starting and Ending fields.
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10Enter the offices to include in the Office Code field.
» Check All to include the information for all offices.
OR
 Enter the office codes to include in the Starting and Ending fields.

11Enter the employees to include by last name in the Employee Last Name field.
This field is only available if Employee Last Name is selected in the Sort
Options field.

12Enter the level of employees to include in the Employee Level field.
This field is only available if Employee Level is selected in the Sort Options
field.

13Click Print to print the report, or Preview to preview the report.

The Time Analysis Report by Employee result depends upon the settings selected
for the report. The following report is sorted by employee code, and includes
billable and non-billable hours, target hours, billable fees, and variance data.

(i Time Analysis Report by Employee M=l E3
Time and Biling P
TIME ANALYSIS REPORT BY EMPLOYEE
SORTED BY Employee CODE
PER]l PERZ PER3 FER4 FERS PER6 PER7 PERS PERS PERI0 PER1l PERI1Z  TOTAL
Employes CODE: 0100 IMA WINNUR
BILLAELE HOUES 810 360 80.0 400 580 00 0.0 0.0 00 0.0 00 0.0 3250
HON-EILL HOURS: 7.0 330 410 760 150 0.0 0.0 0.0 0.0 0.0 0.0 0.0 173.0
TARGET HOUES 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 12000
COMBINED VAE: 120- 310 210 150 40 1000-  1000- 1000 1000-  1000-  1000-  1000- W20-
VARIANCE %: l200%  -3100%  2100%  1600%  4.00% -l00.00% -10000% -100.00% -100.00% -10000% -l0000% -10000%  -58.50%
BILLAELE FEES: 14580 £480 13400 7200 15840 0 0 [ 0 [ [ 0 58500
Employes CODE: 0110  DREW LEEDER
BILLABLE HOUES 400 720 84.0 300 750 00 0.0 0.0 00 0.0 00 0.0 3510
HON-EILL HOURS 200 350 380 360 130 00 0.0 0.0 00 0.0 00 0.0 1420
TARGET HOUES: 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 12000
COMBINED VAR: 40.0- 70 220 150 120-  1000-  1000-  1000-  1000-  1000-  1000- 1000 07.0-
VARIANCE %: 4000%  700%  2200%  1600% -1200% -100.00% -100.00% -10000% -100.00% -10000% -100.00% -10000%  -58.92%
BILLABLE FEES 8000 ldd4d 17800 18000 14600 0 [} i 0 i [ [} 74844
Employes CODE 0120 B.A. WINNUR
BILLAELE HOUES 550 500 740 910 470 00 0.0 0.0 00 0.0 00 0.0 3270
HON-EILL HOURS 130 260 340 240 310 00 0.0 0.0 00 0.0 00 0.0 1280
TARGET HOUES 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 1000 12000
COMBINED VAR: 320- 14.0- 8.0 150 220-  1000- 1000 1000-  1000-  1000-  1000-  1000- 745.0-
VARIANCE %: 3200% -1400%  BOO%  1500% -2200% -100.00% -100.00% -100.00% -100.00% -10000% -100.00% -10000%  -6208%
BILLABLE FEES 8835 10125 13030 15390 3460 0 [} i 0 i [ [} 55840
Employes CODE 0130 RACHEL SCOTT =l
s =l

B@l e JOIE)

Time Analysis Report by Employee

Print a Time Analysis Report by Category
Use the Time Analysis Report by Category to print time analysis information

recapped by category for up to 13 periods. You can choose to print information for
billable hours, non-billable hours, and billable fees.
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1 Select Time Analysis Report by Category from the Time Analysis Reports
window. The Time Analysis Report by Category window appears.

ﬂ*ﬁTime Analysis Report by Category H BE B
[ Print Billable Hours Print Man-Billable Hours Print Billable Fees ]
Selectian All Starting Ending

Category Code: % zz % ‘

Canon Sales

FPrint I Preview l PFrinter Setup..

[ Lwz | 9/7/2005
Time Analysis Report by Category Window

2 Check Print Billable Hours to include billable hours in the report.
3 Check Print Non-Billable Hours to include non-billable hours in the report.

4 Check Print Billable Fees to include billable fees in the report.

I:gj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

5 Enter the categories to include in the Category Code field.
» Check All to include the information for all categories.
OR
» Enter the category codes to include in the Starting and Ending fields.

6 Click Print to print the report, or Preview to preview the report.
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The Time Analysis Report by Category result depends upon the settings selected
for the report. The following report contains all the categories and includes billable
hours, non-billable hours, and billable fees.

(i Time Analysis Report by Category [_ O] <]

d Billing Pr

TIME ANALY SIS REPORT BY CATEGORY

PER 1 PER2 PER3 PER &4 PER 3 PERE PERT PERE PER2? PERI10 PEEI1l PER1Z TOTAL

CATEGORY CODE: ACC  GENERAL aCCOUNTING SERVICES

BILLABLE HOURS 370 660 A21.5 £420 650 0o oa oa 0o oa 0o oa 28705
WON-BILL HOTURS 0o oa 0o oa oa 0o oa oa 0o oa 0o oa oa
EBILLAELE FEES: 35575 58850 32738 59915 38713 o o o o o o o 283793

CATEGORY CODE: AUD  AUDIT SERVICES

EBILLAELE HOUES: 6.0 1750 46,0 2910 270 0o oo oo 0o oo 0o oo 830
WON-BILL HOTURS 0o oa 0o oa oa 0o oa oa 0o oa 0o oa oa
BILLABLE FEES. 2905 19635 8330 29425 2500 o o o o o o o 27505
CATEGORY CODE: CDS CLIENT DEVELOPMENT
BILLABLE HOURS 0o oa 0o oa oa 0o oa oa 0o oa 0o oa oa
NON-BILL HOUES 0o oo &7.0 oo oo 0o oo oo 0o oo 0o oo E7.0
EBILLAELE FEES: o o o o o o o o o o o o o
CATEGORY CODE: CLKE  CLEFICAL
BILLABLE HOURS 205 2210 2600 2040 2225 0o oa oa 0o oa 0o oa 2380
NON-BILL HOUES 0o oo 0o oo oo 0o oo oo 0o oo 0o oo oo
EBILLAELE FEES: 2497 &307 7580 5942 7079 o o o o o o o 29413
CATEGORY CODE: FPS FINANCIAL PLANNING SERVICES
BILLABLE HOURS 0o 70 a0 70 50 0o oa oa 0o oa 0o oa 270
NON-BILL HOUES 00 0o 00 0o 0o 00 0o 0o 00 0o 00 0o 0o |
(B 3

[0 IR O [ P EYES

Time Analysis Report by Category

Client Billing Analysis Report

Use the Client Billing Analysis Report to print billing history information for up to 13
periods by client or engagement. You can choose to print billable hours,
non-billable hours, billable fees, billed fees, and billed expenses.

1 From the Analysis menu of the Time and Billing Professional module, select
Client Billing Analysis Report. The Client Billing Analysis Report window

appears.
(i Client Billing Analysis Report E W= 3
Sort Optiores Client Cade =
Pririt Billable Hours Pritit Mon-Billable: Hours Fririt Billable Fees
Fririt Billed Fees Fririt Billed Expenses
Selection All Starting Ending
Cliert Code o Q, fliErrrrrrd] SN
Engagement Code frrrsrrrrrrrrrrrrrrrd
L]
L]
L]
L]
L]
L]
Canan Sales [ Prirt | Presiew | Printer Setup..
[ Lw2 | 9/7/2005

Client Billing Analysis Report Window
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2 Select how to sort the report from the Sort Options field. You can sort the report
by:
Client Code
Client Name
Sort Field
Zip Code
Client Type
Client Partner
Client Employee
Engagement Partner
Engagement Employee

You can also sort the report by any of the user-defined fields created on the
Time and Billing Professional Options window (see page 80).

3 Check Print Billable Hours to include billable hours in the report.
4 Check Print Billed Fees to include fees already billed to the client in the report.
5 Check Print Non-Billable Hours to include non-billable hours in the report.

6 Check Print Billed Expenses to include expenses already billed to the client in
the report.

7 Check Print Billable Fees to include billable fees in the report.
8 Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR

» Enter the client codes to include in the Starting and Ending fields.

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

9 Enter the client engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.

10Enter the names of clients to include in the Client Name field.
This field is available only if Client Name is selected in the Sort Options field.

11Enter sort data to include in the Sort Field field.
This field is available only if Sort Field is selected in the Sort Options field.

12Enter the clients’ zip codes to include in the Zip Code field.
This field is available only if Zip Code is selected in the Sort Options field.
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13Enter the types of clients to include in the Client Type field.
This field is available only if Client Type is selected in the Sort Options field.

14Enter the employee partners to include in the Client Partner field.
This field is available only if Client Partner is selected in the Sort Options field.

15Enter the employees to include in the Client Employee field.
This field is available only if Client Employee is selected in the Sort Options
field.

16Enter the employee partners for the engagement to include in the Engagement
Partner field.
This field is available only if Engagement Partner is selected in the Sort
Options field.

17Enter the employees for the engagement to include in the Engagement
Employee field.
This field is available only if Engagement Employee is selected in the Sort
Options field.

18Enter the miscellaneous data to include in the Miscellaneous field.
This field is available only if one of the user-defined fields created on the Time
and Billing Professional Options window (see page 80) is selected in the Sort
Options field.

19Click Print to print the report, or Preview to preview the report.

The Client Billing Analysis Report result depends upon the settings selected for
the report. The following report is sorted by client code, and includes engagement
code details, billable and non-billable hours, fees and expenses already billed, and
billable fees.

(i Client Billing Analysis Report [_ O] <]
Time and Billing Pro nal Demo
CLIENT BILLING ANALYSIS REPORT
SORTED BY Glient GODE
PER1 PER 2 PER3 PER 4 PER 3 PER & PER7 PER® PEE® PER10 PER1l PER 12 TOTAL

Client CODE 01-ABLEMAN ABLE MANTFACTURING

E: CODE: 00000000000000000000 PROFESSIONAL SERVICES

BILLABLE HOTRS. 1205 1000 1385 520 250 oa 0o 0o oa 0o oa 0o 3170

HON-EBILL HOURS: 230 140 7.0 4.0 4.0- oo 0o 0o oo 0o oo 0o 44.0

EBILLAELE FEES: 18527 10427 13863 3878 B411- o o o o o o o 37882

BILLED FEES. 2100 13318 BAET 7300 3957- o o o o o o o 34644

BILLED EXPENSES. o 82 o o 1057 o o o o o o o 1139

Client CODE 01-ACME ACME WELDING COMPANT

Engagement CODE 00000000000000000000 NETWORKING SERVICES

EBILLAELE HOTURS: oo 0o oo 0o L3 oo 0o 0o oo 0o oo 0o L3

HON-BILL HOURS. oa 0o oa 0o 10 oa 0o 0o oa 0o oa 0o 10

BILLABLE FEES o o o o 730 o o o o o o o 730

EBILLED FEES: o o o o o o o o o o o o o

EBILLED EXPEMSES: o o o o o o o o o o o o o

Client CODE: 01-ALEXEDW EDWARD AND SUSAN ALEXANDER

E: CODE: 00000000000000000000 PROFESSIONAL SERVICES

EBILLAELE HOTURS: oo 140 20 0o 33 oo 0o 0o oo 0o oo 0o 215

HON-EBILL HOURS: oo 4.0 oo 0o 20 oo 0o 0o oo 0o oo 0o &0

BILLABLE FEES o 1240 350 o 445 o o o o o o o 2035

EBILLED FEES: o 1000 o 350 445 o o o o o o o 1795

EBILLED EXPEMSES: o o o o o o o o o o o o o
Client CODE: 01-CANEIDG CANTON RIDGE APARTMENTS |

6] 3
[ == [0 ()

Client Billing Analysis Report
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Budget Reports

The Budget Reports feature consists of four separate reports:

» Budget Report by Client (see page 303)

» Budget Report by Employee (see page 306)
» Budget Report by Work Code (see page 309)
» Budget Report by Category (see page 311)

These reports provide a recap of budget hours and amounts compared to actual
hours and amounts by client code, employee code, work code, and category code.
(See the Budget Reports Calculations section, see page 56.) Budget information is
detailed by budget items you entered on the Schedule/Budget Maintenance
window (see page 150) available in Client Maintenance (see page 144). You can
use sort options to select the information to be included on applicable reports.

» Select Budget Reports from the Time and Billing Professional Analysis menu
to access this option.

EE Budget Reports [z _[C]x]

Optiot

@ Budaet Benort by Client

(" Budget Report by Employes
(3 Budget Report by Work Code
(" Budget Report by Categany

[ Proceed I Lancel
| Lw2 | w7/2008
Budget Reports Window

Print a Budget Report by Client

Use the Budget Report by Client to print budget and variance information
recapped by client/engagement. You can detail the budget information further by
work code, category code, or employee code. You can also choose to print only
completed budget items.
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1 Select Budget Report by Client from the Budget Reports window. The Budget
Report by Client window appears.

{5 Budget Report by Client E mE=
Sort Options Client Code hdl
Prirt Completed Budgets Yes hdl
Selection All Starting Ending
Client Code 00- a, [EpeernrrdliSS
Engagement Code e
‘work Code G, =z |,
Category Code Q; 7 %
Budget Employee Code % ZEZZ %
[
[
[
[
[
Canon Sales [ Print Preview | Frinter Setup
[ Lw2 | 9/7/2005

Budget Report by Client Window

2 Select how to sort the report from the Sort Options field. You can sort the report
by:
Client Code
Client Name
Sort Field
Zip Code
Client Type
Client Partner
Client Employee
Engagement Partner
Engagement Employee

You can also sort the report by any of the user-defined fields created on the
Time and Billing Professional Options window (see page 80).

3 Select whether or not to include completed budgets from the Print Completed
Budgets field. You can select:

Yes
No
Completed Budgets Only

I:gj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.
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4 Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR
» Enter the client codes to include in the Starting and Ending fields.
5 Enter the client engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.
6 Enter the tasks to include in the Work Code field.
» Check All to include the information for all work codes.
OR
» Enter the work codes to include in the Starting and Ending fields.
7 Enter the categories to include in the Category Code field.
» Check All to include the information for all categories.
OR
» Enter the category codes to include in the Starting and Ending fields.
8 Enter the employees to include in the Budget Employee Code field.
» Check All to include the information for all employees.
OR
» Enter the employee codes to include in the Starting and Ending fields.

9 Enter the names of clients to include in the Client Name field.
This field is available only if Client Name is selected in the Sort Options field.

10Enter sort data to include in the Sort Field field.
This field is available only if Sort Field is selected in the Sort Options field.

11Enter the clients’ zip codes to include in the Zip Code field.
This field is available only if Zip Code is selected in the Sort Options field.

12Enter the types of clients to include in the Client Type field.
This field is available only if Client Type is selected in the Sort Options field.

13Enter the employee partners to include in the Client Partner field.
This field is available only if Client Partner is selected in the Sort Options field.
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14Enter the employees to include in the Client Employee field.
This field is available only if Client Employee is selected in the Sort Options

field.

15Enter the employee partners for the engagement to include in the Engagement
Partner field.
This field is available only if Engagement Partner is selected in the Sort
Options field.

16Enter the employees for the engagement to include in the Engagement
Employee field.
This field is available only if Engagement Employee is selected in the Sort
Options field.

17Enter the miscellaneous data to include in the Miscellaneous field.
This field is available only if one of the user-defined fields created on the Time
and Billing Professional Options window (see page 80) is selected in the Sort
Options field.

18Click Print to print the report, or Preview to preview the report.

The Budget Report by Client result depends upon the settings selected for the
report. The following report is sorted by client code, and includes completed

(i Budget Report by Client [_ O] <]
Time and Billing Pro
BUDGET REPORT BY CLIENT
SORTED BY Glient GODE
W Employes
CATEG CODE WAME
B HOURS + +- VARIANCE —+ +-- BUDGET ---+ +-- ACTTTAL —+ +- WARTANCE -+
BUDGET  NON-EILL EILL HOUES Ed AMOUNT EATE AMOUNT EATE AMOUNT o

Client CODE 01-ABLEMAN ABLE MANUFACTURING
E: CODE: 00000000000000000000 PROFESSIONAL SERVICES
ALL ALL Emplayee CODES ACTIVE ANNTTAT

5500 5000 33%.00 334 00 07 2% 6289 75 1205450 40236 98 103 440 26062 77- -3931%
TACT ALL Employee CODES ACTIVE ANNUAL

000 113.50 236 50- -BT AT 28750 00 85000 12613.00 111130 17137.00- -57.60%

IATTT ALL Emplayee CODES ACTIVE ANNTTAT

5000 0.00 13.00 37.00- -74.00% 4000.00 20000 214500 165,000 1855.00- -46.38%
A4S ALL Employee CODES ACTIVE ANNUAL

000 3%.00 1.00- -2.50% 2000.00 200000 AT65.00 173460 123500- -15.44%

MIC ALL Emplayee CODES ACTIVE ANNTTAT

17500 0.00 £5.00 110.00- -B2BE% 17500.00 100.000 2375.00 144230 £125.00- -46.43%
UHALLOCATED 560.00- 5000 108.50 71830 -128.30% 704975 740,450 9338.98 58.920 228923 3247%
Engm TOTALS: 5500 5000 332.00 33400 E07.27% BE299.75 4023898 2606277 -39.31%
Engagement CODE 00000000000000000001 HETWORK INSTALLATION
ALL ALL Employee CODES ACTIVE NON-EECUREING

3000 000 0.00 30.00- -100.00% 3250.00 108333 0.00 0.000 325000- -100.00%
AMIC 0130 RACHEL SCOTT ACTIVE NON-EECUREING INITIAL NETWORK INSTALLATION

27.00 0.00 2200 5.00- -18.52% 337500 125,000 2730.00 125,000 2500 -18.52%
MIC 0140 GEORGE ROGERS PLANNED WON-RECURRING COMPLETION OF DATA CONVERSION

2500 0.00 0.00 25.00- -100.00%. 312500 125.000 0.00 0.000 3125.00- -100.00% |

‘ v
[ == [0 ()

Budget Report by Client

Print a Budget Report by Employee

Use the Budget Report by Employee to print budget and variance information
recapped by employee. You can detail the budget information further by
client/engagement code and work/category code. You can also choose to print
only completed budget items, and select whether you want the variance based on
billable hours only, non-billable hours only, or billable and non-billable hours
combined.
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1 Select Budget Report by Employee from the Budget Reports window. The
Budget Report by Employee window appears.

ﬂj Budget Report by Employee [ 2] -1C]
Sart Optians Employee Code ﬂ
Print Completed Budgets Yeg ﬂ
Base Hours Variance On Combined Eilable/Non-Billable Hours | |
Selection All Starting Ending
Employee Code % ZETE %
Cliert Code - Q, irrrrrrriiiey
Engagement Code b e
‘Work Code Q, zzz |G
Category Code % s %
L
L
L
Canon Sales [ Frint | Prewview | Frinter Setup...
[ Lw2 | 9/7/2008

Budget Report by Employee Window

2 Select how to sort the report from the Sort Options field. You can sort the report
by:
Employee Code
Employee Last Name
Office Code
Employee Level

3 Select whether or not to include completed budgets from the Print Completed
Budgets field. You can select:

Yes
No
Completed Budgets Only

4 Select the type of hours to include in the report from the Base Hours Variance
On field. You can select:
Combined Billable/Non-Billable Hours

Billable Hours
Non-Billable Hours

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

5 Enter the employees to include in the Employee Code field.
» Check All to include the information for all employees.
OR

» Enter the employee codes to include in the Starting and Ending fields.
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6 Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR
» Enter the client codes to include in the Starting and Ending fields.
7 Enter the client engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.
8 Enter the tasks to include in the Work Code field.
» Check All to include the information for all work codes.
OR
» Enter the work codes to include in the Starting and Ending fields.
9 Enter the categories to include in the Category Code field.
» Check All to include the information for all categories.
OR
» Enter the category codes to include in the Starting and Ending fields.

10Enter the employees to include by last name in the Employee Last Name field.
This field is only available if Employee Last Name is selected in the Sort
Options field.

11Enter the employees’ office codes to include in the Office Code field.
This field is only available if Office Code is selected in the Sort Options field.

12Enter the level of employees to include in the Employee Level field.
This field is only available if Employee Level is selected in the Sort Options
field.

13Click Print to print the report, or Preview to preview the report.
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The Budget Report by Employee result depends upon the settings selected for the
report. The following report is sorted by employee code, and includes completed
budgets, and combined billable and non-billable hours.

i Budget Report by Employee H[=]

BUDGET REPORT BY EMPLOYEE

SORTED BY Employee CODE

wed
CATEG ~ DESCRIPTION
J— (1) - p— + +COMEINED VAR+ +-- BUDGET -+ +-- ACTUAL -+ +- VARIANCE -+
BUDGET ~ NON-BILL BILL HOURS % AMOUNT  RATE AMOUNT  RATE AMOUNT 3

Employee CODE: 0130 RACHEL SCOTT

Client CODE. 01-ABLEMAN
E: CODE: 00000000000000000001 NETWORK INSTALLATION
MIC MICROCOMPUTER CONSULTING ACTIVE WON-RECURRING INITIAL NETWORK INSTALLATION

27.00 0o0o 22.00 5.00- -18.52% 3375.00 125.000 275000 125.000 #25.00- -18.528
Clnt TOTALS: 27.00 000 22.00 5.00- -18.52% 337500 275000 62500- -18.52%%
Client CODE: 01-GENECOM
E: CODE: 00000000000000000001 NETWORK INSTALLATION
MIC MICROCOMPUTER CONSULTING PLAMNED WON-RECURRING UPGRADE TO REV 30

500 0o0o o.00 500- -100.00% 180.00 38.000 o.00 0.000 180.00- -100.00%

Clnt TOTALS: 500 000 000 500- -100.00% 180.00 000 180.00- -100.00%
Empl TOTALS 3200 000 22.00 10.00- -31.25% 355500 275000 20500- -2264%
Employee CODE: 0140 GEORGE ROGERS
Client CODE. 01-ABLEMAN
E: CODE: 00000000000000000001 NETWORK INSTALLATION i

K|
Elol ruer JO[0)

Budget Report by Employee

Print a Budget Report by Work Code

Use the Budget Report by Work Code to print budget and variance information
recapped by work code. You can detail the budget information further by
client/engagement code and employee code. You can also choose to print only
completed budget items.

1 Select Budget Report by Work Code from the Budget Reports window. The
Budget Report by Work Code window appears.

ﬂ-ﬁBudget Report by Work Code K HE B
Print Completed Budgets Yes ﬂ
Selection Al Starting Ending
work Code =% zz |G,
Clierkt Code - Q 997777777 |G,
Engagement Code b b
Employes Code % prrrs %
Canon Sales [ FBrint | Prexvigw | Frinter Setup...
I Lw2 | 9/7/2008

Budget Report by Work Code Window

2 Select whether or not to include completed budgets from the Print Completed
Budgets field. You can select:

Yes
No
Completed Budgets Only
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I:gj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

3 Enter the tasks to include in the Work Code field.
» Check All to include the information for all work codes.
OR
+ Enter the work codes to include in the Starting and Ending fields.
4 Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR
 Enter the client codes to include in the Starting and Ending fields.
5 Enter the client engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.
6 Enter the employees to include in the Employee Code field.
» Check All to include the information for all employees.
OR
+ Enter the employee codes to include in the Starting and Ending fields.

7 Click Print to print the report, or Preview to preview the report.
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The Budget Report by Work Code result depends upon the settings selected for
the report. The following report includes completed budgets.

(i Budget Report by Work Code M=l E3
Time and Billing Pro
BUDGET REPORT BY WORK CODE
Employes
CODE  NAME
B HOURS + +- VARIANCE —+ +-- BUDGET ---+ +-- ACTTTAL —+ +- WARTANCE -+
BUDGET  NON-EILL EILL HOUES Ed AMOUNT EATE AMOUNT EATE AMOUNT E

Work CODE. ALL Work CODES
Client CODE: 0l-ABLEMAN ABLE MANUFACTUEING
Engagement CODE 00000000000000000000 PROFESSIONAL SERVICES
ALL Employes CODES ACTIVE ANNUAL

5500 5000 33%.00 334 00 07 2% 6289 75 1205450 40236 98 103 440 26062 77- -3931%
E: CODE: 00000000000000000001 NETWORK INSTALLATION
ALL Employee CODES ACTIVE HON-RECURRING

3000 000 0.00 30.00- -100.00% 3250.00 108333 0.00 0.000 325000- -100.00%
Clnt TOTALS 8500 5000 332.00 304,00 357.83% £3549.75 4023898 2931277 -42.15%
Client CODE: 01-ACME ACME WELDING COMPANY
E CODE: 00000000000000000000 WETWORKING SERVICES
ALL Employes CODES PLANNED NON-EECUREING

40,00 1.00 £.50 32.50- -B1.25% 4800.00 120,000 780.00 104,000 4020.00- -B3.75%
Clnt TOTALS 40,00 1.00 £.50 32.50- -B1.25% 4800.00 780.00 4020.00- -B3.75%
Client CODE 01-ALEXEDW EDWARD AND SUSAN ALEXANDER |

I | v
[ == [0 ()

Budget Report by Work Code
Print a Budget Report by Category

Use the Budget Report by Category to print budget and variance information
recapped by category. You can detail the budget information further by
client/engagement code and employee code. You can also choose to print only
completed budget items.

1 Select Budget Report by Category from the Budget Report window. The
Budget Report by Category window appears.

Ejﬂudget Report by Category [ M= 3
Prirt Completed Budgets Yes =
Selection All Starting Ending
Category Code % o %
Client Code 00 @, $977Z77 |G
Engagement Code - - T 7T 7T T |
Employee Code % 22 %
Canon Salss [ Brit | Prewiew | Printer Setup.
[ Lw2 | 9/7/2005

Budget Report by Category Window

2 Select whether or not to include completed budgets from the Print Completed
Budgets field. You can select:

Yes
No
Completed Budgets Only
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I:gj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

3 Enter the categories to include in the Category Code field.
» Check All to include the information for all categories.
OR
+ Enter the category codes to include in the Starting and Ending fields.
4 Enter the clients to include in the Client Code field.
» Check All to include the information for all clients.
OR
» Enter the client codes to include in the Starting and Ending fields.
5 Enter the client engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.
6 Enter the employees to include in the Employee Code field.
» Check All to include the information for all employees.
OR
+ Enter the employee codes to include in the Starting and Ending fields.

7 Click Print to print the report, or Preview to preview the report.
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The Budget Report by Category result depends upon the settings selected for the
report. The following report includes completed budgets.

[ Budget Report by Category [_ O]
Time and Billing Professional Demo
BUDGET REPORT BY CATEGORY
Employes
CODE  HAME
[r— a0 cTopu— + +- TARTANCE -+ 4-- BUDGET —+ 4o ACTUAL -+ +- VARIANCE -+
EUDGET  NON-EILL BILL HOURS E3 AMOUNT RATE AMOUNT RATE AMOUNT E

CATEGORY CODE. ALL CATEGORIES
Client CODE: 01-ABLEMAN AELE MANUFACTURING
E t CODE PROFESSIONAL SERVICES
ALL Employes CODES ACTIVE ANNUAL

55.00 50.00 33900 334.00 B07.27% BE299 75 1205 450 40236 58 103.440 26062.77- -3331%
E it CODE HETWORK INSTALLATION
ALL Employee CODES ACTIVE HON-RECURRING

30.00 000 000 30.00-  -10000% 325000 102333 000 0.000 3250.00- -100.00%%
Clat TOTALS: g5.00 50.00 339.00 304.00 35785% B9549.75 4023698 29312.77- -42.15%
Client CODE: 01-ACME ACME WELDING COMPANY

it CODE HETWORKING SERVICES

ALL Employes CODES PLANNED HON-RECURRING

40.00 1.00 .50 32.50- -81.25% 480000 1200000 780,00 104.000 4020.00- -83.75%
Clat TOTALS: 40.00 1.00 .50 32.50- -81.25% 480000 780,00 4020.00- -83.75%
Client CODE . 01-ALEXEDW EDWARD AND SUSAN ALEXANDER |

i g

17 [ M= [ [

Budget Report by Category

Employee Scheduling Report

Use the Employee Scheduling Report to print a detailed listing of all scheduled
activities entered on the Schedule/Budget Maintenance window (see page 150)

available in the Client Maintenance window. The scheduled activities appear in
chronological order by projected start date.

Print the Employee Scheduling Report

1 From the Analysis menu of the Time and Billing Professional module, select
Employee Scheduling Report. The Employee Scheduling Report window

appears.
i Employee Scheduling Report EH M= B
Sort Optiohs Emplayes Code hdl
Status Tupe to Print All ﬂ
Schedule Type to Print Al =
Selection All Starting Ending
Employes Code Q 7777 By
Projected Start Date 12/31/29593
Actual Start Date 1243142999
Projected Completion Date 12/31/29593
Actual Completion Date 12431729593
[
L]
[

Canon Sales

[ Frint [ Preview | Printer Setup..

Lw2 | 9/7/2005

Employee Scheduling Report Window
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2 Select how to sort the report from the Sort Options field. You can sort the report
by:
Employee Code
Client Code
Work Code
Category Code

3 Select the type of budgets to include in the report from the Status Type to Print
field. You can select:

All
Planned
Active
Completed
Cancelled

4 Select the schedule types include in the report from the Schedule Type to Print
field. You can select:

All
Non-Recurring
Monthly
Quarterly
Semi-Annual
Annual

I:gj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

5 Enter the employees to include in the Employee Code field.
» Check All to include the information for all employees.
OR
+ Enter the employee codes to include in the Starting and Ending fields.
6 Enter the estimated start date for the schedule in the Projected Start Date field.
» Check All to include the information for all estimated start dates.
OR
» Enter the estimated start dates to include in the Starting and Ending fields.
7 Enter the actual start date for the schedule in the Actual Start Date field.
+ Check All to include the information for all actual start dates.
OR

» Enter the actual start dates to include in the Starting and Ending fields.
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8 Enter the estimated finish date for the schedule in the Projected Completion
Date field.

» Check All to include the information for all estimated finish dates.
OR
* Enter the estimated finish dates to include in the Starting and Ending fields.

9 Enter the actual finish date for the schedule in the Actual Completion Date
field.

» Check All to include the information for all actual finish dates.
OR
» Enter the actual finish dates to include in the Starting and Ending fields.

10Enter the clients to include in the Client Code field.
This field is only available if Client Code is selected in the Sort Options field.

11Enter the tasks to include in the Work Code field.
This field is only available if Work Code is selected in the Sort Options field.

12Enter the categories to include in the Category Code field.
This field is only available if Category Code is selected in the Sort Options
field.

13Click Print to print the report, or Preview to preview the report.

The Employee Scheduling Report result depends upon the settings selected for
the report. The following report is sorted by employee code, and includes all status
types and all schedule types.

(i Employee Scheduling Report [_ O] <]

Time and Billing Profes

EMPLOYEE SCHEDULING REFORT
SORTED BY Employes CODE
ALL STATUSES AND ALL TYPES

PROJECTED ACTIAL PROIECTED ACTUAL Wy SCH BUDGET

START START COMPLETE COMPLETE Cht Engmt CATEG ST TYP HOURS COMMENT

Employee CODE 0130 RACHEL SCOTT

0171088 011498 O1-ABLEMAN  00000000000000000001 AMIC A N 27.00 INITIAL NETWORE INSTALLATION

0871598 OI-GEWECOM  00000000000000000001 AMIC P N 5.00 UPGFADE TOFEV 3.0

Employee CODE 0140 GEORGE ROGERS

053198 01-ABLEMAN  00000000000000000001 MIC P W 2500 COMPLETION OF DATA CONVERSION

Employee CODE o0z10 BAFBAFRA FEVHOLDS

063098 01-ABLEMAN  00000000000000000001 MIC P W 5.00 BEGIN SPEC. FOR CTIST REPORTS

Employee CODE 0240 JENNIFEE HAAS

061598 01-GENECOM  O0000000000000000001 MIC P W 3.00

Employee CODE 0z70 MARK MILLER

04,2098 051998 O1-ABLEMAN  00000000000000000001 AMIC A N 20.00

0812598 OI-GEWECOM  00000000000000000001 AMIC PO 3.00 QUARTEFLY PREV. MAINT CHECE

Employee CODE 02z0 JOHN DOE

030705 00705 01-4CME HP& P W 40.00 i |
I :
[ () BT [ 7]

Employee Scheduling Report
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Employee Hourly Analysis Report

The Employee Hourly Analysis Report provides a recap of hours recorded by day
of the week for each employee. This report is particularly useful for checking for
missing time cards and analyzing workload information for each employee. You
can produce the report for a five-, six-, or seven-day work week.

The program retains employee analysis information in the Employee Hourly
Analysis file for the period of time specified in the Days to Retain Employee
Hourly Analysis field on the Time and Billing Professional Options window (see

page 80).

Print an Employee Hourly Analysis Report

1 From the Analysis menu of the Time and Billing Professional module, select
Employee Hourly Analysis Report. The Employee Hourly Analysis Report
window appears.

EjEmplnyEE Houtly Analysis Report I M= 3
Sart Options Employes Code ﬂ
Days per ‘Week 5 Day Week [Monday - Friday] |
Selection All Starting Ending
Employes Code % b %
Office Code Q, =z |4,
Date ] 03/04/2005 03/10/2005
[
[
Canon Sales [ PBrint [ Previen | Pinter Setup
I Lwz | a/7/2008

Employee Hourly Analysis Report Window

2 Select how to sort the report from the Sort Options field. You can sort the report
by:
Employee Code
Employee Last Name

Office Code
Employee Level

3 Select the work week to use from the Days per Week field. You can select:

5 Day Week (Monday - Friday)
6 Day Week (Monday - Saturday)
7 Day Week (Sunday - Saturday)

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in

the field.
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4 Enter the employees to include in the Employee Code field.
» Check All to include the information for all employees.
OR
» Enter the employee codes to include in the Starting and Ending fields.
5 Enter the offices to include in the Office Code field.
» Check All to include the information for all offices.
OR
» Enter the office codes to include in the Starting and Ending fields.
6 Enter the date for the report in the Date field.
» Check All to include the information for all dates of the report.
OR
» Enter the dates of the report to include in the Starting and Ending fields.

7 Enter the employees to include by last name in the Employee Last Name field.
This field is only available if Employee Last Name is selected in the Sort
Options field.

8 Enter the level of employees to include in the Employee Level field.
This field is only available if Employee Level is selected in the Sort Options
field.

9 Click Print to print the report, or Preview to preview the report.

The Employee Hourly Analysis Report result depends upon the settings selected
for the report. The following report is sorted by employee code, and includes data
for a five-day work week.

Employee Hourly Analysis Report [_ O[]
Time and Billing Pre j
EMPLOYEE HOURLY ANALYSIS REPORT
FOR DATES THRU 1231759
SORTED BY Ermployee CODE
Emplogee WEEE.
CODE  NAME OFFC LVL OF MONDAY ~ TUESDAY WEDNESDAY THURSDAY FRIDAT TOTAL
o100 M4 WINHUR MCC 1 0372098 2500 0o i} i} i} 2500
04/10/98 800 00 a0 a0 00 3800
0571558 0 0 a0 a0 200 200
Employee 0100 TOTALS 33.00 00 a0 a0 2.00 3500
o110 DREW LEEDER GAS 0 0372098 1500 o i} i} i} 1500
0471098 800 0o i} i} i} 800
05/01/28 oo oo oo .00 0o .00
05/29/98 2.00 .00 .00 15.00 .00 45.00
Employee 0110 TOTALS 31.00 200 200 21.00 .00 76.00
o120 B.A WINNUR GAS 1 0372098 14.00 0o i} i} i} 14.00
0372798 oo oo oo 20,00 0o 2000
0410778 2.00 oo oo oo i} 2.00
050198 0o 0o i} 8.00 i} 800
0smems ] ] 0 0 16.00 16.00
Employee 0120 TOTALS 2200 0o il 23.00 le.00 86,00
0130 RACHEL SCOTT MCC 3 032796 ] ] a0 200 o 200
0471058 200 ] a0 a0 il 200
050198 o o i} .00 i} 800
05/08/98 00 00 a0 40.00 00 40.00 |
FIT]
5] () I ) )

Employee Hourly Analysis Report
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A/R and WIP Reconciliation Report

The A/R and WIP Reconciliation Report provides a concise recap of Accounts
Receivable and work in process activity for the current period by
client/engagement.

Page 318

For Accounts Receivable reconciliation, the report includes the balance forward
amount, invoiced amount, finance charge amount, payment received amount,
and ending balance.

For Work in Process reconciliation, the report includes opening work in process
balance, billable fees and expenses, billed amount, write-up/write-downs, and
closing work in process.

Print the A/R and WIP Reconciliation Report

1 From the Analysis menu of the Time and Billing Professional module, select

A/R and WIP Reconciliation Report. The A/R and WIP Reconciliation Report
window appears.

Ejn,;"ll and WIP Reconciliation Report
Sort Optiohs Client Code hdl
Period 05 05/01/58 Thiu 05/31/38
Fieconciliation to Print AR andwWIP v
Selection All Starting Ending
Clignt Code 0- Q 97777777 By
Engagement Code ) e
L
|
L
|
L
Canon Sales [ Frint [ Preview | Printer Setup..
I Lw2 | 9/7/2005

A/R and WIP Reconciliation Report Window

2 Select how to sort the report from the Sort Options field. You can sort the report

by:

Client Code
Client Name
Sort Field

Zip Code

Client Type
Client Partner
Client Employee.

You can also sort the report by any of the user-defined fields created on the
Time and Billing Professional Options window (see page 80).
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3 Select the type of data to include in the report from the Reconciliation to Print
field. You can select:

A/R and WIP
AR
wWIP

I:b HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

4 Enter the clients to include in the Client Code field.
+ Check All to include the information for all clients.
OR
» Enter the client codes to include in the Starting and Ending fields.
5 Enter the client engagements to include in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.

6 Enter the names of clients to include in the Client Name field.
This field is available only if Client Name is selected in the Sort Options field.

7 Enter sort data to include in the Sort Field field.
This field is available only if Sort Field is selected in the Sort Options field.

8 Enter the clients’ zip code to include in the Zip Code field.
This field is available only if Zip Code is selected in the Sort Options field.

9 Enter the types of clients to include in the Client Type field.
This field is available only if Client Type is selected in the Sort Options field.

10Enter the employee partners to include in the Client Partner field.
This field is available only if Client Partner is selected in the Sort Options field.

11Enter the employees to include in the Client Employee field.
This field is available only if Client Employee is selected in the Sort Options
field.

12Enter the miscellaneous data to include in the Miscellaneous field.
This field is available only if one of the user-defined fields created on the Time
and Billing Professional Options window (see page 80) is selected in the Sort
Options field.

13Click Print to print the report, or Preview to preview the report.
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The A/R and WIP Reconciliation Report result depends upon the settings selected
for the report. The following report is sorted by client code that contains work in

process information only.

i Ar and WIP Reconciliation Report M=l E3
Time and Billing Prr : j
AR AND WIP RECONCILIATION REPORT
PERIOD: 05 05/01/98 THRU 05/31/98
FOR WiP ONLY, SORTED BY Client
Engagement COPENING BILLABLE BILLABLE BILLED BILLED WRITE ENDING
CODE WIP FEES EXPENSE FEES EXPENSES URDH WIP
Client CODE 01-ABLEMAN  ABLE MANTUFACTURING
00000000000000000000 &189.20 B411.83- 147.00- 3958.93- 105893 2105 35180
00000000000000000001 315000 oo Ruil oo oo Ruil 315000
Client 01-ABLEMAN TOTALS, 933920 2411 65- 147.00- 3956 93- 1056 83 2105 370160
Client CODE 01-ACME ACME WELDING COMPANT
00000000000000000000 oo 780,00 3500 oo oo Ruil 21500
Client 01-4CME TOTALS oo 73000 3500 oo oo na 1500
Client CODE: Ol-ALEXEDW EDWAERD AND SUSAN ALEXANDER
00000000000000000000 oo 44500 na 44500 oo na oo
Client 01-ALEXEDW TOTALS: oo 44500 Ruil 44500 oo Ruil oo
Client CODE: 0l-CANEIDG ~ CANYON EIDGE APARTMENTS
00000000000000000000 oo 354500 30.00 354500 3000 na oo
Client 01-CANFIDG TOTALS oo 354500 30.00 354500 3000 Ruil oo

i)
[ == [0 ()

A/R and WIP Reconciliation Report

Professional manual.
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Chapter 11
Using the Period End Menu

Chapter 11: Using the Period End Menu focuses on the accounting aspects of the
Time and Billing Professional module and explains how to process the period end
data and print invoices. The activities in this chapter are usually performed by an
accountant or financial administrator.

How to Use the Period End Processing Menu

The options available in the Period End menu allow your company to process
financial data for the period end.

Open a Window from the Period End Menu

1 Double-click the Professional Retainer Control module from the Modules tab.
The module expands to display all the menu options available in the
Professional Retainer Control module.

2 Click the Period End menu. The names of the windows available in the menu
appear on the right side of the Sage MAS 90 or 200 window.

Professional Retainer Control - Period End
Up one level...
Statement Printing
[E=lPerind End Pracessing

Windows Available in the Period End Menu

3 Double-click the name of the window to open. The system displays the selected
window.

Statement Printing

Use the Statement Printing feature to print statements for selected clients onto
preprinted statement forms or plain paper. A standard, default statement format is
supplied with your Time and Billing Professional module.

Print Time and Billing Statements

1 Select Statement Printing from the Time and Billing Professional Period End
menu.

2 If this is the first time you are selecting the Statement Printing window, the
Template Selection window appears. Select the form or report template to use or
to customize in Crystal Reports Designer, and click OK.

The Statement Printing window appears. The window consists of two tabs: the
Main and the Select tab.
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{h Statement Printing (LW2) 7/24/2007 =19
Form Code %
Description ‘ |

MNurber of Copies I:Ij Multi-Part Form Enabled Multi Part...

1. Main W 2 Select 1

Sort Statements By l:l

Age Invoices as OF
Select Statements with Minimum B alance Of

Select Customers with Balance Past Aging Category

L

Produce Statements For |

Include

Temporary Customers I:l Credit Balances I:l
Zero Balance Customers [ Zero Balance Invoices l:l

‘ | [ghgnmentJ [ Frint I Prexiew J

Statement Printing Window

3 Select the form code from the Form Code field.

4 Change the description in the Description field, if necessary.

5 Click the button to access the Accounts Receivable Statement
Messages window.

[k Statement Messages

Standard Meszage
LIME ONE OF THE &

‘ THIS |5 LINE T\wW0 OF THE STANDARD MESSAGE = |

Ower 30 Days

‘ Just an over-sight? “we would appreciate bringing |

‘your account curent. Thanks for your business. |

Ower BO Days

‘ Paymert is expected within 30 days of invoice |

‘ date. Please remit all past due amaunts today, |

Ovwer 90 Days

‘ Please remit all past due amounts TODAY. |f there |

‘ iz a biling problem, please call our office,

Ower 120 Days

‘Youl account with us is sefiously past due.

‘ Remit today so that we may continue to serve you,

Statement Messages Window

a Enter additional messages to printed invoices in the fields available on this
window.

b Review the information and click OK.

See the Accounts Receivable Online Help by Sage Software for more information.
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6 Type the number of copies you want to produce in the Number of Copies field.

OR

Use the spin buttons (|1 j ) to increment (up arrow) or decrement (down

arrow) to the number of copies you want.

field.

|Z[NOTE: Setting this field to any number beyond 1 activates the Collated

This field is NOT available if you use the Multi Part Enable feature.

7 Select the check box next to the Collated option to collate the copies of the

report (that is, sort them in sets).

Clear this check box to output copies of the report unsorted.

8 Select the Multi Part check box to enable multi-part printing, that is set up the
printers and the number of copies on the Multi-Part Form Maintenance window.

The button is available only if this check box is selected.

Clear this check box to disable multi-part printing.

Multi-part printing allows you to print your documents to multiple locations. This
functionality takes the place of preprinted multiple part carbon/carbonless forms.

See the Library Master Online Help by Sage Software for more details.

¥ On the Main tab of the Statement Printing window:

{7 Statement Printing (LW2) 6/22/2007 EEX

FomCode | STANDARD] a,

Description | Plain

MNumber of Copies 1 j Multi-Part Form Enabled |:|

1. Main W 2 Select 1

Sort Statements By | Customer Mumber  +

Age Invoices as OF E/22/2007 E

Select Statements with Minimum Balance Of 0

=

Select Customers with Balance Past Aging Category | Currert Category v

Produce Statements For Frirt All Statements <

Include

Temporary Customers Yes v Credit Balances No -

Zero Balance Customers [ Zero Balance Invoices | Curent Month Orly +

Canorn iR330-400 PS Ver 1.0 - [glignment} [ Frint I Prexview I Setup

Statement Printing Window - Main Tab

Chapter 11: Using the Period End Menu Time and Billing Professional Manual

Page 323




Chapter 11

9 Select how to sort the statements from the Sort Statements By field. You can
sort the statements by:

Customer Number
Customer Name
Salesperson
Customer Type
Sort Field

State

Zip Code

Tax Schedule,
Client Partner
Client Employee

You can also sort the report by any of the user-defined fields created on the
Time and Billing Professional Options window (see page 80).

10The Age Invoices as Of field defaults to the current date. Change the date, if
necessary.

Click the [ button available in this field to select the accounting date to use to
age the invoices printed on the statements from an electronic calendar.

11Enter the minimum balance to use to determine which customer statements to
print in the Select Statements with Minimum Balance Of field.

Statements for customers with balances less than the amount entered are NOT
printed.

12Select the option for printing statements for customers with balances in the
current period or with past due balances in an aging category from the Select
Customers with Balance Past Aging Category field. You can select:

» Current Category - for currently due balances
» 1st Category - for balances 30 days past due

* 2nd Category - for balances 60 days past due
+ 3rd Category - for balances 90 days past due

+ 4th Category - for balances 120 days past due
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13 Select whether to print and/or e-mail customer statements from the Produce
Statements For field. Statements that are e-mailed are sent in PDF format.
You can select:

» Print All Statements to print all statements for all customers, regardless of
whether the e-mail option was selected

+ E-mail Statement Customers Only to e-mail the statement for customers with
the e-mail option selected

* Print Statement Customers Only to print the statement for customers with the
e-mail option cleared

* Print All and E-mail Customers to print all statements and e-mail only those
customers with the e-mail option selected

* Print or E-mail Customers to print all statements or e-mail to those customers
with the e-mail option selected

If you select the E-mail Statement Customers Only, Print All and E-mail
Customers, or Print or E-mail Customers options, the E-mail button becomes
available.

a Click the button to access the E-mail Options window.

[ E-mail Options @E|

E-mail
|

Subject
From Address

Test Mode
Send in Test Mode O

E-mail Address to Receive Test

E-mail Options Window
b Enter the relevant information in the available fields.
c Click OK.

14Select the types of customers to include from the Temporary Customers field.
You can select:

Yes
No
Only

15Select whether to include credit balances from the Credit Balances field. You
can select:

Yes
No
Only

16Check Print Zero Balance Customers to print invoices for customers with a
zero balance due.
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17Select whether to include zero balance invoices in the Zero Balance Invoices
field. You can select:

Yes
No
Current Month Only

V¥ On the Select tab of the Statement Printing window:

i Statement Printing (LW2) 6/22/2007 [=E

FormCods | STANDARD a,

Description | Plain

MNumber of Copies 1 ﬂ Multi-Part Form Enabled I:‘

1. Main 1 2. Select 1

Select Field Operand WValue |

Statement Cycle Beging with hd

Customer Number Al v

Customer Name Al

Salesperson Begins with

Customer Type: All

Sort Field Al pu

State Range

ZIP Code Al

Client Partner Al

Client Employes All b
Canen R330-400 P3 Ver 1.0 -

Statement Printing Window - Select Tab

18Choose the desired item from the Select Field column.

19Click the arrow in the Operand column and select the search equation for
sorting criteria you want from the drop-down list. Options include:

Operand Description

Begins With Returns any record whose field value begins with the filter
value specified on this row.

Ends With Returns any record whose field value ends with the filter
value specified on this row.

Contains Returns any record whose field value contains the filter
value specified on this row.

Less Than Returns any record where the field value is less than the
filter value specified on this row. Specifically, fieldValue <
filterValue.

Greater Than Returns any record where the field value is greater than

the filter value specified on this row. Specifically,
fieldValue > filterValue.

Range Returns any record where the field value is in between the
specified filter value. To enter the filter value, separate two
values by a comma. Specifically: filterValue1 < fieldValue
AND fieldValue > filterValue2.
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Operand Description

Equal To Returns any record where the field value exactly equals
the filter value.

All For display in filter preview only, has no effect on filter
results.

20Depending on the choice you make in the Operand column, click the E] button
in either or both Value columns, and select values for the sort function.

a Enter up to five statement cycles for the invoice printing in the Statement
Cycle field.

b Enter the customers to include in the Customer Number field.

¢ Enter the names of customers to include in the Customer Name field. This
field is available only if Customer Name is selected in the Sort Options field.

d Enter the salesperson to include in the Salesperson field. This field is
available only if Salesperson is selected in the Sort Options field.

e Enter the types of customers to include in the Customer Type field. This field
is available only if Customer Type is selected in the Sort Options field.

f Enter sort data to include in the Sort Field field. This field is available only if
Sort Field is selected in the Sort Options field.

g Enter the clients’ zip codes to include in the Zip Code field. This field is
available only if Zip Code is selected in the Sort Options field.

h Enter the employee partners to include in the Customer Partner field. This
field is available only if Customer Partner is selected in the Sort Options
field.

i Enter the employees to include in the Customer Employee field. This field is
available only if Customer Employee is selected in the Sort Options field.

j Enter the miscellaneous data to include in the user-defined fields. These fields
are available only if one of the user-defined fields created on the Time and
Billing Professional Options window (see page 80) is selected in the Sort
Options field.

21Click Alignment. An alignment test page for the selected form prints.

22Click Print to print the invoices, or Preview to preview the invoices.
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The invoices the system prints depend upon the settings selected for the invoices.
The following invoice is for a customer that is 120 days overdue.

R Customer Statements [_ o]
4 4 Taf1+ P M oE S & |[l00x ]| Tomaz 100z 32 0f 32
ABLE MANUFACTURING -
9445 HIGHLAND AVE
IRVINE, Ch 92713
01-ABLEMAN
031598 0000037-IN 8,633.00
04127198 PAYMENT REF: 10633 2,000.00
0510398 PAYMENT REF: 10442 5,000.00 1,683.00
041598 0000042-IH 7,900.00 7,900.00
051598 0000038-IH 506005 5,060.05
TOTAL 1464305
CURRENT 30 DAYS 60 DAYS 90 DAYS 120 DAYS
a0 000 000 000 14,643.05 14,643.05 &
K I D

Customer Statements

Period End Processing

Page 328

You perform Period End Processing at the end of each accounting period (usually,
the last business day of each month) to clear periodic files and prepare for the
following period’s business. When performed at year end, this same process also
clears year-to-date balances accumulated in the Client, Engagement, Employee,
and Work Code Master files to prepare for the new year. You can use other options
on the Period End Processing selection window to remove invoices with zero
balances and clear billing detail history information from the Billing History file.

This section contains instructions on how to use all of the Period End Processing
features available in Time and Billing Professional, and includes a checklist for
how to complete the period end processing.

Using Period End Processing

Process period end data, clear history files, and clear terminated employees with
the Period End Processing window. The following types of period end processing
options are available:

 Full Period End Processing (see page 329)

* Full Period End and Year End Processing (see page 330)

» Only Clear Billing Detail History File (see page 332)

» Purge Terminated Employees (see page 332)
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» From the Period End menu of the Time and Billing Professional menu bar,
select Period End Processing. The Period End Processing window appears.

[ T/2 Period End Processing

~—Perod End O phon
(%) Full Period End Processing

() Full Period and Year End Processing
() Only Clear Biling Detail History

() Purge Teminated Employees

Period End Piocessing will be performed for
Period 05 ending 05431/98

[ Lw2 | 9/7/2005

T/2 Period End Processing Window

Full Period End Processing

The Full Period End Processing option performs routine period end processing,
which usually occurs on the last business day of every month.

Complete Full Period End Processing

1 From the Period End Processing window, select Full Period End Processing
and click the Proceed button. The following window appears.

{5 1/2 Period End Processing [ x|

Full Period End Processing

Petiod 05 Ending 05/31/98

T/2 Period End Processing Window

®WARNING: Verify that the correct period and period ending date appear in
the Period and Ending fields of the Period End Processing window. If the
correct date does not appear, open Time and Billing Professional Options (see
page 80) and verify the period and date information.
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2 Click Proceed to continue. The Period End Reports window appears.

ﬂj Period End Reports

~—Frint the following report:
aged Work in Process Heport
Detall ‘Work in Process Report
&/F and WIF Reconciliation Report

Canon Sales [ FErint I Presiew I Frinter Setup...

Period End Reports Window

3 Check each period end report to print, and then click Print. The reports include:
* Aged Work in Process Report

* Detail Work in Process Report

¢ A/R and WIP Reconciliation Report

After the selected reports finish printing, the following dialog box appears.
{5 Sage MasS 90

9
</

Do you want to complete Period End Processing?

Sage MAS 90 Dialog

4 Click Yes The system completes the processing and advances to the next
period.

The Current Time and Billing Period field on the Time and Billing Professional
Options window (see page 80) increases to the next period.

Current Time and Biling Fiscal Year 1993 |° 4
Current Time and Biling Period 113 ﬂ

Full Period End and Year End Processing

The Full Period End and Year End Processing option performs the same functions
as Full Period End Processing, but it updates the balances for the last year. Select
this option only at year end (your last fiscal accounting period).

Time and Billing Professional Manual Chapter 11: Using the Period End Menu



Chapter 11

Complete Full Period End and Year End Processing

1 From the Period End Processing window, select Full Period End and Year End
Processing and click Proceed. The following window appears.

{if /2 Period End Processing

Full Period and ‘v'ear End Processing

Period 05 Ending 05/31/98

T/2 Period End Processing Window

®WARNING: Verify that the correct period and period ending date appear in
the Period and Ending fields of the Period End Processing window. If the
correct date does not appear, open Time and Billing Professional Options (see
page 80) and verify the period and date information.

2 Click Proceed to continue. The Period End Reports window appears.

{i Period End Reports [ x|

~Frint the fallowing report:
Aged Work in Process Report
Detail ‘work in Process Report
AR and WP Reconciliation Report

Canon Sales [ Print [ Preview [ Frinter Setup

Period End Reports Window

3 Check each period end report to print, and then click Print.

After the selected reports finish printing, the following dialog box appears.

i Sage MAS 90 [ <]

9 Do you want to complete Period End Processing?
</

Sage MAS 90 Dialog

4 Click Yes. The system completes the processing and resets the period and
advances to the next year.

The Current Time and Billing Fiscal Year and Current Time and Billing Period
fields on the Time and Billing Professional Options window (see page 80) reset the
period and advance to the next year.

Current Time and Biling Fizcal Year 1999 |
Current Time and Biling Period om j
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Only Clear Billing Detail History File

The Only Clear Billing Detail History File option purges the billing history for
invoices dated up to the current accounting date set in the Time and Billing
Professional module. Use this feature when your company needs to clear old
billing history.

Clear Billing History

1 From the Period End Processing window, select Only Clear Billing Detail
History, and then click Proceed. The following window appears.

EE T/2 Period End Processing

Selection All Starting Ending

Client Code - Q, [irrrrrrrilioN
Engagement Code i i

Biling History will be removed
if paid on ar before the follawing date
09407705

Proceed | Lancel
[ Lw2 | 9/7/2005
T/2 Period End Processing Window

I:gj HINT: Click the E] button in the appropriate field to select an item from a
Lookup window. Selecting from a sortable list places the item you selected in
the field.

2 Enter the clients to purge in the Client Code field.
» Check All to include the information for all clients.
OR
» Enter the client codes to include in the Starting and Ending fields.
3 Enter the client engagements to purge in the Engagement Code field.
» Check All to include the information for all engagements.
OR
» Enter the engagement codes to include in the Starting and Ending fields.

4 Click Proceed to continue. The system clears old billing history from Time and
Billing Professional.

Purge Terminated Employees

The Purge Terminated Employees option purges all employees terminated on and
before the date you specify on the Period End Processing window. This feature
purges employees that have the Terminated Employee field checked on the
Employee Maintenance window (see page 92).
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Clear Terminated Employees

1 From the Period End Processing window, select Purge Terminated
Employees. The Terminated Employees Date field appears on the window.

{5 1/2 Period End Pracessing

—Period End Optiar:
> Full Period End Processing

3 Full Period and ‘rear End Processing
(3 Only Clear Billing D etail History

(% Purge Teminated Employess

Terminated Employees will be purged

if termination date on or before

-

[ Lw2 | 9/7/2005

T/2 Period End Processing Window

2 Enter the last date to use for purging terminated employees in the field, and click
Proceed. The following window appears.

gﬁT,.-"Z Period End Processing

Purge Teminated Emplopees

Teminated Emplayees wil be purged
if termination date on or before:

09/07 /2005

T/2 Period End Processing Window - Purge

3 Click Proceed to continue. The system clears old, terminated employee files
from Time and Billing Professional.

Procedural Checklist

The following pages present a step-by-step review of the routine daily, period-end,
and year-end Time and Billing Professional activities you will need to perform. Use
this information as a checklist to ensure that you have completed all necessary
procedures to keep your operation running smoothly.

®WARNING: Backing up your data is an important part of your daily, period
end, and year end procedures. For more information on backing up your data,
see the Library Master Online Help by Sage Software.

Daily Processing Checklist

1 Set the Time and Billing Professional accounting date you want to use for
today's transactions.

2 Make any necessary changes or additions to client information using
Client Maintenance (see page 144).
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Enter daily time sheet and expense entries using Time/Expense Entry
(see page 168) and Edit Work in Process Entry (see page 231). Print the
Time/Expense Journal (see page 173) and Edit Work in Process Journal
(see page 235), and update the system with the changes.

Print the Daily Transaction Regqister (see page 177) and update to the
General Ledger.

Back up Time and Billing Professional data files. For more information
about backing up files, refer to the Library Master Online Help by Sage
Software.

Bill Processing Checklist

The following activities can be performed on a daily, weekly, or monthly basis,
depending upon your normal billing cycle.

1

4

S5

6
7

9o

Set the Time and Billing Professional accounting date you want to use to
post to the General Ledger.

Print the Billing Worksheet (see page 182) for clients/engagements to be

billed. The worksheet should be reviewed by the responsible partner or
employee for any adjustments to be made to the bill amount.

Select a group of clients/engagements to be billed using Billing Selection

(see page 186).

Select individual clients/engagements using Billing Data Entry (see page
191). You can also use Billing Data Entry to enter write-up/write-down
amounts by the client/engagement total, by category, or by individual
transactions.

Print the Billing Selection Register (see page 189) to review the selected
clients/engagements before printing invoices. Repeat step 4, as
necessary, to make any adjustments.

Print client invoices using the Invoice Printing option (see page 216).

Print the Billing Register (see page 219) and update the system with the
changes.

Print the Daily Transaction Register (see page 177) and update to the

General Ledger.

Print the Aged Invoice Report (see page 252), Aged Work in Process
Report (see page 255), and Accounts Receivables Analysis, as needed.

10 Print the Productivity (see page 271), Profitability (see page 279), Fee

Analysis (see page 286), and Budget Reports (see page 303), as needed.

1" Perform Transfer Work in Process (see page 222) or Delete Work in

Process (see page 224), as needed.
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12 Back up the Time and Billing Professional data files. For more information
about backing up files, refer to the Library Master Online Help by Sage
Software.

Period End Processing Checklist

1 Back up the Time and Billing Professional files onto a monthly set of
backup disks or tapes. For more information about backing up files, refer
to the Library Master Online Help by Sage Software.

2 Ensure that all time/expense entries, billings, and cash receipts have been
recorded for the current month.

3 Print all reports that you require from the Time and Billing Professional
Analysis menu.

4 Select Period End Processing (see page 328) and choose the Full Period
End Processing option (see page 329). When performing year-end
processing, select the Full Period End and Year End Processing option
(see page 330).

5 Select the reports you want to print for the period end. It is recommended
that you print at least the Aged Invoice Report. If you have retainer
clients/engagements, you should print the Retainer Transaction Report.

6 Complete period end processing after all of the selected reports have
been printed.

7 Back up the Time and Billing Professional files using a separate set of
disks or tapes. Do not use the set you used to back up the system in
step 1.

This concludes Chapter 11: Using the Period End Menu of the Time and Billing
Professional manual.
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Integration with Sage MAS 90 or 200

Chapter 12: Integration with Sage MAS 90 or 200 describes the changes to the
modules when integrated with Time and Billing Professional.

The Time and Billing Professional module can be integrated with your existing
Sage MAS 90 or 200 software. The Time and Billing Professional enhancement
can be used with the following modules:

» Accounts Receivable (see current page)

» Accounts Payable (see page 339)

» General Ledger (see page 14)

Accounts Receivable Module

The Time and Billing Professional module is automatically integrated with the
Accounts Receivable module. You can use the Accounts Receivable Cash
Receipts Entry window for retainer payments for Time and Billing Professional
engagements.

Cash Receipts Entry

Use Accounts Receivable Cash Receipts Entry to record retainer payments.
Retainer payments are added to the retainer balance for the client/engagement
and do not affect the Accounts Receivable balance. In Cash Receipt Entry, enter
your check detail as you would for a normal cash transaction.

For more information about the Cash Receipts Entry feature, see the Accounts
Receivable Online Help by Sage Software.

A On the Lines tab, in the Invoice field, enter RT.

B If the customer is a Time and Billing Professional client with a retainer billing
method, you will be asked if this is a Time and Billing Professional retainer. Click
Yes. The Engagement Lookup will appear.

C Select the engagement to apply the retainer to. The General Ledger account
will change to the default retainer account as set up in Time and Billing
Professional Division Maintenance (see page 90).

D Enter the retainer amount, and click Accept.

E When the A/R Cash Receipts Journal is posted, the retainer will be posted to
the client/engagement.
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Process a Retainer Payment

1 From the Accounts Receivable Main menu, select Cash Receipts Entry. The
Cash Receipts Deposit window appears.

Eﬁtash Receipts Deposit [z _]C]
Dieposit Murmber | 00007 [ | @ @ @ @
Description Deposit
Bank Code A % REGULAR CHECKING

Depasit Date 97200 =

Cash Deposit Amount 1.500.00

Deposit Balance 1.500.00

| Accept | LCancel l LDelete

Cash Receipts Deposit Window

2 Create a new deposit by clicking the button in the Deposit Number field.
You can also select an existing deposit from the Lookup list.

3 Enter the amount for the retainer deposit in the Cash Deposit Amount field,
and click Accept. The Cash Receipts Entry window appears.

gﬁtash Receipts Entry (LW2) 9/7/2005

Customer No, |01-#45TMIC |7 [ (0 (@ () O Deposit Type | Cash =

Hame MASTER MICRO MANUFACTURING
Check No. 565
1. Header I 2 Lines I

Amount Received 1.500.00
~Depasit Information
Customer Balance 11.933.00 Deposit Mumber ooaot
Pasting Balance 1,500.00 Description Depasit
Bark Code A
Deposit Date 9/7/2005
Cazh Amount Remaining oo
Deposit Remaining on

[ Accept l Cancel I Delste ;

Cash Receipts Entry Window - Header Tab

4 Select the customer for the retainer payment from the Customer No field.

5 Enter or select the number of the check for the customer payment in the Check
No field.

6 Enter the amount for the check in the Amount Received field.

Chapter 12: Integration with Sage MAS 90 or 200 Time and Billing Professional Manual Page 337



Chapter 12

7 Click the Lines tab to apply the retainer to the Time and Billing Professional

engagement.
£ Cash Receipts Entry (LW2) 6/26/2007 CEX
Customer No. @ @ @ ® Deposit Type
MName ABLE MANUFACTURING
Check No
1. Header ] 2 Lines ]
Guick Fiow = =] =T
Ireoice No. Iree Date I Asmount Disc Used Amt Posted
1 | .00 .00 .00
1a oo oo oo
< | 3
Line Type Invoice < -1
Rlcolit —1 Posting Balance oo
GL Account
o = v Total Posted 0o

Cash Receipts Entry Window - Lines Tab

8 Enter RT in the Invoice No field. The following dialog box appears.

5§ MAS 90 [ %]
9 Is this a Time and Billing Retainer?
¢

Sage MAS 90 Dialog

9 Click Yes The Engagement Code List window appears.

_Engagement Code /| Descriotion Started

kil | i
Search | EngagementCode~Engar ™| | Begins with =/

[Found 1 records Lw2 | B/11/2004

Engagement Code List Window

10Select the engagement code for the Time and Billing Professional engagement
to apply the retainer to. The retainer amount appears in the Line Details section.

11Click Accept to save the cash receipt.
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Accounts Payable Module

Expenses related to specific clients/engagements can be posted to Time and
Billing Professional when processing Accounts Payable transactions, if Accounts
Payabile is integrated with Time and Billing Professional. When the Accounts
Payable module is integrated with Time and Billing Professional, the following
features are available:

* Multiple expenses per employee, client/engagement, and work code can be
entered on distribution lines during Invoice Data Entry and Manual Check Entry.

* The Accounts Payable Invoice Data Entry Register and Accounts Payable
Manual Check Register will reflect clients, engagements, employees, work
codes, and General Ledger line accounts.

+ During the update process of the Accounts Payable Invoice Register and the
Accounts Payable Manual Check Register the Time and Billing Professional files
will also be updated.

Required Setup

To integrate Time and Billing Professional with Accounts Payable, complete the
following steps.

A On the Accounts Payable Options window, check the Time and Billing Pro
field on the Additional tab.

Integrate Accounts Payable with the Followin:
General Ledger ]
[] Bank Reconciliation ]
Time and Billing Pra

Time and Billing Pro Field

B For transactions to post to the Time and Billing Professional Work in Process
(WIP) accounts, check the Post Work in Process to General Ledger field
available on the Time and Billing Professional Options window (see page 80).
Setting this option will post billable expense amounts from Accounts Payable to
the General Ledger Work in Process account and the Work in Process offset
accounts.

Invoice Data Entry

Line items can be distributed to specific clients/engagements during Invoice Data
Entry in Accounts Payable. Information entered on the Header tab of Invoice Data
Entry is entered in the same manner for Time and Billing Professional related
invoices as it is for other Accounts Payable invoices. On the Lines tab, you can
enter Time and Billing Professional and General Ledger distribution for the invoice.
You can distribute the invoice to multiple employee/clients/engagements.

» Leave the Employee, Client, and/or Engagement fields blank for entries that
should not be distributed to Time and Billing Professional engagements.

» The Rate field is used to enter a percentage to mark up the expense. The
markup amount is what will post to Work in Process (WIP) in Time and Billing
Professional.
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For more information about the Invoice Data Entry feature, see the Accounts
Payable Online Help by Sage Software.

Create an Invoice for a Time and Billing Professional Engagement

1 Select Invoice Data Entry from the Accounts Payable Main menu. The Invoice
Date Entry window appears.

{3 A Invoice Data Entry (LW2) 6/26/2007 =
Yt [0 ] @@@®@E
Name AMERICAN CREDIT BANK |
Irwoice No E
2 e 1

Irwoice Date E‘] Tems Code El% NET 10TH
Irwoice Amolint Irwoice Due Date E‘]
Discount Due Date E‘]
Discount Amount 0o
Subiject to Discount
Prepaid Inwvoice l:l%
Hold Payment [] Separate Check  [[]
Cormmenk ‘ |

A/P Invoice Data Entry Window - Header Tab

2 Select the vendor from the Vendor No field.

3 Enter the amount for the invoice in the Invoice Amount and Subject to
Discount fields.

4 Click the Lines tab to enter the Time and Billing Professional engagement
expenses.

[ AP Invoice Data Entry (LW2) 6/26/2007

“endor Mo, (OIOIOION =]
Narme: AMERICAN CREDIT BANK ‘
Irmvoice Mo @
1. Header ] 2. Lines ]
QuickRow [ 1 BBBE ER--H-
Employes Client Engagement Work Units Rate Aot
1 o0 OTABLEMAN 00000000000000000000 CAR o 1.000
2 oo 0o
| 3
G/ Account | 40401 Q| -
G/L Acct Desc | Expenses Charged to Client GAS
Bill Tax O -
Distrbution Balance | 1000 Total | [

A/P Invoice Data Entry Window - Lines Tab

5 Select the employee for the Time and Billing Professional engagement in the
Employee field.
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6 Select the client for the Time and Billing Professional engagement in the Client
field.

7 Select the engagement for the Time and Billing Professional engagement in the
Engagement field.

8 Select the work code for the Time and Billing Professional engagement in the
Work field.

9 Select the General Ledger account for the line from the G/L Account field.
10Enter the amount of the expense toward the engagement in the Amount field.
11Click Accept to save the invoice.

Adjustments

The Accounts Payable Invoice Data Entry is also used to enter adjustments
against previously updated invoices. Adjustments may be entered if the invoice or
discount amount was entered incorrectly, if an invoice needs to be deleted, or the
distribution of the invoice was entered incorrectly. To enter an adjustment:

+ Select the vendor, and enter the invoice number to adjust.
» Select Adjust to modify the amount and dates for the invoice.

« To reduce the amount of the invoice, enter the adjustment as a negative number.
To increase the amount, enter the adjustment as a positive number.

|Z[NOTE: To delete an invoice, enter the balance of the invoice as a negative
amount. The balance adjusts to zero.

Adjust an Invoice for a Time and Billing Professional Engagement

1 Select Invoice Data Entry from the Accounts Payable Main menu. The Invoice
Data Entry window appears.

2 Select the vendor for the invoice from the Vendor No field.

3 Select the invoice from the Invoice No field. The Adjust Invoice on File window
appears.

[z Adjust Invoice on File H

Thiz invoice is alieady on file

[] ilnvaies.on Hald
[] Separate Check

[ Ok I LCancel I Adjust

Adjust Invoice on File Window

4 Click the Adjust button.

Chapter 12: Integration with Sage MAS 90 or 200 Time and Billing Professional Manual Page 341



Page 342

Chapter 12

The Header tab of the A/R Invoice Data Entry window displays the information
for the invoice.

[ AP Invoice Data Entry (LW2) 6/26/2007

‘endor Mo, Wo®®E
Mame AMERICAN CREDIT BANKE |

Ireenice No E

2 Lines ]

Irvoice Dale /262007 | Tetms Code (03 [@, WET 10TH

Iresnice Amount Ireenice Due Date

Dizcount Due Date ra
Diszount Amount on

Prepaid Invaice

Subject to Discount
L%

Hold Payment [] Separate Check [
Cornment | |

A/P Invoice Data Entry Window - Header Tab

5 Enter the amount for the adjustment in the Adjustment Amt and Subject to
Discount fields.

 To reduce the amount of the invoice, enter the adjustment as a negative number.
» To increase the amount, enter the adjustment as a positive number.

6 Click the Lines tab to apply this adjustment to a Time and Billing Professional

engagement.
[5 AP Invoice Data Entry (LW2) 6/26/2007 (=] J
vt [0 ] @@@®E
Mame AMERICAN CREDIT BANK |
Irmvoice Mo @
1. Header ] 2. Lines ]
Quick Faw l:l % @ % @E:% % T
Employes Client Engagement Wwork Units: Rate Amaunt
1 o0 OTABLEMAN 00000000000000000000 CAR o 1.000
2 oo .ooo
| »
G/ Account | 40401 Q| -
G/L Acct Desc | Expenses Charged to Client GAS
Bill Tax O -
Distribustion B alance | 10.00 | Tatal | 0.00 |

A/P Invoice Data Entry Window - Lines Tab

7 Select the employee for the Time and Billing Professional engagement from the
Employee field.

8 Select the client for the Time and Billing Professional engagement from the
Client field.
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9 Select the engagement for the Time and Billing Professional engagement from
the Engagement field.

10Select the work code for the Time and Billing Professional engagement from the
Work field.

11Select the General Ledger account for the invoice from the G/L Account field.
12Enter the amount for the invoice in the Amount field, and click OK.

+ To reduce the amount of the invoice, enter the adjustment as a negative number.
» To increase the amount, enter the adjustment as a positive number.

13Click Accept to save the invoice.

Invoice Register

After entering the transactions in Accounts Payable Invoice Data Entry, the next
step is to update Accounts Payable, Time and Billing Professional, and General
Ledger (if you are integrating with that module).

Updating Invoices

1 Select Invoice Register from the Accounts Payable Main menu. The Invoice
Register window appears.

{5 Accaunts Payable Invoice Regisler (LW2) 6/26/2007 Px
Current General Ledger Period |s: 05 | Ending |5/31/1338
Accounts Payable Posting Date |s: B/26/2007 @
PFrint Full Comments O
! ! MNotice: This &ccounts Papable posting date falls inta a future General Ledger period.
Canon iR330-400 PS Ver 1.0 - [ Frint I Preview I Setup

Invoice Register Window

2 Enter the date in the Accounts Payable Posting Date field.

3 Click Print or Preview, and then review the Accounts Payable Invoice Register
and Recap By Division reports.
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[ View Accounts Payable Invoice Register EJEl&‘
1 |« «—————— 1 sllaa | powe o by .
& & floex -] [ i b crystal =,®
Preview |
—
Accounts Papable Invoice Register
Joumal Posting Date: BR2E/2007
Register Number: AP-000003
Time and Biling Professional Demo (LW2)
[rerr— Daes
ivoe Numoer  mwocs Due Discount Invoice Amaunt Discount
Rem Unes Diarzea
Emo  Chet Engmement wark Maxo s Fasd Amt Amaunt
aCR [R———
1
1 Hnd
Srepad Amoue
Regort Tata T
Srepad Amous
v
< >

Invoice Register Journal

After the journal prints, the following dialog box appears.

i Sage MAS 90 [ <]

9 Do you want to update the Invoice Register?
-/

Sage MAS 90 Dialog

4 Click Yes to update the information.

|Z[NOTE: This step updates Accounts Payable and Time and Billing
Professional files.

The following dialog box appears.

i Sage MAS 90 [ x]

9 , Doyouwant to print a Daily Transaction Register?
</

Sage MAS 90 Dialog

5 Click Yes to print the Daily Transaction Register. The Daily Transaction Register
window appears.

EﬁDaily Transaction Register (LW2) 5/31,/1998

ACCOUNTS PAYABLE DAILY TRANSACTION REGISTER

j [ Print lF‘rexiewl Setup

Daily Transaction Register Window

6 Click Print or Preview, and then review the Daily Transaction Register.
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gﬂ‘view Daily Transaction Register [_ (O] x
| % & & o= =] || 1 4 ! oy | *Crystalege
Prevvigw I

-

Daily Transaction Register
Time and Billing Professional Demo {L'W2)

Postings For: 5311998

Source Joumal Account Number Account Description/Posting Comment Debit Credit
AP-000003 11500 ‘Wark In Frocess 1,794.30
ACCNT PAYABLE ENTRY FOR TR
116-00 Waork In Frocess Offset 1,794.30
ACCNT PAYABLE ENTRY FOR TR
203-00 Ascounts Payable 1.213.00
&P INVDICE ENTRY /D Iv: 00
413-02 Installation and Configuration 100.00
BUSINESS TRAVEL AN:TETE-DM
413-02 Installation and Configuration 200.00
QUICK PRINT SERYICE AN TEIE-D M
526-00 Travel and Entertainment 589.00
BUSINESS TRAVEL /IN: 5555
526-00 Travel and Entertainment 330.00
BUSINESS TRAVEL /IN: 5555
Joumal 000003 Toraks: 3.013.90 3.013.90
Source AP Totals: 3,013.70 3,013.70
373171998 Totals: 3,013.30 3,013.30
Report Totals: 3,013.70 3.013.70

-

I DCD | Lw2 | /7/2005

Daily Transaction Register

After the register prints, the following dialog box appears.

% , Doyouwant to update the Daily Transaction R egister?
</

Sage MAS 90 Dialog

7 Click Yes to update the information. This step updates General Ledger files.

Manual Check Entry

Use Manual Check Entry on the Accounts Payable Main menu to enter information
for handwritten checks. You can enter information for checks with payments
against open invoices or for invoices not already in the system.
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Enter a Manual Check for a Time and Billing Professional Engagement

1 Select Manual Check Entry from the Accounts Payable Main menu. The

Manual Check Entry window appears.

[ Manual Check Entry (LW2) 6/26/2007

Bank Code Cash Account | 10200
[ @@®®

Check No.

2 Lines ]

Check Date | B/26/2007 =]

Check Amount 10,00

Vendor No, AMCAD Q, [ |AMERICAN CREDIT BANK
Comment

EIEIX

Manual Check Entry Window - Header Tab

2 Select the bank code for the entry from the Bank Code field.

3 Create a new check by clicking the button in the

Check No field.

You can also select an existing check from the Lookup list.

4 Enter the amount of the check in the Check Amount field.

5 Select the vendor for the invoice from the Vendor No field.

6 enter the Time and Billing Professional engagement information for the invoice.

7 Click the Lines tab to enter invoice information.

% Manual Check Entry (LW2) 6/26/2007 =023
skt [ @ @@ ® Cahtina
CheckNo. [011173 |
1 Header W 2. Lines W

EA= Quick Fow g} -
Create GAL Distibution. Alt-G
T Inwoice No Inwoice Date Irmvice Amt Discaunt Amt Comment
1 CKO1173m 67262007 0o oo
] & o o
< 3
Due Date
Discount Date
G AL Distribution O
Check Distibution Balance | 2000 | Payment Total | 000 |

Manual Check Entry Window - Lines Tab
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¥ On the Lines tab, the following can occur: A new invoice can be created and
distributed to a client/engagement by selecting the Create G/L Distribution

([E) button.
8 Click the @ button. The G/L Distribution window appears.

[ Time and Billing Pro Distribution

Guick Row % E 5@ % <
Employee Client Engagement Wark Units Rate Amount
1 o100 01ABLEMAN  DO000000000000000000 CaR .oo 1.000 oo
2 0o ang 0o
< 3
G/ Account | 101-00 =
G/L Acct Desc | Cash on Hand ]
Bill Tax O o
Employee Mame | IMA WINNLUR -
Distribution Balance 20.00 Distribution Tatal 0.00

Time and Billing Pro Distribution Window

9 Select the employee for the Time and Billing Professional engagement from the
Employee field.

10Select the client for the Time and Billing Professional engagement from the
Client field.

11Select the engagement for the Time and Billing Professional engagement from
the Engagement field.

12Select the work code for the Time and Billing Professional engagement from the
Work field.

13Select the General Ledger account for the invoice from the G/L Account field.
14Enter the number of units in the Units field.

15Enter the percentage of the markup in the Rate field.

16Enter the amount for the manual check entry in the Amount field.

17Click Accept on the Time and Billing Pro Distribution window. The information
appears on the Manual Check Entry Lines tab.

18Click Accept on the Manual Check Entry window to save the information.

Manual Check Register

After entering Manual Checks, the Manual Check Register can be printed from
Manual Check Entry by clicking the button, or by selecting Manual Check
Register from the Accounts Payable Main menu. You must print the Accounts
Payable Manual Check Register prior to updating.
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Update the Sage MAS 90 or 200 System with the Manual Check Information

1 Select Manual Check Register from the Accounts Payable Main menu. The
Manual Check Register window appears.

ik Manual Check Register (LW2) 6/26/2007 2x

Curnrent General Ledger Period Is: Ending | 5/31/1998
Accounts Payable Pasting Date |+ . 07| @

Print Full Comments (|

! E MNotice: This Accounts Payable posting date falls into a future General Ledger period

[ Canan R330-400 PS Ver 1.0 -] (it | Preview | selw

Manual Check Register Window

2 Enter the date in the Accounts Payable Posting Date field.

3 Click Print or Preview and review the Accounts Payable Manual Register and
Accounts Payable Recap By Division reports.

[ View Manual Check Register f‘El&‘
1 |« «—————— 1 sllaa | powe o oy .
& & floex -] [ i b crystal =,®
Preview |
—
Manual Check Register
Joumal Posting Date: 6262007
Register Number: MC-000003
Time and Biling Professional Dem o (LW2)
Bank A REGULAR CHECKNG
Che Numoe: CheciDgte  Wendor Numter
Imveice Numser  mumics Date mvice Amount Dizemume Chesk Amount
Rae unte Distibtin
Emr i Engmemen Wak  Mamip i Faed Am Amoum
TRE
o117t
172
R faia
o1 4
BaniA Tont
RemortTots: g0
v
< >

Manual Check Register Journal

After the journal prints, the following dialog box appears.

[ Sage MAS 90 [ %]

% , Doyouwant to update the Manual Check Register?
\:/

Sage MAS 90 Dialog

4 Click Yes to update the information.

|Z[NOTE: This step updates Accounts Payable and Time and Billing
Professional files.
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The following dialog box appears.

[fiSage MAS 90

L ] Do pou want to print & Daily Transaction Register?
2

Sage MAS 90 Dialog

5 Click Yes to print the Daily Transaction Register. The Daily Transaction Register
window appears.

ﬂﬂbaily Transaction Register {LW2) 5/31,/1998

ACCOUNTS PAYABLE DAILY TRANSACTION REGISTER

j [ PBrint lF’rexiewl Setup

Daily Transaction Register Window

6 Click Print or Preview, and review the Daily Transaction Register.

ﬂﬁ\'iew Daily Transaction Register M=l E3
| % & &l =] || 1 4] 1  or|| o | *Ciystalege

Preview I
ﬂ

Daily Transaction Register
Time and Billing Professional Demo {(L'W2)

Postings For: 5311998

Source Joumal Account Humber Aceount Description/Posting Comment Debix Credic
MC-000001 102-00 Cash In Bank-Regulsr Checking 3589
AP MAHUAL CHECK REGISTER JDIV: 00

115-00 Waork In Prosess 46 £
&P M&NUAL CHECK REGISTER -T/2 LINES
116-00 ‘Wark In Frocess Offset 46 BE
A/ MANUAL CHECK REGISTER -T/2 LINES
524-00 Fostage and Delivery 3588
JANSEN COURIER SERVICE  /CKD11170
Joumal 000001 Totaks: a2 55 9z.95
Source MC Totals: 42 55 42 55
5/R141998 Torals: 32 55 3255
Report Totals: 3255 3255

KT _'I_I
[ Lw2 | 9/13/2005 ,;

Daily Transaction Register

After the register prints, the following dialog box appears.

% , Doyouwant to update the Daily Transaction R egister?
</

Sage MAS 90 Dialog

7 Click Yes to update the information. This step updates General Ledger files.

This concludes the Time and Billing Professional manual.
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Aging Category

Audit Report

Balance Forward Billing

Bank Code

Batch

Bill Type

Billing Format Code

Billing Rate

Billing Rate Code

Glossary

Glossary

Use this method for classifying accounts by the time elapsed after the date of
billing or the due date. You can define four categories. If invoices are aged by
days, the number of days in each aging category is user-definable. If invoices are
aged by months, the system defaults to one-, two-, three-, and four-month
categories.

Use this report to verify the accuracy of information entered into the computer.
Audit reports are usually required before a file update is permitted.

A billing method in which only current period activity is retained in detail. All
outstanding activity from the prior period is summarized into a single balance
forward amount.

Use this one-character alphanumeric code to identify each bank account set up in
the system. You can associate each bank code with a separate description,
General Ledger cash account number, and bank account number.

A collection of related data items entered at one time. Typically, a register is
printed listing all entries of a batch prior to updating the permanent files.

You assign one of four types of bill type when you create a category in Category
Maintenance that determines the manner in which the category of work is billed.
The bill type for a category code can be billable, non-billable, billable expense, or
non-billable expense.

Use this alphabetical code to identify a specific billing format for printing invoices.
You can maintain up to 26 different billing formats on the system including seven
predefined formats (billing format codes A through G). Billing format codes are
used system-wide and are not company specific.

The amount charged per hour or per unit to the client for the services of an
employee or for the completion of a particular task. You can establish billing rates
for employees, work codes, or clients.

Use this numeric code (0-9) to identify the billing rate assigned to an employee for
one or more specific tasks. You can assign each employee up to 10 billing rates.
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Category Code

Client Code

Client Referral

Compressed Printing

Custom Bill Rate

Detail Data Iltem

Employee Code

Employee Level

Engagement Code

Page 352

Glossary

Use this alphanumeric code to group related work codes for sorting and
summarizing work code information. Category codes are also used to classify
work codes as billable, non-billable, billable expense, or non-billable expense,
based on the bill type assigned to the category when you created it.

Use this alphanumeric code to identify the party for whom work is being
performed. You can change the term "client" in Time and Billing Options to suit the
terminology used by your business.

Enter this client code or person’s name in Client Maintenance indicating who
referred a client to your firm. You can print the Client Referral Listing to review
referral sources for your business. If PRSP is entered in the Client Type field for a
prospective client, you can use the Client Referral Listing to list only prospective
clients.

A capability provided by some 80-column printers which allows reports formatted
for a 132-character column width to be compacted and printed on an 8-1/2" X 11"

page.

Assign this unique billing rate to a specific employee working for a specific client or
on a specific engagement. The rates are established on the Custom Bill Rate
Maintenance window in Client Maintenance. Custom billing rates can also be
assigned to employee levels.

Use this data item in Billing Format Maintenance to designate work in process
detail information to be printed within the fees or expenses section of an invoice.

Use this alphanumeric code to identify an employee for whom you want to track
billing rate and history information.

Use this predefined code (0-9) to identify how an employee’s work should be
billed. You can assign levels by position (for example, manager or director) or by
the type of work being performed by an employee (for example, one level for
construction and another level for maintenance work).

Use this alphanumeric code to identify and track separate work activities for a
single client. You can assign each engagement code assigned a different fee
arrangement, billing rate, billing format, budgets, and employees. You can change
the term "engagement" in Time and Billing Options to suit the terminology used by
your business.
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Extended Comment

Fee Arrangement

Header Data Item

Header/Total Data ltem

Label Form Code

Marker Data Item

Open Item Billing

Progress Bill Balance

Progress Billing

Glossary

Glossary

You enter a comment during Time/Expense Entry, Edit Work in Process Entry, or

Billing Data Entry which is more than 30 characters in length. You can edit the text
in the Extended Comment window using the text editing functions in your Library

Master Online Help.

Use this method for determining how a particular client or engagement is billed,
and how the work in process (unbilled fees and expenses) is relieved. Fee
arrangements can be fixed, non-billable, progress, retainer, standard, or not to
exceed. You assign fee arrangements to each client/engagement using the Billing
tab in Client Maintenance.

Use this data item in Billing Format Maintenance to designate information to be
printed on each page of an invoice (for example, company name, address, and
engagement information).

Use this data item in Billing Format Maintenance to designate Client/Engagement
Master file information and to print applicable totals information on each page of
an invoice or in the Totals section of an invoice.

Use this alphanumeric code identifying a specific format contained in the Forms
file for printing labels. You must assign each format on file its own Label Form
Code.

Use this data item in Billing Format Maintenance to designate where a specific
section begins and ends on an invoice form.

Use this billing method to retain all invoice information in detail, and to apply cash
receipts and write-offs to specific invoices.

A balance of total progress bill amounts maintained for the client/engagement. The
progress bill balance is updated after the Billing Register is printed.

Use this billing method to bill a client/engagement on a progressive basis, without
relieving work in process. Each billing cycle, the client is billed automatically for the
progress bill amount established on the Billing tab in Client Maintenance. When
the engagement is completed, a final bill is processed to relieve work in process
and to bill the outstanding balance.
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Prospect Client

Rate Method

Retainer Applied

Retainer Balance

Retainer Billing

Sort Field

Standard Comment

Subtotal Data Item

System Options

Page 354

Glossary

A prospective client indicated by the entry of PRSP in the Client Type field in
Client Maintenance. You can make Time/Expense and Edit Work in Process
entries for prospective clients. You can print this type of client only on the Client
Listing, Client Mailing Labels, Client Memos, and Client Referral Listing.

Enter this code in Work Code Maintenance to determine which of the many

possible bill rates is charged for an activity. You can determine the rate charged by
these methods: a specific amount established for a work code; various levels/rates
established for an employee; a custom rate established for a client; or a fixed rate.

An amount entered during Billing Data Entry that is less than or equal to the
retainer balance for a client/engagement using the retainer fee arrangement. The
retainer applied is deducted from the billed work in process total amount to
calculate the bill amount for the invoice.

The total retainer payments received but not yet applied against billings. When you
record retainer payments using Cash Receipts/Write-Off Entry, the retainer
balance is increased. As retainers are applied during Billing Data Entry, the
retainer balance is decreased.

Use this billing method to specify a retainer amount to be billed during each billing
cycle. Clients/engagements using the retainer fee arrangement can apply prepaid
retainer balances against current billings to reduce the amount due for a given
period.

A maximum ten-character code, set up for each client in the Client Master file,
which provides an alternate means of sorting Accounts Receivable reports.

Any commonly-used phrase, description, or comment entered during
Time/Expense Entry, Edit Work in Process Entry, or Billing Data Entry which can
be printed on invoices.

Use this data item in Billing Format Maintenance to designate category and
invoice totals for fees and expenses to be printed in the Fees or Expenses section
of an invoice.

You enter this information during an application’s startup process. Use this
information to define specific operations of an application, meeting the individual
needs of the business.
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Uncollected Retainer

User Code

Work Code

Write-Down

Write-Off

Write-Up

Glossary

Glossary

The total retainer amount billed but not yet received. As retainers are billed, the
uncollected retainer is increased. As retainer payments are recorded using Cash
Receipts/Write-Off Entry, the uncollected retainer is reduced.

Use this alphanumeric code to identify which modules a particular user can
access. In the Time and Billing module you can print the Time/Expense Journal
and Edit Work in Process Journal by user code to track user activity within the
Time/Expense Entry and Edit Work in Process Entry functions. For additional
information about user codes, refer to your Library Master Online Help.

Use this alphanumeric code to identify each type of service, work, and expense
that you want to track for billing and reporting purposes. The term "work code" can
be changed in Time and Billing Options to suit the terminology used by your
business.

A reduction of the balance of an asset by charging an expense or loss account,
due to the diminished value of the asset. Use write-downs to reduce the bill
amount by adjusting the work in process during billing. You can enter write-downs
for the client/engagement total, for the category total, and for individual
transactions.

The reduction of a client’s invoice(s), as in the case of bankruptcy. Use write-offs
to reduce receivables after billing and updating.

The increase in the book value of an asset not due to a cash payment or other
asset. Use write-ups to increase the bill amount by adjusting the work in process
during billing. You can enter write-ups for the client/engagement total, for the
category total, and for individual transactions.
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